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Preface

This document provides information and instructions to help you set up Hitachi Device
Manager - Storage Navigator for your storage system, and manage user accounts and
permissions. It explains the GUI features and provides basic navigation information.

Additional information about performing specific tasks in Hitachi Device Manager -
Storage Navigator is contained in the software user guides.

Please read this document carefully to understand how to use this product, and keep a
copy for reference

Intended audience

This document is intended for system administrators, Hitachi Vantara representatives,
and authorized service providers who are involved in installing, configuring, and
operating Hitachi Virtual Storage Platform G1000, Virtual Storage Platform G1500, and
Hitachi Virtual Storage Platform F1500 storage systems.

Readers of this document should be familiar with the following:
■ Data processing and RAID storage systems and their basic functions.
■ The Hitachi Virtual Storage Platform G1000, Virtual Storage Platform G1500, and

Hitachi Virtual Storage Platform F1500 storage systems Product Overview.
■ The operating system and web browser software on the SVP hosting the Device

Manager - Storage Navigator software.

Product version

This document applies to the following product versions:
■ VSP G1x00, VSP F1500: Microcode 80-06-6x or later
■ SVOS RF: 8.3 or later

Release notes

Read the release notes before installing and using this product. They may contain
requirements or restrictions that are not fully described in this document or updates or
corrections to this document. Release notes are available on Hitachi Vantara Support
Connect: https://knowledge.hitachivantara.com/Documents.
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Changes in this revision
■ Changed description of LAN cables.
■ Updated information on capacity saving.
■ Updated the descriptions of the following system option modes (SOMs): 448, 449,

664, 1115.

Referenced documents
■ Hitachi Device Manager - Storage Navigator Messages, MK-948017

Document conventions

This document uses the following typographic conventions:

Convention Description

Bold ■ Indicates text in a window, including window titles, menus,
menu options, buttons, fields, and labels. Example:

Click OK.
■ Indicates emphasized words in list items.

Italic ■ Indicates a document title or emphasized words in text.
■ Indicates a variable, which is a placeholder for actual text

provided by the user or for output by the system. Example:

pairdisplay -g group

(For exceptions to this convention for variables, see the entry for
angle brackets.)

Monospace Indicates text that is displayed on screen or entered by the user.
Example: pairdisplay -g oradb

< > angle
brackets

Indicates variables in the following scenarios:
■ Variables are not clearly separated from the surrounding text or

from other variables. Example:

Status-<report-name><file-version>.csv

■ Variables in headings.

Changes in this revision
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Convention Description

[ ] square
brackets

Indicates optional values. Example: [ a | b ] indicates that you can
choose a, b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates
that you must choose either a or b.

| vertical bar Indicates that you have a choice between two or more options or
arguments. Examples:

[ a | b ] indicates that you can choose a, b, or nothing.

{ a | b } indicates that you must choose either a or b.

This document uses the following icons to draw attention to information:

Icon Label Description

Note Calls attention to important or additional information.

Tip Provides helpful information, guidelines, or suggestions for
performing tasks more effectively.

Caution Warns the user of adverse conditions and/or consequences
(for example, disruptive operations, data loss, or a system
crash).

WARNING Warns the user of a hazardous situation which, if not
avoided, could result in death or serious injury.

Conventions for storage capacity values

Physical storage capacity values (for example, disk drive capacity) are calculated based
on the following values:

Physical capacity unit Value

1 kilobyte (KB) 1,000 (103) bytes

1 megabyte (MB) 1,000 KB or 1,0002 bytes

1 gigabyte (GB) 1,000 MB or 1,0003 bytes

1 terabyte (TB) 1,000 GB or 1,0004 bytes

Conventions for storage capacity values
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Physical capacity unit Value

1 petabyte (PB) 1,000 TB or 1,0005 bytes

1 exabyte (EB) 1,000 PB or 1,0006 bytes

Logical capacity values (for example, logical device capacity, cache memory capacity) are
calculated based on the following values:

Logical capacity unit Value

1 block 512 bytes

1 cylinder Mainframe: 870 KB

Open-systems:
■ OPEN-V: 960 KB
■ Others: 720 KB

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 1,0242 bytes

1 GB 1,024 MB or 1,0243 bytes

1 TB 1,024 GB or 1,0244 bytes

1 PB 1,024 TB or 1,0245 bytes

1 EB 1,024 PB or 1,0246 bytes

Accessing product documentation

Product user documentation is available on Hitachi Vantara Support Connect: https://
knowledge.hitachivantara.com/Documents. Check this site for the most current
documentation, including important updates that may have been made after the release
of the product.

Getting help

Hitachi Vantara Support Connect is the destination for technical support of products and
solutions sold by Hitachi Vantara. To contact technical support, log on to Hitachi Vantara
Support Connect for contact information: https://support.hitachivantara.com/en_us/
contact-us.html.

Accessing product documentation
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Hitachi Vantara Community is a global online community for Hitachi Vantara customers,
partners, independent software vendors, employees, and prospects. It is the destination
to get answers, discover insights, and make connections. Join the conversation today!
Go to community.hitachivantara.com, register, and complete your profile.

Comments

Please send us your comments on this document to
doc.comments@hitachivantara.com. Include the document title and number, including
the revision level (for example, -07), and refer to specific sections and paragraphs
whenever possible. All comments become the property of Hitachi Vantara Corporation.

Thank you!

Comments
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Chapter 1:  Configuring the storage system
software

Device Manager - Storage Navigator (HDvM - SN) is the application used to configure the
storage system.

You can access Device Manager - Storage Navigator from management software to
perform additional system administration tasks on your storage system. In addition, you
can easily access advanced storage configuration options while performing management
operations with the management software.

Device Manager - Storage Navigator is factory-installed and runs on the service
processor (SVP) connected to the storage system.

In addition to the information in this guide, the HDvM - SN online help has procedures
for setting up and managing the storage system.

Setup workflow

Before you start managing your storage system, confirm the requirements and perform
set up procedures. The following workflow describes the set up tasks for Device Manager
- Storage Navigator:

1. Set up the management clients. See Setting up a management client (on page 24) .
2. An Hitachi Vantara representative attaches the SVP in your storage system to the

LAN. Device Manager - Storage Navigator is already set up on the SVP and is
therefore ready for access by management clients.

3. Set up network connections. If needed, see Network settings overview (on
page 23) .

4. Set up additional communications security for remote operations with Secure
Sockets Layer (SSL) if required. See Setting up SSL encryption (on page 73) for
details.

5. Set up user accounts. See User accounts (on page 114) .
6. Configure the management environment. See Device Manager - Storage Navigator

environmental parameters (on page 27) .
7. Install license keys for any software applications that are installed on the system.

See Managing license keys (on page 128) .

Requirements for the various tasks are included in the following topics.
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System Administrator Guide for VSP G1x00 and VSP F1500 19



Requirements for management clients

The Device Manager - Storage Navigator administrator is responsible for setting up
management clients.

The administrator's responsibilities include:
■ Ensuring that Device Manager - Storage Navigator management clients run on

supported versions of Windows and UNIX/Linux operating systems.

■ Verifying that management clients can access and use Device Manager - Storage
Navigator.

■ Configuring the server if you use a physical or virtual server running on Windows as a
management client.

General requirements

■ An SVP, required for system maintenance, must be connected to the storage system.
Device Manager - Storage Navigator connects to the SVP through a TCP/IP network.

■ Several storage systems can be managed by one management client. Device Manager
- Storage Navigator must be set up for each storage system.

■ A maximum of 32 management clients (Device Manager - Storage Navigator) can
access the same storage system concurrently.

■ Use category 5e or 6a LAN cable for LAN connections when the transfer speed is 1
Gbps. Maximum cable length is 328 feet (100 meters). For assistance, contact
customer support.

Requirements for Windows-based computers

The storage system must meet hardware and software requirements to run Windows as
the operating system.

The combinations of operating system, architecture, browser, Java Runtime Environment,
and Adobe Flash Player described below are fixed requirements. Using other
combinations or versions might produce unpredictable results such as the inability to
operate program windows.

Hardware requirements

Item Requirement

Processor (CPU) Pentium 4 640 3.2 GHz or better

(Recommended: Core2Duo E6540 2.33 GHz or better)

Memory (RAM) 2 GB or more

Recommended: 3 GB

Requirements for management clients
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Item Requirement

Available storage space 500 MB or more

Monitor True Color 32-bit or better

Resolution: 1280 x 1024 or better

Keyboard and mouse You cannot use the mouse wheel feature.

Ethernet LAN card for TCP/IP
network

100BASE-TX

1000BASE-T

Software requirements

Operating
system Browser

Java Runtime
Environment (JRE)

Adobe Flash
Player

Windows Server
2008 (SP2) 32 bit
or 64 bit

Internet Explorer 9.0 JRE 7.0 Update 17 11.7

Internet Explorer 9.0 JRE 7.0 Update 17 11.7

Windows 2008
R2 (SP1) 64 bit

Internet Explorer
11.0

JRE 7.0 Update 51 12.0

Windows Server
2012 64 bit

Internet Explorer
10.0

JRE 7.0 Update 17 11.7

Windows Server
2012 R2 64 bit

Internet Explorer
11.0

JRE 7.0 Update 51 12.0

Windows Server
2016 64 bit

Internet Explorer
11.0

JRE 8.0 Update 111 24.0

Windows Server
Vista (SP2) 32 bit
or 64 bit

Internet Explorer 9.0 JRE 7.0 Update 17 11.7

Internet Explorer 9.0 JRE 7.0 Update 17 11.7

Windows 7 (SP1)
32 bit or 64 bit

Internet Explorer
11.0

JRE 7.0 Update 51 12.0

Internet Explorer
11.0

JRE 7.0 Update 51 12.0

Windows 8.1 32
bit or 64 bit

Google Chrome 48.0
or later

JRE 8.0 Update 71 20.0

Internet Explorer
11.0

JRE 7.0 Update 51 12.0

Requirements for Windows-based computers
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Operating
system Browser

Java Runtime
Environment (JRE)

Adobe Flash
Player

Google Chrome 48.0
or later

JRE 8.0 Update 71 20.0

Notes:
■ If the SVP supports Internet Protocol Version 6 (IPv6), you can specify IPv6

addresses.
■ Use Adobe Flash Player with the same architecture (32 bit or 64 bit) as the browser.
■ Only the latest version of Internet Explorer active on each OS is supported,

according to Microsoft support policy.
■ The Device Manager - Storage Navigator computer must be restarted after enabling

Adobe Flash Player.

Note: To use Device Manager - Storage Navigator secondary windows, first
install Java Runtime Environment (JRE).

Requirements for UNIX/Linux-based computers

The storage system must meet hardware and software requirements to run UNIX or
Linux as the operating system.

Note: The combinations of operating system, architecture, browser, Java
Runtime Environment, and Adobe Flash Player described below are fixed
requirements. Using other combinations or versions might produce
unpredictable results such as the inability to operate program windows.

Hardware requirements

Item Requirement

Processor (CPU) Pentium 4 640 3.2 GHz or better

(Recommended: Core2Duo E6540 2.33 GHz or better)

Memory (RAM) 2 GB or more

Recommended: 3 GB

Available storage space 500 MB or more

Monitor Resolution: 1280 x 1024 or better

Keyboard and mouse You cannot use the mouse wheel feature.

Requirements for UNIX/Linux-based computers
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Item Requirement

Ethernet LAN card for TCP/IP
network

100BASE-TX

1000BASE-T

Software requirements

Operating system Architecture Browser
Java Runtime

Environment (JRE)
Adobe Flash

Player

Solaris 10 32 bit Firefox 3.6.26 JRE 7.0 Update 17 11.2

Red Hat Enterprise
Linux 6.2

64 bit Firefox 3.6.24 JRE 7.0 Update 17 11.2

Notes:
■ Use Flash Player with the same architecture (32 bit or 64 bit) as the browser.

Note:

The IPv6 HTTPS connection from Firefox is not supported.

Network settings overview

You can use IPv6 to set communication between the management client and the SVP.

You should assign the SVP the same type of IP addresses (IPv4 or IPv6) that are used on
the storage system. You must also configure the client computers with the same IP
version that you assign to the SVP. In addition, use the same communication options for
both the management client and the SVP.

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but IPv4 communication is actually used.

For information about how to configure IP communication from an SVP, see the
hardware guide for your storage system model. The following topics provide brief
instructions on configuring IPv6 communication.

Note: If the SVP uses IPv6, you must configure management clients to use
IPv6 for communication. Consult your operating system's documentation for
instructions.

Configuring IPv6 communication in Windows 7

If the SVP uses IPv6, you must configure Windows 7 management clients to use IPv6 for
communication.

Network settings overview
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Procedure

1. Select Control Panel > Network and Sharing Center > Manage network
connections.

2. Right-click the network where the SVP resides, and then click Properties in the pop-
up menu.
If the User Account Control dialog box opens click Continue. Otherwise, the
Networking dialog box opens.

3. In the Networking dialog box, clear the Internet Protocol Version 4 (TCP/IPv4)
check box.

4. Click OK to save the changes and close the dialog box.

Configuring IPv6 communication in Solaris 10

If the SVP uses IPv6, you must configure Solaris 10 management clients to use IPv6 for
communication.

Procedure

1. Start a command window or system console.
2. Execute the following command:

ifconfig network-interface-name inet down

Setting up a management client

Before running Device Manager - Storage Navigator on a management client, certain
web browser guidelines must be followed. Some guidelines apply to all browsers, while
other are specific to Internet Explorer and servers running Windows.

The Device Manager - Storage Navigator administrator is responsible for:
■ Ensuring that Device Manager - Storage Navigator management clients run on

supported versions of Windows and UNIX/Linux operating systems.

■ Verifying that management clients can access and use Device Manager - Storage
Navigator.

■ Configuring the server if you use a physical or virtual server running on Windows as a
management client.

Configuring a Windows Server

If you are using a Windows Server and Internet Explorer, set the options described below
before logging in to an SVP. For more information on configuring these settings, see the
Internet Explorer help documentation.

Configuring IPv6 communication in Solaris 10
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Procedure

1. Navigate to Tools > Internet Options > Advanced, and then click the Do not save
encrypted pages to disk check box to enable it.

2. Navigate to Tools > Internet Options > Security and register the URL of the SVP.

Configuring the web browser

To configure the client web browser, note the following:
■ The browser must allow first-party, third-party, and session cookies.
■ Pop-up blocker and plug-ins must be disabled.
■ The management client must be connected to the network via LAN.
■ The version of Adobe Flash Player specified in the management client requirements

must be installed.
■ For Firefox and Chrome users, you must enable Adobe Flash Player in your web

browser.

Consult your browser's documentation for instructions.

Adding your SVP to the trusted sites zone for Windows Server
computers

If you are using Device Manager - Storage Navigator on a Windows Server computer, the
following message may appear during login. If it does, you must add the SVP to the
trusted sites zone.

The message below may appear differently depending on the Windows version you are
using.

Configuring the web browser
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Procedure

1. Click Add in the message dialog box. The Trusted Sites dialog box opens.
2. In Add this web site to the zone, enter the URL of the SVP that you want to log in

to. For example, if the host name is host01, the URL is http://host01. If the IP
address is 127.0.0.1, the URL is http://127.0.0.1.

3. Click Add to add the URL of the SVP to the web sites list.
4. Click Close to close the dialog box.

Setting Device Manager - Storage Navigator environmental
parameters

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task. See Roles and permissions (on page 105) .
■ Read the information describing the Device Manager - Storage Navigator

environmental parameters (on page 27) .

Procedure

1. Start a web browser and enter the following URL to open the tool panel.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

2. Click Control Panel to open the Control Panel.
3. Enter the user ID and password and click Login.
4. Click the Set Env. tab to open the Environment Parameter window.
5. Specify the Device Manager - Storage Navigator parameters as required.
6. Click Submit.

Setting Device Manager - Storage Navigator environmental parameters
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7. Click Exit ( ) to close the Control Panel.

8. Log out of the Device Manager - Storage Navigator SVP and then log in again to
make the new parameters take effect.

9. Back up the Device Manager - Storage Navigator configuration file by downloading
the file from the SVP.

Device Manager - Storage Navigator environmental parameters

Using the tool panel, you can set the following Device Manager - Storage Navigator
environmental parameters:
■ Polling period for monitoring who is changing information while others are viewing
■ Time interval for monitoring disk controller and storage system status
■ Time period that a user is logged out of the SVP because of a network error
■ Time period when no changes are made that access the RMI server and the user is

released from Modify mode as a result

You can also specify whether to show or hide the Alerts tab.

Device Manager - Storage Navigator environment parameters are described in the
following table.

Item Description

RMI time-out
period

If the user cannot access the SVP for a certain period of time because
of a network error, the RMI time-out logs the user out of the SVP.
■ The value of the RMI time-out period must be greater than the

value set for the smallest polling period, either for checking
exclusive lock or for checking obstacles (see below for those
parameters). For example, specify a value of the RMI time-out
period to satisfy the following condition:

RMI time-out period > min [A, B]

where    

A = Polling period for checking exclusive lock    

B = Polling period for checking obstacles, and min [A, B] indicates
the minimum value selected from A and B.

■ The default is 1 minute. You can specify 1 minute, 5 - 60 minutes in
5-minute increments, 70 to 120 minutes in 10-minute increments,
or one day (24 hours).

■ This parameter cannot be disabled.

Device Manager - Storage Navigator environmental parameters
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Item Description

RMI time-out
period for
Modify

If a user is in Modify mode but does not make any changes that
access the RMI server for a specified period of time, Modify mode is
released, and the View mode appears.
■ The default time period is 30 minutes. You can specify between 10

and 60 minutes in 10-minute increments, or between 120 and 360
minutes in 60-minute increments.

■ Specify NO to disable this parameter.

Polling period
for checking
exclusive lock

Using Device Manager - Storage Navigator's secondary window,
specify the polling period for monitoring who is changing information
while in Modify mode when other users are viewing the storage
system information in View mode. The Locked and Unlocked icons are
automatically updated either when a user who is in Modify mode
either logs out from Device Manager - Storage Navigator or changes
to View mode.
■ The shorter the time period you specify, the more frequently the

Lock/Unlock status is updated, but this does increase network
traffic.

■ The default time period is 35 seconds. You can specify 5 to 60
seconds in 5-second increments, or 70 to 120 in 10-second
increments.

■ Specify NO to disable this parameter.

Polling period
for checking
obstacles

Specify a time interval to monitor the Disk Controller and Disk Array
Unit status, which is indicated by the Alerts window or the Device
Manager - Storage Navigator secondary window.
■ The default time period is 110 seconds. You can specify 5 to 60

seconds in 5-second increments, and 70 to 120 seconds in 10-
second increments for the parameter.

■ Specify NO to disable this parameter.
■ We recommend that you select NO when Hide alert information is

set in the Edit Advanced System Settings window.

Setting up Java

Set up Java to perform the following activities:
■ Enable tracing and logging so that you can collect log files when an application error

occurs on a Device Manager - Storage Navigator computer
■ Change the cache settings so that to prevent the old microcode from remaining in

cache when a microcode is updated, the old microcode will not remain in the cache
■ Configure a proxy server

Setting up Java
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Proxy server settings

You can set Device Manager - Storage Navigator to either use or not use a proxy server
to access the SVP. To do this, change the HTTP setting on the web browser on the
management client to either use a proxy server, or set the SVP as an exception so that it
does not use a proxy server. Whichever setting you use, make the same setting for Java.

Procedure

1. Start the Java Control Panel.

■ In Windows, from Windows Control Panel, double-click the Java icon.

■ In Unix, run one of the following executable files:

SDK-directory/jre/bin/ControlPanel

SDK-directory/jre/ControlPanel

JDK-directory/jre/ControlPanel

■ Alternatively, use a web browser to display one of the following Control Panel
pages:

SDK-directory/jre/ControlPanel.html

JDK-directory/ControlPanel.html

2. In the Java Control Panel, click the Advanced tab.
3. Under Debugging, click Enable tracing and Enable logging.

Setting up Java
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4. In the Java Control Panel, click the General tab.
5. In the Temporary Internet Files, click Settings. The Temporary Files Settings dialog

box displays.

6. In the Temporary Files Settings dialog box:
a. For JRE 7.0, click the Keep temporary files on my computer checkbox to

enable it.

Setting up Java
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b. In the Disk Space area, enter 1 MB.
c. Click OK to close the dialog box.

7. Configure the proxy settings as required.
a. In the Java Control Panel, select the General tab.
b. Click Network Settings to display the Network Settings dialog box.

8. In the Java Control Panel, click OK to close it.

Changing Java security settings

If you are having trouble opening the Device Manager - Storage Navigator secondary
window, make sure your Java security settings are set correctly.

If you use a management client in which Java 7 Update 55 or later is installed, or the one
in which Java 8 Update 5 or later is installed, the execution of an application might be
blocked when you try to open the Device Manager - Storage Navigator secondary
window. In this case, you need to change Java security settings according to the
procedure below.

Procedure

1. Check the version and update information of Java installed in your management
client. Click Start > Control Panel > Java.

2. On the General tab, click About.
3. Check the version and update information of Java, and then close the About Java

dialog box. If your PC uses either Java 7 update 55 or later, or Java 8 Update 5 or
later, you need to change Java security settings referring to Step 4 and after.

4. Select the Security tab.
5. Click Edit Site List.
6. In the Exception Site List dialog box, specify either of the following URLs, and then

click Add.

■ http://IP-address-of-SVP

■ https://IP-address-of-SVP

7. Click OK.
8. Select the Advanced tab.
9. Select Do not check (not recommended) of Perform signed code certificate

revocation checks on, and then click OK.
10. Close the Control Panel dialog box.

Device Manager - Storage Navigator secondary windows

The Device Manager - Storage Navigator secondary window runs within the Java Runtime
Environment (JRE).

Changing Java security settings
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The secondary window opens when you select a menu on the Device Manager - Storage
Navigator main window. The following functions and software applications use
secondary windows:
■ Authentication function of LUN Manager
■ Login Message function
■ Cache Residency Manager
■ Compatible PAV
■ Compatible XRC
■ Data Retention Utility
■ Server Priority Manager
■ Volume Retention Manager

To use the Device Manager - Storage Navigator secondary window, you must enable it in
advance. By default, this setting is disabled. When disabled, these functions and software
applications do not appear in the menu on the Device Manager - Storage Navigator main
window.

Google Chrome restrictions

Google Chrome shows the message "This type of file can harm your computer. Are you
sure you want to download <file name>.jnlp?" when you open the secondary
window.

Click Save in the message window and save the object file. Then open the file. Continue
the operation though Java security warning is displayed when you open the file.

SJsvlSNStartServlet (<serial number>).jnlp is saved in the download folder.
This file is duplicated every time you open the second window because this file is not
overwritten or deleted automatically. Delete extraneous downloaded
SJsvlSNStartServlet (<serial number>).jnlp files periodically to prevent
shortage of disc capacity. To confirm the download location, follow Chrome Menu >
Settings > Show advanced settings > Downloads.

Do not click Discard in the message window, or you will be unable to operate for a while
until the error (20020-108000) appears. Click OK to close the error and operate again.

If you don't want to wait for the error to appear, close Chrome and log in to Device
Manager - Storage Navigator again.

The error also appears if you do not click Save or do not open the saved file for some
time.

Requirements for using HDvM - SN secondary windows

This topic describes the configuration prerequisites for using Device Manager - Storage
Navigator secondary windows.

Requirements for using HDvM - SN secondary windows
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Installing and configuring JRE

JRE must be installed and configured in a Windows or Unix environment. You can
download JRE from http://www.oracle.com/technetwork/java/index.html.

Path setting (UNIX)

Verify that JRE is installed correctly by opening the ControlPanel.html file. It is located in
the JRE root directory. If the file opens, JRE is installed correctly.

Configuring JRE

On the JRE of each Device Manager - Storage Navigator computer, Java log file trace and
logging must be enabled and caching must be disabled. The Java log file can help you
troubleshoot a problem when an application error occurs in the Device Manager -
Storage Navigator web client. Disabling the caching feature can help prevent
complications when the microcode is updated. See the http://java.sun.com website for
more information on configuring JRE through the Java Control Panel.

Enabling the Device Manager - Storage Navigator secondary window

The Device Manager - Storage Navigator secondary window must be enabled before it
can be used.

Before you begin
■ You must have Storage Administrator (View Only) role to perform this task.
■ JRE must be installed and configured in a Windows or Unix environment. You can

download JRE from http://www.oracle.com/technetwork/java/index.html.
■ Verify that JRE is installed correctly by opening the ControlPanel.html file. It is located

in the JRE root directory. If the file opens, JRE is installed correctly.
■ On the JRE of each Device Manager - Storage Navigator computer, Java log file trace

and logging must be enabled and caching must be disabled. The Java log file can help
you troubleshoot a problem when an application error occurs in the Device Manager -
Storage Navigator web client. Disabling the caching feature can help prevent
complications when the microcode is updated. See the http://java.sun.com website
for more information on configuring JRE through the Java Control Panel.

Procedure

1. From the Settings menu, click Environmental Settings > Edit Information Display
Settings. The Edit Information Display Settings window opens.

2. In the Secondary window field, click Enable.
3. Click Apply.

Installing and configuring JRE

Chapter 1: Configuring the storage system software

System Administrator Guide for VSP G1x00 and VSP F1500 33

http://www.oracle.com/technetwork/java/index.html
http://www.oracle.com/technetwork/java/index.html


Lowering the IE security level on Windows Server 2012 or
later

One or more pages in Internet Explorer might not be displayed correctly due to the
Internet Explorer security settings. The following procedure explains how to decrease the
security level of the trusted Internet Explorer sites zone.

Before you begin

You must add the URL of the SVP to the "trusted sites zone".

Procedure

1. From the Internet Explorer menu bar, click Tools > Internet Options > Security.
The Internet Options window opens.

2. Click the Security tab. The Security window opens.
3. In the Security window, select Trusted sites.
4. Set the Security level for this zone to Medium-high.
5. Click OK and close the IE window.

Device Manager - Storage Navigator restrictions

Certain actions might cause errors within Device Manager - Storage Navigator or within
the browser when using Device Manager - Storage Navigator.

To avoid errors when using Device Manager - Storage Navigator, observe the following
restrictions.

General restrictions

To avoid errors while using Device Manager - Storage Navigator:
■ Do not change the local storage area value in Adobe Flash Player.
■ Do not change the management client clock setting while you are logged in to the SVP.
■ Do not change screen display settings such as resolution or refresh rate.
■ Do not use Microsoft Remote Desktop.
■ Do not use screen savers that change the screen resolution.
■ Do not set the management client to standby or hibernate. Do not allow the

management client battery to discharge far enough so that the management client
automatically enters standby or hibernate. If you do, you must restart Device
Manager - Storage Navigator.

■ If applicable, disable the auto-login function of any web-based software or web site
being used on the management client.

Lowering the IE security level on Windows Server 2012 or later
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Note: The functions keys, as well as the Home, End, and Delete keys are
disabled for Device Manager - Storage Navigator operations.

Web browser restrictions while using Device Manager - Storage
Navigator

When logged in to Device Manager - Storage Navigator, do not use web browser menus,
shortcuts, or other browser options as described here.
■ If you use Back, Next, or web browser shortcut keys such as F5 and Esc, you will be

logged out of Device Manager - Storage Navigator. Any settings you made during the
session will be lost.

■ Do not use the  button, the Close option in the File menu, or the Alt+F4 shortcut to
close the web browser. To close Device Manager - Storage Navigator, click Logout or
File > Close in the Device Manager - Storage Navigator menu.

■ Do not change the web browser settings such as Tools > Folder options in Internet
Explorer. If you do so and see unexpected results, close the web browser and log in to
Device Manager - Storage Navigator again.

■ Do not disable Adobe Flash Player because Adobe Flash Player is necessary for Device
Manager - Storage Navigator and works as an add-on to a web browser. If you use
Internet Explorer, do not change the settings in Tools > Manage Add-ons.

■ Do not use the following web browser functions: character encoding, text size, the
zoom function, the Ctrl+F (search), Ctrl+A (select all).

■ Use only the Tab key to move the focus to the Adobe Flash Player window. If you use
Shift+Tab to move the focus in reverse, the focus may not move from the web
browser to the Adobe Flash Player.

■ If you click a link that is blank or one for which a hyphen is displayed, nothing
happens.

■ In Internet Explorer, the window closes automatically when you click Logout at the
upper right corner of the Device Manager - Storage Navigator main window.

In Google Chrome, the window does not close when you logout.

When you display an HTML format report saved in your local file system in a Web
browser to which Adobe Flash Player version 23 or later is applied, add the folder
containing the HTML format report to Trusted Location Settings.

If a path to the folder where the report is stored is a Windows UNC path, perform either
of the following beforehand:
■ Copy the report to a folder in the local drive.
■ Register the folder containing the report to a network drive.

Procedure:

In Internet Explorer and Firefox:

1. Open Adobe Flash Player Settings Manager.
2. On the Advanced tab, click Trusted Location Settings under Developer Tools. The

Trusted Location Settings dialog box opens.

Web browser restrictions while using Device Manager - Storage Navigator
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3. Click Add. The Add Site dialog box opens.
4. Click Add Folder. Select the folder that contains the HTML format report, and then

click OK.
5. In the Add Site dialog box, click Confirm.
6. In the Trusted Location Settings dialog box, click Close.
7. Close Adobe Flash Player Settings Manager.

In Google Chrome:

1. Open Adobe Flash Player Settings Manager.
2. On the Global Security Settings panel, select Add locations from the drop-down list

box.
3. Enter a path to the folder containing the HTML format report in the Trust this

location text box. Do not use Browse for files or Browse for folder because they do
not work correctly.

4. Click Confirm.
5. Close Adobe Flash Player Settings Manager.

Unsupported actions in Windows version of HDvM - SN

The following actions are not supported in any version of Device Manager - Storage
Navigator:
■ The right mouse button does not open a popup menu in the Device Manager -

Storage Navigator main window. If you right click, the Adobe Flash Player pop-up
menu opens instead.

■ The copy (Ctrl+C) and paste (Ctrl+V) shortcuts do not copy and paste text to a text
box in Device Manager - Storage Navigator.

■ No drag-and-drop operation is available in Device Manager - Storage Navigator.
■ The mouse wheel may not function in the Device Manager - Storage Navigator

secondary window.
■ The web browser zoom function does not work correctly in the Device Manager -

Storage Navigator window. When you hold down on the Ctrl key and use the mouse
wheel, part of the Device Manager - Storage Navigator window might not be
displayed.

Unsupported actions in UNIX version of HDvM - SN

The following actions are not supported in the UNIX version of Device Manager - Storage
Navigator:
■ You cannot change the Device Manager - Storage Navigator window size.
■ You cannot drag-and-drop objects in the Volume Migration or LUN Manager windows.

Unsupported actions in Windows version of HDvM - SN
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■ If you click the Device Manager - Storage Navigator secondary window when you are
using Volume Migration, the Volume Migration window may be fully or partially
hidden behind the Device Manager - Storage Navigator window. However you cannot
use the front Device Manager - Storage Navigator window.

Close the Volume Migration window before using the Device Manager - Storage
Navigator secondary window. If the Volume Migration window is hidden behind the
Device Manager - Storage Navigator window, click the Volume Migration window to
bring it to the foreground, and then close it.

■ The Close  button on the Volume Migration window remains active even if you click
Apply while the Volume Migration process is running. If you click Close  after
clicking Apply, the Volume Migration window closes but the Volume Migration process
continues.

■ The word "Loading..." only appears in the Volume Migration window message
dialog box for the first operation. This message does not re-appear after the first
operation.

Applying changes made in Device Manager - Storage Navigator

When applying changes in Device Manager - Storage Navigator, be aware of the following
behavior:
■ When an internal process is running on the SVP (for example, a configuration change,

option check, or an operational information acquisition), Device Manager - Storage
Navigator processing might be temporarily delayed.

■ If you request a change to the storage system configuration in the secondary window
while another change is being made, an error message appears.

If the error occurs while you are logging in or clicking Apply to implement changes,
wait a few minutes, then retry the operation.

If the error occurs while you are either switching between Modify and View mode, or
switching tabs, wait a few minutes, click Refresh on the File menu, and then retry the
operation.

■ When the microcode is being updated on the SVP, you must exit and restart all web
client sessions on the Device Manager - Storage Navigator management client.

■ When you use Device Manager - Storage Navigator on Windows, the Add or Remove
Programs window in the Windows Control Panel might or might not display Device
Manager - Storage Navigator. Device Manager - Storage Navigator works in both
cases.

Updating data after a Volume Migration or Quick Restore operation

During an operation for Volume Migration, ShadowImage, ShadowImage for Mainframe,
or Quick Restore, a Device Manager - Storage Navigator window might display old
information (data from before the operation) on logical volume (LDEV) configurations.
Wait until the operation completes, and then click File > Refresh All to update the Device
Manager - Storage Navigator window.

Applying changes made in Device Manager - Storage Navigator
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Updating data after operations performed with another application

Be aware that it may take time to update the information in Device Manager - Storage
Navigator after you have performed an operation on the storage system using another
application, such as CCI.

Capacities displayed on the Device Manager - Storage Navigator
screen

Unless otherwise specified in this manual, capacity values are rounded down to the
second decimal place for TB, GB, or MB or to the nearest integer for Cyl when displayed
on the Device Manager - Storage Navigator screen. Therefore, displayed values may be
lower than the actual values.

The value converted from 1Cyl to KB depends on the volume's emulation type. The
following table lists cylinder capacities by emulation type.

Emulation Type 1 Cylinder Capacity (KB)

Open Systems OPEN-V 960

Other 720

Mainframe - 870

Caution on LUN ID notation

The format of LUN IDs in the Device Manager - Storage Navigator main and secondary
windows depends on the storage system. The following table describes those
differences.

Storage system Format in the main window
Format in secondary

windows

VSP G1000, VSP G1500, and
VSP F1500

Decimal or hexadecimal

Default: Decimal

Decimal only

USP V/VM Hexadecimal only Decimal only

Virtual Storage Platform Hexadecimal only Decimal only

If LUN IDs are displayed in hexadecimal format, you can enter LUN IDs for USP V/VM or
VSP as is.

However, if LUN IDs are displayed in decimal format, you must convert them to decimal
format before entering them in the Device Manager - Storage Navigator main window.

To switch the LUN ID notation of the Device Manager - Storage Navigator main window
between decimal and hexadecimal, use the Edit Information Display Settings window.
For details, see Edit Information Display Settings window (on page 385) .

Updating data after operations performed with another application
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Chapter 2:  Using Device Manager - Storage
Navigator

Follow instructions to log on to Device Manager - Storage Navigator properly. You then
can use Device Manager - Storage Navigator, windows, and wizards to get started.

For information about viewing storage system information, see Viewing and managing
the storage system (on page 144) .

Logging in to Device Manager - Storage Navigator

You can log in to Device Manager - Storage Navigator in different ways.

If you are an administrator, you can log in to Device Manager - Storage Navigator with a
one-time only initial login.

If you are a superuser, you can log in first to Device Manager - Storage Navigator to
create other user accounts.

If you are a Device Manager - Storage Navigator and storage system user or
administrator, you can log in normally.

Initial superuser login

Follow these instructions to log in as a superuser.

When logging on to Device Manager - Storage Navigator for the first time, you must log
on as a superuser to set up additional user accounts.

The superuser account has a built-in ID, which includes all permissions, and a default
password.

Procedure

1. Call your local service representative to obtain the superuser ID and default
password.

2. In your web browser, specify the URL for your SVP:

https://IP-address-or-host-name-of-SVP/sanproject/
          

To change the port number of the protocol from the initial value (443), specify the
following URL:

https://IP-address-or-host-name-of-SVP:port-number-of-the-protocol/
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3. Log in with the superuser ID and password.
4. To prevent unauthorized use of the superuser account, change the password

immediately after you log in. Click Settings > User Management > Change
Password to change your password.

After you log in, the Device Manager - Storage Navigator main window opens. You
can navigate using the menu, tree, or General Tasks. Precise instructions for
performing an operation can be found in the software user guides. Also, see
Appendixes D through I, which describe the screens in the GUI.

User login

By logging in, you can manage users and licenses, create a login message, or edit
advanced system settings.

Procedure

1. In your web browser, specify the following URL:

https://IP-address-or-host-name-of-SVP/sanproject/

2. The following actions might be required to open the login dialog box, depending on
your environment:

■ If a message indicates that the enhanced security configuration is enabled on the
management client, select In the future, do not show this message and click
OK.

■ If the SVP is set to support SSL-encrypted communication and security messages
appear, make sure the certificate is correct and follow the instructions in the
dialog box.

■ If a message indicates that certain web sites are blocked, follow instructions in
Adding your SVP to the trusted sites zone for Windows Server computers (on
page 25) .

3. Type the user ID and password.
4. Click Login.
5. If the Security Information dialog box appears, click Yes.
6. If a local storage area pop-up dialog box of Adobe Flash Player Setting appears, click

Allow to open the Device Manager - Storage Navigator main window. The cache
function of Adobe Flash Player optimizes the process of Device Manager - Storage
Navigator. Denial of the request might delay the processing speed of Device
Manager - Storage Navigator.

User login
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After you log in, the Device Manager - Storage Navigator main window opens. You
can navigate using the menu, tree, or General Tasks. Precise instructions for
performing an operation can be found in the software user guides. Also, see
Appendixes D through I, which describe the screens in the GUI.

Note: If login fails three times with the same user ID, Device Manager -
Storage Navigator stops responding for one minute. This is for security
purposes and is not a system failure. Wait, then try again. The roles and
resource groups for each user are set up ahead of time and will be
available to you when you log in to Device Manager - Storage Navigator.
If the roles or resource allocations for your username are changed after
you log in, the changes will not be effective until you log out and log back
in again. When you use a web browser for a long period of time, memory
is heavily used. We recommend closing or logging out of Device Manager
- Storage Navigator after you are finished using it.

Changing the initial password

After the administrator gives you a user ID and password, you should change the
password after you log in.

Procedure

1. Log in to Device Manager - Storage Navigator with the user ID and password given
to you by the administrator.

2. Click Settings > User Management > Change Password to change your password.

Navigating the Device Manager - Storage Navigator user
interface

The following figure shows an example of the GUI main window. In this example, Logical
Devices has been selected.

Changing the initial password
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Menu bar

The following illustration shows the menu bar in the Device Manager - Storage Navigator
main window. The table below the illustration describes the menu items and their
functions.

Item Description

Click to return to the previous window.

Click to advance to the next window.

Menu bar
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Item Description

File ■ Refresh All: Acquires all the information about the storage
system and updates both the SVP and Device Manager - Storage
Navigator. You must have the Storage Administrator (initial
configuration) permissions to use this function. See Roles and
permissions (on page 105) .

■ Logout: Logs the current user out of Device Manager - Storage
Navigator.

Actions Provides actions to the storage system such as creating LDEVs or
performing replication copy.

Reports ■ Task Management: Manages the tasks that will be applied to the
storage system.

■ Configuration Report: Creates and downloads storage system
configuration reports.

■ Performance Monitor: Monitors performance of the storage
system.

■ Shredding Report: Downloads the shredding report.

Settings ■ User Management: Manages Device Manager - Storage
Navigator user accounts, including changing passwords.

■ Resource management: Performs resource group related
operations

■ Security: Performs audit log or encryption operations
■ Environmental Settings: Configures the license, the refresh

interval of the window or an external server. Resets view
settings that can be customized, such as width or order of table
column. See the table in Column Settings window (on page 362)
for items that are reset using Reset View Settings.

View Changes the font size in the window.

Help Displays the online help

Using the Device Manager - Storage Navigator main window

You can perform operations by using the main window and wizards.

Procedure

1. Click a function in the resource tree in the Explorer.

Using the Device Manager - Storage Navigator main window
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2. If necessary, choose a tab and use a filter to reduce the number of items in the
table.

3. Select an item in the table and click a button to open a wizard.

4. Set options in the wizard and click Finish to confirm the setting.
5. Enter a task name and click Apply to apply the setting to the storage system. The

setting is queued as a task and performed in order.

Tip: To open the task window after closing the wizard, select Go to tasks
window for status and click Apply in the wizard.

6. Open the task window to verify the result of the operation. A task can be suspended
or canceled if the processing of the task is not started.

Main window controls

The following figure shows the buttons that appear in the upper left part of the main
window.

Buttons

Main window controls
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The Back button displays the previous window; the Next button displays the next
window. Device Manager - Storage Navigator tracks up to 10 operations and the windows
that display depend on the selection from the navigation tree.

The following figure shows the buttons that appear in the upper right part of the main
window.

Table Controls

The following figures shows the controls used to view and filter the results in a main
window table:

To scroll through pages of the table, use the left and right arrows or type a page number
into the number field. To select all rows in the table, click Select All Pages. To display a
table column, click Column Settings. If filter is ON, the filtered rows are selected. To sort
the table, click the header of the column that you want to use to sort.

When you sort a capacity column, the column will be sorted by bytes regardless of the
capacity unit used in the items in the column. Therefore columns in units of cylinders
(cyl) may not necessarily be sorted in ascending or descending order of the number of
cylinders. Even if the number of cylinders is the same, the capacity may not be the same
according to the emulation type.

To save the displayed information to a TSV file, click Export under More Actions. This
action is demonstrated in the following figure.

Table Controls
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When you change the default file name, confirm that the file name contains the .tsv
extension to save the file.

Filtering

To filter the table, select or input the desired filtering conditions and click Apply.

Note:
■ Users can set up to 16 conditions.
■ When the input condition is wrong, click Apply to clear the condition.
■ Select the attribute whose date and time values must be entered, and

then enter the values.
■ The values of date and time are "YYYY/MM/DD" and "hh:mm:ss",

respectively.
■ After you enter the date in the first box, "00:00:00" is displayed in the

second box as a default time value. Edit this value as needed and click
Apply.

Tooltip

When text displays in the main window, ellipses (...) may be displayed to show that the
text is truncated. If you place the mouse cursor over an ellipsis (...), the full text displays
in a tooltip (a small "hover box").

Filtering
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Main window and Modify mode

There is no Modify mode for the Device Manager - Storage Navigator main window. Main
window and wizard operations are queued as tasks and performed in order. However,
when using a Device Manager - Storage Navigator secondary window, you must be in
Modify mode before changing any settings. Secondary window operations are not
queued or displayed in the task window.

Using Device Manager - Storage Navigator secondary windows

Some Hitachi Device Manager - Storage Navigator operations are performed through
secondary window within the Java Runtime Environment (JRE).

This section describes requirements, operation methods, notes, and troubleshooting
required to use Hitachi Device Manager - Storage Navigator secondary windows.

Secondary windows and wizards

When you select an operation to perform, a secondary window or wizard is displayed.

Figure 1 Example of a secondary window

Main window and Modify mode
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Figure 2 Example of a wizard

Secondary window menus and buttons

The following figure shows the Device Manager - Storage Navigator secondary window.

The following table describes the menus and buttons accessible in the window.

Secondary window menus and buttons
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Item Description

Title bar Provides information about the connected storage system.
■ IP indicates the IP address of the SVP.
■ S/N indicates the serial number.
■ D/N indicates the device name specified in the Edit storage system

window.

File > Refresh
All

Updates the information on the SVP. All information displayed on the
Device Manager - Storage Navigator secondary window is reacquired
from the storage system. We recommend that you use this command
only when error recovery is required.
■ Takes time until the processing has been completed.
■ While updating, other users are not allowed to perform any

operation on the Device Manager - Storage Navigator windows.
Maintenance of the storage system or the SVP operation by the
service personnel is not allowed, either.

■ Available only for the user with Storage Administrator (Initial
Configuration) role.

■ Available only when the user is in Modify mode.
■ The information may not display correctly if SVP maintenance is in

progress.
■ Try this command if the configuration information displayed on

the Device Manager - Storage Navigator differs from the actual
configuration information that can be recognized from the host.

File > Refresh Displays the latest information on Device Manager - Storage
Navigator.

The information might not display correctly when the exclusive lock is
effective or SVP maintenance is in progress.

File > Close Closes the Device Manager - Storage Navigator secondary window

Go menu Indicates software names

Help menu About: Opens the About dialog box to show the version of the
storage system.

 Unlocked

 Locked

Indicates the current operational mode of Device Manager - Storage
Navigator.

If all logged in users are currently working in the view mode, the blue

unlocked-shaped icon ( ) appears. If any user is working in the

Modify mode, the red locked-shaped icon ( ) appears.

Secondary window menus and buttons
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Item Description

Note: The operational status might not be displayed correctly when
the exclusive lock is effective or SVP maintenance is in progress.

 View

 Modify

Allows users to switch the operation mode between Modify and View.
The button always shows the current user operation mode. To change
the modes, click the button.

You cannot switch to the Modify mode while any other user is
operating in the Modify mode. Make sure to confirm the exclusive
lock icon before switching to the Modify mode.

Reset Reset the remaining time for the Modify mode. Appears only when
you are in Modify mode.

Logged in as Shows the user ID of the currently logged-in user.

Logout
Closes the Device Manager - Storage Navigator secondary window.

Apply Implements all the changes or settings displayed in blue bold italics.
This button is available only in Modify mode.

You can create and store up to 20,000 settings or operations before
actually applying them to the storage system. To avoid a possible
error, do not apply more than 20,000 settings at a time.

Cancel Cancels the changes or settings made on the window. This button is
available only in Modify mode.

Opening Device Manager - Storage Navigator secondary windows

Some Device Manager - Storage Navigator operations are performed through secondary
windows that use a Java application. For this reason, whether you are using JRE 5.0 or
6.0, a message might appear and ask if you want to run a Java Application. You might see
slightly different dialog boxes depending on your environment and configuration. For JRE
5.0, the Warning - Security dialog box (shown below) displays when the digital signature
has expired.

To use Device Manager - Storage Navigator, if you select Always trust content from this
publisher in the Warning - Security dialog box before clicking Run, Device Manager -
Storage Navigator is always allowed to access the local files. When you click Run, you will
not see this dialog box again.

Opening Device Manager - Storage Navigator secondary windows
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Note: The Device Manager - Storage Navigator digital signature has an
expiration date and it might be expired depending on the Device Manager -
Storage Navigator version that you use. Even though the digital signature is
expired, you can continue using Device Manager - Storage Navigator.

Note: The following Java versions do not allow the Device Manager - Storage
Navigator secondary window to display.
■ Java 7 Update 55 or later
■ Java 8 Update 5 or later

To start up the window, you need to change Java security settings. For details,
see Changing Java security settings (on page 31) .

HDvM - SN secondary windows and Modify mode

A secondary window opens when you click a command from the Device Manager -
Storage Navigator menu. To make settings in a secondary window, you must change to

Modify mode by clicking . Modify mode prohibits other users or programs from
changing the storage system setting. As soon as you close the secondary window, Modify
mode is released.

Modify mode has a timeout period. If you do not access SVP before the end of the
timeout period, Modify mode is released. On some windows, the settings made but not
yet applied to the storage system will be canceled.

Resetting timeout period for Modify mode

The secondary window displays the progress bar (shown in the following figure)
indicating the remaining time in the timeout period. To extend this period and remain in
Modify mode, click Reset.

HDvM - SN secondary windows and Modify mode
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The Modify mode default timeout period is 30 minutes, but can be changed by modifying
RMI time-out period for Modify.

If Modify mode is released due to a timeout, the current window will still be visible, but
an error message is returned when you click Apply, or when you try to update the

window through File > Refresh All  or Refresh .

Resetting the secondary window

The Device Manager - Storage Navigator secondary window is reset when you do any of
the following:
■ Click Apply or Cancel
■ Click Refresh or Refresh All on the File menu
■ Switch tabs

Cautions when using secondary windows

If you use IPv6 to display the Device Manager - Storage Navigator main window when
both IPv4 and IPv6 are available, IPv6 addresses are displayed in the Device Manager -
Storage Navigator secondary window but actually IPv4 communication is used.
■ The mouse wheel may not function in the Device Manager - Storage Navigator

secondary window.
■ If you accept other processing while you are changing the configuration of the storage

system on the secondary window, an error occurs.
■ If an error occurs when you try to log in or when you click Apply, wait awhile and log

in again.
■ If an error occurs when you switches operation modes (View/Modify) or tabs, wait

awhile and click File > Refresh.

Resetting the secondary window
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Java updates

Some Device Manager - Storage Navigator operations are performed using Java
applications. You may be prompted to update the Java application when navigating to
these operations, as shown in the following figure.

Note: The following Java versions do not allow the Device Manager - Storage
Navigator secondary window to display.
■ Java 7 Update 55 or later
■ Java 8 Update 5 or later

To start up the window, you need to change Java security settings. For details,
see Changing Java security settings (on page 31) .

Note:

The Java Update Needed dialog box appears when a newer version of Java is
available. Depending on your environment, the appearance of this dialog box
might differ.

Note the following:
■ To download and install the recommended Java version, click Update (recommended).

If the secondary window does not display after the update is complete, see Enabling
the Device Manager - Storage Navigator secondary window (on page 33) .

■ To prevent Java content from displaying in the current browser session, click Block. If
the secondary window does not display after the update is complete, see Enabling the
Device Manager - Storage Navigator secondary window (on page 33) .

■ To use the currently installed Java version, click Later. The Device Manager - Storage
Navigator secondary window for the application you are using opens.

After you click Later, if the error 20020-108000 appears, open the Device Manager -
Storage Navigator main window, and then open the secondary window again.

■ To prevent this dialog box from appearing again, check Do not ask again until the next
update is available.

Java updates
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Troubleshooting secondary windows

This topic describes cautions peculiar to the Device Manager - Storage Navigator
secondary window. For troubleshooting issues common to the main and secondary
windows, see Chapter 8 Troubleshooting.

Java application errors

Error condition Probable cause / recommended action

When you click the Device Manager -
Storage Navigator menu, the system does
not respond. One minute later,
application error (20020-108000) occurs.

The pop-up blocker function of your web
browser might restrict Device Manager -
Storage Navigator. If the problem still
continues after you perform the operation
multiple times, perform one or both of the
following actions:
■ Disable the pop-up blocker function of

your web browser.
■ Disable the pop-up blocker function of

any browser plug-in/add-on.

If neither of the above can be performed
in Internet Explorer, you can open the
window by clicking the Device Manager -
Storage Navigator menu while holding
down the Ctrl key.

Another possible cause is that a Java
application was not allowed to start. If a
message appears and asks if you want to
run an application, click Run.

If none of the above actions solve the
problem, reinstall the JRE.

When you click the Device Manager -
Storage Navigator menu, a message
appears asking you to download the file
SJsvlSNStartServlet.do or
SJsvlAppStartServlet.do. One minute later,
the application error (20020-108000)
occurs.

The possible causes are that the JRE is not
installed in the management client, the
JRE installation failed, or the JRE add-on is
disabled on the web browser. Cancel the
message, and install the JRE. If the JRE is
already installed, reinstall it.

When you click the Device Manager -
Storage Navigator menu, a message
appears asking you to save a Jnlp file.

Perform the following to save the
encrypted page:

1. In Internet Explorer, click Tools >
Internet options, and then select the
Advanced tab.

2. In the Security section, uncheck Do
not save encrypted pages to disk.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

3. Click OK.

■ The application errors (20020-108000
and 10-6027) occur when you click the
Device Manager - Storage Navigator
menu.

■ The application error (10-6027) occurs
and Device Manager - Storage
Navigator terminates when you click
the Device Manager - Storage
Navigator menu.

If the problem continues after you
perform the operation multiple times, see
the probable causes listed below.

For Windows: Exit all applications using
Java, and then terminate the javaw.exe
and javaws.exe applications through Task
Manager.
■ Java on the Device Manager - Storage

Navigator web client might have failed
to start due to timeout. Close all other
applications and perform the Device
Manager - Storage Navigator operation
again.

■ The version of Device Manager -
Storage Navigator installed on the
management client might not match
the SVP version. Close all the windows
of your web browser and then clear the
Java and web browser cache.

■ The management client might have
entered standby or hibernate mode.
Restart the management client.

■ If a proxy server is used for network
connections, the proxy cache may be
storing the older version of the
program. If the problem continues
after you clear the Java and web
browser caches, contact your network
administrator.

■ The network connection between the
SVP and the management client might
be blocked by a firewall or some kind
of device.

Check the firewall settings and contact
your network administrator.

If none of the above actions solve the
problem, save the dump file, the Java
trace file and the log file on the
management client, and report to
customer support. Then restart Device
Manager - Storage Navigator.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

When you click the Device Manager -
Storage Navigator menu, the system does
not respond.

If the problem continues after you
perform the operation multiple times,
close all the Device Manager - Storage
Navigator windows and clear the Java and
web browser caches.

The application error (1-7050) occurs
when you click the Device Manager -
Storage Navigator menu.

The version of Device Manager - Storage
Navigator installed on the management
client might not match the SVP version.
Close all the windows of your web
browser and then clear the Java and web
browser caches. In addition, if a proxy
server is used for network connections,
the proxy server cache may be storing the
older version of the program. If the
problem continues after you clear cache
of both Java and web browser, contact
your network administrator.

Java console is grayed out and does not
start when you try to open the Device
Manager - Storage Navigator secondary
window (Java application).

Restart the management client, or
terminate the Device Manager - Storage
Navigator process with one of the
following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

A message box remains displayed when
opening the Device Manager - Storage
Navigator secondary window (Java
application). The Device Manager -
Storage Navigator secondary window
does not appear for a long time.

Restart the management client, or
terminate the Device Manager - Storage
Navigator process with one of the
following methods:
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
the Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

A message remains displayed when the
Device Manager - Storage Navigator
secondary window opens and the system
does not respond.

The SVP may be set as an exception on
the proxy setting of the web browser.

Make the settings the same on the
Network Configuration dialog box,
which is located in the Java Control Panel's
General dialog box.

If you open the Java console dialog box by
selecting the Java icon on the system tray
while opening the Device Manager -
Storage Navigator secondary window
(Java application), the browser and Java
console may stop responding.

Do not open the Java console dialog box
while opening the Device Manager -
Storage Navigator secondary window. If
the browser and Java console stop
responding, restart the management
client.

When you click the Device Manager -
Storage Navigator menu. The application
error (20020-108000) occurs.

If the problem continues after you repeat
the operation several times, you might
have cancelled the display of the
secondary window. Restart the
management client, or terminate the
Device Manager - Storage Navigator
process with one of the following
methods: For example:
■ You might have clicked Exit on the

Security Warning window.
■ You might have clicked Cancel on the

Warning - Security window.

Close all the Device Manager - Storage
Navigator windows and clear the Java and
web browser caches.

If the problem continues after you clear
both Java and web browser caches, save
the Device Manager - Storage Navigator
dump file and the Java trace file, and send
them to customer support.

Troubleshooting secondary windows

Chapter 2: Using Device Manager - Storage Navigator

System Administrator Guide for VSP G1x00 and VSP F1500 57



Error condition Probable cause / recommended action

The following message displays in Device
Manager - Storage Navigator.
■ Java has discovered application

components that could indicate a
security concern.

■ Block potentially unsafe components
from being run. (recommended)

■ The application contains both signed
and unsigned code. Contact the
application vendor to ensure that it has
not been tampered with.

Select Yes to continue using Device
Manager - Storage Navigator. If the
problem continues, the cause may be one
of the following:
■ The version of Device Manager -

Storage Navigator installed on the
management client might not match
the SVP version. Close all the windows
of your web browser and then clear the
cache of both Java and the web
browser

■ If a proxy server is used for network
connections, the proxy server cache
may be storing an older version of the
program. Clear the cache of both Java
and the web browser. If the problem
remains, contact your network
administrator.

In Internet Explorer, the following pop-up
window appears when you open the
Device Manager - Storage Navigator
secondary window.

"Internet Explorer has stopped working. A
problem caused the program to stop
working correctly. Windows will close the
program and notify you if a solution is
available."

Third-party browser extensions of Internet
Explorer might be enabled.

Disable third-party browser extensions as
follows:

1. In the Windows menu bar, click Tools
> Internet Options, and then click the
Advanced tab.

2. In the Advanced tab, clear the Enable
third-party browser extensions
(requires restart) check box.

3. Restart Internet Explorer.

In Internet Explorer, an application error
(10-6027) occurs when you open the
Device Manager - Storage Navigator
secondary window.

The SmartScreen Filter function might be
enabled when you use Internet Explorer
8.0 or later. Turn off SmartScreen Filter as
follows:

1. In the Windows menu bar, click
Safety > SmartScreen Filter > Turn Off
SmartScreen Filter.

2. Restart Internet Explorer.

In Internet Explorer or Google Chrome,
either of the following pop-up windows
appears when you open the Device
Manager - Storage Navigator secondary
window.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

"Application Blocked by Java Security" or
"Application Blocked by Security Settings"

Note: The following Java versions do not
allow the Device Manager - Storage
Navigator secondary window to display.
■ Java 7 Update 55 or later
■ Java 8 Update 5 or later

To start up the window, you need to
change Java security settings. For details,
see Changing Java security settings (on
page 31) .

Also, note that the certificate signed to the
SVP program might be expired.

You can perform the application by adding
the SVP URL to the exception site list by
using the following procedure:

1. Open the Java Control Panel.
2. Click Edit Site List on the Security tab.

Exception Site List displays.

3. Click Add.
4. Enter URL. Begin with http:// or

https://
(example: http://IP-address-of-
SVP or https://IP-address-of-
SVP).

5. Click OK. If Security Warning - HTTP
Location displays, click Continue.

6. Click OK on the Java Control Panel
and close the window.

7. Restart your web browser.

No response errors

Error condition Probable cause / recommended action

Device Manager - Storage Navigator hangs
and does not respond.

From the Device Manager - Storage
Navigator secondary window, press
Ctrl+Alt+Shift+D all at once to exit Device
Manager - Storage Navigator.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

Device Manager - Storage Navigator may
hang in the following cases:
■ When you move a window displayed in

front of the Device Manager - Storage
Navigator secondary window, the area
behind the window remains gray and
does not go back to normal for a long
period of time.

■ The entire Device Manager - Storage
Navigator secondary window goes gray
and does not go back to normal for a
long period of time.

If you cannot exit Device Manager -
Storage Navigator, reboot the
management client or restart Device
Manager - Storage Navigator after
finishing Device Manager - Storage
Navigator forcibly by the following way.
■ For Windows: Exit all applications using

Java, and then terminate the javaw.exe
and javaws.exe applications through
Task Manager.

■ For UNIX: Exit all applications using
Java, and then terminate javaw and
javaws with the kill command.

When you click Refresh All or Refresh in
the Device Manager - Storage Navigator
secondary window, it displays the
message "Loading" for a long time".

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration. The window will be
updated shortly after the configuration
change ends.

■ Volume Migration operations, Quick
Restore operations or Thin Image
operations may be in progress. The
window will be updated shortly after
the operations end.

Error 110-67005 occurred during a Device
Manager - Storage Navigator operation on
the secondary window.

The probable causes are:
■ Another application such as Command

Control Interface may be changing
configuration.

■ Volume Migration operations, Quick
Restore operations, or Thin Image
operations may be in progress.

■ The configuration data may not be
matched if a communication error
occurs between the storage system
and the SVP. Wait a few minutes and
then click File > Refresh All to reread
the configuration information. Then
launch Device Manager - Storage
Navigator again.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

While you are using a Device Manager -
Storage Navigator secondary Window, it
closes unexpectedly and error
20020-108000 occurs.

Start the Device Manager - Storage
Navigator secondary window from the
Device Manager - Storage Navigator main
window again. If this error occurs
repeatedly, close all the Device Manager -
Storage Navigator windows, and then
clear the Java and web browser caches.

The web browser closes abnormally This problem can occur if a Mozilla
process keeps running after Mozilla stops
responding. Delete the "java_vm" and
"mozilla" processes and continue with
Device Manager - Storage Navigator
operations.

One of the following sets of errors
occurred when using Device Manager -
Storage Navigator:
■ 20121-107024 and 10-6027
■ 20020-108000 and 10-6027
■ 10-6027

The probable causes are:
■ The SVP may have been restarted.

Close Device Manager - Storage
Navigator, wait 10 minutes, and then
restart it.

■ The version of Device Manager -
Storage Navigator installed on the
management client might not match
the SVP version. Close all the browser
windows and then clear the browser
cache.

■ The management client might be in
standby or hibernate mode. Restart
Device Manager - Storage Navigator.

■ If a proxy server is used for network
connections, the proxy server cache
may be storing the older version of the
program. If the problem continues
after you clear the browser cache,
contact your network administrator.

■ Restart the web browser

If none of the above actions solve the
problem, save the Device Manager -
Storage Navigator dump file and send it to
customer support.

Troubleshooting secondary windows
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Incorrect display errors

Error condition Probable cause / recommended action

Only the Exit button and the Refresh and
Refresh All commands are effective when
accessing the SVP from Device Manager -
Storage Navigator.

The SVP might not be ready to perform
some write processes from the other
system. Wait a few minutes and then click
File > Refresh. If the SVP is not restored,
click Refresh All.

Only the Exit button and the Refresh All
command are effective when accessing
the SVP from the Device Manager -
Storage Navigator.

An error may have occurred in the SVP.
Click File > Refresh All. If the SVP is not
restored, log in to Device Manager -
Storage Navigator again.

The commands in the Go menu are
unavailable.

The required software options might not
be installed or an error might occur on the
window that appears after you click the
command.

Make sure that all the required software
options are installed. If they are installed,
do one of the following:
■ Click File > Refresh.
■ Click File > Refresh All.
■ Log in to Device Manager - Storage

Navigator again.

When you switch windows from one
window to the Device Manager - Storage
Navigator window, the Device Manager -
Storage Navigator window is not
displayed.

Close all windows, and then log in to
Device Manager - Storage Navigator again.

The items in a list are not synchronized
with a scroll bar.

Click the scroll buttons  or 

above and below the scroll bar.

The focus disappears from the edit box. Close all dialog boxes, and then log in to
Device Manager - Storage Navigator again.

The web browser does not display
correctly, because some GUI items such as
labels and icons cannot be loaded
properly.

Log out of Device Manager - Storage
Navigator, and then log in again. If this
error occurs before you log in to the
Device Manager - Storage Navigator, close
all dialog boxes and then log in to Device
Manager - Storage Navigator.

The characters are unreadable because
they are overlapped or garbled.

Log out of Device Manager - Storage
Navigator, and then log in again.

Troubleshooting secondary windows
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Error condition Probable cause / recommended action

The characters are garbled in a window
where a tree is displayed.

Click File > Refresh.

Even though you have clicked Apply to
change storage system settings, the new
settings are not displayed in Device
Manager - Storage Navigator.

Click File > Refresh.

The dialog box that says Loading... stays
open for a long period of time.

A Device Manager - Storage Navigator
message dialog box other than the dialog
box that says Loading... might be
displayed behind this window. Press
Alt+Tab to switch the dialog box.

If the dialog box that says Loading...
remains displayed for several hours after
you apply the settings to the storage
system, contact customer support.

The following information does not
display in Device Manager - Storage
Navigator windows:
■ Information on the storage system,

such as ports or HDDs
■ Information configured with another

management client

Click File > Refresh. If the problem
continues, close all Device Manager -
Storage Navigator windows, and then
clear the Web browser caches.

The Device Manager - Storage Navigator
secondary window does not display.

■ In the Java Control Panel, click the
Temporary Internet Files section. In the
Disk Space area, enter 1 MB, and then
click Delete Files.

■ Click Security > Java Control Panel.
Ensure that Enable Java content in the
browser is checked.

■ Clear the browser cache.
■ Ensure that Java Plug-in is enabled.

If none of the above actions solve the
problem, the web browser might not
recognize Plug-in correctly. Initialize and
redo the web browser settings.

Troubleshooting secondary windows
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Other errors

Error condition Probable cause / recommended action

If you click in a Device Manager - Storage
Navigator secondary window while a
dialog box is open, the dialog box
disappears behind the Device Manager -
Storage Navigator secondary window.

Click the dialog box again.

An error occurs because a digital
signature or security certificate has
expired.

You can continue using Device Manager -
Storage Navigator even though the digital
signature for the Device Manager -
Storage Navigator Java application is
expired.

You specify IPv6 communication
addresses when you start Device Manager
- Storage Navigator, but IPv6 is not being
used. Instead, IPv6 is being used and IPv4
addresses are output to audit logs for
operations on the Device Manager -
Storage Navigator secondary window.

IPv4 has higher priority when both IPv4
communication and IPv6 communication
can be used. As a result, IPv4 may be used
when you specify IPv6 communication
addresses. Also, IPv4 addresses may
appear in audit logs.

For details on configuring only IPv6
communication, see Network settings
overview (on page 23) .

Clearing Java caches

When an error occurs on Device Manager - Storage Navigator, clear the Java and web
browser caches to solve the problem. To clear the Java cache, click Delete the temporary
files in the General dialog box of the Java Control Panel.

Saving Java log and trace files

Before you contact your service representative, save the detail dump files collected using
the Dump tool, and the Java log and trace file on your Device Manager - Storage
Navigator computer, and then restart the web browser.

Examples of the Windows trace and log file locations are shown below.
■ C:\Users\logon user ID\AppData\LocalLow\Sun\Java\Deployment\log\*.trace
■ C:\Users\logon userID\AppData\LocalLow\Sun\Java\Deployment\log\*.log

Examples of the UNIX trace and log file locations follow:
■ user home directory\.java\deployment\log\*.trace
■ user home directory\.java\deployment\log\*.log

Clearing Java caches
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Balloon dialog box

When you click an underlined link on the Device Manager - Storage Navigator screen,
additional information may appear as a pop-up, which is called a balloon dialog box. The
following illustration shows an example of a balloon dialog box.

Session timeout

A session timeout occurs if the system receives no user operation for one minute due to
a network error.

Updating your user view

If you remain in the same Device Manager - Storage Navigator view while other users
change the configuration of the system, the changes that others make do not appear in
your view. You can tell how long it has been since your screen was updated by checking
the clock on the title bar to the left of the update button. The clock displays server time,
not the time on your local workstation. When you place the cursor over the clock, the
system displays the number of minutes that have passed since the screen was updated.

To see changes that others might have made, click Update in the title bar in the top right
corner of the screen.

Balloon dialog box
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Reverting to the default view

You can adjust Device Manager - Storage Navigator settings for column width and order,
table options, filter conditions, and similar parameters. Device Manager - Storage
Navigator saves these settings after you logout. When you login again, your settings
appear as you left them in your last session.

You can also return your settings to default.

To return your settings to default, select Settings > Environmental Settings > Reset User's
View Settings.

The parts and items that are recorded as user settings are shown in the following table:

Window part Item State after reset

Magnification - Normal (100%)

Summary Open/Closed Open

Table General Selecting row NA

Page First page

Scroll position Top left

Setting column Default state1

Column Sort NA

Width Default state1

Order Default state1

Option Row/Page 1000

Capacity unit GB or Cyl

Filter ON/OFF OFF

Settings NA

Open/Closed Closed

Wizard Option part Open/Closed Default state1

LUN ID notation - - Decimal integer

1. The default state varies from window to window.

Reverting to the default view
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Creating a login message

You can create text to be displayed on the Device Manager - Storage Navigator login
page.

Prerequisites
■ You must have Security Administrator (View & Modify) role to perform this task.
■ You must enable the Device Manager - Storage Navigator secondary window. See

Enabling the Device Manager - Storage Navigator secondary window (on page 33) .

Procedure

1. Click Settings > Security > Login Message.
The Device Manager - Storage Navigator secondary window opens.

2. Click  to change to Modify mode.

3. Enter the message in the window.
Alphanumeric characters and symbols can be used in the message. The maximum
length of the message is 2,048 characters.

4. Click Apply to save the message and close the dialog box.

Creating a login message
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Chapter 3:  Configuring the storage system

When configuring the storage system, you must set storage system information, set up
the network connection, and register the SVP if using one.

Setting storage system information

You can set the name, contact information, and location of the storage system.

Caution: Make sure to document the configured values, because they are
required to use SNMP agents.

Caution: When changing a setting more than once, ensure that the current
setting is complete before changing it again. Otherwise, only the new change
will be applied, and the result might be different from what you expected.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to complete this

procedure.

Procedure

1. In the Device Manager - Storage Navigator Storage Systems tree, select the storage
system.

2. From Settings, click Environmental Settings > Edit Storage System.
3. Enter the items that you want to set.

You can enter up to 180 alphanumeric characters (ASCII codes) excluding several
symbols (\ , / ; : * ? " < > | & % ^). Do not use a space at the beginning or the end.

4. Click Finish.
5. In the Confirm window, check the settings and enter a task name in Task Name.
6. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to show the status of the task.

Setting up security

Device Manager - Storage Navigator supports a variety of security features for
authenticating users and configuring secure system operation.
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Configure the storage system with the security settings appropriate for your
environment.

Setting up TCP/IP for a firewall

To connect the Device Manager - Storage Navigator computer and the SVP through a
firewall, configure the firewall so that the TCP/IP port for the protocol you use becomes
available.

When attaching Device Manager - Storage Navigator to multiple storage systems, the
installer must log in to the SVP of each storage system using separate Device Manager -
Storage Navigator sessions and separate web browser instances.

The following table describes the firewall configuration.

Protocol Port number Direction of communication

HTTP 80 From the Device Manager - Storage Navigator
web client to the SVP

HTTPS 443

HTTPS (raidinf) 5443

RMI 1099

RMI 51099

RMI 51100

SMI-S 427

SMI-S 5989

SNMP1 161

SNMP Trap1 162 From the SVP to the Device Manager - Storage
Navigator web client

Command Control
Interface

31xxx2 From a host to the SVP

Command Control
Interface

34xxx2 From the SVP to a host

Configuration
Manager REST API

23454 From the SVP to the Configuration Manager REST
API

Notes:

1. Required if you use a Device Manager - Storage Navigator web client as an SNMP
manager.

2. x indicates a number. For details about port numbers that are used for
communication between a host and an SVP using CCI, see the Command Control
Interface User and Reference Guide.

Setting up TCP/IP for a firewall
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Managing authentication and authorization servers

An authentication server enables users to log in to Device Manager - Storage Navigator
with the same password as the password that they use for other applications.

The authentication server must be configured for each user.

The following figure shows login workflow without an authentication server:

The following figure shows login workflow with an authentication server:

If an authorization server works together with an authentication server, the user groups
that are registered in the authorization server can be assigned to a user for Device
Manager - Storage Navigator.

The following figure shows login workflow when an authentication server and an
authorization server are used in combination:

You can use the authentication server without knowing the host names and port
numbers, if you register the information of the authentication server as a service record
(SRV) on the DNS server. If you register multiple numbers of authentication servers to
the SRV record, you can determine the authentication server to be used, based on the
priority that has been set in advance.

Authentication server requirements

Authentication servers support the LDAP, RADIUS, and Kerberos protocols.

The following lists explain requirements for each protocol:

Managing authentication and authorization servers
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LDAP
Authentication format

LDAPv3 simple bind authentication

Certificate file format
■ X509 DER format
■ X509 PEM format

RADIUS
Authentication format

RFC 2865-compliant RADIUS
■ PAP authentication
■ CHAP authentication

Kerberos
Authentication format

Kerberos v5

Encryption type
Windows
■ AES128-CTS-HMAC-SHA1-96
■ RC4-HMAC
■ DES3-CBC-SHA1
■ DES-CBC-CRC
■ DES-CBC-MD5

Solaris or Linux
■ DES-CBC-MD5

Note:

Two authentication servers (one primary and one secondary) can be
connected to a storage system. In this case, the server configurations must be
the same, except for the IP address and the port.

If you search for a server using information registered in the SRV records in
the DNS server, confirm that the following conditions are satisfied. For
RADIUS servers, you cannot use the SRV records.

LDAP server conditions:
■ The environmental setting for the DNS server is completed at the LDAP server.
■ The host name, the port number, and the domain name of the LDAP server are

registered in the DNS server.

Authentication server requirements
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Kerberos server conditions:
■ The host name, the port number, and the domain name of the Kerberos server

are registered in the DNS server.
■ You cannot use the SRV records on a RADIUS server.

Because UDP/IP is used to access the RADIUS server, encrypted communications,
including negotiation between processes, are not used. To access the RADIUS server in a
secure environment, encryption in the packet level, such as IPsec, is required.

Authorization server requirements

The authorization server must satisfy the following requirements if it works together with
the authentication server:

Prerequisite OS
■ Windows Server 2003
■ Windows Server 2003 R2
■ Windows Server 2008
■ Windows Server 2008 R2
■ Windows Server 2012
■ Windows Server 2012 R2

Prerequisite software
■ Active Directory

Authentication protocol for user for searching
■ LDAP v3 simple bind

Note:

When using an LDAP server or a Kerberos server as an authentication server,
and combining it with an authorization server, use the same host for the
authentication and authorization servers.

When a RADIUS server is used as an authentication server, two
authentication servers (one primary and one secondary) can be specified, but
only one authorization server can be specified.

Connecting authentication and authorization servers

Before you can connect an authentication server and an authorization server, you must
configure your network.

Authorization server requirements
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Before you begin
■ If you have not already done so, obtain a security administrator account with a View &

Modify role.
■ Contact your server administrator for information about the values to be written in

the LDAP, RADIUS, or Kerberos configuration file. If you use LDAP servers, the files of
the LDAP servers must be certified; obtain certification.

■ Contact your network administrator for information about the network settings.
■ Give your service representative the IP address of the DNS server and ask that

representative to configure the SVP.

Procedure

1. Click Settings > Environmental Settings > View External Authentication Server
Properties.

2. Click Setup Server to open the Setup Server window
3. Select the type of the authentication server.
4. Specify options to connect to the authentication server. If you use more than one

authentication server or an authorization server, specify an option for each server.
5. To test the connection, in the Server Configuration Test field, click Check.
6. Click Finish.
7. Enter a task name and then click Apply.
8. After you finish setting up the authentication and authorization servers and confirm

that you can use the servers, save a copy of the configuration files for connecting
the authentication server.

Setting up SSL encryption

To improve security of remote operations from a Device Manager - Storage Navigator
SVP to a storage system, you can set up Secure Sockets Layer (SSL) encrypted
communication. By setting SSL encryption, the Device Manager - Storage Navigator User
ID and Password are encrypted.

Note: To enable SSL, the private and public key pair and SVP server certificate
must be valid. If either the keys or the certificate is expired, the user cannot
connect to the SVP.

Note: To add the Secure attribute to cookies using Device Manager - Storage
Navigator, you must block HTTP communication. For details, see Blocking
HTTP communication to the storage system (on page 83) .

Note: Device Manager - Storage Navigator supports HTTP Strict Transport
Security (HSTS) with a max range of 31536000 seconds. To enable HSTS, you
must use the security certificate issued by a trusted root certificate authority
for your Device Manager - Storage Navigator domain. HSTS is valid for one
year (31536000 seconds), and it is renewed automatically every time the HSTS
header is sent to the browser. The security certificate to use is determined by
the browser. For details, contact your browser vendor.

Setting up SSL encryption
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SSL terminology

Note the following SSL terms:
■ Secure Sockets Layer: SSL is a protocol first developed by Netscape to securely

transmit data over the Internet. Two SSL-enabled peers use their private and public
keys to establish a secure communication session, with each peer encrypting
transmitted data with a randomly generated and agreed-upon symmetric key.

■ Keypair: A keypair is two mathematically-related cryptographic keys consisting of a
private key and its associated public key.

■ Server Certificate: A Server Certificate (also called a Digital Certificate) forms an
association between an identity (in this case the SVP server) and a specific keypair. A
Server Certificate is used to identify the SVP server to a client so that the server and
client can communicate using SSL. Server Certificates come in two basic types:
● Self-signed: You generate your owned self-signed certificate and the subject of the

certificate is the same as the issuer of the certificate. If the Device Manager -
Storage Navigator computers and the SVP are on an internal LAN behind a firewall,
you may find that this option provides sufficient security.

● Signed and Trusted: For a Signed and Trusted Server Certificate, a Certificate
Signing Request (CSR) is sent to and certified by a trusted Certificate Authority (CA)
such as VeriSign (http://www.verisign.com/). Use of this certificate results in higher
reliability in exchange for more cost and requirements.

If you enable SSL, you must make sure that the key pair and associated server certificate
do not expire. If either the key pair or the server certificate expires, users will be unable
to connect to the SVP.

Setting up SSL communications

Before you enable SSL encryption, you must create a private key and a public key to
establish a secure communication session.

The following figure shows the procedure to set up SSL communication. Unless
otherwise noted, all steps are required. Note that creation of private and public keys
requires a dedicated program. You can download a program for creating private and
public keys from the OpenSSL website (http://www.openssl.org/).

SSL terminology
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Notes on updating the signed certificate to the SVP

Read the following notes about uploading the signed certificate to the SVP:
■ While the SVP server certificate is being updated, tasks that are being executed or

scheduled for execution on Device Manager - Storage Navigator are not executed.
■ Certificates for RMI communication are updated asynchronously (within

approximately two minutes).
■ If an SVP certificate is updated during Hitachi Command Suite setup operation, the

Hitachi Command Suite setup operation will result in an error.
■ Update of the SSL certificate gives a great influence to the system and may lead to

SVP failure. Therefore take sufficient care about the content of the certificate and
private key to be set.

■ After the certificate update is complete, depending on the environment, the SVP web
server can take 30 to 60 minutes to restart. When it takes that long, an internal server
error occurs, and the update completion dialog box does not display. However, the
certificate update is complete.

Creating a keypair

To enable SSL, you must create a keypair consisting of a public and a private key on the
management client. The instructions use Windows 7 as an example.

Notes on updating the signed certificate to the SVP
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Creating a private key

A private key is required to create an SSL keypair. The following procedure for Windows 7
creates a private key file called server.key in the c:\key folder.

Before you begin

Download openssl.exe from the OpenSSL website.

Procedure

1. If the read-only attribute is set, release it from the c:\openssl folder.

2. Open a command prompt with administrator permissions.
3. Move the current directory to the folder to which the key file is output (such as

c:\key), and execute the following command:

c:\key > c:\openssl\bin\openssl genrsa -out server.key 2048

Creating a public key

A public key has the file extension .csr. It is required to create an SSL keypair. The
following procedure is for the Windows 7 operating system.

Before you begin

Download openssl.exe from the OpenSSL website.

Procedure

1. Open a command prompt with administrator permissions.
2. Move the current directory to the folder to which the key file is output (such as

c:\key). Execute the following command:
c:\key > c:\openssl req -sha256 -new -key server.key -config
c:\openssl\bin\openssl.cfg -out server.csr

3. Enter the following information in the prompt:

■ Country Name (two-letter code)

■ State or Province Name

■ Locality Name

■ Organization Name

■ Organization Unit Name

■ Common Name

To create a self-signed certificate, enter the IP address of the SVP. The name you
entered here is used as the server name (host name). To obtain a signed and
trusted certificate, ensure that the server name is the same as the host name.

■ Email Address

Creating a private key
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■ Challenge password (optional)

■ Company name (optional)

Example

The following example shows the contents of a command window when you create a
public key.

......++++++ 

..++++++ 
is 65537 (0x10001) 
C:\key>c:\openssl\bin\openssl req -sha256 -new -key server.key -config c 
You are about to be asked to enter information that will be incorporated 
into your certificate request. What you are about to enter is what is 
called a Distinguished Name or a DN. 
\openssl\bin\openssl.cfg -out server.csr 
For some fields there will be a default value. 
If you enter '.', the field will be left blank. 
----- 
Country Name (2 letter code) [AU]:JP 
State or Province Name (full name) [Some-State]:Kanagawa 
Locality Name (eg, city) []:Odawara 
Organization Name (eg, company) [Internet Widgits Pty Ltd]:Hitachi 
Organization Unit Name (eg, section) []:ITPD 
Common Name (eg, YOUR name) []:192.168.0.1 
Email Address []: 
Please enter the following 'extra' attributes 
to be sent with your certificate request 
A challenge password []:

Converting the SSL certificates to PKCS#12 format

Uploaded SSL certificates need to be in PKCS#12 format.

If you are uploading a created private key and the SSL certificate to the management
client, you need to convert the SSL certificate to PKCS#12 format. If you are not
uploading the SSL certificate, conversion is not required.

Before you begin
■ You must store a private key and SSL certificate in the same folder.
■ In the following procedure:

● The private key file name is “client.key”.
● The SSL certificate file name is “client.crt”.
● The SSL certificate in PKCS#12 format is output to c:\key.

Procedure

1. Open a command prompt with administrator permissions.

Converting the SSL certificates to PKCS#12 format

Chapter 3: Configuring the storage system

System Administrator Guide for VSP G1x00 and VSP F1500 77



2. Enter the following command: C:key>c:\openssl\bin\openssl pkcs12 -
export -in client.crt –inkey client.key -out client.p12

3. Enter a password, which is used when uploading the SSL certificate in PKCS#12
format. You can use up to 128 alphanumeric characters and the following symbols: !
# $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

4. The client.p12 file is created in the C:\key folder. This client.p12 file is the
SSL certificate in PKCS#12 format.

5. Close the command prompt.

Obtaining a signed certificate

After creating a private key and public key, obtain a signed public key certificate file. You
can use any of these methods to obtain a signed certificate file.
■ Create a certificate by self-signing. See Obtaining a self-signed certificate (on

page 78) .
■ Obtain a certificate from the certificate authority that is used by your company.
■ Request an official certificate from an SSL certificate authority. See Obtaining a signed

and trusted certificate (on page 78) .

Note:

When you send a request to a certificate authority, specify the SVPas the host
name.

Hitachi recommends that self-signed certificates be used only for testing
encrypted communication.

Obtaining a self-signed certificate

To obtain a self-signed certificate, open a command prompt and execute the following
command:

c:\key>c:\openssl\bin\openssl x509 -req -sha256 -days 10000 -in
server.csr -signkey server.key -out server.crt

Note: This command uses SHA-256 as a hash algorithm. MD5 or SHA-1 is not
recommended for a hash algorithm due to its low security level.

This command creates a server.crt file in the c:\key folder, which is valid for 10,000
days. This is the signed private key, which is also referred to as a self-signed certificate.

Obtaining a signed and trusted certificate

To obtain a signed and trusted certificate, you must obtain a certificate signing request
(CSR), send that file to a Certificate Authority (CA), and request that the CA issue a signed
and trusted certificate. Each certificate authority has its own procedures and
requirements. Use of this certificate results in higher reliability in exchange for greater
cost and requirements. The signed and trusted certificate is the signed public key.

Obtaining a signed certificate
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Releasing an SSL certificate passphrase

An SSL certificate cannot be applied for the SVP if the passphrase is set. If the
passphrase is set, release the passphrase for the SSL certificate before applying the SSL
certificate to the SVP. The following procedure explains how to verify and release the
passphrase settings.

Before you begin
■ A private key (.key file) has been created.
■ OpenSSL must be installed. In this procedure, it is installed in C:\openssl.

Procedure

1. Open a command prompt window with administrator permissions.
2. Move the current directory to the folder (for example, C:\key) where the key file is

stored, and run the following command:

Caution: Executing this command will overwrite the current key file. To
prevent loss of the key file, do one of the following:

■ Back up the key file first.

■ Use a different key file input destination and output destination.

C:\key>C:\openssl\bin\openssl rsa -in key-file-input-destination -out 
key-file-output-destination

If Enter pass phrase for server.key: is displayed, the passphrase is set.
Enter the passphrase. The passphrase in the SSL private key will be released, and
the SSL certificate can be applied to the SVP.

Example (when passphrase is set)

C:\key>c:\openssl\bin\openssl rsa -in server.key -out server.key

Enter pass phrase for server.key: "Enter passphrase"

Writing RSA key

Example (when passphrase is not set)

C:\key>c:\openssl\bin\openssl rsa -in server.key –out server.key

Writing RSA key

Releasing an SSL certificate passphrase
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Uploading a signed certificate

To use SSL-encrypted communication, you must update and upload the private key and
the signed server certificate (Public Key) to the SVP.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must be logged into the SVP.
■ A private key (.key file) has been created. Make sure that the file name is server.key.

See Creating a private key (on page 76) .
■ The passphrase for the private key (server.key file) is released.
■ A signed public key certificate (.crt file) has been acquired. Make sure that the file

name is server.crt. See Creating a public key (on page 76) .

■ The private key (.key file) must be in PEM format. You cannot use DER format.
■ The signed public key certificate (.crt file) must be in X509 PEM format. You cannot use

X509 DER format. See Obtaining a self-signed certificate (on page 78) .
■ The passphrase for the private key (server.key file) is released.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the management client, open a web browser and enter the following URL to

open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Update Certificate Files.
If SSL communication has been established, the Security Alert dialog box opens
before the login dialog box opens. In the Security Alert dialog box, click OK. The
Security Alert dialog box closes and the Login dialog box opens.

Uploading a signed certificate
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4. In the Login dialog box, enter the administrator user ID and password, and click
login. The Upload dialog box opens.

5. In the Upload dialog box, enter the public key certificate file name in the Certificate
file box and the private Key file name (server.key file) in the Key file box. You can
enter the file names directly or by clicking Browse.

6. In the Upload dialog box, click Upload. A confirmation dialog box opens.
7. Click OK to begin the certificate update. When the update is complete, the SVP web

server restarts.
Depending on the environment, the SVP web server can take 30 to 60 minutes to
restart. When it takes that long, an internal server error occurs, and the update
completion dialog box does not display. However, the certificate update is complete.

It can take 30 to 60 minutes for the web server to restart. After the SVP restarts, the
Completion dialog box does not appear. Instead, an "internal server error"
message is displayed. However, the setting is actually completed.

8. In the error message box, click OK. If the Security Alert dialog box for the
certificate opens, click View Certificate to display the certificate. Confirm that the
certificate is correct, and click Yes.

Note: If an error occurs during the certificate update, an error message
displays. Resolve the problem described in the error message and then
repeat this procedure, starting with Step 4 (login) above.

Returning the certificate to default

You can return the certificate that was updated by the procedure in Uploading a signed
certificate (on page 80) to default.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

Returning the certificate to default
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3. In the Tool Panel dialog box, click Update Certificate Files. The Update
Certificate Files login dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the login dialog box. In the Security Alert dialog box, click OK.

4. In the Login dialog box, enter the administrator user ID and password, and click
login. The Upload dialog box opens.

5. In the Upload dialog box, click Return to Default. A confirmation dialog box opens.
6. Click Yes to confirm and close the dialog box.

When the certificate update is complete, the SVP Web server restarts to show the
update. When the restart is complete, the Update Completion dialog box opens.

7. In the Update Completion dialog box, click OK. The dialog box closes and the
display returns to the Login dialog box.

Note: If an error occurs during the certificate update, an error message
appears. Resolve the problem described in the error message and then
repeat this procedure, starting with Step 4 (login) above.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Problems with a website security certificate

Some operations in the Device Manager - Storage Navigator menu are executed with a
Java application. Therefore, an SSL-related security warning may appear when the
secondary window opens. When the message "There is a problem with this website's
security certificate." is displayed, click Continue to this website (not recommended).

Problems with a website security certificate
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If the security certificate is not issued by a trusted certificate authority, the browser
displays a warning message when it connects to an SSL-enabled Device Manager -
Storage Navigator.

Disabling TLSv1.0 and TLSv1.1 communications

To enhance security, you can disable TLSv1.0 and TLSv1.1 communications and use only
TLSv1.2.

If you want to disable TLSv1.0 and TLSv1.1 communications, contact the customer
support.

Note: If you disable TLSv1.0 and TLSv1.1 communications, pages might not
be displayed correctly depending on the TLS setting. Change the TLS setting
of the browser.

Enabling TLSv1.0 and TLSv1.1 communications

You can enable the disabled TLSv1.0 and TLSv1.1 communications.

If you want to enable TLSv1.0 and TLSv1.1 communications, contact the customer
support.

Blocking HTTP communication to the storage system

If the web server supports SSL (HTTPS), the HTTP setting tool allows you to block access
to port 80. When you block access to port 80, the connection used to import the
certificate from the web browser to the web server occurs on port 443 (HTTPS).

If you are using Hitachi Command Suite to access Device Manager - Storage Navigator,
blocking HTTP communication might interfere with that access. Make sure the Hitachi
Command Suite can use SSL communication to access Device Manager - Storage
Navigator.

Disabling TLSv1.0 and TLSv1.1 communications
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Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Set up HTTP Blocking. A login dialog box opens.
4. In the Login dialog box, enter the storage administrator user ID and password, then

click Login. The Set up HTTP Blocking dialog box opens.
5. In the dialog box, click OK. A confirmation dialog box opens.
6. In the confirmation dialog box, click OK to implement HTTP blocking.

When the configuration change is complete, the SVP web server restarts. When the
restart is complete, the HTTP Communications Blocked dialog box opens.

Depending on the environment, it can take 30 to 60 minutes for the web server to
restart. If it does, after the SVP restarts, the Completion dialog box does not
appear. Instead, an "internal server error" message appears. However, the setting is
actually completed.

7. Click OK to continue the operation and return to the Login dialog box, or click
Cancel to cancel the operation and return to the Login dialog box.

Blocking HTTP communication to the storage system
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Releasing HTTP communication blocking

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser. Enter

the following URL to open the Tool Panel dialog box.

https://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Release HTTP Blocking.
4. Enter the User ID and Password for the root storage administrator, then click Login.

The Release HTTP Blocking dialog box opens.
5. Click OK. A configuration dialog box opens.
6. Click OK to release HTTP blocking. When the configuration change is complete, the

SVP web server reboots. Once the reboot is complete, the Release HTTP Blocking
Complete dialog box opens.
Depending on the environment, it can take 30 to 60 minutes for the web server to
restart. After the SVP restarts, the Completion dialog box does not appear. Instead,
an "internal server error" message is displayed. However, the setting is actually
completed.

7. Click OK to continue the operation and return to the Login dialog box, or click
Cancel to cancel the operation and return to the Login dialog box.

Configuring certificates for HCS

To configure certificates for HCS, you must use the Device Manager - Storage Navigator
Tool Panel.

Releasing HTTP communication blocking
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Hitachi Command Suite (HCS) uses certificates to verify the server's reliability when SSL
communication for HCS external authentication is performed. You can register and
delete certificates by using the command prompt.

Registering certificates for HCS

To check the server reliability at the time of SSL communication for HCS external
authentication, upload an HCS public key certificate to the web server to register the
certificate. Complete the steps in the following procedure to upload and register a
certificate using the certificate update tool.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ If the certificate to be registered has an extension other than ".crt", change it to ".crt".
■ The certificate to be registered must be in X509 PEM or X509 DER format.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Set or Delete Certificate File for HCS. The Login
dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the Login dialog box. In the Security Alert dialog box, click OK.

4. When the Login dialog box opens, enter the administrator user ID and password,
and click Login. The Login dialog box opens.

Registering certificates for HCS
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5. In the dialog box, enter the certificate file for HCS (.crt file) in the Certificate file (.crt
file) box. You can enter the file name directly or by clicking Browse and searching
for the file name.

6. Click Register. The execution confirmation dialog for Set or Delete Certificate File
for HCS opens.

7. Click OK to register the certificate. Registration of the certificate starts.
When the certificate is registered, the registration completion dialog box for Set or
Delete Certificate File for HCS opens.

8. In the registration completion dialog box for Set or Delete Certificate File for HCS,
click OK. The display returns to the login dialog box.

Note: If an error occurs during registration of the HCS certificate, an
error message displays. Resolve the problem and then run the
procedure again, starting with logging in to Set or Delete HCS Certificate.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Notes on registering certificates for HCS

Read the following notes about registering certificates for HCS:
■ Ensure that the certificate to be registered is the right one. If you register a wrong

certificate, HCS external authentication is not performed.
■ Only with registration or deletion of the correct certificate, HCS external

authentication operates normally

Deleting certificates for HCS

You can delete the certificates you registered in the procedure of the "Registering
certificates for HCS" section. Once you delete a certificate, server reliability for that
certificate is not checked by SSL communication for HCS external authentication.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

Notes on registering certificates for HCS
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3. In the Tool Panel dialog box, click Set or Delete Certificate File for HCS. The login
dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the login dialog box. In the Security Alert dialog box, click OK.

4. In the login dialog box, enter the administrator user ID and password, and click
Login. The Set or Delete Certificate File for HCS dialog box opens.

5. In the dialog box, click Delete. A confirmation dialog box opens.
6. Click OK to delete the certificate. Deletion of the certificate starts.
7. When the certificate has been deleted, a completion dialog box opens.
8. In the completion dialog box click OK. The display returns to the login dialog box.

Note: If an error occurs during deletion of the certificate for HCS, an
error message displays. Resolve the problem and then run the
procedure again, starting with logging in, to Set or Delete Certificate for
HCS.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Changing advanced system settings

You can change alert display settings and data acquisition settings in advanced system
settings.

Log off and log in again after you have enabled or disabled an advanced system setting.

Changing advanced system settings
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Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.

Procedure

1. Click Settings > Environmental Settings > Edit Advanced System Settings.
2. Select the advanced system settings and click Enable.

Option Description

Hide alert information If you enable this advanced system setting, the Alert
window in the Device Manager - Storage Navigator
main window does not open.

Refresh forcibly after
Apply

If you enable this advanced system setting, after
settings changes are applied to the storage system, the
configuration information for the storage system is
always updated to the latest information.

Disable data polling If you enable this advanced system setting, polling
stops.

Disable retry of data
updating

If you enable this advanced system setting, retry does
not occur even if data cannot be acquired.

Enable Device
Manager - Storage
Navigator 2 All
Function

If you enable this advanced system setting, the
restrictions on login from Device Manager - Storage
Navigator's login window are cleared, including the
restrictions on the users who can log in and on the
functions available after login. When enabling or
disabling the advanced system setting, log in again.

External
Authentication
Compatibility option

If you enable this option, the authentication method is
switched from VSP G1x00 and VSP F1500 to VSP.

Enable reboot of
background service

If you enable this option, when either of the followings
exceeds its threshold value, the background service
process for managing configuration information is
restarted. Enable this option only when requested.

■ The amount of memory used in the background
service process.

■ Time elapsed after the background service process
is started.

Notify an alert when
tier relocation is
suspended by system

If you enable this option, when tier relocation is
suspended by the system, an alert is issued to users.
For details about an alert (SIM) to be issued, see the
Troubleshooting chapter of the Provisioning Guide for
Open Systems or Provisioning Guide for Mainframe
Systems.
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Option Description

Disable login of the
same user

Set this option only when requested.

Disable cache of the
PP Info

Set this option only when requested.

Use a unique SNMP
engine ID

If you enable this option, a unique SNMP engine ID is
set. If you disable it, the fixed value is set. When
changing the settings for this option, first set SNMP
Agent to Disable, then after the completion of the
settings, set it back to Enable.

3. Click Finish. The Confirm window opens.
4. In the Confirm window, check the settings and enter a task name in Task Name.
5. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to display the status of the task.

Backing up HDvM - SN configuration files

You can make backup copies of the various Device Manager - Storage Navigator
configuration files by downloading them to a folder that you specify. You can then use
the backup copies to restore one or more configuration files if it becomes necessary. See
Restoring HDvM - SN configuration files (on page 92) .

Before you begin

You must have one of the following roles, depending on the configuration you are
backing up or restoring.

Configuration
file Description

Required role to back
up a file

Required role to
restore a file

User Account
Information

User account information
registered to the Device Manager
- Storage Navigator.

Security
Administrator (View
Only)

Security
Administrator (View &
Modify)

Environment
Parameter List

The parameters settings in the
Set Env. window.

Storage
Administrator (Initial
Configuration)

Storage
Administrator (Initial
Configuration)

Log Transfer
Information

Settings made in the Edit Audit
Log Settings window and the
Edit Alert Settings wizard

Audit log
Administrator (View
Only)

Audit log
Administrator (View &
Modify)

SIMSyslog
Transfer
Information

Settings made in the Edit Alert
Settings wizard

Storage
Administrator (Initial
Configuration)

Storage
Administrator (Initial
Configuration)

Backing up HDvM - SN configuration files
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Configuration
file Description

Required role to back
up a file

Required role to
restore a file

External
Authentication

Connection to the authentication
server.

Security
Administrator (View &
Modify)

Security
Administrator (View &
Modify)

Key
Management
Server

Connection to the Key
Management Server1

Security
Administrator (View &
Modify)

Security
Administrator (View &
Modify)

Password
Policy

Password policy for backing up
encryption keys on the Device
Manager - Storage Navigator
computer

Security
Administrator (View &
Modify)

Security
Administrator (View &
Modify)

Notes:

1. The client certificate in use when the key management (KMIP) server is connected cannot be
backed up or restored by Device Manager - Storage Navigator. Consult the administrator of
the key management server to determine the best way to use the server to manage and back
up the certificate.

Procedure

1. Start a web browser and enter the following URL to open the tool panel:

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

2. Click Control Panel to open the Control Panel.
3. Enter the user ID and password and click Login.
4. Click the Download tab to open the Download file window.
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5. Click the files to be downloaded. You can download only the files for which you have
permission.

6. Click Submit. The Download File dialog box shows the list of the files to be
downloaded.

7. Click Download. The File Download dialog box opens.
8. Click Save. The Save As dialog box opens.
9. Specify the name of a folder to save the compressed file, and then click Save to

start downloading.
10. Decompress the downloaded *.tgz file as required. To decompress the *.tgz file,

use a tool supporting tar and gzip.

Restoring HDvM - SN configuration files

You can restore the backup copies of one or more configuration files if it becomes
necessary.

Before you begin
■ See Prerequisites in Backing up HDvM - SN configuration files (on page 90) .

Procedure

1. Start a web browser and enter the following URL to open the tool panel:

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

2. Click Control Panel to open the Control Panel.
3. Enter the user ID and password and click Login.
4. Click the Restore tab to open the Restore file window.
5. Click the files and click Browse to specify the directory of the file. You can restore

only the files for which you have permission.

Restoring HDvM - SN configuration files
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6. Click Next.
7. Click the configuration files to restore.
8. Click Submit.
9. If the Password check dialog box opens, enter User ID, Password, and Re-enter

Password of the storage administrator on the backup user list, and click Submit on
the Password check dialog box.
The Restore File dialog box opens.

10. Confirm the restoring process has been completed successfully.
11. Click Close to close the dialog box.

Using the SMI-S function with a Device Manager - Storage
Navigator user account

Hitachi Virtual Storage Platform G1x00 and Hitachi Virtual Storage Platform F1500
storage systems support the SMI-S function developed by SNIA. Storage administrators
can use the SMI-S function by using SMI-S compliant management software.

Using the SMI-S function

To use the SMI-S function, create a Device Manager - Storage Navigator user account and
specify a storage system as the access destination from the management software.

Procedure

1. Create a Device Manager - Storage Navigator user account in the management
software. The user account must belong to one of the following built-in user groups:

■ Storage Administrator (View & Modify) User Group: Users have full permissions
to access the SMI-S function from the management software.

■ Storage Administrator (View Only) User Group: Users have read- only
permissions to access the SMI-S function from the management software.

2. In the management software program, enter the following storage system
information:

■ IP Address of the storage system

■ Protocol: specify HTTPS

■ Port: 5989

■ Namespace:root/hitachi/smis or interop

Uploading a signed certificate to the SMI-S provider

To use certificates in SSL communication with the SMI-S provider, you must update and
upload the private key and the signed server certificate (public key) to the SMI-S provider
to update the certificate. Use the following procedure to upload and update certificates
using a certificate update tool.
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Before you begin

Ensure that the following items have been completed:
■ You must have the Storage Administrator (View & Modify) role to perform this task.
■ A private key (.key file) has been created. Change the file name to server.key unless

the file is already named that. See Creating a private key (on page 76) .
■ The passphrase for the private key (server.key file) is released.
■ A signed public key certificate (.crt file) has been acquired. Change the file name to

server.crt unless the file is already named that. See Creating a public key (on
page 76) .

■ The private key (.key file) is in PEM format. (You cannot use the DER format.)
■ The signed public key certificate (.crt file) is in X509 PEM format. (You cannot use the

X509 DER format.) See Obtaining a self-signed certificate (on page 78) .

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SVP.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Update Certificate Files for SMI-S. The login
dialog box for Update Certificate Files for SMI-S opens.
If SSL communication has been established, the Security Alert dialog box opens
before the login dialog box. In the Security Alert dialog box, click OK.

4. In the login dialog box for Update Certificate Files for SMI-S, enter the
administrator's user ID and password, and click Login. The upload dialog box for
Update Certificate Files for SMI-S opens.

5. In the upload dialog box for Update Certificate Files for SMI-S, enter both the public
key certificate file name in the Certificate file (server.crt file) box and the Private Key
file (server.key file) box. You can enter the file names directly or by clicking Browse.
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6. Click Upload. The execution confirmation dialog box for Update Certificate Files for
SMI-S opens.

7. Click OK to update the certificate. Update of the certificate starts.
Upon completion of the certificate update, the SMI-S provider restarts to reflect the
update.

Upon completion of the restart of the SMI-S provider, the update completion dialog
box for Update Certificate Files for SMI-S opens

8. In the update completion dialog box for Update Certificate Files for SMI-S, click OK.
The display returns to the login dialog box.

Note: If an error occurs during update of the certificate, an error
message displays. Resolve the problem and then run the procedure
again, starting with logging in, to upload configuration files for SMI-S.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Returning an SMI-S provider certificate to default

You can return a certificate updated in Uploading a signed certificate to the SMI-S
provider (on page 93) to default.

Before you begin
■ You must have the Storage Administrator (View & Modify) role to perform this task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SMI-S provider.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

Returning an SMI-S provider certificate to default
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3. In the Tool Panel dialog box, click Upload Configuration Files for SMI-S. The
Upload Configuration Files Login dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the login dialog box. In the Security Alert dialog box, click OK.

4. In the Login dialog box, enter the administrator's user ID and password, and click
Login. The upload dialog box for Update Certificate Files for SMI-S opens.

5. In the upload dialog box for Update Certificate Files for SMI-S, click Return to the
default configuration. The execution confirmation dialog box for Update
Certificate Files for SMI-S opens.

6. Click OK to update the certificate. Update of the certificate starts.
Upon completion of the certificate update, the SMI-S provider restarts to reflect the
update. Upon completion of the restart of the SMI-S provider, the update
completion dialog box for Update Certificate Files for SMI-S opens.

7. In the update completion dialog box for Update Certificate Files for SMI-S, click OK.
The display returns to the login dialog box.

Note: If an error occurs during update of the certificate, an error
message displays. Resolve the problem and then run the procedure
again, starting with logging in, to update certificate files for SMI-S.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Uploading an SMI-S provider configuration file

You can control the SMI-S function using the SMI-S provider configuration file that you
create.

Uploading an SMI-S provider configuration file
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Before you begin
■ Ensure that the SMI-S provider configuration file has already been created. If the

configuration is not already named array-setting-01.properties, rename it to that
name.

■ You must have the Storage Administrator (View & Modify) role to perform this task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SMI-S provider.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Upload Configuration Files for SMI-S. The Login
dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the Login dialog box. In the Security Alert dialog box, click OK to confirm
and open the Login dialog box.

4. In the Login dialog box, enter the administrator user ID and password, and click
Login. The Upload dialog box opens.

5. In the Upload dialog box, enter the SMI-S provider configuration file (array-
setting-01.properties).
Enter a file name in Configuration file or click Browse and then select a file in the
displayed dialog box.

6. Click Upload. The execution confirmation dialog box opens.
7. Click OK to update the configuration file. Update of the configuration file starts.

Upon completion of the configuration file update, the SMI-S provider restarts to
reflect the update. Upon completion of the restart of the SMI-S provider, the update
completion dialog box for Upload Configuration Files for SMI-S opens.

8. In the Upload Configuration Files for SMI-S dialog box, click OK. The display
returns to the login dialog box.

Uploading an SMI-S provider configuration file

Chapter 3: Configuring the storage system

System Administrator Guide for VSP G1x00 and VSP F1500 97



Note: If an error occurs during update of the certificate, an error
message displays. Resolve the problem and then run the procedure
again, starting with logging in, to upload configuration files for SMI-S.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Returning an SMI-S provider configuration file to default

You can return a configuration file updated in Uploading an SMI-S provider configuration
file (on page 96) .

Before you begin
■ You must have the Storage Administrator (View & Modify) role to perform this task.

Procedure

1. Close all Device Manager - Storage Navigator sessions on the SMI-S provider.
2. On the Device Manager - Storage Navigator computer, open a web browser and

enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

3. In the Tool Panel dialog box, click Upload Configuration Files for SMI-S. The Login
dialog box opens.
If SSL communication has been established, the Security Alert dialog box opens
before the Login dialog box. In the Security Alert dialog box, click OK to confirm
and open the Login dialog box.

4. In the Login dialog box, enter the administrator user ID and password, and click
Login. The Upload dialog box opens.

Returning an SMI-S provider configuration file to default
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5. In the Upload dialog box, click Return to the default configuration. A
confirmation dialog box opens.

6. In the confirmation dialog box, click OK to update the configuration file. The update
process starts.
When the file has been updated, the SMI-S provider restarts to include the update.
When the SMI-S provider restarts, the update completion dialog box opens.

7. In the update completion dialog box, click OK to confirm and return to the Login
dialog box.

Note: If an error occurs during update of the SMI-S provider
configuration file, an error message appears. Resolve the problem
described in the error message and then run the procedure again,
starting with Step 4.

Note: If the Security Alert dialog box for the certificate opens at other
times, click View Certificate to confirm that the certificate is correct and
then click Yes.

Sending SMI-S artificial indication

You can send an SMI-S artificial indication to determine whether the communication
between the listeners and the SMI-S provider succeeds or fails.

Before you begin
■ SMI-S Provider software application must be installed.
■ The network environment is configured so that the computer on which the listener

application operates is connected to the SVP.
■ The listeners are subscribed to the SMI-S provider.
■ You must have the Storage Administrator (View & Modify) role to perform this task.

Procedure

1. Close all Device Manager - Storage Navigator sessions connected to the related SMI-
S provider.

2. On the Device Manager - Storage Navigator computer, open a web browser and
enter the following URL to open the Tool Panel dialog box.

http://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

Sending SMI-S artificial indication
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3. In the Tool Panel dialog box, click SMI-S Artificial Indication. The SMI-S Artificial
Indication dialog box opens.

4. In the SMI-S Artificial Indication dialog box, enter the user ID and password, and
click Test. The testing begins.

5. When the test communication is completed, SMI-S Artificial Indication Result
window opens. In the SMI-S Artificial Indication Result window, click OK.

The dialog box closes and the display returns to the SMI-S Artificial Indication
dialog box.

Note: If the SMI-S artificial indication fails, an error message and a code
display. Resolve the problem described in the error message.

Registering the primary SVP host name

You must register the primary SVP host name before completing any of the following
tasks.
■ Specify a host name instead of an IP address when accessing Device Manager -

Storage Navigator.
■ Obtain the public key certificate for SSL-encrypted communication from the CA

(Certificate Authority). You must register the server name as the host name to the
DNS server or the hosts file. The server name is entered in the certificate as a
common name.

Enter the SVP host name and IP address in the DNS server or the hosts file of the
management client. You can register any host name to the DNS server or the hosts
file, but there are restrictions on the letters you can use for the host name.

Registering the primary SVP host name
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■ DNS setting: You must register the IP address and host name of the SVP to the DNS
server that manages the network to which the SVP is connected.

■ Hosts file setting: You must enter the IP address and host name of the SVP to the
hosts file of the management client. The general directory of the hosts file is:
● Windows 7: C:\Windows\System32\drivers\etc\hosts
● UNIX: /etc/hosts

Registering the primary SVP host name
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Chapter 4:  User administration using Device
Manager - Storage Navigator

You can use the Device Manager - Storage Navigator to create, modify, or delete users,
user groups, and accounts.

User administration overview

Device Manager - Storage Navigator provides a rich set of user administration, roles and
permissions, and access control features. Administrators can manage users by groups
and set up access control by defining who can access what storage resources .

Manage roles and permissions

You can use the Device Manager - Storage Navigator to view existing user groups, and to
create, modify, or delete them.

Before creating or manipulating user groups, read and understand the following
precautions.
■ When a user is assigned to multiple user groups, the user has the permissions of all

the roles in each user group that are enabled on the resource groups assigned to
each user group.

■ If a user has All Resource Groups Assigned set to Yes, the user can access all the
resources in the storage system. For example, if a user is a security administrator and
a storage administrator taking care of some resources, have all resource groups
assigned, and has roles of Security Administrator (View & Modify) and Storage
Administrator (View & Modify), the user can modify storage system settings for all the
resources.

If this is a problem, the recommended solution is to register the following two user
accounts in the storage system and use these different accounts for different
purposes:
● A security administrator user account that has All Resource Groups Assigned set to

Yes.
● A storage administrator user account that does not have all resource groups

assigned and has only some of the resource groups assigned.
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■ For the user groups whose roles are other than the Storage Administrator, All
Resource Groups Assigned is automatically set to Yes. If you delete all the roles except
the Storage Administrator, reassign resource groups to the user group because All
Resource Groups Assigned is automatically set to No. To assign resource groups to
the user group, see Changing assigned resource groups (on page 113) .

■ Regardless of assigned roles, users in a user group to which no resource groups are
assigned cannot modify storage system settings.

■ Security settings that affect the entire system is configured by the administrator.
■ Resource group 10 is configured by user A.
■ Resource group 20 is configured by user B.

To implement the above configuration, assign the users to the user groups as shown
below.

User
User group to be

registered
Roles to be assigned to the

user group

Resource group to be
assigned to user

group

Adminis
trator

user group 1 Security Administrator (View &
Modify)

All Resource Groups
Assigned1

User A user group 10 Storage Administrator2 Resource group 10

User B user group 20 Storage Administrator2 Resource group 20

Notes:

1. For the user group that is assigned the Security Administrator role, All Resource
Groups Assigned is automatically set to Yes.

2. There are a few types of storage administrators. For more information, see Roles
and permissions (on page 105) .

Roles and user groups

Roles are defined for each user group. The tasks that users can do on the system depend
on the roles assigned to the user groups to which they belong. Users can belong to from
one to eight groups. To change the privileges that are assigned to users, use either of the
following methods:
■ Add users to groups with the permissions they need or delete users from groups with

permissions they don’t need.
■ Change the roles assigned to the group to which the users belong.

Roles and user groups
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Resource group and user groups

The resource groups determine the resources that users can manage. They are
associated with user groups rather than users. There are two ways to change the
resources that are allowed to users:
■ Moving users to another user group.
■ Change the resource groups assigned to the user group where the user belongs.

For details about resource groups, see the Provisioning Guide for Open Systems.

User group registration example

■ Security settings that affect the entire system is configured by the administrator.
■ Resource group 10 is configured by user A.
■ Resource group 20 is configured by user B.

To implement the above configuration, assign the users to the user groups as shown
below.

User
User group to be

registered
Roles to be assigned to the

user group

Resource group to be
assigned to user

group

Adminis
trator

user group 1 Security Administrator (View &
Modify)

All Resource Groups
Assigned1

User A user group 10 Storage Administrator2 Resource group 10

User B user group 20 Storage Administrator2 Resource group 20

Notes:

1. For the user group that is assigned the Security Administrator role, All Resource
Groups Assigned is automatically set to Yes.

2. There are a few types of storage administrators. For more information, see Roles
and permissions (on page 105) .

Resource group and user groups
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Precautions when working with user groups

Before creating or manipulating user groups, read and understand the following
precautions.
■ When a user is assigned to multiple user groups, the user has the permissions of all

the roles in each user group that are enabled on the resource groups assigned to
each user group.

■ If a user has All Resource Groups Assigned set to Yes, the user can access all the
resources in the storage system. For example, if a user is a security administrator and
a storage administrator taking care of some resources, have all resource groups
assigned, and has roles of Security Administrator (View & Modify) and Storage
Administrator (View & Modify), the user can edit the storage for all the resources.

If this is a problem, the recommended solution is to register the following two user
accounts in the storage system and use these different accounts for different
purposes:
● A security administrator user account that has All Resource Groups Assigned set to

Yes.
● A storage administrator user account that does not have all resource groups

assigned and has only some of the resource groups assigned.
■ For the user groups whose roles are other than the Storage Administrator, All

Resource Groups Assigned is automatically set to Yes. If you delete all the roles except
the Storage Administrator, reassign resource groups to the user group because All
Resource Groups Assigned is automatically set to No. To assign resource groups to
the user group, see Changing assigned resource groups (on page 113) .

Naming a user group in Device Manager - Storage Navigator

When you create a user group in Device Manager - Storage Navigator, you name the
group with the user's memberOf attribute value which is found in the Active Directory.
Device Manager - Storage Navigator supports Active Directory nested groups.

After entering the user group name, verify that the user group name that you entered is
registered in the authorization server.

Note: The domain name (DN) of the user group to be set to Active Directory
must be between 1 and 250 characters. The number of user groups that can
be registered at one time is 20 at maximum.

Caution: If a user needs to use different user groups for different purposes,
create local user accounts on Device Manager - Storage Navigator. Do not use
the authorization server.

Roles and permissions

The following table shows all the roles that are available for use and the permissions that
each role provides to the users. You cannot create a custom role.

Precautions when working with user groups
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Note: The Support Personnel group and the Support Personnel (Vendor Only)
role contain permissions to perform maintenance. Assign this role only to the
accounts used by support personnel from vendors responsible for
maintenance.

Role Permissions

Security Administrator
(View Only)

■ Viewing information about user accounts and encryption settings
■ Viewing information about the encryption key in the key management

server

Security Administrator
(View & Modify)

■ Configuring user accounts
■ Creating encryption keys and configuring encryption settings
■ Viewing and switching where encryption keys are generated
■ Backing up and restoring encryption keys
■ Deleting encryption keys backed up in the key management server
■ Viewing and changing the password policy for backing up encryption

keys on the management client
■ Connection to the external server
■ Backing up and restoring connection configuration to the external

server
■ Configuring the certificate used for the SSL communication
■ Configuring the fibre channel authentication (FC-SP)
■ Configuring resource groups
■ Editing virtual management settings
■ Setting reserved attributes for global-active device

Audit Log
Administrator (View
Only)

■ Viewing audit log information and downloading audit logs

Audit Log
Administrator (View &
Modify)

■ Configuring audit log settings and downloading audit logs

Storage Administrator
(View Only)

■ Viewing storage system information

Storage Administrator
(Initial Configuration)

■ Configuring settings for storage systems
■ Configuring settings for SNMP
■ Configuring settings for e-mail notification
■ Configuring settings for license keys

Roles and permissions
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Role Permissions

■ Viewing, deleting, and downloading storage configuration reports
■ Acquiring all the information about the storage system and updating

Device Manager - Storage Navigator window by clicking Refresh All

Storage Administrator
(System Resource
Management)

■ Configuring settings for CLPR
■ Configuring settings for MP Blade
■ Deleting tasks and releasing exclusive locks of resources
■ Completing SIMs
■ Configuring attributes for ports
■ Configuring LUN security
■ Configuring Server Priority Manager
■ Configuring tiering policies

Storage Administrator
(Provisioning)

■ Configuring caches
■ Configuring LDEVs, pools, and virtual volumes
■ Formatting and shredding LDEVs
■ Configuring external volumes
■ Configuring alias volumes for Compatible PAV
■ Configuring Dynamic Provisioning
■ Configuring host groups, paths, and WWN
■ Configuring Volume Migration except splitting Volume Migration pairs

when using CCI
■ Configuring access attributes for LDEVs
■ Configuring LUN security
■ Creating and deleting quorum disk used with global-active device
■ Creating and deleting global-active device pairs

Storage Administrator
(Performance
Management)

■ Configuring monitoring
■ Starting and stopping monitoring

Storage Administrator
(Local Copy)

■ Performing pair operations for local copy
■ Configuring environmental settings for local copy
■ Splitting Volume Migration V2 pairs when using CCI

Storage Administrator
(Remote Copy)

■ Remote copy operations in general
■ Operating global-active device pairs (except for creation and deletion)

Roles and permissions
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Role Permissions

Support Personnel
(View & Modify)

Configuring the SVP
■ Normally, this role is for service representatives.
■ Downloading dump files using the Dump tool

Note: Normally, the Support Personnel role is reserved for service
representatives, but if the role is assigned to a user account, dump files can
be downloaded using the Dump tool.

Built-in user groups

You can assign users to one or more built-in user groups and custom user groups. You
cannot change roles or resource groups set to the built-in groups, but you can create
custom user groups according to the needs of your storage environment.

The following table shows all the built-in groups, and their built-in roles and resource
groups.

Built-in group Role
Resource

group

Administrator ■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

All Resource
Groups
Assigned

System ■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

All Resource
Groups
Assigned

Built-in user groups
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Built-in group Role
Resource

group

■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

Security Administrator (View
Only)

■ Security Administrator (View Only)
■ Audit Log Administrator (View Only)
■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Security Administrator (View
& Modify)

■ Security Administrator (View &
Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Audit Log Administrator (View
Only)

■ Audit Log Administrator (View Only)
■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Audit Log Administrator (View
& Modify)

■ Audit Log Administrator (View &
Modify)

■ Storage Administrator (View Only)

All Resource
Groups
Assigned

Storage Administrator (View
Only)

■ Storage Administrator (View Only) meta_resourc
e

Storage Administrator (View &
Modify)

■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

meta_resourc
e

Built-in user groups
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Built-in group Role
Resource

group

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)

Support Personnel ■ Storage Administrator (Initial
Configuration)

■ Storage Administrator (System
Resource Management)

■ Storage Administrator
(Provisioning)

■ Storage Administrator
(Performance Management)

■ Storage Administrator (Local Copy)
■ Storage Administrator (Remote

Copy)
■ Support Personnel

All Resource
Groups
Assigned

Verifying the roles available to a user group

You can use Device Manager - Storage Navigator to verify the roles that are available to
use with any user group.

Before you begin

You must have the Security Administrator (View Only) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator tree, click User Administration.
2. On the User Groups tab, click the name (not the checkbox) of a user group whose

roles you want to check.
3. In the User Administration window, click the Roles tab.

The list of roles applied to the selected user group is displayed.
4. To return to the User Administration window, click User Administration.

Verifying the roles available to a user group

You can use Device Manager - Storage Navigator to verify the roles that are available to
use with any user group.

You can assign users to one or more built-in user groups and custom user groups. You
cannot change roles or resource groups set to the built-in groups, but you can create
custom user groups according to the needs of your storage environment.

Verifying the roles available to a user group

Chapter 4: User administration using Device Manager - Storage Navigator

System Administrator Guide for VSP G1x00 and VSP F1500 110



Before you begin

You must have the Security Administrator (View Only) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, click User
Administration.

2. On the User Groups tab, click the name (not the checkbox) of a user group whose
roles you want to check.

3. In the User Administration window, click the Roles tab. The list of roles applied to
the selected user group is displayed.

4. To return to the User Administration window, click User Administration.

Creating a new user group

You can customize a user group, as long as it supports your storage system.

This section explains how administrators can create a user group.

A user group name consists of 1 to 64 characters including alphanumeric characters,
spaces, and the following symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

The system can support a maximum of 256 user groups, including the built-in user
groups.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Administration tree, select User Groups.
2. In the User Groups tab, click Create User Groups to open the Create User Group

window.
3. Enter a user group name.
4. If you use an authorization server, click Check and verify that the entered user

group name is registered in the authorization server.
5. Click Next to open the Assign Roles window.
6. Select the roles to assign to the user group, and click Add.
7. Click Next to open the Assign Resource Groups window.
8. Select the resource groups to assign to the user group, and click Add. If you select a

role other than the storage administrator in the Assign Roles window, you do not
need to select resource groups because all the resource groups are assigned
automatically.

9. Click Finish to finish and confirm settings.
Click Next to add another user.

10. Check the settings and enter a task name in Task Name.

Creating a new user group
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11. Click Apply. The task is now registered. If the Go to tasks window for status check
box is checked, the Task window opens to show the status of the task.

Changing a user group name

You can change the name of a user group by using Hitachi Device Manager - Storage
Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The names of built-in groups cannot be changed.
■ A user group name consists of 1 to 64 characters including alphanumeric characters

(ASCII), spaces and the following symbols:

# $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Procedure

1. In the Administration tree, select User Groups.
2. In the User Groups tab, select the user group.
3. Click More Actions > Edit User Group.
4. In the Edit User Group window, enter a new user group name.
5. If you use an authorization server, click Check and verify that the entered user

group name is registered in the authorization server.
6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to display the status of the task.

Changing user group permissions

You can change the permissions that are assigned to user groups by using Hitachi Device
Manager - Storage Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The permissions of a built-in group cannot be changed.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. In the User Groups tab, select the user group whose permission you want to
change.

3. Click the Roles tab.
4. Click Edit Role Assignment.

Changing a user group name
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5. In the Edit Role Assignment window, change roles to be assigned to the user
group.

■ Select roles to add, and then click Add.

■ Select a role to remove, and then click Remove.

6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens.

Changing assigned resource groups

You can change the resource groups that are assigned to user groups by using Hitachi
Device Manager - Storage Navigator.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ Create a resource group to be assigned to the user group in advance.
■ You cannot change the resource groups of a user group that has All Resource Groups

Assigned set to Yes
■ You cannot change resource groups of a built-in group.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select a user group to change the resource group.
3. Select the Resource Groups tab.
4. Click Edit Resource Group Assignment to open the Edit Resource Group

Assignment window.
5. In the Edit Resource Group Assignment window, change resource groups to be

assigned to the user group.

■ Select the resource group to add, and click Add.

■ Select the resource group to remove, and click Remove.

6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to display the status of the task.

Deleting a user group

You do not have to retain a user group for the life of the project. You can delete it at any
time by using Hitachi Device Manager - Storage Navigator.

Changing assigned resource groups
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Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ You cannot delete a built-in user group.
■ You cannot delete a user group if the users in it belong to only the user group to be

deleted.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. In the User Groups tab, select the user-created user groups that you want to delete.
3. Click More Actions > Delete User Groups.
4. Check the settings, then click Apply.

User accounts

When adding a new user, you need to add it to a user group with desired permissions.
You can use one of the built-in user group or a custom user group.

For more information about roles, permissions, and user groups, see Roles and
permissions (on page 105) .

You will need to use the local administrator account created during the initial setup step,
or create administrator accounts using the procedures described in this chapter as
needed to access the storage system temporarily when the management software is not
available.

It is prudent to create more than one user account in case the system administrator is
not available when the management software becomes unavailable, or when someone
else needs to access the system. This is also helpful if multiple users need to access
Device Manager - Storage Navigator to use storage features that are not available in the
management software.

Creating user accounts

You must create a user account and register the account to a user group with
appropriate permissions.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ You or an authorized technical support representative can log in to Device Manager -

Storage Navigator and CCI with user accounts that are created in Device Manager -
Storage Navigator.

User accounts
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■ Support representatives must have the Support Personnel (Vendor Only) role to log
in.

■ The system can support a maximum of 512 user accounts, including the built-in user
accounts.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select a user group to which to add a user. This is
dependent on which permissions you want to give to the user.

3. On the Roles tab, confirm that the displayed permissions are appropriate for the
user.

4. On the Users tab, click Create User.
5. Enter a name.
6. Select Activate or Lock for the account. If you select Lock, the user of this account

is disabled and cannot log in to Device Manager - Storage Navigator.
7. To use an authentication server, select External. To authenticate users with only

Device Manager - Storage Navigator, select Local.
8. If you select Local, enter the password for this user account in two places.

For a password, all alphanumeric characters and symbols can be used. The length
must be between 6 and 256.

9. Click Finish.
10. In the Confirm window, check the settings.
11. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to display the status of the task.

Character restrictions for user names and passwords

The user account you created for Device Manager - Storage Navigatorcan also be used
for SVP, CCI, and the raidinf command. Note that the Support Personnel (View & Modify)
role is required to log in to SVP.

The number of characters and characters you can use for the user name and password
are determined by the software you will log in. You can log in to one or more of Device
Manager - Storage Navigator, SVP, CCI, and the raidinf command. If you log in to multiple
programs, specify the user name and the password that satisfy the user name and
password requirements (listed below) for the applicable software applications.

Note the following restrictions for user names and passwords.

Character restrictions for user names and passwords
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User name and password for Device Manager - Storage Navigator

Item
Length in
characters Characters that can be used

User name 1-256 ■ Alphanumeric (ASCII code) characters
■ The following symbols:

# $ % & ' * + - . / = ? @ ^ _ ` { | } ~

You cannot use the # symbol when you enter a user
name in a screen from the Tool Panel dialog box.

Password 6-256 ■ Alphanumeric (ASCII code) characters
■ All symbols

You cannot use the quotation mark (") or backslash
(\) symbols when you enter a password in a screen
from the Tool Panel dialog box.

Note: If you cannot log in on a Tool Panel dialog box screen, check to see if
you have used a number sign (#) in the user name, or used a quotation mark
(") or a backslash (\) in the password.

User name and password for logging in to SVP

Item
Length in
characters Characters that can be used

User name 1-128 ■ Alphanumeric (ASCII code) characters
■ The following symbols:

! # $ % & ' - . @ ^ _ ` { } ~

Password 6- 127 ■ Alphanumeric (ASCII code) characters
■ All symbols

User name and password for logging in to CCI or the raidinf command

Item
Length in
characters Characters that can be used

User name 1-63 ■ Alphanumeric (ASCII code) characters
■ The following symbols1:

- . @ _

Character restrictions for user names and passwords
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Item
Length in
characters Characters that can be used

Password 6- 63 ■ Alphanumeric (ASCII code) characters
■ The following symbols1, 2:

- , . :@ _

Note:

1. If the host on which CCI is installed is running on UNIX, a slash (/) can be specified.
2. If the host on which CCI is installed is running on Windows, a back slash (\) can be

specified.

Changing user passwords

You can change or reissue passwords for other users by using Device Manager - Storage
Navigator.

Caution: When using Hitachi Command Suite, you need to change
information, such as passwords, registered in Hitachi Command Suite. For
details, see the section describing how to change storage system settings in
the Hitachi Command Suite User Guide.

Before you begin
■ Security administrators with View & Modify roles can change user passwords on

Device Manager - Storage Navigator.
■ If the target user has a local user account for Device Manager - Storage Navigator, the

security administrator can use Device Manager - Storage Navigator to change the
target user's password.

■ If the target user has a local user account for the authentication server, the security
administrator can use the authentication server to change the target user's password.
After the password is changed, the target user can use the new password on both the
authentication server and Device Manager - Storage Navigator.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select the user group to which the user belongs.
3. On the User tab, select the user whose password you want to change.
4. In the User tab, click Change Password.
5. In the Change Password dialog box, specify a new password for the user in the two

password fields.
6. Click Finish.
7. In the Confirm window, check the settings and enter a task name in Task Name.

Changing user passwords
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8. Click Apply. The task is now registered. If the Go to tasks window for status check
box is checked, the Task window opens to show the status of the task.

Changing user permissions

You can change user permissions by changing membership in the user group. A user can
belong to multiple user groups.

For example, if you want to change the role of the user who manages security to the
performance management role, add this user to the Storage Administrator (Performance
Management) role group and then remove the user from the Security Administrator
(View & Modify) role group.

Before you begin
■ You must have the Security Administrator (View & Modify) role to perform this task.
■ The user whose permissions you want to change must belong to at least one user

group.
■ A user group can contain a maximum of 512 user accounts, including the built-in user

accounts.

Adding a user

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, select the user group that has the role you want the user
to have, and then add or remove users.
To add users to the selected groups:

a. Click Add Users.
b. In the Add Users window, select a user and click Add.

To remove users from the selected groups:
a. In the Remove Users window, select one or more users.
b. Click More Actions > Remove Users.

3. Click Finish.
4. In the Confirm window, check the settings. If the Task Name field is empty, enter a

task name.
5. Click Apply. The task is now registered. If you selected the Go to tasks window for

status check box, the Task window opens to show the status of the task.

Enabling and disabling user accounts

To allow or prevent a user from logging in to Device Manager - Storage Navigator, follow
the steps below.

Changing user permissions
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Before you begin
■ Log into an account that is different from the user whose account that you want to

disable.
■ You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, click User Groups.
2. On the User Group tab, select the user group.
3. On the Users tab, select a user.
4. Click Edit User.
5. Click the Account Status check box, then click Disable.
6. Click Finish.
7. In the Confirm window, check the settings.
8. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to show the status of the task.

Deleting user accounts

Security Administrators can delete a user account when the account is no longer in use.
Built-in user accounts cannot be deleted.

Before you begin

You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Device Manager - Storage Navigator Administration tree, select User
Groups.

2. On the User Groups tab, click a user group to which a user belongs.
3. On the Users tab, select the user whose account you want to delete.
4. Click More Actions > Delete Users.
5. In the Delete Users window, select the user to be deleted, then click Finish.
6. In the Confirm window, check the settings.
7. Click Apply. The task is now registered. If the Go to tasks window for status check

box is checked, the Task window opens to show the status of the task.

Managing resource groups

You can divide a provisioned storage system into resource groups that allow you to
manage the storage system as multiple virtual private storage systems. Configuring
resource groups involves creating resource groups, moving storage system resources
into the resource groups, and assigning resource groups to user groups.

Deleting user accounts
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About resource groups

A storage system can connect to multiple hosts and be shared by multiple divisions in a
company or by multiple companies. Many storage administrators from different
organizations can access the storage system. Managing the entire storage system can
become complex and difficult. Potential problems are that private data might be
accessed by other users, or a volume in one organization might be accidentally
destroyed by a storage administrator in another organization.

To avoid such problems, use Hitachi Resource Partition Manager software to set up
resource groups that allow you to manage one storage system as multiple virtual private
storage systems. The storage administrator in each resource group can access only their
assigned resources. Resource groups prevent the risk of data leakage or data destruction
by another storage administrator in another resource group.

The following resources can be assigned to resource groups.
■ LDEV IDs
■ Parity groups
■ External volumes
■ Ports
■ Host group IDs
■ iSCSI target IDs

Note:

Before you create LDEVs, you can reserve the desired number of LDEV IDs
and assign them to a resource group for future use. You can also reserve and
assign host group IDs and iSCSI target IDs in advance because the number of
host groups or iSCSI targets per port is limited.

meta_resource

The meta_resource group is the resource group consisting of the resources that exist on
the storage system (other than external volumes) before Resource Partition Manager is
installed. By default, all existing resources initially belong to the meta_resource group to
ensure compatibility with older software when a system is upgraded to include Resource
Partition Manager.

Resource lock

When a task is being processed on a resource, all of the resource groups assigned to the
logged-on user are locked for exclusive access. When a resource is locked, a status
indicator appears on the Device Manager - Storage Navigator status bar. To view
information about the locked resource, click Resource Locked.

Note: Opening a Device Manager - Storage Navigator secondary window
(such as Basic Information Display) or performing an operation from the
service processor (SVP) locks all of the resource groups in the storage system.

About resource groups
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Examples

The following examples illustrate how you can configure resource groups on your
storage system.

Resource groups sharing a port

If you have a limited number of ports, you can still operate a storage system effectively
by sharing ports using resource groups.

The following example shows the system configuration of an in-house division providing
virtual private storage system for two divisions. Divisions A and B each use their own
assigned parity group, but share a port between the two divisions. The shared port is
managed by the system division.

The Security Administrator in the system division creates resource groups for each
division in the storage system and assigns them to the respective divisions. The Storage
Administrator in Division A can manage the resource groups for Division A but cannot
access the resource groups for Division B. In the same manner, the Storage
Administrator in Division B can manage the resource groups for Division B but cannot
access the resource groups for Division A.

Examples
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The Security Administrator creates a resource group for managing the common
resources, and the Storage Administrator in the system division manages the port that is
shared between Divisions A and B. The Storage Administrators in Divisions A and B
cannot manage the shared port belonging to the resource group for common resources
management.

Configuration workflow for resource groups sharing a port

1. The system division forms a plan about the resource group creation and
assignment of the resources.

2. The Security Administrator creates the resource groups.
3. The Security Administrator creates the user groups.
4. The Security Administrator assigns the resource groups to the user groups.
5. The Storage Administrator in the system division sets a port.
6. The Security Administrator assigns resources to the resource groups.
7. The Security Administrator assigns the Storage Administrators to the appropriate

user groups.

After the above procedures, the Storage Administrators in Divisions A and B can manage
the resource groups assigned to their own division.

Resource groups not sharing ports

If you assign ports to each resource group without sharing, performance can be
maintained on a different port even if the bulk of I/O is issued from one side port.

Resource groups not sharing ports
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The following shows a system configuration example of an in-house system division
providing the virtual private storage system for two divisions. Divisions A and B each use
individual assigned ports and parity groups. In this example, they do not share a port.

The Security Administrator in the system division creates resource groups for each
division in the storage system and assigns them to the respective divisions. The Storage
Administrator in Division A can manage the resource groups for Division A but cannot
access the resource groups for Division B. In the same manner, the Storage
Administrator in Division B can manage the resource groups for Division B but cannot
access the resource groups for Division A.

Configuration workflow for resource groups not sharing a port

1. The system division forms a plan about creating resource groups and the assigning
resources to the groups.

2. The Security Administrator creates the resource groups.
3. The Security Administrator creates the user groups.
4. The Security Administrator assigns the resource groups to user groups.
5. The Storage Administrator in the system division sets ports.
6. The Security Administrator assigns resources to the resource groups.
7. The Security Administrator assigns each Storage Administrator to each user group.

After the above procedures, the Storage Administrators in Divisions A and B can access
the resource groups allocated to their own division.

Resource groups not sharing ports
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Resource group assignments

All resource groups are normally assigned to the Security Administrator and the Audit
Log Administrator.

Each resource group has a designated Storage Administrator who can access only their
assigned resources and cannot access other resources.

All resource groups to which all resources in the storage system belong can be assigned
to a user group. Configure this in Device Manager - Storage Navigator by setting All
Resource Groups Assigned to Yes.

A user who has All Resource Groups Assigned set to Yes can access all resources in the
storage system. For example, if a user is a Security Administrator (with View & Modify
privileges) and a Storage Administrator (with View and Modify privileges) and All
Resource Groups Assigned is Yes on that user account, the user can edit the storage for
all the resources.

If allowing this access becomes a problem with security on the storage system, then
register the following two user accounts and use these different accounts for different
purposes.
■ A user account for a Security Administrator where All Resource Groups Assigned is set

to Yes.
■ A user account for a Storage Administrator who does not have all resource groups

assigned and has only some of the resource groups assigned.

Resource group rules, restrictions, and guidelines

Rules
■ The maximum number of resource groups that can be created on a storage system is

1023.

If you are providing a virtual private storage system to different companies, you should
not share parity groups, external volumes, or pools if you want to limit the capacity that
can be used by each user. When parity groups, external volumes, or pools are shared
between multiple users, and if one user uses too much capacity of the shared resource,
the other users might not be able to create an LDEV.

Creating resource groups

When you create a resource group, you enter a name and assign the desired resources
(parity groups, LDEVs, ports, host groups, and iSCSI targets) to the new group. You can
create more than one resource group at a time.

Before you begin

You must have Security Administrator (View & Modify) role to perform this task.

Resource group assignments
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Procedure

1. In the Explorer pane, expand the Storage Systems tree, click the Administration
tab, and then select Resource Groups.

2. Click Create Resource Groups.
3. In the Create Resource Groups window, enter the name for the new group, select

the desired resources for the new group, and click Add to add the new group to list
of resource groups to be added.

Naming guidelines:

■ A resource group name can use alphanumeric characters, spaces, and the
following symbols: ! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

■ The characters in a resource group name are case-sensitive.

■ Duplicate occurrences of the same name are not allowed.

■ You cannot use the following names: meta_resource

4. Repeat the previous step for each new resource group to be added. If you need to
remove a group from the list of resource groups to be added, select the group, and
click Remove.

Note: The maximum number of resource groups that can be created on
a storage system is 1023.

5. When you are finished configuring new resource groups in the Create Resource
Groups window, click Next.

6. Enter a task name or accept the default, and then click Submit.
If you select View task status, the Tasks & Alerts tab opens.

Adding resources to a resource group

You can add resources to, remove resources from, and rename existing resource groups.

Note the following restrictions for editing resource groups:
■ Only resources allocated to meta_resource can be added to resource groups.
■ Resources removed from a resource group are returned to meta_resource.
■ No resource can be added to or removed from meta_resource.
■ The name of the meta_resource group cannot be changed or used for any resource

group other than the meta_resource group.
■ The system does not allow duplicate names.

Adding resources to a resource group
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■ LDEVs with the same pool ID or journal ID cannot be added to multiple resource
groups or partially removed from a resource group. For example, if two LDEVs belong
to the same pool, you must allocate both to the same resource group. You cannot
allocate them separately.

You cannot partially remove LDEVs with the same pool ID or journal ID from a
resource group. If LDEV1 and LDEV2 belong to the same pool, you cannot remove
LDEV1 leave only LDEV2 in the resource group.

Use the sort function to sort the LDEVs by pool ID or journal ID. Then select the IDs
and add or remove them all at once.

■ Host groups that belong to the initiator port cannot be added to a resource group.
■ To add or delete DP pool volumes, you must first add or delete DP pools.

Before you begin

You must have Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Explorer pane, click the Administration tab, and then select Resource
Groups.

2. Select the desired resource group (check the box next to the name of the resource
group) to display the resource information for the resource group.

■ To change the name of the selected resource group, click Edit Resource Group,
and enter the new name.

■ To add resources to the selected resource group, select the Parity Groups,
LDEVs, Ports, or Host Groups / iSCSI Targets tab, click Add Resources, and
follow the instructions on the Add Resources window.

■ To remove resources from the selected resource group, select the Parity
Groups, LDEVs, Ports, or Host Groups / iSCSI Targets tab, select the resources
to be removed, and then click Remove Resources.

3. Enter a task name or accept the default, and then click Submit.
If you select View task status, the Tasks & Alerts tab opens.

Deleting resource groups

You can delete a resource group only when the resource group does not contain any
resources and is not assigned to any user groups.

The following resource groups cannot be deleted:
■ meta_resource
■ A resource group that is assigned to a user group
■ A resource group that has resources assigned to it
■ Resource groups included in different resource groups cannot be removed at the

same time.

Deleting resource groups
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Before you begin

The Security Administrator (View & Modify) role is required to perform this task.

Procedure

1. In the Explorer pane, expand the Storage Systems tree, click the Administration
tab, select Resource Groups.

2. Click the check box of a Resource Group Name.
3. Click Delete Resource Groups.
4. Enter a task name or accept the default, and then click Submit.

If you select View task status, the Tasks & Alerts tab opens.

Account lock policy

A user account is automatically locked after three unsuccessful logins to Device Manager
- Storage Navigator or Command Control Interface. The account is locked for 60 seconds.

Unlock a user account

If a user attempting to log in to Device Manager - Storage Navigator or Command
Control Interface enters an incorrect username or password three times, the system sets
the login status to locked, preventing further login attempts for 60 seconds. If necessary,
you can release the locked status before the lock times out.

Before you begin

You must have the Security Administrator (View & Modify) role to perform this task.

Procedure

1. In the Administration tree, select User Groups.
2. On the User Groups tab, click a user group to which the locked-out user belongs.
3. On the User tab, select the user you want to unlock.
4. On the User tab, click More Actions > Release Lockout.

The Release Lockout window opens.
5. Specify a task name, and then click Apply.

Account lock policy
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Chapter 5:  Managing license keys

Accessing software functionality for your storage system requires a license key.

License keys overview

When you install a license key, it is also enabled. The functionality for the software that
you installed is available in Device Manager - Storage Navigator.

The license key can be disabled. This allows you to conserve time on a term key, for
example. If you have a 365-day term key for a software product, the license server starts
the count the day you install the key. However, you may not use the license immediately,
in which case you can disable the key. Disabling stops the count. You re-enable the key
when you become ready to use it.

This topic provides information in the order it is required:
■ License key types (on page 128) . Lists the key types; explains whether keys are

permanent or temporary; shows the term limit, if any; and provides the estimated
license capacity, if required.

■ Using the term key (on page 130) . Explains that you can conserve the term key when
you are not using it.

■ Using the temporary key (on page 130) . Explains that you can conserve the
temporary key when you are not using it.

■ Estimating licensed capacity (on page 131) . Provides information and instructions for
calculating license capacity according to your system and organization requirements.

■ Installing and uninstalling software (on page 137) . Provides instructions for installing,
disabling, enabling, and removing keys.

■ License key expiration (on page 142) provide information for dealing with these
situations.

License key types

To use software, you must install the license key provided when you purchase that
software.
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You can use software with licensed capacity for a term key by installing a term key and
overwriting a permanent key as long as the term key is valid. If the term key expires
when the system is being used, and the capacity needed for the operation is insufficient,
operations that you can perform are limited. In this case, a SIM that indicates the term
key expiration (reference code 7ff7xx) is output on the Alerts tab in the Storage Systems
window.

The following table describes the four types of license keys.

Type Description
Effective

term1

Estimating
licensed
capacity

Permanent For purchase No limit Required

Term For purchase 365 days Required

Temporary For trial use before purchase (try and
buy)

120 days Not required

Emergency For emergency use 30 days Not required

Notes:

1. When you log in to Device Manager - Storage Navigator, a warning message
appears if 45 days or less remain before the expiration.

Using the permanent key

You can purchase the permanent key to use a software application indefinitely. You must
estimate a licensed capacity required for using the software application and purchase a
license key for the amount of the required capacity.
■ If insufficient license capacity is installed, Not Enough License displays in the status

field of the License Keys window, and the software application is not enabled.
■ If the capacity of the usable volume exceeds the licensed capacity while the storage

system is running (for example, when an LDEV is additionally installed), Grace Period
displays in the status field of the License Keys window. You can continue to perform
the same operations, but the deficient amount of license capacity must be purchased
within 30 days.

Using the permanent key
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Using the term key

You can purchase the term key to use the software application for a specific number of
days. You must estimate a licensed capacity required for using the software application
and purchase a license key for the amount of the required capacity.
■ If insufficient license capacity is installed, Not Enough License or Grace Period

displays in the status field of the License Keys window.
■ You can enable or disable the term key for each software application. Unlike the

temporary key and the emergency key, the number of days the term key is enabled is
counted as the number of effective days of the term key rather than the number of
elapsed days from the installation date.

■ The number of effective days is decremented by one day when the date changes.

For example, if the term key is set to be enabled for 150 days during installation and
the term key is disabled for 100 days and a total of 250 days have elapsed since the
installation, the number of remaining effective days of the term key is 215 days. This
is determined by subtracting 150 days from 365 days. By disabling the term key on
the days when the software application is not used, you can prevent the unnecessary
shortening of the period in which the term key can be used.

■ If the term key is expired, Not Installed displays in the status field of the License Keys
window, and the software application is disabled.

Using the temporary key

You can use the temporary key for trial purposes. The effective term is 120 days from the
time of installation of the temporary key. The effective term is not increased even if the
temporary key is reinstalled during the effective term.

If you uninstall the temporary key, even though the effective term remains, Temporary is
displayed in the status field, Not Installed is displayed in the Key Type field, and the
remaining days of the effective term are displayed in the Term (Days) field of the License
Keys window.

If the temporary key expires, you cannot reinstall the temporary key for 180 days.
Expired displays in the status field of the License Keys window, and the software
application is disabled.

Using the emergency key

You can use the emergency key if the license key cannot be purchased, or if an
emergency occurs, such as a system failure or a communication error.

You can also use the emergency key if the configuration of the software application that
is installed by the temporary key remains in the changed status and cannot be restored
to the original status. For example, if you do not plan to purchase the software
application after using the temporary key for trial purposes, you can restore the changed
configuration to the original status by temporarily enabling the software application with
the emergency key.

Using the term key

Chapter 5: Managing license keys

System Administrator Guide for VSP G1x00 and VSP F1500 130



Caution:
■ If an emergency key is installed for a software application for which a

permanent or term key is installed, the effective term of the license key is
30 days. However, because the emergency key can be reinstalled during
the effective term, the effective term can be restored to 30 days.

■ In other scenarios, the emergency key can be installed only once.

Estimating licensed capacity

The licensed capacity is volume capacity that you are licensed to use with the software
application. You must estimate the amount of capacity that you want to use with the
software application before you purchase the permanent key or the term key.

Software and licensed capacity

Three licensed capacity types are available. The one you choose depends on the
software application. The following tables describe the licensed capacity types:

Table 1 Licensed capacity types

Type Description

Used capacity The licensed capacity is calculated by using one of the following
capacities:
■ Normal volumes (volumes)
■ External volumes mapped to the storage system
■ Pools

If the pool contains pool volumes that belong in accelerated
compression-enabled parity groups, you must purchase physical
capacity of the pool for the license capacity.

Mounted capacity/
usable capacity

The licensed capacity is estimated by using the capacity of all the
volumes in the storage system.

When you estimate for the capacity of the accelerated
compression-enabled parity groups, the physical capacity of the
parity group is the maximum of the estimated capacity, even if
you created an internal volume which exceeds the physical
capacity of the accelerated compression-enabled parity group.
See the Provisioning Guide for an explanation of accelerated
compression.

Unlimited capacity You can use the software regardless of the volume capacity.

The following table lists the software and the licensed capacity.

Estimating licensed capacity
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Option name
Licensed
capacity Notes

HDvM/Device Manager -
Storage Navigator

Mounted
capacity

SNMP Agent Mounted
capacity

JAVA API Mounted
capacity

SMI-S Provider Mounted
capacity

LUN Manager Mounted
capacity

Used only for open-system devices
(including LUN security).

Virtual LVI Mounted
capacity

Open Volume Management Mounted
capacity

Used only for open-systems devices

Volume Shredder Mounted
capacity

Cache Residency Manager Mounted
capacity

Cache Residency Manager for
Mainframe

Mounted
capacity

Performance Monitor Mounted
capacity

Server Priority Manager Mounted
capacity

To use Server Priority Manager, first
install Performance Monitor.

Volume Migration Mounted
capacity

To use Volume Migration, first install
Performance Monitor.

For information about Volume
Migration, contact the customer
support.

Volume Migration V2 Mounted
capacity

For information about Volume
Migration V2, contact the customer
support.

TrueCopy Used capacity
for normal
volumes1

Default state1

Software and licensed capacity
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Option name
Licensed
capacity Notes

TrueCopy for Mainframe Used capacity
for normal
volumes1

Universal Replicator Used capacity
for normal
volumes1

To use Universal Replicator, first install
TrueCopy.

Universal Replicator for
Mainframe

Used capacity
for normal
volumes1

To use Universal Replicator for
Mainframe, first install TrueCopy for
Mainframe.

Disaster Recovery Extended Unlimited To use Disaster Recovery Extended,
first install Universal Replicator or
Universal Replicator for Mainframe.
See the prerequisites for these in the
two rows directly above this one.

ShadowImage Used capacity
for normal
volumes1

ShadowImage for Mainframe Used capacity
for normal
volumes1

Compatible FlashCopy® V2 Used capacity
for normal
volumes1

Hitachi Compatible
FlashCopy®

Used capacity
for normal
volumes1

Thin Image Used capacity
for normal
volumes1 +
total pool
capacity

To use Thin Image, first install Dynamic
Provisioning.

Dynamic Provisioning Used capacity
(Total pool
capacity)

Dynamic Provisioning for
Mainframe

Used capacity
(Total pool
capacity

To use Dynamic Provisioning for
Mainframe, first install Dynamic
Provisioning.

Software and licensed capacity
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Option name
Licensed
capacity Notes

Dynamic Tiering Used capacity
(Total pool
capacity)

To use Dynamic Tiering, first install
Dynamic Provisioning.

Dynamic Tiering for
Mainframe

Used capacity
(Total pool
capacity

To use Dynamic Tiering for Mainframe,
first install Dynamic Provisioning for
Mainframe and Dynamic Tiering.

Active flash Used capacity
(Total pool
capacity

To use active flash, first install Dynamic
Tiering.

Active flash for mainframe Used capacity
(Total pool
capacity

To use active flash for mainframe, first
install active flash and Dynamic Tiering
for Mainframe.

Compatible PAV Used capacity
for normal
volumes

Compatible Hyper PAV Unlimited To use Compatible Hyper PAV, first
install Compatible PAV.

Compatible XRC Used capacity
for normal
volumes

For controller emulation type I-2107
only.

FICON® Data Migration Used capacity
for external
volumes

High Performance
Connectivity for FICON®

Unlimited

Data Retention Utility Mounted
capacity

Volume Retention Manager Mounted
volumes

Universal Volume Manager Used capacity
for external
volumes

Virtual Partition Manager Unlimited You may use up to four CLPRs without
the Virtual Partition Manager license
key. With a license key, you can define
up to 32 CLPRs.

Resource Partition Manager Unlimited

Software and licensed capacity
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Option name
Licensed
capacity Notes

Nondisruptive migration Used capacity
for external
volumes.

Encryption License Key Unlimited

FMD Encryption License Key Unlimited

Global-active device Used capacity
for normal
volumes1

High temperature mode Unlimited

FIPS140-2 Level2 Unlimited To use, first install Encryption License
Key.

VSP F1500 All Flash Array Unlimited A license key which is required for VSP
F1500.

Dedupe and compression Unlimited A license which is required to use the
capacity saving function. To use the
capacity saving function, you need to
install Dynamic Provisioning.

VSP G1500 and F1500 VSD Unlimited A license which is required to upgrade
from VSP G1000 to VSP G1500. To
upgrade to VSP G1500, change the MP
blade type from MPB1 to MPB2 before
installing this license.

Notes:

1. If you use V-VOLs of Dynamic Provisioning, Dynamic Provisioning for Mainframe,
Dynamic Tiering, or Dynamic Tiering for Mainframe as P-VOLs or S-VOLs of the
following software applications, the license capacity is calculated using the page
capacity allocated to the V-VOLs (that is, used pool capacity).

■ ShadowImage

■ Thin Image

■ TrueCopy

■ Universal Replicator

■ ShadowImage for Mainframe

■ TrueCopy for Mainframe

■ Universal Replicator for Mainframe
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Option name
Licensed
capacity Notes

■ Compatible FlashCopy®

■ Global-active device

Calculating licensed capacity for a normal volume

A normal volume is a volume that is not blocked or protected. The volume can be written
to. The calculation of the normal volume capacity depends on the volume emulation
type. Use the formula in the following table to estimate capacity for purchase. When you
calculate the volume capacity, round the value up to the second decimal place.For OPEN-
V volumes, the licensed capacity of a volume is the same as the capacity specified when
creating the volume.

Table 2 Formulas for calculating capacity of a normal volume

Volume emulation type Formula for calculating capacity of a normal volume

3390-x1 870 KB × number-of-user-cylinders

OPEN-x1 Same as the capacity specified when creating the
volume

Notes:

1. x indicates a number or a letter. For example, OPEN-x refers to emulation types
such as OPEN-3 and OPEN-V.

An example is shown in the following table.

Table 3 Example of calculating license capacity

Item Value

Volume emulation type 3390-3

Number of user cylinders 3,339

Number of volumes 2,048

Total capacity of all the
volumes

870 KB × 3,339 × 2,048 = 5,949,296,640 KB

5,949,296,640 KB / 1,024 = 5,809,860 MB

5,809,860 MB / 1,024  5,673.70 GB

5,673.70 GB / 1,024  5.55 TB

Estimated required capacity At least 6 TB

Calculating licensed capacity for a normal volume
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Calculating licensed capacity for an external volume

Use the following equation to calculate the licensed capacity for an external volume:

External Volume Capacity (KB) = Volume Capacity (number of blocks) X
512 (bytes) / 1,024

Calculating pool capacity

The license capacity of Dynamic Provisioning is calculated using the total capacity of the
Dynamic Provisioning pool. If you use Dynamic Provisioning V-VOLs as P-VOLs or S-VOLs
of ShadowImage, TrueCopy, Universal Replicator, or global-active device, the license
capacity of ShadowImage, TrueCopy, Universal Replicator, or global-active device is
calculated by using the page capacity allocated to the Dynamic Provisioning V-VOLs (that
is, used pool capacity).

For more information on calculating pool capacity, see the Provisioning Guide for Open
Systems and the Provisioning Guide for Mainframe Systems.

Accelerated compression-enabled parity group capacity

For the actual capacity of accelerated compression-enabled parity groups, the total
capacity of LDEVs created in the parity group and the physical capacity are compared.
The one with the least capacity is added as the actual capacity. See the following table for
an example.

Total LDEV capacity in the
parity group Physical capacity

Actual capacity which is
added

12 TB 20 TB 12 TB

24 TB 20 TB 20 TB

Installing and uninstalling software

This section provides instructions for installing and uninstalling software.

Installing license keys using Device Manager - Storage Navigator

Use license keys to install software.

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ You must install a license key for each software application before you use it.

Calculating licensed capacity for an external volume
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Procedure

1. From the Administration tree, click License Keys.
2. In the License Keys window, click Install Licenses.
3. Select whether to enter a key code or specify a license key file.

■ Key Code: Enter a key code to install the software. In Key Code, enter the license
key code for the software.

■ File:  Specify a license key file to install the software. Click Browse and specify
the license key file. You can use a file name of up to 200 alphanumeric
characters, excluding several symbols (" \ ; : * ? < > | / ,). The file extension is
"plk".

4. Click Add .
5. In the Selected License Keys table, set the status of license keys for each software

application.

■ Enable Licenses: Installs license keys in enabled status. You can select more
than one software application to install licenses for.

■ Disable Licenses: Installs license keys in disabled status. You can select more
than one software application to install licenses for.

■ Clear All: Delete all license keys from the Selected License Keys table.

6. Click Finish. The Confirm window opens.
7. In the Confirm window, check the settings. In the Task Name field, enter a task

name.
8. Click Apply. The task is registered. If the Go to tasks window for status check box

is checked, the Task window opens.
If a software installation fails, the Error Message window opens. To display the
cause of error, from the Error Message window, select the software and click
Detail.

When the status is Installed (Disabled)

If you do not install the prerequisite software before you install the license key software,
the software will install correctly but will be disabled. To enable a license key, install the
prerequisite software, and then enable the key.

Enabling a license

You can enable a license that is in disabled status.

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Administration tree, click License Keys.

When the status is Installed (Disabled)
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2. In the License Keys window, select one or more licenses to enable, and then click
Enable Licenses.

3. Check the settings, and then click Apply.

Disabling a license

You can disable a license that is in enabled status.

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Administration tree, click License Keys.
2. In the License Keys window, select one or more licenses to disable, and then click

Disable Licenses.
3. Check the settings, and then click Apply.

Removing a software application

Remove software from the storage system by uninstalling license keys.

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Administration tree, click License Keys.
2. In the License Keys window, select one or more licenses to uninstall.

Note:

On rare occasions, a software option that is listed as Not Installed but
still has available licensed capacity (shown as XX TB) might remain in the
list. In this case, select that option, and then uninstall the software.

3. Click Remove to display the Remove Licenses window.
4. Check the settings, and then click Apply.

Note:

To reinstall a license key after uninstalling it, contact customer support to
reissue the license key file.

Disabling a license
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Updating license status

In the following cases, the status of software might remain at Not Enough License or
Grace Period. In that case, update the license status.
■ When the licensed capacity exceeds the mounted capacity after you reduce the

number of LDEVs
■ When the licensed capacity exceeds the used capacity after you delete pairs or pool

volumes

Before you begin

You must have the Storage Administrator (Initial Configuration) role to perform this task.

Procedure

1. From the Administration tree, click License Keys.
2. In the License Keys window, click Update License Status.
3. Check the settings, and then click Apply

Examples of license information

The following table provides examples of license information displayed in the License
Key window.

License key status
(example) Status Key type

Licensed
capacity Term (Days)

Not installed Not installed blank Blank Blank

Installed with the
permanent key

Installed permanent Permitted -

Installed with the term
key and set to Enabled

Installed term Permitted Number of
remaining days
before
expiration

Installed with the term
key and set to
Disabled

Installed
(Disabled)

term Permitted -

Installed with the
temporary key.

Installed temporary - Number of
remaining days
before
expiration

Installed with the
emergency key.

Installed emergency - Number of
remaining days
before
expiration

Updating license status
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License key status
(example) Status Key type

Licensed
capacity Term (Days)

A temporary key was
installed, but has
expired.

Expired temporary - Number of
remaining days
before
expiration

A term key or an
emergency key was
installed, but has
expired.

Not installed blank Blank Blank

Installed with the
permanent key or the
term key, but the
licensed capacity was
insufficient.

Not Enough
License

permanent or
term

Permitted and
Used

-

Installed with the
permanent or term
key, and then LDEVs
are added, but the
license capacity was
insufficient.

Grace Period permanent or
term

Permitted and
Used

Number of
remaining days
before
expiration

Installed with the
temporary key, and
then reinstalled with
the permanent key,
but the license
capacity was
insufficient.

Installed temporary Permitted and
Used

Number of
remaining days
before
expiration

Installed with the
permanent or term
key, then reinstalled
with the emergency
key.

Installed emergency Permitted and
Used

Number of
remaining days
before
expiration

Cautions on license capacities in license-related windows

License capacities are displayed not only in license-related windows but also in the Pools
window and the Replication window.

When you install or overwrite a temporary key or an emergency key for an installed
software application, the license capacity before the overwrite installation is displayed as
Permitted (TB) in license-related windows. However, Unlimited (license capacity for the
temporary key or emergency key) is displayed as Licensed Capacity in the Pools window
and the Replication window.

Cautions on license capacities in license-related windows
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For example: You install a term key that has a license capacity of 5 TB for Compatible
FlashCopy®, and when the term expires, you use an emergency key. In license-related
windows, 5 TB is displayed in the Permitted (TB) field. However, in the Licensed
Capacity field in a Replication window, Unlimited (capacity of the emergency key) is
displayed.

Cautions on licenses

Observe the following precautions when working with licenses:

Caution: If you use Dynamic Provisioning, the licensed capacity might
become insufficient because the used capacity of Dynamic Provisioning pools
could increase even if you do not add any volumes. If this occurs, you must
purchase an additional license within 30 days to cover the capacity shortage.
For details on how to calculate pool capacity, see the Provisioning Guide for
Open Systems.

Caution: When you remove Data Retention Utility an error might occur even
if the Permitted Volumes column of the License Keys window indicates that
the licensed capacity is 0 TB.

Resolving errors when removing Data Retention Utility

If a Data Retention Utility error occurs during removal, you must resolve it before
continuing removal.

For details about the Data Retention window, see the Provisioning Guide for Open
Systems.

Procedure

1. Click Actions > Other Function > Data Retention to open the Data Retention
window.

2. In the Data Retention window, find logical volumes that are unusable as S-VOLs
(secondary volumes).

3. Change the settings so that the logical volumes are usable as S-VOLs.
4. Uninstall Data Retention Utility.

License key expiration

If the license key for software-A expires, the license key for software-B is also disabled if
software-B requires an enabled software-A. In this scenario, Installed (Disabled) is shown
for software-B in the Status column of the License Keys table. After that, when you re-
enable software-A, software-B is also re-enabled. If the Status column for software-B
continues to display Installed (Disabled), go to the License Keys table and manually
change the status of software-B back to Installed.

Cautions on licenses
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After your license key expires, no new configuration settings can be made, and no
monitoring functions can be used with Performance Monitor. Configuration settings
made before the expiration of the license key remain in effect. You can cancel
configuration changes for some software.

License key expiration
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Chapter 6:  Viewing and managing the storage
system

Use Device Manager - Storage Navigator to view storage system information, manage
system configuration reports, and manage queued operations.

This section describes how to navigate to your storage system information, create and
download system configuration reports, and manage Device Manager - Storage
Navigator tasks.

Viewing storage system information

Use Device Manager - Storage Navigator to view high-level information, create reports,
and manage tasks.

The storage system information appears immediately when you start Device Manager -
Storage Navigator.

Viewing basic information

The main window shows basic information about the storage system.
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Viewing specific information

You can view more specific information when you make a selection in the resource tree
in the left pane.

Viewing other system information

You can also find other system information such as a port status and data regarding
used and unused resources. This information displays in a Device Manager - Storage
Navigator secondary window.

Procedure

1. Click Settings > Environmental Settings > License Keys. Java starts.
2. If a message appears and asks if you want to run the Java application, click Run. The

Device Manager - Storage Navigator secondary window opens.
3. In the Device Manager - Storage Navigator secondary window, click File > Basic

Information. The Basic Information Display dialog box opens.
4. Click the tab to display the Basic Information Display dialog box.
5. To save information in the dialog box, click Export. In the dialog box that opens,

enter location and file name, then click Save.

Viewing specific information
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Viewing port conditions

You can view port conditions by clicking Actions > Component > View Port conditions.

Status icons for certain resources

The status of certain resources is indicated by the following icons:

Status Description

The resource can be used normally.

Viewing port conditions

Chapter 6: Viewing and managing the storage system

System Administrator Guide for VSP G1x00 and VSP F1500 146



Status Description

The resource has the following status:
■ The resource can be used, but has a limit on I/O performance and so

on.
■ The status of the resource is changing.
■ The status of the resource is being confirmed.
■ The resource has subresources of different status.

For example, parity groups are in this status if the statuses of logical
volumes in the parity groups are not the same.

In this case, the subresources might be blocked. Confirm the status
of subresources.

The resource has the following status:
■ The resource cannot be used because it is blocked due to a failure or

maintenance operations.
■ The status of the resource is unknown.

Restore the resource to the normal status.

Using the storage system in high temperature mode

High temperature mode is a licensed feature that allows the storage system to be run at
either standard temperature (60.8°F to 89.6°F / 16°C to 32°C) or at higher temperatures
(60.8°F to 104°F / 16°C to 40°C) in a data center, saving energy and cooling costs.

Normal and high temperature alerts
When high temperature mode is disabled, a SIM displays when the temperature in
the storage system exceeds 89.6°F / 32°C.

When high temperature mode is enabled, a SIM displays when the temperature in
the storage system exceeds 104°F / 40°C.

Using the storage system in high temperature mode
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Caution: Important information about using high temperature mode. See the
Hardware Guide for Hitachi Virtual Storage Platform G1000, G1500, and F1500
for additional information.
■ Notify Technical Support. Before enabling high temperature mode, call the

customer support. They may have updates or additional information
besides the following notes.

■ Operating with FMDs. Do not enable high temperature mode if the system
contains FMDs. FMDs can be used only in the standard temperature
environment.

■ Operating Altitude. The lifetime of a storage system that is operated in
standard temperature mode is six years. The lifetime of a storage system
that is operated in high temperature mode is five years.

■ Cache Flash Memory battery life. When high temperature mode is
enabled, the cache flash memory battery life will be reduced to two-thirds
of the battery life that remains at the time when high temperature mode is
enabled.

Example 1: A new cache flash memory battery has three years of usable
life when operated in a standard temperature environment. If you enable
high temperature mode when the battery is new, the battery life will be
reduced to two years.

Example 2: The storage system is used for two years at normal
temperature mode. The cache battery has one year of usable life
remaining at that time. If you enable high temperature mode, the life of
the battery will be reduced to eight months.

■ Cache Flash Memory battery date. When high temperature mode is
enabled, the battery replacement notice displays one year earlier than
when high temperature mode is disabled.

After high temperature mode is enabled, the date of the battery
replacement notice cannot be changed back to normal, even if high
temperature mode is disabled. When high temperature mode is enabled, a
confirmation message is displayed.

■ System noise. When the storage system is used in a high temperature
environment near 104°F / 40°C, the fans operate at high speed, increasing
noise. See Appendix A, Specifications, in the Hardware Guide for Hitachi
Virtual Storage Platform G1000, G1500, and F1500 for information about
system noise levels.

Using the storage system in high temperature mode
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Enabling high temperature mode

Before you begin
■ You must have the Storage Administrator (Initial Configuration) role to perform this

task.
■ The license for this feature must be installed before using it.
■ For details about the Components window, see the Provisioning Guide for Open

Systems and the Provisioning Guide for Mainframe Systems.

Procedure

1. In the Storage Systems tree, select the Components tab.
2. In the Components tab, click Edit High Temperature Mode. The Edit High

Temperature Mode window opens.
3. Click Enable (16-40 degrees C).
4. Click Finish.
5. In the Confirm window, verify the settings and enter a task name.
6. Click Apply. The task is registered. If the Go to tasks window for status check box

is checked, the Task window opens.

Managing tasks

You can use Device Manager - Storage Navigator to handle multiple tasks without
interruption.

Because Device Manager - Storage Navigator operations are executed in the background,
you start the next task immediately after performing the previous one. You keep track of
your tasks' progress by entering a task name during each Device Manager - Storage
Navigator procedure and then tracking its status and other information using the Task
window.
■ Each procedure you perform requires a task name. For example, when you provision

or configure the system, create a pair, or any other procedure, you must assign a
name for the task.

■ Each task is queued and then processed by the storage system in the order of its
arrival.

Note: You cannot use a secondary window to make any settings while a task
in the main window has a status of In Progress, Waiting, or Suspended.

Only one task is executed at the same time, except for the following. In the case of the
following operations, the next task may be executed before the current task completes
or fails.
■ Create LDEVs
■ Format LDEVs

Enabling high temperature mode
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■ Shred LDEVs
■ Shrink Pool
■ Edit Encryption

Tasks window

The Tasks window can display 384 tasks, including up to 128 tasks with a status of In
Progress, Waiting, and Suspended, and up to 256 tasks with a status of Completed and
Failed. If the number exceeds these limits, the oldest completed tasks are automatically
removed from the window.

Managing your tasks

Device Manager - Storage Navigator allows you to suspend, resume, cancel, and prevent
tasks from being automatically deleted.

Before you begin
■ Users that execute the task or users with Storage Administrator (System Resource

Management) role can view the details of tasks.
■ Users with the Storage Administrator (System Resource Management) role can delete,

suspend, resume tasks, and enable or disable auto-deletion of tasks.

Procedure

1. In the tree, click Storage Systems > Tasks. The list of tasks appears.
2. In the list, click the task or tasks that you want to modify.
3. In the bottom right corner of the window, click the corresponding button for the

task you want to perform:

■ Click Delete Tasks to delete or cancel a task.

■ Click Suspend Tasks to suspend a queued task.

■ Click Resume Tasks to resume a suspended task.

■ Click More Actions > Enable Auto Delete to delete tasks from the Task list when
they have completed and the task list is full. This allows you to check for
completed tasks and to clear the list when the limit (384) is reached.

■ Click More Actions > Disable Auto Delete to keep tasks in the task list after the
tasks are completed.

4. Verify the displayed settings and click Apply.

Referencing the detailed task status

To view the Task Status, click Status for each task in the Tasks window.

Tasks window
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When an operation that contains several connected tasks is set as one task, you can still
check the status of each task in the Tasks window. You can also check which task has
failed. The following example shows that an error has occurred for the task action
number 2.

In the LDEV creations or LUN operations, some tasks are processed as one and the
individual result may not be reported. Some of the settings may not be applied because
internal processing has been stopped due to the error displayed in the following Tasks
window.

Referencing the detailed task status
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For example, the following figure shows a single task in which "an LDEV 01 and an LDEV
02" are created. Though shown as a single task, this task is internally divided into two
parts: a setting for LDEV 01 (setting A) and a setting for LDEV 02 (setting B). If an error
occurs in the setting A task, the setting B task will not be processed. The operation result
for the setting A task is displayed in the Status of the Tasks window. The setting B task
will also not be processed for LDEV 01.

After the task operation is complete, check both the LDEV 02 which has failed in the
setting A task and the setting A task for LDEV 01 which has completed. Then run the
necessary task again.

Referencing the detailed task status
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Stalled tasks

If a queued task is not performed over a reasonable period, check the following:
■ Did the task fail? Click failed to view the reason. Then delete the task using the Delete

Tasks window, correct the problem, and try the task again.
■ Are too many tasks in the task list because Auto Delete is disabled? Use the Enable

Auto Delete window to remove tasks from the window.
■ Is another program changing the storage system configuration? Check this by

observing whether Resource Lock is displayed for too long a time. If so, verify that
another program is running and then wait until its changes are completed.

■ The percentage of progress of an ongoing task may not change if another operation is
in progress.

Setting the status refresh interval of the Tasks window

The Tasks window automatically updates every 60 seconds by default. This interval can
be changed using the following procedure.

Procedure

1. Click Settings > Environmental Settings > Edit Information Display Settings.
2. Specify the interval for Task Screen Refresh Interval. If No Update is specified, the

Tasks window will not be automatically updated. In this case, to update the window,
you must use Refresh or File > Refresh All.

3. Click Apply.

Stalled tasks
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Chapter 7:  Using reports to view storage system
information

Device Manager - Storage Navigator can generate reports that contain information about
your storage system's physical configurations and logical settings. Reports can cover
specific areas of the storage system, such as reporting on configuration, ports, channel
adapters, and disk adapters. You can save reports as comma-separated-value (CSV) files
or as HTML files. Tables in the HTML version of the configuration reports are sortable.

Before making changes to a storage system, generate reports of your storage system’s
physical configurations and logical settings. Generate a similar report after the changes,
and then compare the reports to verify that new settings were made as intended.

Creating configuration reports

You can create up to 20 configuration reports for each storage system. If you already
created 20 reports, delete unnecessary reports first, and then create a new report.

Before you begin

You must have Storage View permission to perform this task.

Procedure

1. Open the Create Configuration Report window. From General Tasks, click Create
Configuration Report.

2. Specify a task name and click Apply. This task name is used as the report name in
the Reports window. This process takes approximately 10 minutes to complete.

3. Click Refresh to update the Reports window. The created report appears in the list.

Viewing configuration reports

You can view configuration reports in three ways: in table view, in graphical view, and as
comma-separated value (CSV)-formatted files.

Before you begin
■ Adobe Flash Player must be installed.
■ Users can view the reports that they created.
■ Users that have the Storage Administrator (Initial Configuration) role can view all

reports.
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Note: The window used to specify the location where the folder will be saved
might not appear when downloading the report in Google Chrome. In this
case, follow Chrome Menu > Settings > Show advanced settings and uncheck
the Protect you and your device from dangerous sites checkbox under
Privacy.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Specify the report to download.
3. Click Download Reports.
4. Specify a folder in which to save a .tgz file.

5. Extract the downloaded .tgz file.

6. Display the report.
For HTML reports:

Open the file extracted-folder\html\index.html.

For CSV reports:

Open a CSV file in the folder extracted-folder\csv.

Viewing configuration reports in the Reports window

You can view only HTML format reports in the Reports window.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Click the name of the report to display.

The report is displayed in the Reports window.
3. In the Reports window, click the name of the report in the list at the left, and then

view the report at the right.

Deleting configuration reports

You can delete a configuration report when you no longer need it, or to make room in
the Reports window when the number of reports is near the limit.

Before you begin

Users that create the report or users with the Storage Administrator (Initial
Configuration) role can delete a configuration report.

Procedure

1. Expand the Storage Systems tree, and then click Reports.
2. Select the report to delete.

Viewing configuration reports in the Reports window
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3. Click Delete Reports.
4. Click Apply.

Examples of Device Manager - Storage Navigator storage
configuration reports

The Device Manager - Storage Navigator can show configuration reports for your storage
systems in table, graph, and CSV formats.

The following examples show various storage configuration reports in table, graph, and
CSV formats.

Report examples: table view

Some Device Manager - Storage Navigator reports appear in table format.

The following figure provides examples of reports in table format. The  icons are
displayed before the names of the reports in table view. If the icons are not displayed
correctly, update the window.

■ To sort data in table reports, click any column header.
■ While a table is reading a large amount of data, the table columns cannot be

manipulated, sorted, or resized. However, you can view previously displayed items,
select rows, and scroll.

CHAP Users report

Examples of Device Manager - Storage Navigator storage configuration reports

Chapter 7: Using reports to view storage system information

System Administrator Guide for VSP G1x00 and VSP F1500 156



The following figure shows an example of a CHAP Users report. The table following the
figure describes the items in the report.

Item Description

Port Location Name of the port

User Name Name of the CHAP user for authentication

iSCSI Target Alias Alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Disk Adapters report

The following illustration shows an example of a Disk Adapters report. The table
following the illustration describes the items in the report.

Item Description

DKA Location of the disk adapter (also called a back-end director).
■ "External" is displayed when the storage system has an external

storage system.
■ "External (FICON DM)" is displayed when the storage system has

volumes for FICON DM.

Module Module number.

A hyphen (-) displays if "DKA" is "External" or "External (FICON DM)".

Disk Adapters report
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Item Description

Number of PGs The number of the parity groups that the disk adapter controls.
■ If "DKA" is "External", this item indicates the number of parity groups

mapped to external volumes.
■ If "DKA" is "External (FICON DM)", this item indicates the number of

parity groups mapped to volumes for FICON DM.

Number of LDEVs
(Total)

The number of the logical volumes belonging to the parity groups that
the disk adapter controls.

Number of LDEVs
(Unallocated)

The number of the logical volumes that are inaccessible from the host
and belong to the parity groups controlled by the disk adapter.

Total LDEV Capacity
(MB)

Total capacity of the logical volumes belonging to the parity groups that
the disk adapter controls.

Unallocated LDEV
Capacity (MB)

Total capacity of the logical volumes that are inaccessible from the host
and belong to the parity groups controlled by the disk adapter.

Host Groups / iSCSI Targets report

The following figure shows an example of a Host Groups / iSCSI Targets report. The table
following the figure describes the items in the report.

Item Description

Port Location Name of the port

Type Type of the host group

Host Group Name /
iSCSI Target Alias

Name of the host group / alias of the iSCSI target

Host Group ID / iSCSI
Target ID

Number of the host group / ID of the iSCSI target

Host Groups / iSCSI Targets report
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Item Description

iSCSI Target Name Name of the iSCSI target

Resource Group Name Resource Group Name where the host group belongs

Resource Group ID Resource Group ID where the host group belongs

Number of LUNs The number of LU paths defined to the host group

Number of LDEVs The number of logical volumes that are accessible from the hosts in the
host group

Number of PGs The number of parity groups with logical volumes that are accessible
from the hosts in the host group

Number of DKAs The number of disk adapters controlling the parity groups where the
logical volumes that are accessible from the hosts in the host group
belong

Total LDEV Capacity
(MB)

Total capacity of the logical volumes accessible from the hosts in the
host group. This is the total capacity of LDEVs referred to in "Number of
LDEVs".

Port Security Security of the port

Authentication :
Method

iSCSI target method authentication settings
■ CHAP
■ None
■ Comply with Host Setting

Authentication : Mutual
CHAP

Enable or disable the iSCSI target mutual CHAP
■ Enabled
■ Disabled

Authentication : User
Name

Authenticated iSCSI target user name

Authentication :
Number of Users

The number of authenticated users registered in the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host mode option of the host group. Host mode options are separated
by semicolons (;) when more than one option is specified.

Number of Hosts The number of the hosts in the host group.

Host Groups / iSCSI Targets report
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Hosts report

The following figure shows an example of a hosts report. The table following the figure
describes the items in the report. When a host is registered to more than one port, more
than one record shows information about the same host.

Item Description

Port Location Name of the port

Type Port type

Port Internal WWN Port WWN

Port Security Port security setting

Host Group Name /
iSCSI Target Alias

Name of the host group / alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host group host mode option. When more than one host mode option
is specified, they are separated by semicolons (;)

Host Name Name of the host that can access the LU path through the port

HBA WWN / iSCSI Name Host WWN / host iSCSI name. The name is in 16-digit hex format.

Logical Devices report

The following figure shows an example of a logical volumes report. The table following
the figure describes the items in the report.

Hosts report
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Item Description

LDEV ID The logical volume number

LDEV Name The logical volume name

Capacity (MB) Capacity of the logical volume

Emulation Type Emulation type of the logical volume

Resource Group Name Resource group name where LDEV belongs

Resource Group ID Resource group ID where LDEV belongs

PG The parity group number.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the number starts with "M" (for example, M1-1), the parity group

contains FICON DM volumes.

A hyphen displays for Dynamic Provisioning or Thin Image V-VOLs.

RAID Level RAID level of the parity group where the logical volume belongs1

Drive Type/RPM Drive type and round-per-minute (RPM) of the drive of the parity group
where the logical volume belongs.

A hyphen (-) is displayed as RPM when the drive is SSD.1

Drive Type-Code Type code of the drive of the parity group where the logical volume
belongs1

Drive Capacity Capacity of the drive of the parity group where the logical volume
belongs.1

PG Members List of the drive locations of the parity group where the logical volume
belongs1

Allocated Information about whether the host can access the logical volume.

For mainframe volumes and multi-platform volumes, "Y" is displayed
unless the volumes are in the reserved status.

SSID SSID of the logical volume

CVS Information about whether the logical volume is a customized volume

OCS Oracle checksum

Attribute The attribute of the logical volume

Provisioning Type Provisioning type of the logical volume

Logical Devices report
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Item Description

Pool Name ■ For V-VOLs of Dynamic Provisioning, the name of the pool related to
the logical volume is displayed1

■ If the logical volume attribute is Pool, the name of the pool where the
logical volume belongs is displayed

■ When neither of the above are displayed, the pool name is blank

Pool ID The ID of the pool indicated by "Pool Name" A hyphen (-) displays for
volumes other than pool-VOLs or V-VOLs

Current MPB The number of the microprocessor that currently controls the logical
volume

Setting MPB The number of the MP blade that you specified to control the logical
volume

Command Device:
Security

Indicates whether Security is specified as the attribute for the command
device. A hyphen (-) displays when "Attribute" is not "CMDDEV".

Command Device:

User Authentication

Indicates whether User Authentication is specified as the attribute for
the command device. A hyphen (-) displays when "Attribute" is not
"CMDDEV".

Command Device:

Device Group Definition

Indicates whether Device Group Definition is specified as the attribute
for the command device. A hyphen (-) displays when "Attribute" is not
"CMDDEV".

Encryption Indicates whether the parity group to which the LDEV belongs is
encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: blank

T10 PI Indicates the T10 PI attribute set for the LDEV.
■ Enabled
■ Disabled
■ Blank if the emulation type is not OPEN-V

ALUA Mode Indicates whether the ALUA mode is enabled:
■ Enabled: ALUA mode is enabled.
■ Disabled: ALUA mode is disabled.

Notes:

1. A hyphen (-) displays if the LDEV is an external volume or a FICON DM volume.

Logical Devices report
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LUNs report

The following figure shows an example of an LU path definitions report. A record is
created for each LU path. The table following the figure describes the items in the report.

Item Description

Port Location Name of the port

HBA WWN / iSCSI Name Port WWN or name of the iSCSI (16 digits in hexadecimal)

Port Security Name of the type of security of the port

Host Group Name /
iSCSI Target Alias

Name of the host group or alias of the iSCSI target

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode of the host group

Host Mode Option Host mode option of the host group. Host mode options are separated
by semicolons (;) when more than one option is specified.

LUN Logical unit number

LDEV ID Logical volume number

Emulation Type Emulation type of the logical volume

Capacity (MB) Capacity of the logical volume

Asymmetric Access
State

Asymmetric access status:
■ Active/Optimized: Prioritized
■ Active/Non-Optimized: Lower priority

LUNs report
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MP Blades report

The following illustration shows an example of an MP blades report. The table following
the illustration describes the items in the report.

Item Description

MP Blade ID MP blade ID

MP Blade Name MP blade name

Module Module number

Auto Assignment Auto assignment attribute for the MP blade

Number of Resources
(LDEV)

The number of logical volumes that the MP blade controls

Number of Resources
(Journal)

The number of journals that the MP blade controls

Number of Resources
(External Volume)

The number of external volumes that the MP blade controls, including
FICON DM volumes

Number of Resources
(Total)

The total number of resources that the MP blade controls

The sum of "Number of Resources (LDEV)", "Number of Resources
(Journal)", and "Number of Resources (External Volume)"

MP Blade Type Package type of the MP blade

MP Blade Details report

The following illustration shows an example of an MP blade details report. The table
following the illustration describes the items in the report.

MP Blades report
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Item Description

MP Blade ID MP blade ID

MP Blade Name MP blade name

Auto Assignment Auto assignment attribute for the MP blade

Resource ID ID of this resource that the MP blade controls

Resource Name The name of the resource that the MP blade controls. If "Type" is LDEV,
the LDEV name that is set is displayed. A hyphen (-) displays for journal
volumes or external volumes.

Type The type of the resource that the MP blade controls

MP Blade Type Package type of the MP blade

Parity Groups report

The following figure shows an example of a parity groups report. The table following the
figure describes the items in the report.

Parity Groups report
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Item Description

PG Parity group number
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes (Hitachi Universal Volume Manager User
Guide).

■ If the number starts with "M" (for example, M1-1), the parity group
contains volumes for FICON DM.

Module Module number1

DKA Name of the disk adapter that controls the parity group1

RAID Level RAID level of the parity group1

Resource Group Name Name of the resource group in which the parity group belongs

Resource Group ID ID for the resource group in which the parity group belongs

Emulation Type Emulation type of the parity group

Number of LDEVs
(Total)

The number of the logical volumes in the parity group

Number of LDEVs
(Unallocated)

The number of the logical volumes in the parity group that the host
cannot access

Total LDEV Capacity
(MB)

Capacity of the logical volumes in the parity group

Unallocated LDEV
Capacity (MB)

Capacity of the logical volumes in the parity group that the host cannot
access

Drive Type-Code The type code of the drive in the parity group.
■ The type code of the first drive in the parity group.
■ If the parity group contains external volumes, the drive type code

displays the vendor, the model, and the serial number of the storage
system.

■ A hyphen (-) displays if the parity group contains volumes for FICON
DM.

Drive Type/RPM Drive type and revolutions-per-minute (RPM) of the drive in the parity
group1

A hyphen (-) is displayed instead of the RPM when the drive is an SSD.

Drive Capacity Capacity of the drive in the parity group1

RAID Concatenation #0 The number indicating a parity group #0 connected to this parity
group1,2

Parity Groups report
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Item Description

RAID Concatenation #1 The number indicating a parity group #1 connected to this parity
group1,2

RAID Concatenation #2 The number indicating a parity group #1,2 connected to this parity
group1,2

Encryption Indicates whether the parity group is encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: A hyphen (-) is displayed

Accelerated
Compression

Accelerated compression of the parity group
■ If accelerated compression is supported, Enabled or Disabled is

displayed.
■ If accelerated compression is not supported, a hyphen (-) is

displayed.

Automatically manage
compressed space of
FMD parity group

Indicates whether to manage the compressed area of the FMD parity
group automatically.
■ When accelerated compression is supported, Enabled (the area is

managed automatically) or Disabled (the area is not managed
automatically) is displayed.

■ If accelerated compression is not supported, a hyphen (-) is
displayed.

Notes:

1. A hyphen is displayed if the parity group contains external volumes or FICON DM volumes.
2. A hyphen is displayed if the parity group is not connected with another parity group or if the

parity group contains external volumes including volumes for FICON DM.

Parity Groups report
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Ports report

The following figure shows an example of part of a ports report. The actual report
includes several more columns of information. The table following the figure describes
the items in the report.

Item Description

CHA Name of the channel adapter (also called a front-end director)

Type Package type of the channel adapter

Port Location Name of the port on the channel adapter

Port Attribute Attribute of the port

TCP Port Number Port number to use for a socket (decimal)

Internal WWN / Internal
iSCSI Name

WWN / iSCSI name of the port

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch1

Connection Type One of the Fibre topology settings1

■ Point to Point
■ FC-AL

Ports report
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Item Description

IPv4 : IP Address IPv4 address of the port

Output example: 192.168.0.100

IPv4 : Subnet Mask IPv4 subnet mask of the port

Output example: 255.255.255.0

IPv4 : Default Gateway IPv4 default gateway of the port

Output example: 255.255.255.0

IPv6 : Mode IPv6 settings of the port
■ Enabled
■ Disabled

IPv6 : Link Local
Address

IPv6 link local address of the port (16-digit hexadecimal)

IPv6 : Global Address IPv6 global address of the port.

Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

IPv6 : Global Address 2 IPv6 global address 2 of the port.

Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

IPv6 : Assigned Default
Gateway

Assigned IPv6 default gateway

Selective ACK Selective ACK mode
■ Enabled
■ Disabled

Ethernet MTU Size
(Byte)

MTU settings (binary)
■ 1,500

Keep Alive Timer iSCSI keep alive timer (0 to 64,800) (sec)

VLAN : Tagging Mode Tagging mode of VLAN
■ Enabled
■ Disabled

VLAN : ID Number of VLAN set to the port (1 to 4,094)

CHAP User Name User name for the CHAP authentication

iSNS Server : Mode iSNS mode settings
■ ON
■ OFF

Ports report
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Item Description

iSNS Server : IP Address IP address of the iSNS server (30 to 65,535)

iSNS Server : TCP Port
Number

Number of the TCP port used in iSNS (binary)

Address (Loop ID) Fibre port address and Loop ID of the port1

Port Security Security of the port1

■ Enabled
■ Disabled

Speed Data transfer speed of the port1

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if the port type is a Fibre port other than 16FC2(CHB). For iSCSI

ports, a hyphen (-) is displayed.

Resource Group Name Name of the resource group to which the port belongs

Resource Group ID ID for the resource group to which the port belongs (0 to 1023)

Number of Hosts The number of the hosts registered to the port1

Number of LUNs The number of the LU paths defined to the port1

Number of LDEVs The number of the logical volumes that can be accessed through the
port1

Number of PGs The number of the parity groups having the logical volumes that can be
accessed through the port1

Number of DKAs The number of the disk adapters controlling the parity group that
contains the logical volumes that can be accessed through the port1

Notes:

1. For ports in a mainframe system, a hyphen is displayed.

Power Consumption report

The following figure shows an example of a power consumption report. A record is
created every two hours for each power consumption and temperature monitoring data.
The table following the figure describes the items in the report.

No records are created during a system power failure or if the breakers are turned off. If
the system is in maintenance mode or the SVP is rebooted, up to two hours of records
could be lost.

Power Consumption report
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If a failure occurs in the storage system, the correct information might not be output.

Item Description

Date and Time Date and time when power consumption
and temperature were recorded for the
two-hour period

Power Consumption Average (W) Average of the power consumption

Power Consumption Maximum (W) Maximum of the power consumption

Power Consumption Minimum (W) Minimum of the power consumption

TEMP:DKC0-Cluster1 Average (degrees C) Average temperature of DKC0:CL1

TEMP:DKC0-Cluster1 Maximum (degrees
C)

Maximum temperature of DKC0:CL1

TEMP:DKC0-Cluster1 Minimum (degrees
C)

Minimum temperature of DKC0:CL1

TEMP:DKC0-Cluster2 Average (degrees C) Average temperature of DKC0:CL2

TEMP:DKC0-Cluster2 Maximum (degrees
C)

Maximum temperature of DKC0:CL2

TEMP:DKC0-Cluster2 Minimum (degrees
C)

Minimum temperature of DKC0:CL2

TEMP:DKC1-Cluster1 Average (degrees C) Average temperature of DKC1:CL1

TEMP:DKC1-Cluster1 Maximum (degrees
C)

Maximum temperature of DKC1:CL1

TEMP:DKC1-Cluster1 Minimum (degrees
C)

Minimum temperature of DKC1:CL1

TEMP:DKC1-Cluster2 Average (degrees C) Average temperature of DKC1:CL2

Power Consumption report
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Item Description

TEMP:DKC1-Cluster2 Maximum (degrees
C)

Maximum temperature of DKC1:CL2

TEMP:DKC1-Cluster2 Minimum (degrees
C)

Minimum temperature of DKC1:CL2

Table 4 Power Consumption report for DKU00

Item Description

Date and Time Date and time when temperature was
recorded

TEMP:DKU00-DKUPS000-1 Average
(Temperature in degrees C) ,

TEMP:DKU00-DKUPS000-1 Maximum
(Temperature in degrees C) ,

TEMP:DKU00-DKUPS000-1 Minimum
(Temperature in degrees C) ,

… ,TEMP:DKU00-DKUPS007-2 Average
(Temperature in degrees C) ,

TEMP:DKU00-DKUPS007-2 Maximum
(Temperature in degrees C) ,

TEMP:DKU00-DKUPS007-2 Minimum
(Temperature in degrees C)

Average temperature, maximum
temperature, and minimum temperature
of the DKU for the two-hour period.
Outputs in the following format:

TEMP:DKUXY-DKUPSXYZ-CL Average,
Maximum, or Minimum (Temperature in
degrees Celsius)

・ X: Module number (0, 1)

・ Y: DKU number (0 to 5)

・ Z: HDU number (0 to 7)

・CL: Cluster number (1, 2)

Spare Drives report

The following figure shows an example of a spare drives report. The table following the
figure describes the items in the report.

Spare Drives report
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Item Description

Drive Capacity Capacity of the spare drive

Drive Type-Code Type code of the spare drive

Location Location of the spare drive

SSD Endurance report

The following figure shows an example of an SSD endurance report. The table following
the figure describes the items in the report.

SSD Endurance report
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Item Description

Drive Type-Code Type code of the SSD

Drive Capacity Capacity of the SSD

Location Location of the SSD

Used Endurance
Indicator (%)

Used endurance of the SSD

Storage System Summary report

The following illustration shows an example of part of a report of a summary of the
storage system. The actual report includes several more rows of information. The table
following the illustration describes the items in the report.

Storage System Summary report
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Item Description

Storage System Type Type of the storage system.

Serial Number Serial number of the storage system.

IP Address IP address of the SVP.

Microcode Versions Version of the following programs.
■ Main
■ HTP
■ FHTP
■ FCHF
■ FOEF
■ ISCF

Storage System Summary report
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Item Description

■ DKAF
■ SVP
■ SSVP
■ FCDG
■ FFCDG
■ CUDG4
■ ROM BOOT
■ RAM BOOT
■ CMBK
■ BTCL
■ Expander
■ Expander(FMU)
■ Config
■ CFM
■ HDD
■ HDD (SVP)
■ Printout Tool

Number of CUs The number of control units in the storage system

Shared Memory Size
(GB)

Shared memory capacity

Includes the cache management information (directory)

Cache Size (GB) Cache capacity

Number of DKAs The number of disk adapters on the module

System Options List of the system options specified for the storage system

Drive Capacity (TB) Total capacity of drives in the storage system except for external
volumes

Spare Drive Capacity
(TB)

Total capacity of the spare drives in the storage system

OPEN Volume Capacity
(GB) 1

List of the capacity of the open volumes

M/F Volume Capacity
(GB) 1

The list of the capacity of the mainframe volumes and multi-platform
volumes

Storage System Summary report
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Item Description

Number of LDEVs1 List of the numbers of the volumes in the following status.
■ allocated
■ unallocated
■ reserved
■ free

The list for open-systems and the list for mainframe-systems are
separate.

Notes:

1. You cannot sort this list.

Report examples: graphical view

Some Device Manager - Storage Navigator reports appear in graphical format.

The reports described in this topic display as graphics.  icons are displayed before the
names of reports in graphical view. If the icons or graphics are not displayed properly,
update the window.

Cache Memories report

This report shows cache memory data, including shared memory capacity, PCB cache,
and DIMM cache.

Report examples: graphical view
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Channel Adapters report

This report shows the channel adapters (also called front-end directors) and the ports,
and also indicates the type of channel adapter for each port. The keys (green = installed,
gray= not installed) show which channel adapters are installed and which are not
installed.

Physical View report

This report shows disk controllers and disk units, and includes cache PCBs, MP blades,
channel adapters (also called front-end directors), disk adapters (also called back-end
directors), data drives, and spare drives.

The report also shows the storage system type, serial number, and microcode version.
You can also check the legend for disk units, such as SAS, SSD, Spare, or Not Installed.

Channel Adapters report
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Report examples: CSV files

Some Device Manager - Storage Navigator reports appear in CSV format.

This topic describes reports that are saved in CSV format.

AllConf.csv

This is the concatenated file of all the csv files.

CacheInfo.csv

This CSV file contains information about cache packages. A record is created for each
cache package.

Report examples: CSV files
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Table 5 CacheInfo.csv file (Title: <<Cache>>)

Item Content

Module# Module number

Cache Location Name of cache package

CM DIMM Size (GB) Capacity of one CM DIM in cache package (in GB)

Cache Size (GB) Total cache capacity of this package (in GB)

SM Size (GB) Shared memory capacity (in GB). Includes the cache management
information (directory). Output only when Cache Location is CACHE-1CA
or CACHE-2CA. Blank displays in other cases.

Cache Residency Size
(MB)

Capacity allocated to the cache package for Cache Residency Manager
(in MB). Output only when Cache Location is CACHE-1CA or CACHE-2CA.
Blank displays in other cases.

CFM Size (GB) Backup package CFM capacity (in GB)

ChapUserInfo.csv

This CSV file contains information about the iSCSI CHAP authenticated user registered to
the port in the channel adapter. A record is created for each target related to the CHAP
authenticated user.

Item Content

Port Port name

User Name Name of the CHAP authenticated user1

iSCSI Target ID2 The iSCSI number of the target (00 to fe, hexadecimal)

Notes:

1. If the character string contains a comma, the comma is converted to a tab.
2. For the target information, see the record information with the same iSCSI target ID in

IscsiTargetInfo.csv.

ChaStatus.csv

This CSV file contains information about the status of each channel adapter (CHA). A
record is created for each CHA.

ChapUserInfo.csv
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Table 6 ChaStatus.csv file (Title: <<Cha Status>>)

Item Content

Module# Module number

CHA Location CHA name

PCB Status Status of this CHA1

Port#00, #01, …, #07 Status of ports on this CHA2

DRR#00, #01 Status of DRR on this CHA2

DMA#00, #01, …, #03 Status of DMA on this CHA2

MFDMA#00 Status of MFDMA#00 on this CHA1

*1 Normal, 0: Abnormal

DcrInfo.csv

This CSV file contains information about Cache Residency Manager. A record is created
for each logical volume for which Cache Residency Manager is set.

Table 7 DcrInfo.csv file (Title: <<DCR Information>>)

Item Content

HDEV# ID of the logical volume for which Cache Residency Manager is set. "No
Install BIND/PRIO Extent" displays if Cache Residency Manage is not set.

Type Cache Residency Manager type.
■ BIND
■ PRIO

From Start slot for Cache Residency Manager.

To End slot for Cache Residency Manager

PreStaging Request Information about whether data is the target of prestaging or not.
■ On
■ Off

DeviceEquipInfo.csv

This CSV file contains information about equipment and devices that are part of the
storage system, including power supplies and batteries for DKC, DKU, and SVP. A record
is created for each device.

DcrInfo.csv
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Item Content

Module# Module number

Device Location Device location name. For example:
■ For DKCPS: DKCPS-00
■ For DKUPS: DKUPS000-1
■ For Battery: BATTERY-1BA
■ For SVP: SVP-BASIC

Equip Status Equipment status of the device:
■ Equipped
■ Not Equipped

Status Status of the device:
■ Normal
■ Abnormal
■ Blank if "Equip Status" is Not Equipped

DkaInfo.csv

This CSV file contains information about disk adapters (DKAs). A record is created for
each DKA.

Table 8 DkaInfo.csv file (Title: <<DKA Information>>)

Item Content

Module # Module number

DKA Location DKA name

Package Type DKA type

Example:
■ DKA (4Port)

DkaStatus.csv

This CSV file contains information about the status of disk adapters (DKAs). A record is
created for each DKA.

DkaInfo.csv
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Table 9 DkaStatus.csv file (Title: <<DKA Status>>)

Item Content

Module # Module number

DKA Location DKA name

PCB Status Status of this DKA1

BECON#00, #01 Status of BECON on this DKA2

BEPORT#0000, #0001,
…, #0103.

Status of BEPORT on this DKA.2

Items are output in the format of "BEPORT#XXYY".

XX: BE controller number (2-digit hexadecimal (00 to 01))

YY: BE port number (2-digit hexadecimal (00 to 03))

DRR#00, #01. Status of DRR on this DKA2

DMA#00, #01, …, #03 Status of DMA on this DKA2

Notes:

1. 1: Normal, 0: Abnormal
2. 1: Normal, 0: Abnormal, Blank: Not installed

DkcInfo.csv

This CSV file contains information about DKC. A record is created for each module.

When Module #1 is not installed, the record for Module #1 is not created.

Table 10 DkcInfo.csv file (Title: <<DKC Information>>)

Item Content

Storage System Type Storage system type.

Output example: VSP G1000

Serial Number # Serial product number (in the decimal format, from 1 to 99999)

IP Address IP address1

Output example: xxx.xxx.xxx.xxx (xxx is in decimal format)

Subnet Mask Subnet mask1

Output example: xxx.xxx.xxx.xxx (xxx is in decimal format)

Number of CUs Number of CUs (number in the decimal format)1

Number of DKAs Number of DKAs (number in the decimal format)2

DkcInfo.csv
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Item Content

Configuration Type Configuration type1

Output example: PCM

Module # Module number

Notes:

1. The same value is output for Module #0 and #1.
2. Different values are output for Module #0 and #1.

DkuTempInfo.csv

This CSV file contains information about DKU temperature for every two hours. A record
is DKU temperature information obtained from the environment monitor. A record
output to the first line shows the latest temperature information. Because DKU
temperature information is measured by DKUPS, items are displayed in this unit*.

DkuTempInfo.csv shows the average temperature, maximum temperature, and
minimum temperature as DKU temperature data. The total number of items is 577.

The DKU temperature data displayed in DkuTempAveInfo.csv (average temperature
only), DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv
(minimum temperature only) is the same value as the DKU temperature data for
DkuTempInfo.csv.

No reports are output if the breakers of the storage system are turned off. In addition, if
the system is in maintenance mode or the SVP is rebooted, the data which is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Table 11 DkuTempInfo.csv file (Title: <<DKU temperature Information>>)

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DKU00 DKUPS0001

Temperature average

Average temperature (°C) for the two-hour
period of DKU00 DKUPS0001

DKU00 DKUPS0001

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DKU00 DKUPS0001

DKU00 DKUPS0001

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DKU00 DKUPS0001

DkuTempInfo.csv
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Item Description

DKU15 DKUPS1572

Temperature average

Average temperature (°C) for the two-hour
period of DKU15 DKUPS1572

DKU15 DKUPS1572

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DKU15 DKUPS1572

DKU15 DKUPS1572

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DKU15 DKUPS1572

Note: An item name is displayed as DKUxx DKUPSxxy. The names are listed in ascending
order of the DKU number.

The following tables list DKUxy, DKUPSxyzc: xy values

DKU # 0 1 2 3 4 5

x 0 1 0 1 0 1

y 0 0 1 1 2 2

DKUxy DKU00 DKU10 DKU01 DKU11 DKU02 DKU12

DKUPSxyz
c

DKU00zc DKU10zc DKU01zc DKU11zc DKU02zc DKU12zc

DKU # 6 7 8 9 10 11

x 0 1 0 1 0 1

y 3 3 4 4 5 5

DKUxx DKU03 DKU13 DKU04 DKU14 DKU05 DKU15

DKUxxy DKU03zc DKU13zc DKU04zc DKU14zc DKU05zc DKU15zc

The following tables list DKUPSxyzc: zc values (where DKC# is 0 and xy is 00)

DKU # 0

z 0 0 1 1 2 2

c 1 2 1 2 1 2

DkuTempInfo.csv
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DKU # 0

DKUPSxyz
c

DKUPS00
01

DKUPS000
2

DKUPS001
1

DKUPS001
2

DKUPS00
21

DKUPS00
22

DKU # 0

z 3 3 4 4 5 5

c 1 2 1 2 1 2

DKUPSxyz
c

DKUPS00
31

DKUPS003
2

DKUPS004
1

DKUPS004
2

DKUPS005
1

DKUPS00
52

DKU # 0

z 6 6 7 7

c 1 2 1 2

DKUPSxyzc DKUPS0061 DKUPS0062 DKUPS0071 DKUPS0072

DkuTempAveInfo.csv

This CSV file contains information about DKU temperature for every two hours. A record
is DKU temperature information obtained from the environment monitor. A record
output to the first line shows the latest temperature information. Because DKU
temperature information is measured by DKUPS, items are displayed in this unit*.

DkuTempAveInfo.csv shows the average temperature as DKU temperature data. The
total number of items is 193.

The DKU temperature data displayed in DkuTempAveInfo.csv (average temperature
only), DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv
(minimum temperature only) is the same value as the DKU temperature data for
DkuTempInfo.csv.

No reports are output if the breakers of the storage system are turned off. In addition, if
the system is in maintenance mode or the SVP is rebooted, the data which is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

DkuTempAveInfo.csv
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Table 12 DkuTempAveInfo.csv file (Title: <<DKU temperature average value
Information>>)

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DKU00 DKUPS0001

Temperature average

Average temperature (°C) for the two-hour
period of DKU00 DKUPS0001

DKU15 DKUPS1572

Temperature average

Average temperature (°C) for the two-hour
period of DKU15 DKUPS1572

*Note: An item name is displayed as DKUxx DKUPSxxy. The names are listed in
ascending order of the DKU number.

DkuTempMaxInfo.csv

This CSV file contains information about DKU temperature for every two hours. A record
is DKU temperature information obtained from the environment monitor. A record
output to the first line shows the latest temperature information. Because DKU
temperature information is measured by DKUPS, items are displayed in this unit*.

DkuTempMaxInfo.csv shows the maximum temperature as DKU temperature data. The
total number of items is 193.

The DKU temperature data displayed in DkuTempAveInfo.csv (average temperature
only), DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv
(minimum temperature only) is the same value as the DKU temperature data for
DkuTempInfo.csv.

No reports are output if the breakers of the storage system are turned off. In addition, if
the system is in maintenance mode or the SVP is rebooted, the data which is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Table 13 DkuTempMaxInfo.csv file (Title: <<DKU temperature maximum value
Information>>)

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DKU00 DKUPS0001

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DKU00 DKUPS0001

DkuTempMaxInfo.csv
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Item Description

DKU15 DKUPS1572

Temperature maximum value

Maximum temperature (°C) for the two-
hour period of DKU15 DKUPS1572

*Note: An item name is displayed as DKUxx DKUPSxxy. The names are listed in
ascending order of the DKU number.

DkuTempMinInfo.csv

This CSV file contains information about DKU temperature for every two hours. A record
is DKU temperature information obtained from the environment monitor. A record
output to the first line shows the latest temperature information. Because DKU
temperature information is measured by DKUPS, items are displayed in this unit*.

DkuTempMinInfo.csv shows the minimum temperature as DKU temperature data. The
total number of items is 193.

The DKU temperature data displayed in DkuTempAveInfo.csv (average temperature
only), DkuTempMaxInfo.csv (maximum temperature only), and DkuTempMinInfo.csv
(minimum temperature only) is the same value as the DKU temperature data for
DkuTempInfo.csv.

No reports are output if the breakers of the storage system are turned off. In addition, if
the system is in maintenance mode or the SVP is rebooted, the data which is output
every two hours might not contain data for the period. If a failure occurs in the storage
system, the correct information might not be output.

Table 14 DkuTempMinInfo.csv file (Title: <<DKU temperature minimum value
Information>>)

Item Description

Date Year, month, and date when temperature
data was acquired in the format:

YYYY/MM/DD hh:mm:ss

DKU00 DKUPS0001

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DKU00 DKUPS0001

DKU15 DKUPS1572

Temperature minimum value

Minimum temperature (°C) for the two-
hour period of DKU15 DKUPS1572

*Note: An item name is displayed as DKUxx DKUPSxxy. The names are listed in
ascending order of the DKU number.

DkuTempMinInfo.csv
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ELunInfo.csv

This CSV file contains information about external volumes. Information about one
external volume is output to multiple records according to the number of prioritized
paths between the local and the external storage systems.

For details of external volumes, see Hitachi Universal Volume Manager User Guide.

Item Content

VDEV# Virtual device number to which the external volume is mapped

Characteristic1 Identification number of the external volume1

Characteristic2 Extended information for identifying the external volume

Device Product name reported to the host by the external volume1

Capacity(blocks) Capacity of the external volume (in blocks)

Cache Mode Indicates whether the write data from the host to the external storage
system is reflected synchronously or asynchronously
■ Enabled: Asynchronously
■ Disabled: Synchronously

ECC Group Number of parity group to which the external volume is mapped.

If the number starts with "E" (for example, E1-1), the parity group
contains external volumes.

Current MP Blade Number and name of a current MP blade controlling the parity group to
which the external volume is mapped

Setting MP Blade Number and name of an MP blade configured to control the external
volume indicated by ECC Group

Vendor Vendor name of the external storage system

Product Name Product name of the external storage system

Serial Number# Serial product number of the external storage system

Path Mode Mode which indicates how the paths between local and external storage
systems operate
■ Multi
■ Single
■ ALUA

Port Name of a local port from which the external path is connected to the
external storage system

WWN Port identifier number of the external storage system

ELunInfo.csv
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Item Content

If "Package Type" is iSCSI, a blank space is displayed.

LUN LU number set for the external volume.

Priority Priority of the paths between the storage systems to be used for
connection with the external volume.

"1" indicates the path of the highest priority.

Status Status of the path between storage systems.
■ Normal
■ Blocked

IO TOV I/O timeout value for the external volume

QDepth The number of Read/Write commands that can be issued to the external
volume at a time

Resource Group ID (ECC
Group)

Resource group ID for the parity group that is mapping external
volumes (in hexadecimal format)

Resource Group Name
(ECC Group)

Resource group name of the parity group that is mapping external
volumes

Load Balance Mode I/O load balance distribution logic specified for external volume
■ Normal Round-robin
■ Extended Round-robin
■ Disabled

A hyphen is displayed if Single is specified in Path Mode

Path Mode on Profile Path mode on profile information of the external storage system:
■ Multi
■ Single

ALUA Settable Indicates whether ALUA mode can be set as path mode on the external
storage system
■ Yes: ALUA mode can be set
■ No: ALUA mode cannot be set

ALUA Permitted Indicates whether ALUA is used as path mode on the local storage
system:
■ Enabled: ALUA mode is used
■ Disabled: ALUA mode is not used

ELunInfo.csv
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Item Content

Target Port Asymmetric
Access State

Status of the port on the external storage system when the path mode
is ALUA:
■ Active/Optimized
■ Active/Non-Optimized

Package Type Type of CHA to which a port of the local storage system connecting to
the external storage system belongs
■ Fibre: 16FC8(Fibre ), 8FC16(Fibre ), 16FC16(Fibre )
■ FCoE: 16FE10(FCoE)
■ iSCSI: 8IS10(iSCSI)

IP Address IP address for an iSCSI target of an external storage system
■ IPv6:

(XXXX:XXXX:XXXX:XXXX:XXXX:XXXX:XXXX:XXXX)

XX: 00 to FF (hexadecimal)
■ IPv4:

(XXX.XXX.XXX.XXX)

XXX: 0 to 255 (decimal)

TCP Port Number TCP port number (1 through 65535) for the iSCSI target of an external
storage system

iSCSI Target Name iSCSI target name of an external storage system

Notes:

1. If the character string contains a comma, the comma is converted to a tab.

EnvMonInfo.csv

This CSV file contains information about the power and temperature of the storage
system. Power and temperature measurements from the environment monitor are
recorded every two hours.

No records are created during a system power failure or if the breakers are turned off. If
the system is in maintenance mode or the SVP is rebooted, up to two hours of records
could be lost.

If a failure occurs in the storage system, the correct information might not be output.

Item Description

Date Year, month, and date when record data was acquired for the two-hour
period in the format:

EnvMonInfo.csv
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Item Description

YYYY/MM/DD HH:MM:SS

Electric power average Average value of electric power (W)

Electric power
maximum value

Maximum value of electric power (W)

Electric power
minimum value

Minimum value of electric power (W)

In the following cases, a lower value might be temporarily displayed:
■ When the storage system is starting up
■ Right after replacing storage system parts
■ During or after microcode update

DKC0 CL1 Temperature
average

DKC0: Average temperature of CL1 (°C)

DKC0 CL1 Temperature
maximum value

DKC0: Maximum temperature of CL1 (°C)

DKC0 CL1 Temperature
minimum value

DKC0: Minimum temperature of CL1 (°C)

DKC0 CL2 Temperature
average

DKC0: Average temperature of CL2 (°C)

DKC0 CL2 Temperature
maximum value

DKC0: Maximum temperature of CL2 (°C)

DKC0 CL2 Temperature
minimum value

DKC0: Minimum temperature of CL2 (°C)

DKC1 CL1 Temperature
average

DKC1: Average temperature of CL1 (°C)

DKC1 CL1 Temperature
maximum value

DKC1: Maximum temperature of CL1 (°C)

DKC1 CL1 Temperature
minimum value

DKC1: Minimum temperature of CL1 (°C)

DKC1 CL2 Temperature
average

DKC1: Average temperature of CL2 (°C)

DKC1 CL2 Temperature
maximum value

DKC1: Maximum temperature of CL2 (°C)

DKC1 CL2 Temperature
minimum value

DKC1: Minimum temperature of CL2 (°C)

EnvMonInfo.csv
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FcSpNameInfo.csv

This CSV file contains information about Fibre Channel Security Protocols (FCSPs). A
record is created for each initiator (host).

For details of port setting, see the Provisioning Guide for Open Systems.

Item Content

Port Port name

Host Group Host group name

Target Username WWN information about the storage system required for authentication
(16-digit hexadecimal number)

Authentication of Group Information about whether to perform authentication or not
■ Enabled
■ Disabled

Initiator Username WWN information about the host required for authentication (16-digit
hexadecimal number)

Protocol Protocol used for authentication ("CHAP" or blank)

FcSpPortInfo.csv

This CSV file contains information about ports related to Fibre Channel Security Protocols
(FCSPs). A record is created for each port.

For details of port setting, see the Provisioning Guide for Open Systems.

Item Content

Port Port name

Time out(Sec) Time interval (in seconds) before retrying authentication in case of
failure in authentication

Refusal Intvl.(Min) Time interval (in minutes) before starting next authentication in case of
failure in authentication for the number of times displayed by "Refusal
Freq(Counts)"

Refusal Freq.(Counts) Number of times of authentication allowable for connection to a port

Switch Port Username WWN information about the Fabric switch required for authentication
(16-digit hexadecimal number)

FcSpNameInfo.csv
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Item Content

Mode Mode of authentication between ports and FC switches
■ Bidirectional
■ Unidirectional

Authentication of Fabric
Switch

Information about whether to perform authentication of the FC switch
identified by "Switch Port Username"
■ Enabled
■ Disabled

HduInfo.csv

This CSV file contains information about hard disk units (HDUs). A record is created for
each HDU.

Table 15 HduInfo.csv file (Title: <<HDU Information>>)

Item Content

Module# Module number

HDU Location HDU location name

Output example: HDU000

HDU Status Information about whether this HDU is installed or not
■ Installed
■ Not Installed

Slot Size Slot size (inches)
■ 2.5
■ 3.5
■ Blank when DKU is FBX (FMD, FMD DC2, or FMD-HDE)

DKU Type DKU type of HDU
■ SBX (DKU for 2.5-inch drive)
■ UBX (DKU for 3.5-inch drive)
■ FBX (DKU for FMD, FMD DC2, or FMD-HDE)

IscsiHostInfo.csv

This CSV file contains information about iSCSI Initiator (Host) set to the channel adapter
port. A record is created for each iSCSI Host (Initiator) target.

HduInfo.csv
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Item Content

Port Port name

iSCSI Name iSCSI host name

Host Name Nickname for iSCSI host name

iSCSI Target ID1 iSCSI target number (hexadecimal format, 00 to fe)

Notes:

1. For the target information, see the record information with the same iSCSI target ID in
IscsiTargetInfo.csv.

IscsiPortInfo.csv

This CSV file contains information about iSCSI information set to the channel adapter
port. A record is created for each iSCSI host (initiator) target.

Item Content

Port Port name

IPv4 | IP Address IPv4 address

Output example: xxx.xxx.xxx.xxx (decimal)

IPv4 | Subnet Mask IPv4 subnet mask (decimal)

Output example: xxx.xxx.xxx.xxx (decimal)

IPv4 | Default Gateway Port IPv4 default gateway

Output example: xxx.xxx.xxx.xxx (decimal)

IPv6 | Mode Port IPv6 settings
■ Enabled
■ Disabled

IPv6 | Link Local
Address

Port IPv6 link local address
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

Auto is displayed if the link local address is automatically set. Blank if
"IPv6 | Mode" is Disabled.

IPv6 | Global Address IPv6 global address of the port
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

IscsiPortInfo.csv
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Item Content

Auto is displayed if the global address is automatically set. Blank if "IPv6
| Mode" is Disabled.

IPv6 | Assigned Default
Gateway

Port IPv6 assigned default gateway
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)

Blank if "IPv6 | Mode" is Disabled.

Channel Speed Data transfer speed of the port (10 Gbps)

Security Switch Port security switch settings
■ On
■ Off

TCP Port Number The number of the port for using socket (1 to 65535)

Ethernet MTU Size
(Byte) | MTU

MTU settings
■ 1500
■ 4500
■ 9000

Keep Alive Timer (sec.) Keep alive timer value of iSCSI (30 to 64800) (sec)

Selective ACK Selective ACK mode
■ Enabled
■ Disabled

Delayed ACK Delayed ACK mode
■ Enabled
■ Disabled

Maximum Window Size
(KB)

Window scale option settings
■ 64KB
■ 128KB
■ 256KB
■ 512KB
■ 1024KB

iSNS Server | Mode iSNS mode settings
■ On
■ Off

IscsiPortInfo.csv
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Item Content

iSNS Server | IP
Address

IP address of the iSNS server
■ IPv4: xxx.xxx.xxx.xxx (decimal)
■ IPv6: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Blank if "iSNS Server | Mode" is Off.

iSNS Server | TCP Port
Number

Port number of TCP used for iSNS (1 to 65535).

Blank if "iSNS Server | Mode" is Off.

VLAN | Tagging Mode VLAN tagging mode set to the port
■ On
■ Off

VLAN | ID VLAN number set to the port (1 to 4094)

Blank if "VLAN | Tagging Mode" is set to Off.

Resource Group ID
(Port)

Resource group ID of the port (0 to 1023 in decimal)

Resource Group
Name(Port)

Resource group name of the port

iSCSI Name iSCSI name of the port

CHAP User Name Authenticated user name of the port

IPv6 | Global Address 2 IPv6 global address 2 of the port
■ Output example: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx (hexadecimal)
■ Output example: Auto

Auto is displayed if the global address 2 is automatically set. Blank if
"IPv6 | Mode" is Disabled.

IscsiTargetInfo.csv

This CSV file contains information about iSCSI target information set to the channel
adapter port. A record is created for each iSCSI target.

Item Content

Port Port name

iSCSI Target Alias iSCSI target alias

iSCSI Target ID Number of the iSCSI target (00 to fe, hexadecimal)

IscsiTargetInfo.csv
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Item Content

iSCSI Target Name Name of the iSCSI target

Host Mode Host mode set to the iSCSI target (hexadecimal)

Host Mode Option Host mode option set to the iSCSI target (0 to 127, decimal)

Separated with a semicolon (;) if multiple host mode options are set.

Security Switch Security switch status set to the iSCSI target port
■ On
■ Off

Authentication |
Method

Authentication method settings of the iSCSI target
■ CHAP
■ None
■ Comply with Host Setting

Authentication | Mutual
CHAP

Mutual CHAP authentication function settings of the iSCSI target
■ Enabled
■ Disabled

Authentication | User
Name

User name set when iSCSI target was authenticated

Resource Group ID
(iSCSI Target)

Resource group ID of the iSCSI target (0 to 1023)

Resource Group Name
(iSCSI Target)

Resource group name of the iSCSI target

JnlInfo.csv

This CSV file contains information about Journals. A record is created for each journal.

Table 16 JnlInfo.cvs file (Title: <<JNL Information>>)

Item Content

JNL# Journal number (in the hexadecimal format)

Current MP Blade Number and name of MP blade currently controlling the journal

Setting MP Blade Number and name of MP blade configured to control the journal

JnlInfo.csv
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LdevCapaInfo.csv

This CSV file contains information about LDEV capacities. A record is created for each of
the classifications shown in "Volume Kind".

Item Content

Volume Kind The following classifications are output:
■ Internal OPEN Volumes
■ Internal Mainframe Volumes
■ External OPEN Volumes
■ External Mainframe Volumes
■ Total OPEN Volumes
■ Total Mainframe Volumes

Allocated LDEV Capacity
(GB)

Allocated LDEV capacity

Unallocated LDEV
Capacity (GB)

Unallocated LDEV capacity

Reserved Capacity (GB) Reserved LDEV capacity

Total Volume Capacity
(GB)

Total capacity of "Allocated LDEV Capacity", "Unallocated LDEV Capacity"
and "Reserved Capacity"

Free Space (GB) Free Space

Total Capacity (GB) Total Capacity

The sum of "Total Volume Capacity" and "Free Space"

LdevCountInfo.csv

This CSV file contains information about the number of logical devices (LDEVs). A record
is created for each of the classifications shown in "Volume Kind".

Item Content

Volume Kind The following classifications are output:
■ Internal Volumes
■ External Volumes
■ Total Volumes

Allocated OPEN LDEVs The number of allocated open-system volumes (LDEVs).

LdevCapaInfo.csv
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Item Content

Unallocated OPEN
LDEVs

The number of unallocated open-system volumes (LDEVs).

Reserved OPEN LDEVs The number of reserved open-system volumes (LDEVs).

Allocated Mainframe
LDEVs

The number of allocated mainframe and multi-platform volumes
(LDEVs).

Reserved Mainframe
LDEVs

The number of reserved mainframe and multi-platform volumes
(LDEVs).

V-VOL The number of virtual volumes.

Output only when "Volume Kind" is Total Volumes.

Total(All LDEVs) Total number of LDEVs.

ECC Groups Total number of parity groups.

LdevInfo.csv

This CSV file contains information about logical devices (LDEVs). A record is created for
each LDEV.

For details of LDEVs, see the Provisioning Guide for Open Systems.

Table 17 Ldevinfo.csv file (Title: <<LDEV Status>>)

Item Content

ECC Group Number of parity group where the LDEV belongs.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the number starts with "M" (for example, M1-1), the parity group

contains FICON DM volumes.
■ If "LDEV Type" is Dynamic Provisioning, Thin Image, or ALU

(Administrative Logical Unit), a hyphen (-) is output.

LDEV# LDEV number

LDEV Name LDEV name1

LDEV Emulation LDEV emulation type

LDEV Type LDEV type:
■ Basic
■ Dynamic Provisioning
■ External

LdevInfo.csv
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Item Content

■ Thin Image (Thin Image virtual volume
■ ALU

LDEV Attribute LDEV Attribute:
■ CMDDEV (Command device)
■ CMDDEV* (Remote command device)
■ Journal ( Journal volume)
■ Pool (Pool volume)
■ Reserve (Reserved volume)
■ Quorum disk (Quorum Disk used with global-active device)
■ TSE (Volume for Hitachi Compatible FlashCopy®)
■ ALU
■ SLU (Subsidiary Logical Unit)
■ Deduplication system data volume
■ Regular (Others)

Volume Size(Cyl) LDEV capacity (in cylinders)

Volume Size(MB) LDEV capacity (in MB)

Volume Size(Blocks) LDEV capacity (in blocks)

CVS Information about whether the LDEV is a custom-sized volume or not:
■ On: Custom-sized volume
■ Off: Others

Pool ID Pool number. This is blank except for the following cases:
■ If "LDEV Type" is Dynamic Provisioning
■ If LDEV Attribute is Pool

RAID Concatenation#0 Number of parity group to be concatenated to parity group (#0)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

RAID Concatenation#1 Number of parity group to be concatenated to parity group (#1)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

RAID Concatenation#2 Number of parity group to be concatenated to parity group (#2)
identified by ECC Group. Blank if the parity group is not concatenated to
another parity group.

LdevInfo.csv
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Item Content

ORACLE CHECK SUM Information about whether this LDEV is Oracle check sum target or not.
■ For open-system or multi-platform volumes: On or Off
■ For other volumes: blank

Current MP Blade Number and name of MP blade currently controlling the LDEV.

Setting MP Blade Number and name of MP blade configured to control LDEV.

Allocated Information about whether this LDEV is allocated to a host or not.
■ When mainframe or multi-platform volumes, "Y" is output for all

except Reserved.
■ When open-system volumes, "Y" is output for volumes accessible to

host.

Pool Name The pool's name1

Name of the pool indicated by Pool ID

CmdDevSecurity Indicates whether Security is specified as the attribute for the command
device.

CmdDevUserAuth Indicates whether User Authentication is specified as the attribute for
the command device.

CmdDevDevGrpDef Indicates whether Device Group Definition is specified as the attribute
for the command device.

Resource Group ID
(LDEV)

LDEV resource group ID (number in the decimal format)

Resource Group Name
(LDEV)

LDEV resource group name

Encryption Indicates whether the parity group identified by ECC Group is encrypted.
■ For internal volumes: Enabled (encrypted) or Disabled (not

encrypted)
■ For external volumes: blank

ALUA Mode Indicates whether the ALUA mode is enabled:
■ Enabled
■ Disabled
■ For mainframe volumes: blank

LdevInfo.csv
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Item Content

T10 PI Indicates the T10 PI attribute set for the LDEV.
■ Enabled
■ Disabled
■ Blank if "LDEV Emulation" is not OPEN-V.

Accelerated
Compression

Indicates whether accelerated compression is enabled

For internal volumes:
■ Enabled: accelerated compression is enabled.
■ Disabled: accelerated compression is disabled.

If the parity group with LDEV does not support accelerated compression,
a blank space is displayed.

For external volumes, a blank is displayed.

Notes:

1. If the character string contains a comma, the comma is converted to a tab.

LdevStatus.csv

This CSV file contains information about the status of logical devices (LDEVs). A record is
created for each LDEV.

Item Content

VDEV# Virtual device number in which the LDEV is defined

VDEV Status VDEV status of "VDEV#"
■ 1: Normal
■ 0: Abnormal

HDEV# LDEV number

HDEV Status LDEV status
■ 1: Normal
■ 0: Abnormal

LDEV Emulation LDEV emulation type

LdevStatus.csv
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Item Content

ECC Group Number of the parity group where the LDEV belongs.
■ If the number starts with "E" (for example, E1-1), the parity group

contains external volumes.
■ If the type of the LDEV is a Dynamic Provisioning, Thin Image, or ALU

virtual volume, a hyphen is output.

Refer to "LdevInfo.csv" for information about the LDEV type.

LogPathStatus.csv

This CSV file contains information about mainframe logical paths.

Table 18 LogPathStatus.csv file (Title: <<Main Frame Logical Path Status>>)

Item Content

Module# Module number

LPN# Logical path number (in the hexadecimal format)

CHA Location CHA name

Port Port name

Link Link address of the connected host (6-digit number in the hexadecimal
format)

LGCL Logical address of the connected host (number in the hexadecimal
format)

LDKC# Number of connected LDKC (in the hexadecimal format)

CU# Number of connected CU (in the hexadecimal format)

LPartition.csv

This CSV file contains information about the cache logical partitioning function. A record
is created for each cache partition for a managed resource.

For details of the cache logical partitioning function, see Virtual Partition Manager.

Table 19 LPartition.csv file (Title: <<Logical Partitioning>>)

Item Content

CLPR# CLPR ID (in the decimal format)

CLPR Name CLPR name

LogPathStatus.csv
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Item Content

Cache Size(MB) Cache size allocated to this CLPR ID (in MB)

Cache Residency
Size(MB)

Cache Residency Manager cache size allocated to this CLPR ID (in MB)

ECC Group Number of parity group allocated to this CLPR ID.

LDEV#(V-VOL) LDEV number allocated to this CLPR ID

The type of this LDEV is Dynamic Provisioning, Thin Image, or ALU.

LunInfo.csv

This CSV file contains information about LU path definitions. A record is created for each
LU path definition. For details about LU path definitions, see the Provisioning Guide for
Open Systems. For information about iSCSI targets, see IscsiTargetInfo.csv.

Item Description

Port Port name

Host Group Host group name

If "Package Type" is iSCSI, the iSCSI target alias is output.

Host Mode Host mode specified for this host group (hexadecimal)

Host Mode Option Host mode option set for this host group (number in the decimal
format)

If more than one option is specified, the options are separated by
semicolons (;).

LUN# LUN number for this LU path definition (hexadecimal)

LDEV# LDEV number for this LU path definition

Command Device Information about whether the LDEV is a command device:
■ On: Command Device
■ On*: Remote Command Device
■ Off: Others

Command Security Information about whether the command device is secured:
■ On
■ Off

LunInfo.csv
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Item Description

CVS Information about whether the LDEV is a custom-sized volume:
■ On: Customized volume
■ Off: Other volumes

CHA Location Name of the CHA on which this port is installed

Package Type CHA type for CHA Location:
■ Fibre:

● 16FC8 (Fibre )
● 8FC16 (Fibre )
● 16FC16 (Fibre)

■ FCoE:
● 16FE10 (FCoE )

■ iSCSI:
● 8IS10 (iSCSI)

Resource Group ID
(Host Group)

Resource group ID of a host group (0 to 1,023, decimal)

Resource Group Name
(Host Group)

Resource group name of a host group

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port for which
the LU path is defined.
■ Enabled
■ Disabled
■ Blank if "Package Type" is "8FC16(Fibre )" or "16FC16(Fibre)"

T10 PI Information about the T10 PI attribute which is set for the LDEV number
of the LU path definition.
■ Enabled
■ Disabled
■ Blank if LDEV# is blank

Asymmetric Access
State

Asymmetric access status (output only for an open system CHA that is
Fibre or FCoE)

Indicates the asymmetric access status:
■ Active/Optimized: Prioritized
■ Active/Non-Optimized: Lower priority

Blank if "Package Type" is iSCSI

LunInfo.csv
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LunPortInfo.csv

This CSV file contains information about LU path definition. A record is created for each
port.

For details of LU path definition, see the Provisioning Guide for Open Systems. For
information about iSCSI ports, see IscsiPortInfo.csv.

Item Content

Port Port name.

Security Switch The setting status of the security switch:
■ On
■ Off

Port Address Port address (2-digit hexadecimal number) 00 to ff

Blank if "Package Type" is iSCSI

Loop ID Port address (0 - 125, decimal)

Blank if "Package Type" is iSCSI

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch:
■ On
■ Off
■ Blank if "Package Type" is iSCSI

Connection One of the Fibre topology settings:
■ Point to Point
■ FC-AL
■ Blank if "Package Type" is iSCSI

Channel Speed Channel Speed of this port
■ 2 Gbps
■ 4 Gbps
■ 8 Gbps
■ 10 Gbps
■ 16 Gbps
■ 32 Gbps
■ Auto

WWN WWN of this port (hexadecimal number)

Blank if "Package Type" is iSCSI

LunPortInfo.csv
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Item Content

CHA Location CHA on which the port is installed.

Package Type CHA type for CHA Location
■ Fibre:

● 16FC8 (Fibre )
● 8FC16 (Fibre )
● 16FC16 (Fibre)

■ FCoE:
● 16FE10 (FCoE )

■ iSCSI:
● 8IS10 (iSCSI)

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is "8FC16(Fibre )" or "16FC16(Fibre)"

MfDMInfo.csv

This CSV file contains information about migration volumes for mainframe. A record is
created for each migration volume.

Table 20 MfDMInfo.csv file (Title: <<M/F DM Information>>)

Item Content

Migration Volume
Group

Number of the migration volume

The number starts with "M" (for example, M1-1)

Current MP Blade Number and name of the MP Blade that is controlling the migration
volume

Setting MP Blade Number and name of the MP Blade specified to control the migration
volume

Resource Group ID (ECC
Group)

Resource group ID of migration volume (number in the decimal format)

Resource Group Name
(ECC Group)

Resource group name of migration volume

MfDMInfo.csv
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MicroVersion.csv

This CSV file contains information about microcode versions.

Table 21 MicroVersion.csv file (Title: <<Micro Version>>)

Item Content

DKCMAIN The version of the microcode for the RAID storage system (10 digits)

HTP HTP microcode version (6 digits)

DKAF DKAF microcode version (6 digits)

SVP The version of the microcode installed on the service processor (8 digits)

SSVP SSVP microcode version (6 digits)

FCDG FCDG microcode version (6 digits)

CUDG4 CUDG4 microcode version (6 digits)

ROM BOOT ROM BOOT microcode version (6 digits)

RAM BOOT RAM BOOT microcode version (6 digits)

CMBK CMBK microcode version (6 digits)

Config Config microcode version (8 digits)

HDD HDD microcode version (4 digits) HDD version in the format of "(HDD
device type - code):(version)." If an HDD drive is not installed, only a
colon (:) is displayed.

HDD (SVP) HDD(SVP) microcode version (4 digits)

Expander Expander microcode version (6 digits)

CFM CFM microcode version (8 digits)

Printout Tool Printout tool version

Expander(FMU) FMU Expander version (6 digits)

FCHF FCHF version (6 digits)

BTCL BTCL version (6 digits)

FOEF FOEF version (6 digits)

FHTP FHTP version (6 digits)

FFCDG FFCDG version (6 digits)

ISCF ISCF version (6 digits)

MicroVersion.csv
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MlcEnduranceInfo.csv

This CSV file contains information about endurance information of SSD or FMD. A record
is created for each SSD or FMD endurance information.

If you change the SVP time 1 month or more, the history acquisition months will not be
in order.

Item Content

ECC Group Number of parity group of which this SSD or FMD is a component

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format of "XX/YY"

XX: C#

YY: R#

Device Type-Code Drive type code of this drive

Output example: SLR5B-M200SS

Used Endurance
Indicator (%)

Current SSD life (0 to 100)

History1 (date) Date on which SSD life was acquired (1 month ago)

Output example: yyyy/mm/dd

History1 (%) SSD life (0 to 100)(1 month ago)

History2 (date) Date on which SSD life was acquired (2 months ago)

Output example: yyyy/mm/dd

History2 (%) SSD life (0 to 100) (2 months ago)

History3 (%) ... History
119 (%)

SSD life (0 to 100) (3 months ago ...119 months ago)

History120 (date) Date on which SSD life was acquired (120 months ago)

History120 (%) SSD life (0 to 100) (120 months ago)

ModePerLpr.csv

This CSV file contains information about system option modes. A record is created for
each system option mode.

Item Content

System Option Mode# System option mode # (decimal number)

MlcEnduranceInfo.csv
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Item Content

LPR#0, LPR#1, …,
LPR#31

System option mode for LPR#0 to LPR#31
■ If the system option mode is on:

On
■ If the system option mode is not on:

Blank

MpPathStatus.csv

This CSV file contains information about the status of logical paths. A record is created
for each MP blade or LR.

Table 22 MpPathStatus.csv file (Title: <<MP Path Status>>)

Item Content

Module# Module number.

MPB#/LR# MP blade number or LR number
■ For MP blade number

MPB#00 to MPB#0f
■ For LR number

LR#00 to LR#1f

MPB#00-00, ...,
MPB#00-0f,

MPB#01-00, ...,
MPB#01-0f,

MPB#02-00, ...,
MPB#02-0f,

MPB#03-00, ...,
MPB#03-0f

MP blade path status for MP blade number in the format of "MPB#XX-
YY". 1

XX: MSW number in one module (2-digit number in the hexadecimal
format)

YY: MP blade number (2-digit number in the hexadecimal format)

LR#00-00, ..., LR#00-1f,

LR#01-00, ..., LR#01-1f,

LR#02-00, ..., LR#02-1f,

LR#03-00, ..., LR#03-1f

LR path status for MP blade number in the format of "LR#XX-YY".1

XX: MSW number in one module (2-digit number in the hexadecimal
format)

YY: LR number (2-digit number in the hexadecimal format)

CACHE#00-00,
CACHE#00-07,

Cache package path status for MP blade number in the format of
"CACHE#XX-YY".1

XX: E path number (2-digit number in the hexadecimal format)

MpPathStatus.csv
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Item Content

CACHE#01-00,
CACHE#01-07

YY: Cache package number (2-digit number in the hexadecimal format)

CACHE#00-00,
CACHE#00-07,

CACHE#01-00,
CACHE#01-07

Cache package path status for LR number in the format of "CACHE#XX-
YY".1

XX: P path number (2-digit number in the hexadecimal format)

YY: Cache package number (2-digit number in the hexadecimal format)

Notes:

1. 1=Normal, 0=Abnormal

MpPcbStatus.csv

This CSV file contains information about the status of MP Blades. A record is created for
each MP blade.

Table 23 MpPcbStatus.csv file (Title: <<MP PCB Status>>)

Item Content

Module# Module number

MP PCB Location MP blade name

MP PCB ID MP blade ID

Auto Assignment Information about whether this MP blade is set to be automatically
assigned to each resource or not
■ Enabled

Set to be automatically assigned
■ Disabled

Not set to be automatically assigned

PCB Status MP blade status1

MP#00, #01, #02..., #07 MP status on MP blades #0 to #071

MP PCB Type MP blade type

Output example: MPB1 or MPB2

Notes:

1. 1=Normal, 0=Abnormal

MpPcbStatus.csv
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PcbRevInfo.csv

This CSV file contains information about revisions of packages such as channel adapters
(CHAs) and others. A record is created for each package.

Table 24 PcbRevInfo.csv file (Title: <<PCB Revision Information>>)

Item Content

Module# Module number

Cluster# Cluster number

Location Package name

Output example:
■ For CHA: CHA-1PC
■ For port: 1A

Name Product name of the package or some other name

PK Revision Revision of the package

Factory Factory manufacturing the package

Number Serial number of the package

MAC Address MAC address of the package

PdevCapaInfo.csv

This CSV file contains information about physical device (PDEV) capacities. A record is
created for each of the classifications shown in "PDEV Kind".

Item Content

PDEV Kind The following four classifications are output:
■ OPEN System (TB)
■ Mainframe System (TB)
■ Total Capacity (TB)
■ Number of PDEVs

SAS Drive SAS drive capacity (TB)

Spare Drive Spare drive capacity (TB)

SSD Drive SSD capacity (TB)

PcbRevInfo.csv
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PdevInfo.csv

This CSV file contains information about physical devices (PDEVs). A record is created for
each PDEV.

Item Content

ECC Group Number of parity group of which this PDEV is a component.
■ Spare Drive: For spare drives

Emulation Type Emulation type for the parity group indicated by "ECC Group"
■ Blank: "ECC Group" is Spare Drive.

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

PDEV Location PDEV location name

Module # Module number

Device Type Drive type
■ SAS
■ SSD

RPM Revolutions per minute

Blank displays as RPM when the drive is SSD.

Device Type-Code Device type code of this drive

Output example: DKR5D-J600SS

Device Size Drive size (inches)
■ 2.5
■ 3.5
■ Blank when DKU is FBX (FMC or FMD)

Device Capacity Drive capacity (GB or TB)

Drive Version Drive firmware version (4-digit hexadecimal number)

DKA1 Name of the DKA (1) controlling the PDEV

DKA2 Name of the DKA (2) controlling the PDEV

Serial Number # Serial number of this drive

RAID Level RAID level of the parity group indicated by "ECC Group"

PdevInfo.csv
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Item Content

Blank if the "ECC Group" is Spare Drive

RAID Concatenation #0 Number of parity group to be concatenated to parity group (#0)
identified by "ECC Group"1

RAID Concatenation #1 Number of parity group to be concatenated to parity group (#1)
identified by "ECC Group"1

RAID Concatenation #2 Number of parity group to be concatenated to parity group (#2)
identified by "ECC Group"1

Resource Group ID (ECC
Group)

Resource group ID of parity group (decimal number)

Resource Group Name
(ECC Group)

Resource group name of parity group

Encryption Encryption status of the parity group to which the PDEV belongs
■ Enabled: Encryption enabled
■ Disabled: Encryption disabled

Accelerated
Compression

Accelerated compression setting.
■ Enabled: accelerated compression is enabled.
■ Disabled: accelerated compression is disabled.

If the parity group with PDEV does not support accelerated
compression, or if the ECC Group is Spare Drive, a blank space is
displayed.

Automatically manage
compressed space of
FMD parity group

Indicates whether to manage the compressed area of the FMD parity
group automatically.2

■ Enabled: The area is managed automatically.
■ Disabled: The area is not managed automatically.

Notes:

1. Blank if the parity group is not concatenated to another parity group or is Spare Drive.
2. Blank if the parity group to which PDEV belongs does not support accelerated compression.

PdevStatus.csv

This CSV file contains information about the status of physical devices (PDEVs). A record
is created for each PDEV.

PdevStatus.csv
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Item Content

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

Pdev Status PDEV status1

Port0 Status Status of Port 0 on this PDEV1

Port1 Status Status of Port 1 on this PDEV1

Pdev Location Location name of this PDEV

Notes:

1. 1=Normal, 0=Abnormal

PhyPathStatus.csv

This CSV file contains information about mainframe physical paths.

Table 25 PhyPathStatus.csv file (Title: <<Main Frame Physical Path Status>>)

Item Content

Module# Module number

CHA Location CHA name

Port Port name

Link(Self) DKC port address (6-digit number in the hexadecimal format)

Link(Dest) Link address of the adjacent node (6-digit number in the hexadecimal
format)

Status Information about whether the adjacent node is enabled:
■ VALID (CUR)
■ INVALID

Type/Model Type of the adjacent node (6-digit number in the hexadecimal format)
and model name of the adjacent node (3-digit number in the
hexadecimal format)

SeqNumber Serial product number of the adjacent node (14-digit number in the
hexadecimal format)

PhyPathStatus.csv
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Item Content

Tag Tag information of the adjacent node (4-digit number in the
hexadecimal format)

WWN(N_Port_Name) N_Port_Name of the adjacent node (16-digit number in the hexadecimal
format)

WWN(Node_Name) Node_Name of the adjacent node (16-digit number in the hexadecimal
format)

Speed Data transfer speed:
■ 2 Gbps
■ 4 Gbps
■ 8 Gbps

PkInfo.csv

This CSV file contains information about channel adapters (CHAs). A record is created for
each CHA.

Table 26 PkInfo.csv file (Title: <<PK>>)

Item Content

Module# Module number

CHA Location CHA name

DKC Emulation DKC emulation type

Port# Number of the port installed on the CHA (2-digit number in the
hexadecimal format)

Port Name of port installed on the CHA

Package Type CHA type

CHA for mainframe systems:
■ 16M8 (Mfibre)
■ 16M16(Mfibre)

PkInfo.csv
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Item Content

CHA for open systems:
■ Fibre:

● 16FC8 (Fibre )
● 8FC16 (Fibre )
● 16FC16 (Fibre)

■ FCoE:
● 16FE10 (FCoE )

■ iSCSI:
● 8IS10 (iSCSI)

SFP Kind SFP (Small Form factor Pluggable) kind:
■ Short Wave
■ Long Wave

SFP Status SFP status:
■ Normal
■ Failed
■ Not Fix

Port Type Port type

Output example:
■ Initiator
■ Target
■ External

Fabric One of the Fibre topology settings indicating the setting status of the
Fabric switch (output only for an open system CHA that is Fibre or FCoE):
■ On
■ Off

Connection One of the Fibre topology settings (output only for an open system CHA
that is Fibre or FCoE)
■ Point to Point
■ FC-AL

Port Address Port address (2-digit number in the hexadecimal format)

Output only for an open system CHA that is Fibre or FCoE

PkInfo.csv
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Item Content

Resource Group ID
(Port)

Resource group ID of port (number in the decimal format)

Resource Group Name
(Port)

Resource group name of port

Port Internal WWN WWN of the port (output only for an open system CHA that is Fibre or
FCoE)

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is "8FC16(Fibre )" or "16FC16(Fibre)"

PpInfo.csv

This CSV file contains information about the software. A record is created for each
software product.

For details about the license key, see Managing license keys (on page 128) .

Item Content

Program Product Name Software name.

Install Information about whether the installed license key is enabled or not
■ Enabled: Installed and the software can be used
■ Disabled: Installed but the software cannot be used

Key Type Installed license key type
■ Permanent
■ Temporary
■ Emergency
■ Term

If no license key is installed, "Not Installed" is output.

Permitted Volumes(TB) Permitted volume capacity for this software (in TB) 1

If no upper limit value is set for the capacity, "Unlimited" is output.

Expiration Date Expiration date of the software.

The format is mm/dd/yyyy (Month/Day/Year).

PpInfo.csv
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Item Content

Status License key status of the software
■ Installed
■ Not Enough License
■ Grace Period
■ Expired
■ Not Installed
■ Installed (Disabled)

Notes:

1. The used volume capacity is not output.

SMfundat.csv

This CSV file contains information about SM functions. A record is created for each of the
classifications shown in "SM Install Function".

Item Content

SM Install function The following classifications are output1:
■ Base(16KLDEV/SI/VM/DP/TI/FC)
■ 64KLDEV Extension
■ TC/UR/GAD
■ HDT/Active Flash
■ DP/HDT/Active Flash/TI Extension1
■ DP/HDT/Active Flash/TI Extension2
■ DP/HDT/Active Flash/TI Extension3

Availability Information about whether the function of "SM Install function" is
enabled
■ Enabled
■ Disabled

SMfundat.csv
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Item Content

Notes:

1. The following values are output:

■ Active Flash: active flash

■ DP: Dynamic Provisioning

■ FC: Compatible FlashCopy®

■ GAD: global-active device

■ HDT: Dynamic Tiering

■ SI: ShadowImage

■ TI: Thin Image

■ TC: TrueCopy

■ TPF: Transaction Processing Facility

■ UR: Universal Replicator

■ VM: Volume Migration

SsdDriveInfo.csv

This CSV file contains information about SSDs. A record is created for each SSD.

Item Content

ECC Group Number of the parity group of which this SSD is a component.

CR# C# and R# (2-digit hexadecimal numbers), which identify the PDEV

Output in the format XX/YY, where:
■ XX: C#
■ YY: R#

PDEV Location Location name of the PDEV

Output example: SLR5B-M200SS

Device Type-Code Drive type code

Output example: SLR5B-M200SS

Device Capacity Drive capacity in GB or TB

SSD Device Type SSD drive type
■ MLC
■ FMD

SsdDriveInfo.csv
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Item Content

■ FMC
■ FMD-HDE

Used Endurance
Indicator (%)

SSD life (0 to 100)

Used Endurance
Indicator Threshold (%)

SSD life threshold (0 to 100)

Used Endurance
Indicator Warning SIM
(%)

Warning SIM threshold (0 to 100)

FMD Battery Life
Indicator Warning SIM
(%)

Threshold of battery life warning SIM (0 to 100)

Blank if SSD is other than FMD

FMD Battery Life
Indicator (%)

Used battery life (0 to 100)

Blank if SSD is other than FMD

SsidInfo.csv

This CSV file contains information about SSIDs. A record is created for each SSID.

Item Content

DEV# Start First LDEV number for the SSID

DEV# End Last LDEV number for the SSID

SSID Subsystem ID (hexadecimal)

SysoptInfo.csv

This CSV file contains information about system options.

Item Content

Spare Disk Recover Speed of copying data to the spare drive.
■ Interleave mode
■ Full Speed mode

SsidInfo.csv
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Item Content

Dynamic Sparing Information about whether to perform automatic copy to a spare drive
if the occurrences of drive failures exceed the threshold.
■ On
■ Off

Correction Copy Information about whether to perform correction copy to a spare drive
if a drive is blocked.
■ On
■ Off

Disk Copy pace Speed of copying the spare drive in the Interleave mode.
■ Faster
■ Medium
■ Slower

System Option On System options that are set to ON.

Output example: modeXXXX (0 to 2047, decimal number)

Link Failure Threshold Threshold to notify the link failure (0 to 255, decimal)

WDCP Enable Information about whether the WDCP option is set or not. Output only
in cases where the Config type is H.
■ On
■ Off

DDUMP Enable DDUMP Enable Information about whether the DDUMP option is set or
not. Output only in cases where the Config type is H.
■ On
■ Off

WwnInfo.csv

This CSV file contains information about hosts. A record is created for each host.

For details about the host setting, see the Provisioning Guide for Open Systems. For
information about iSCSI hosts, see IscsiHostInfo.csv. For information about iSCSI targets,
see IscsiTargetInfo.csv.

Table 27 WwnInfo.csv file (Title: <<World Wide Name Information>>)

Item Content

Port Port name

WwnInfo.csv
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Item Content

Host Group Host group name

If "Package Type" is iSCSI, the iSCSI target alias is output.

Host Mode Host mode that is set for the host group (number in hexadecimal
format)

Host Mode Option Host mode option that is set for the host group (number in the
hexadecimal format)

Multiple options are separated by semicolons.

WWN World Wide Name of the host bus adapter registered to the host group
(number in hexadecimal format)

Blank if Package Type is iSCSI.

Nickname Nickname of the host

Blank if Package Type is iSCSI.

Host Group# Host group number (hexadecimal)

If "Package Type" is iSCSI, the iSCSI target alias is output.

CHA Location CHA on which the port is installed

Package Type CHA type for CHA Location
■ Fibre:

● 16FC8 (Fibre )
● 8FC16 (Fibre )
● 16FC16 (Fibre)

■ FCoE:
● 16FE10 (FCoE )

■ iSCSI:
● 8IS10 (iSCSI)

T10 PI Mode Indicates whether the T10 PI mode can be applied to the port.
■ Enabled
■ Disabled
■ Blank if "Package Type" is "8FC16(Fibre )" or "16FC16(Fibre)"

WwnInfo.csv
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Chapter 8:  Troubleshooting

Troubleshooting for Device Manager - Storage Navigator involves identifying the cause of
the error and resolving the problem.

This section provides information for identifying and correcting problems with Device
Manager - Storage Navigator for your storage system.

Getting help

If you have difficulty with any of the procedures included in this chapter, or if a
procedure does not provide the answer or results you expect, contact Hitachi Vantara
support. See Getting Help in the preface of this manual.

General troubleshooting

A system administrator is responsible for the operation and normal maintenance of the
Device Manager - Storage Navigator web client. The following are guidelines for
troubleshooting the Device Manager - Storage Navigator web client:
■ Check the cabling and the LAN. Verify that both the management client and LAN

cabling are firmly attached, and that the LAN is operating properly.
■ Reboot the management client. Close any programs that are not responding. If

necessary, reboot the management client and restart a Device Manager - Storage
Navigator web client session.

■ Check for any general error conditions. For a complete list of Device Manager -
Storage Navigator error codes, see the Hitachi Device Manager - Storage Navigator
Messages.

■ Check the alert icon. Confirm the severity level of the storage system alert by clicking
Alert in the Device Manager - Storage Navigator main window. If you cannot resolve
an error condition, contact customer support.

The following illustration shows the workflow for troubleshooting:
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Monitoring SIMs alerts in Device Manager - Storage
Navigator

The Device Manager - Storage Navigator main window opens an icon indicating whether
service information messages (SIMs) occurred in the storage system.

Procedure

1. In the Device Manager - Storage Navigator main window, click Alert. The Alerts
window opens.

Monitoring SIMs alerts in Device Manager - Storage Navigator
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2. To check the details of each alert, select and right-click one row, and then click
Detail in the pop-up menu. The detail dialog box opens.

3. If the following SIM reference codes appear (see table below), you must resolve the
error.

Reference code Program product

601xxx* Thin Image

602xxx*

602ffe

620xxx* Dynamic Provisioning

Dynamic Provisioning for Mainframe621xxx*

622xxx*

624000 Thin Image

Dynamic Provisioning

Dynamic Provisioning for Mainframe

625000 Dynamic Provisioning

Dynamic Provisioning for Mainframe626xxx*

641xxx* Dynamic Tiering

Dynamic Tiering for Mainframe

*xxx indicates a pool number. Pool numbers are decimal and displayed on the
Alert Properties window.

For details on how to resolve the error, see the Hitachi Thin Image User Guide, the
Provisioning Guide for Open Systems, or the Provisioning Guide for Mainframe Systems.

Login errors

The following table lists login errors:

Login errors
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Error condition Probable cause / Recommended action

Failed to login is displayed. Check that the user name and password are
correct. If you forget your password, log in with the
Security Administrator (View & Modify) and set a
new password.

When you are using an external authentication
server such as LDAP, check the following:
■ The authentication server has been started.
■ The authentication server can be accessed from

the SVP via the network
■ The user account has been established on the

authentication server
■ The connection information for the

authentication server that has set on the SVP is
correct.

If the symptom recurs even after you correct the
above settings, use the dump tool to collect Device
Manager - Storage Navigator normal dump files to
some recording media and then contact customer
support.

The page is not displayed because of an
invalid syntax error.

Enter the URL of the desired SVP in the Trusted
sites section of the Internet Options dialog box.

The Device Manager - Storage Navigator
window is not displayed.

Make sure that the TLS setting of SVP and that of
the browser are correct.

Device Manager - Storage Navigator does not
start even with repeated attempts.

Close all the web browser windows and then clear
the web browser cache.

Use the Task Manager to check for "hung" or
duplicate processes.

A network error occurred when you logged in
to Device Manager - Storage Navigator.

Close all dialog boxes and log in to the Device
Manager - Storage Navigator again. If the same
error occurs, check the network environment.

The login to a storage system from the
Hitachi Command Suite server fails

If you change your password for a storage system,
you need to change the information registered in
Hitachi Command Suite. For details, see the
section describing how to change storage system
settings in the Hitachi Command Suite User Guide.

The login window is not displayed. You might be using Internet Explorer 11 with
Adobe Flash Player version 10 or earlier. Update
Adobe Flash Player if needed.

Login errors
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No-response errors

The following table lists no-response errors:

Error condition Probable cause / Recommended action

The following error occurs when using Device
Manager - Storage Navigator:
■ 20121-107024

The SVP web server might have been restarted.
Close Device Manager - Storage Navigator, wait 10
minutes, and then restart Device Manager -
Storage Navigator.

Error (20121-107096) occurs repeatedly while
you are using Device Manager - Storage
Navigator.

A timeout error may have occurred in Adobe Flash
Player.

Close the Device Manager - Storage Navigator
window. Click X in the corner of the browser
window or click the window and press Alt+F4.

The following errors occur when using Device
Manager - Storage Navigator:
■ 20121-107024
■ 20121-107025
■ 20121-107096
■ 20121-107097

This error may occur if the load to the
management client is high, or if you start multiple
instances of Device Manager - Storage Navigator
by using multiple tabs in a tab browser or multiple
browsers.

Close the other applications which cause the high
load, or make sure to start only one Device
Manager - Storage Navigator

The following application error occurs when
using Device Manager - Storage Navigator:
■ 20020-108000

■ The version of Device Manager - Storage
Navigator installed on the management client
might not match the SVP version. Close all the
browser windows and then clear the browser
cache.

■ The management client might have entered
standby or hibernate mode. Restart Device
Manager - Storage Navigator.

No-response errors
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Error condition Probable cause / Recommended action

■ If a proxy server is used for network
connections, the proxy server cache may be
storing the older version of the program. If the
problem continues after you clear the browser
cache, contact your network administrator.

■ Java content might be disabled in the web
browser using the JRE 7.0 Update 10 or later.

To enable Java content in the web browser:

1. From Windows, open the Java Control Panel.

2. In the Java Control Panel, click the Security
tab.

3. If Enable Java content in the browser is
checked, uncheck it and click Apply.

4. The User Account Control dialog box opens.
Click Yes. The confirmation window opens. Click
OK.

5. Restart the browser.

If none of the above actions solve the problem,
save the Device Manager - Storage Navigator
dump file and send it to customer support. Then
restart the web browser.

Device Manager - Storage Navigator does not
respond.

Device Manager - Storage Navigator may
hang in the following cases:
■ The Device Manager - Storage Navigator

main window is grayed out and does not
display the percentage of progress, and
you cannot perform any operation for a
long period of time.

■ You cannot perform any operation for a
long period of time and the dialog box
that says Loading... is not displayed.

■ The dialog box that says Loading... opens
when the window switches. However, you
cannot move the dialog box or perform
any operation for a long period of time.

■ The login window does not appear and
the white screen continues.

Close the web browser and reopen it. When using
the Device Manager - Storage Navigator secondary
window, exit Device Manager - Storage Navigator
by pressing Ctrl+Alt+Shift+D all at once.

If you close the web browser but you cannot exit
Device Manager - Storage Navigator, reboot the
management client or restart Device Manager -
Storage Navigator after forcibly closing Device
Manager - Storage Navigator as follows:
■ In Windows:

Exit the web browser and then use the Task
Manager to terminate iexplorer.exe (if you are
using Internet Explorer) or chrome.exe (if you
are using Google Chrome).

■ In UNIX:

Exit the web browser, and then terminate
firefox-bin with the kill command.

■ If the problem continues, ask your maintenance
personnel to restart the SVP.

No-response errors
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Error condition Probable cause / Recommended action

A network error occurred. There is no
response to any operation even after 30
minutes.

Restart the management client. An operation may
take over 30 minutes depending on the use
condition. For example, when several Device
Manager - Storage Navigator web clients are
running, an operation may take a long time.

An internal error occurs, or a web browser
ended abnormally.

Close all dialog boxes and log in to Device Manager
- Storage Navigator again. If the same error occurs,
restart the management client.

During a Device Manager - Storage Navigator
operation, the web browser suddenly
disappears.

Restart the management client.

An error (1-4011) occurs while you are using
Device Manager - Storage Navigator.

The clock time of the management client may have
been changed. Log in to Device Manager - Storage
Navigator again.

The management client reboots on its own. Restart the management client.

A Device Manager - Storage Navigator
window is forcibly closed during a time-
consuming process, such as LDEV formatting.

Close all windows, wait until processing finishes,
and then restart Device Manager - Storage
Navigator.

A Device Manager - Storage Navigator
window is incorrectly closed when you do
one of the following:
■ Click 
■ Use commands such as File > Close on the

web browser
■ Press the Alt and F4 keys

Restart Device Manager - Storage Navigator. If you
cannot log in, wait for one minute and try again.

During a Device Manager - Storage Navigator
operation, an add-on (Flash10e.ocx) error
occurs.

Restart the management client.

If this error occurs repeatedly, reinstall Adobe
Flash Player on the management client.

When you log out from the Device Manager -
Storage Navigator, an Internet Explorer error
occurs.

The probable causes are as follows:
■ Internet Explorer has not been updated. Install

the latest updates
■ Internet Explorer may be configured incorrectly.

Re-install Internet Explorer.

No-response errors
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Error condition Probable cause / Recommended action

When you click File > Refresh All or Refresh in
the Device Manager - Storage Navigator main
window, the percentage of progress remains
99%.

The probable causes are as follows:
■ Another application such as Command Control

Interface may be changing configuration. The
window will be updated shortly after the
configuration change ends.

■ Volume Migration operations, Quick Restore
operations or Thin Image operations may be in
progress. The window will be updated shortly
after the operations end.

One of the following errors occurred during a
Device Manager - Storage Navigator
operation in the main window
■ 20123-107027
■ 20123-108004
■ 00002-058578
■ 00003-002003
■ xxxxx-065740
■ xxxxx-068800

where xxxxx indicates any code.

■ Another application such as Command Control
Interface may be changing configuration.

■ Volume Migration operations, Quick Restore
operations, or Thin Image operations may be in
progress.

■ The configuration data may not be matched if a
communication error occurs between the
storage system and SVP.

Wait a few minutes and then click File > Refresh All
to reload the configuration information. Then run
Device Manager - Storage Navigator again.

When using Encryption License Key or FMD
Encryption License Key:
■ If a failure (00002-058578) occurs when you set

the Encryption Environment for the first time
from the Edit Encryption Environmental
Settings window, do the following:

1. Wait a few minutes and then click File >
Refresh All to reload the configuration
information.

2. Initialize the Encryption Environment
Settings.

3. Set the Encryption Environment again.
■ If a failure (00002-058578) occurs when you set

the Encryption Environment again from the
Edit Encryption Environmental Settings
window, do the following:

1. Wait a few minutes and then click File >
Refresh All to reload the configuration
information.

2. Set the Encryption Environment again.

No-response errors
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Error condition Probable cause / Recommended action

The Device Manager - Storage Navigator
window turns white and the icon shown
below displays in the center of the web
browser when you use Device Manager -
Storage Navigator.

If you are using Internet Explorer: 

If you are using Google Chrome: 

Restart the management client.

Operations cannot be performed due to a
problem with the Device Manager - Storage
Navigator main window. For example, tables
are not displayed correctly or some buttons
are not displayed. Logging out and back in
does not solve the problem.

The Device Manager - Storage Navigator window
setting information may have been saved with an
incorrect value. Click Settings > Environmental
Settings > Reset View to Settings in the Device
Manager - Storage Navigator main window to clear
the window setting information. Then click any
button in the Device Manager - Storage Navigator
window and check that it operates correctly. You
do not need to log out and back in.

Device Manager - Storage Navigator closes
automatically when operating the IPv6
address setting from Device Manager -
Storage Navigator.

When the symptom occurs, the resource group
status remains locked.

Open the Resource Lock Properties window and
release the locked resource group caused by the
symptom. Suspend other operations when
releasing the resource group, as other resource
groups are also released the lock. See Resource
Lock Properties window (on page 393) .

Incorrect display errors

The following table lists incorrect display errors:

Incorrect display errors
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Error condition Probable cause / Recommended action

A question mark or icon displays in a table or
other area of the window.

■ When the question mark appears in the View
Tier Properties window, see the topic
describing this window in the Provisioning Guide
for Open Systems. If the problem still persists,
contact customer support.

■ When the question mark appears in the Add
External Volumes window, see the topic
describing this window in the Hitachi Universal
Volume Manager User Guide. If the problem still
persists, contact customer support.

■ If the question mark or icon appears in another
window, update the window. Contact customer
support if the question mark remains after you
update the window.

The product name, vendor name, and
function name displayed in Device Manager -
Storage Navigator are incorrect.

Contact customer support.

A part of the Device Manager - Storage
Navigator window is not displayed.

You may be using the zoom in and zoom out
function of the web browser. Do not use this
function of the web browser when using Device
Manager - Storage Navigator.

The display on Device Manager - Storage
Navigator's main window is not updated to
the latest information. "Last Updated" on
Device Manager - Storage Navigator's main
window is not updated.

Volume Migration operations, Quick Restore
operations, or Thin Image operations may be in
progress. The window will be updated shortly after
the operations end.

The following message is displayed when
connected to Device Manager - Storage
Navigator on Internet Explorer or Google
Chrome.

This content requires Adobe Flash Player.
■ Get and install Adobe Flash Player from

the Adobe web site.
■ Enable Adobe Flash Player.
■ Adjust the browser security settings.

This message displays when Adobe Flash Player is
not installed. Do the following:
■ Install Adobe Flash Player
■ Disable ActiveX Filtering

Incorrect display errors
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Error condition Probable cause / Recommended action

If you are using Internet Explorer 9 or later, click

Tools > Safety and uncheck ActiveX Filtering.
■ When a message appears indicating that the

specific site was blocked, perform the
procedure described in Adding your SVP to the
trusted sites zone for Windows Server
computers (on page 25) .

■ Do not change the local storage area value in
Adobe Flash Player.

■ Do not disable Adobe Flash Player because
Adobe Flash Player is necessary for Device
Manager - Storage Navigator and works as an
add-on to a web browser. If you use Internet
Explorer, do not change the settings in Tools >
Manage add-ons.

When many items are set, some items might
not be displayed even if you scroll through
the table.

Depending on the size of a window, some items in
a table might not be displayed. Do the following:
■ Increase the resolution so that more areas of

the table can be shown.
■ Use the zoom in or zoom out function of your

browser to adjust the viewing area.

Note: Text might become too small.

If you still cannot solve the problem, contact
customer support.

Incorrect display errors
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Error condition Probable cause / Recommended action

The Tools panel of Google Chrome is not
displayed correctly in Japanese.

Click the Chrome menu > Settings > Show
advanced settings > Languages > Language and
input settings.

1. If you do not have Japanese in the list, click
Add to add Japanese.

2. From the list, select Japanese, and then click
Display Google Chrome in this language >
Done.

3. To apply the changes, close all Google
Chrome windows.

4. Click the Chrome menu > Settings > Show
advanced settings > Languages > Language
and input setting.

5. In the languages list, select another language.
Click the x symbol which is displayed when
you select another language to delete the
selected language. Delete all languages
except Japanese.

6. Click Done to close the window.

The message "Unable to launch the
application" appears on the secondary
window, then operation ends abnormally.

Perform the following:

To disable TLSv1.0 and TLSv1.1 communications,
using JRE 8 or later is recommended. If you use JRE
8, Solaris is not supported.

Confirm Use TLS 1.2 for Java is enabled.

UNIX operation errors

The following table lists UNIX operation errors:

Error condition Probable cause / Recommended action

The web browser is incorrectly displayed
because GUI items, such as labels and icons,
cannot be loaded properly.

Part of a button is outside the window.

If you use Device Manager - Storage Navigator on
the Japanese version of Firefox, log out of Device
Manager - Storage Navigator, and then log in to
Device Manager - Storage Navigator again. Enter
the following commands using the X Server
Emulator.
■ B Shell:

LANG=C

UNIX operation errors
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Error condition Probable cause / Recommended action

export LANG
■ C Shell:

setenv LANG C

The web browser closes abnormally. This problem can occur if a Mozilla process keeps
running after Mozilla stops responding. Delete the
"java_vm" and "mozilla" processes and continue
with Device Manager - Storage Navigator
operations.

Other errors

The following table lists other errors that might occur in Device Manager - Storage
Navigator:

Error condition Probable cause / Recommended action

■ Error about insufficient capacity when
creating an LDEV with sufficient capacity.

■ Operation error about an LDEV that does
not exist when creating a pair for an LDEV
that does exist.

Configuration information displayed in Device
Manager - Storage Navigator and controller
configuration information might not match.

Click File > Refresh All in the Device Manager -
Storage Navigator main window to reload
configuration information.

If the problem persists, contact customer support.

The microcode on the SVP is upgraded or
downgraded.

Close all Device Manager - Storage Navigator
windows, and then clear the browser cache. Even
when you are not sure that the microcode on the
SVP is upgraded or downgraded, clear the browser
cache.

Device Manager - Storage Navigator
processing is temporarily delayed.

Internal processing (such as, configuration change,
P.P. check, or operational information acquisition)
might be running on the SVP.

Device Manager - Storage Navigator
processing is delayed.

The local storage value for Adobe Flash Player
might decrease. Follow these steps:

1. Right-click on the Device Manager - Storage
Navigator main window and click Settings to
open the Adobe Flash Player Settings
window.

2. In the local storage settings, move the slider
until Unlimited appears and then click Close.

Other errors
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Error condition Probable cause / Recommended action

3. Close Device Manager - Storage Navigator.
4. Restart Device Manager - Storage Navigator.
5. If the local storage confirmation dialog box

appears, click Allow.

Installing of signed SSL certificate fails. The passphrase for the SSL certificate might be
set. Release the passphrase. If needed, see
Releasing an SSL certificate passphrase (on
page 79) .

You cannot resolve an error condition. Do the following, and then contact the customer
support.

1. Copy the Device Manager - Storage Navigator
detailed dump files onto recording media
using the Dump tool.

2. Obtain the Java log and trace files.

Clearing the cache in Internet Explorer

If an error occurs in Device Manager - Storage Navigator, try clearing the web browser
cache to solve the problem.

Note: These instructions are for IE8 on Windows 7. If you are using a different
version, the labels in windows might be different.

Procedure

1. Click Tools > Internet Options.
2. On the General tab, under Browsing history, click Delete.

This will delete the temporary internet files, history, cookies, saved passwords, and
web form information.

Clearing the cache in Firefox

If an error occurs in Device Manager - Storage Navigator, try clearing the web browser
cache to solve the problem.

Note: These instructions are for Firefox version 35 on Windows 7. If you are
using a different version, the labels in windows might be different.

Procedure

1. Click Tools > Options.

Clearing the cache in Internet Explorer
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2. In the Options window, click Advanced.
3. On the Network tab, under Cached Web Content, click Clear Now.

Enabling JavaScript for Windows

When using Internet Explorer for the secondary window, you might need to enable
JavaScript.

If you use Windows 8.1, Windows Server 2012, or Windows Server 2012 R2, enable
JavaScript.

Procedure

1. Launch Internet Explorer.
2. From Internet Explorer's menu bar, click Tools > Internet Options > Security.

The Internet Options window opens.
3. Click the Security tab.

The Security window opens.
4. Click Custom Level.

The Security Settings window opens.
5. Set Active scripting to Enable.
6. Click OK.
7. When the Warning dialog box appears, click YES.
8. Click OK to close the Internet Options window.
9. Restart Internet Explorer.

Firefox web browser problems on UNIX

Note the following when using Firefox web browser on UNIX:
■ If a Mozilla process or a Firefox web browser process becomes unavailable, Device

Manager - Storage Navigator performance is affected. Delete the abnormal process
and continue with Device Manager - Storage Navigator operations.

■ When using Device Manager - Storage Navigator on the Japanese version of the
Firefox web browser, you must use the X Server Emulator to properly configure the
browser, as follows:

In a B Shell, enter the following command:

LANG=C 
export LANG

In a C Shell, enter the following command:

setenv LANG C

Enabling JavaScript for Windows
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When you use Device Manager - Storage Navigator with Firefox, movements of the focus
may differ from movements of the focus in Internet Explorer. For example:
■ When the Device Manager - Storage Navigator login window appears, the focus is not

on the User Name box. Even is the User Name box is emphasized, you cannot enter
any characters in it.

■ When you move the focus by using the Tab key, the destination browser window does
not become active.

In Firefox, when you click Logout at the upper right corner of the Device Manager -
Storage Navigator main window, the Device Manager - Storage Navigator login window
appears after you logout. With Internet Explorer, the window closes after the logout.

Downloading dump files using the Dump tool

Use the Dump tool to download dump files onto a Device Manager - Storage Navigator
computer. The downloaded dump files can be used to:
■ troubleshoot the system. Use the Dump tool to download dump files from the SVP

and give it to the Hitachi Vantara support personnel.
■ check system configuration. First click File > Refresh All to update the configuration

information, and then use the Dump tool to download dump files.

Before you begin
■ All other users (including the SVP user) must stop using the Dump tool.
■ Stop all maintenance operations.
■ You must have Support Personnel role to log in.

Procedure

1. Start a web browser and specify the following URL to open the Tool Panel:

https://IP-address-or-host-name-of-SVP/cgi-bin/utility/toolpanel.cgi

Downloading dump files using the Dump tool
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2. Click Download Dump Files. The Login dialog box opens.
3. Enter the user ID and password and click Login. The Download Dump Files dialog

box opens.
4. Select a file that you want to download.

■ Existing Dump Files indicates the last dump file that you downloaded. Select
this when you want to re-download a previously downloaded dump file. If you
have not downloaded any dump files from the Tool Panel, this item does not
display even if you have acquired a dump file via SVP.

■ Normal Dump includes all information about the SVP and the minimum
information about the storage system. Select this when you have a less serious
problem such as incorrect display.

■ Detail Dump includes all information about the SVP and the storage system.
Select this when Device Manager - Storage Navigator has a serious problem (for
example, Device Manager - Storage Navigator does not start) or when you need
to determine if the storage system has a problem.

■ Detail Dump (for DKC Performance) contains the I/O-performance-related
information. This includes performance monitor collection information, in
addition to information applicable to Detail Dump. Choose Detail Dump (for
DKC Performance) to check for I/O performance problems.

Note that while processing takes place, DKC I/O performance may be affected.
During processing, you cannot use Device Manager - Storage Navigator to
change the system configuration or perform SVP maintenance operations.

5. Click Next. A message appears confirming the execution of compression of the
dump files.

6. Click OK. File compression processing starts. When the file is compressed, the
Download Dump Files dialog box opens for the download.

7. Click Download. The File Download dialog box opens.
8. On the File Download dialog box, click Save this file to disk, and then click OK. The

Save As dialog box opens.

Downloading dump files using the Dump tool
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9. Specify the download destination, and then click Save. When the file is downloaded
successfully, the Download complete dialog box opens.

Troubleshooting the SMI-S function

If you cannot access the SMI-S function, check the network environment and access
destination. If access cannot be made even though there is no problem with the network
environment and access destination, contact customer support.

The SMI-S certificate might have expired when you receive a storage system. If so, you
must upload a new signed certificate to the SMI-S provider. Follow the procedure on
Uploading a signed certificate to the SMI-S provider (on page 93) .

SMI-S artificial indication errors

The following table lists SMI-S artificial indication errors:

Error condition Probable cause / Recommended action

The user ID or the password is not valid.
(00190 77302)

User ID or password is invalid. Enter the correct
user ID or password, and then retry the operation.

An error occurred during the listener
information acquisition. (00190 77303)

An error occurred during the listener information
acquisition. Collect Device Manager - Storage
Navigator normal dump file to the media using the
dump tool.

No listeners are subscribed to the provider.
(00190 77304)

The listeners are not subscribed to the SMI-S
provider. Have the listeners subscribe to the
provider, and retry.

The artificial indication cannot be sent to
some listeners. (00190 77305)

The artificial indication cannot be sent to some
listeners. Use the dump tool to collect and save
Device Manager - Storage Navigator normal dump
files. Then contact the customer support.

A time-out error occurred. (00190 77306) Send the artificial indication again. If this problem
persists, use the dump tool to collect Device
Manager - Storage Navigator normal dump files to
some recording media and then contact the
customer support.

An internal error occurred. (00190 77307) Use the dump tool to collect Device Manager -
Storage Navigator normal dump files to some
recording media and then contact the customer
support.

Troubleshooting the SMI-S function
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Appendix A:  Device Manager - Storage
Navigator user management GUI reference

This section describes the Device Manager - Storage Navigator windows and wizards that
you use to manage user security and to set up and manage user accounts on your
storage system.

User Groups window

This window lists all user groups created in Device Manager - Storage Navigator.

Summary

The following table describes the fields in the summary section in the User Groups
window.

Item Description

Number of User
Groups

Number of user groups created in Device Manager - Storage
Navigator.

User Groups tab

The following table describes the fields in the User Groups tab in the User Groups
window.
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Item Description

User Group Name Displays user group name.

User Group Type Displays the user group type.

Built-in: Indicates a built-in user group.

User-created: Indicates a user group that users created.

Number of Roles Displays the number of the roles that are assigned to the user
group.

Number of Resource
Groups

Displays the number of the resource groups that are assigned
to the user group.

Number of Users Displays the number of users who belong to the user group.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Create User Group Creates a new user group.

Add Users Adds the created users to the selected user group.

Edit Resource Group
Assignment

Assigns the created resource groups to the selected user
groups.

Edit Role
Assignment*

Assigns the created roles to the selected user groups.

Delete User Groups* Deletes the selected user groups.

Edit User Group* Edits the user group name.

Export* Displays a window for outputting table information.

* Appears when you click More Actions.

Selected User Group Window

The User Group window lists the names of all of the built-in user groups and any user
groups that were created in Device Manager - Storage Navigator. To open a window for a
specific user group, in the User Groups tab, click the user group name.

Selected User Group Window

Appendix A: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 244



The features of the window that opens when a user group is selected are the same, no
matter which user group is selected. The following example uses the Administrator
User Group window to show the features in the window.

The window for each selected user group contains a Summary section and three tabs.

Summary section

The following table describes the fields and settings in the Summary section of the
selected user group window.

Item Description

Number of Roles Displays the number of roles that are assigned to the selected
user group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
selected user group.

Number of Users Displays the number of users who belong to the selected user
group.

User Group Type Displays the user group type.

Built-in: Indicates a built-in user group.

User-created: Indicates a user group that a user created.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Users tab

The following table describes the fields and settings in the Users tab of the selected user
group window. It lists the users who belong to the selected user group.

Selected User Group Window
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Item Description

User Name Name of user who belongs to the user group.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Lockout1 Indicates whether the status is locked.
■ Yes: The user account is locked, so login to Device Manager -

Storage Navigator is not possible.
■ No: The user can use the account.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

User Type User type. The following types are available:

Built-in or User-created

Number of User
Groups

Displays the number of the user groups where the user belongs.

Create User Creates a new user account.

Change Password Changes your own password if you click this.

Changes the password of other users if you select a user and
then click this.

Edit User Changes the setting for authentication or for the account status.

You can set the password of the selected user if you change
Authentication from External to Local.

Add Users2 Adds the created users to the selected user group.

Remove Users2 Removes the selected user from the user group. The user
account itself will not be deleted.

Delete Users2 Deletes the selected users.

Export2 Displays a window for outputting table information.

Notes:

1. This content is not displayed by default. To display it, change the settings in the
Column Settings window in the table options.

2. Appears when you click More Actions.

Selected User Group Window
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Roles tab

The following illustration shows the Roles tab of the selected user group window.

The following table describes the fields and settings in the Roles tab of the selected user
group window. Role displays the roles assigned to the user group, which determines the
operations the user can perform.

Role Permitted operations

Roles Displays the roles that are assigned to the user
group.

Edit Role Assignment Assigns the created roles to the selected user
groups.

Export Displays a window for outputting table
information.

Resource Groups tab

The following illustration shows the Resource Groups tab of the selected user group
window.

The following table describes the fields and settings in the Resource Groups tab of the
selected user group window. It lists the resource groups that are assigned to the selected
user group.

Selected User Group Window
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Item Description

Resource Group
Name

Displays the name and ID of the resource group assigned to the
user group.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of the parity groups that are assigned to
the resource group.

Number of LDEVs Displays the number of the LDEVs that are assigned to the
resource group.

Number of Ports Displays the number of the ports that are assigned to the
resource group.

Number of Host
Groups

Displays the number of the host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to
the resource group.

Virtual Storage
Machine*

Displays the model type and serial number of the virtual
storage machine set for the resource group.

Edit Resource Group
Assignment

Assigns the created resource groups to the user groups.

Export Displays a window for outputting table information.

* This content is not displayed by default. To display it, change the settings in the
Column Settings window in the table options.

Create User Group wizard

Create User Group window

Use this window to create a new user group.

Create User Group wizard
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Item Description

User Group Name Enter the name of the user group to be created.

You can specify ASCII code characters, spaces, and the following
symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Check Check whether the entered user group name is registered to the
authorization server when you use an authorization server.

Create User Group window
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Create User Group confirmation window

Create User Group

The following table describes the fields in the Create User Group section of the Create
User Group Window.

Item Description

User Group Name Displays the name of user groups that are created.

Number of Roles Displays the number of roles that are assigned to the user group
created.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group created.

Create User Group confirmation window
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Item Description

Number of Users Displays the number of users that belong to the user group
created.

All Resource Groups
Assigned

Displays whether all resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Assigned Roles

The following table describes the fields in the Assigned Roles section of the Create User
Group Window.

Item Description

Role Displays the roles that are assigned to the user group created.

Assigned Resource Groups

The following table describes the fields in the Assigned Resource Group section of the
Create User Group Window.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays details of the selected resource group.

Create User Group confirmation window
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Selected Users

The following table describes the fields in the Selected Users section of the Create User
Group Window. This table displays only when users are added to the user group. This
table displays only when users are added to the user group.

Item Description

User Name Displays the name of the users that belong to the user group to
be created.

Account Status Displays the account status. The following status are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Displays the authentication method. The following methods are
available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Create User wizard

Create User window

Use this window to create a new user account.

Create User wizard
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The following table describes the fields and settings in the Create User window.

Item Description

User Name Enter the user name to be created.

The allowable characters and length of user names depend on
the application that the user uses.

Account Status Account statuses. The following statuses are available:

Enable: The user can use the account.

Disable: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

The allowable characters and length of passwords depend on
the application that the user uses.

Re-enter Password Password as above.

Create User window
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Create User confirmation window

Selected Users

The following table describes the fields and settings used to create a new user account.

Item Description

User Name User name to be created.

Account Status Account statuses. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication methods. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

User Group Name User group name where the user is added.

Create User confirmation window
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Change Password Wizard

Change Password window

Use this window to change the password for yourself or another user.

The following table describes the fields and settings used to change a password.

Item Description

User Name Selected user name.

Current Password Current password of your user account. Required only when you
change your own password.

New Password New password that the selected user enters for login.

The allowable characters and length of passwords depend on
the application that the user uses.

Re-enter New
Password

Same password as above.

Change Password Wizard
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Change Password confirmation window

The following table describes the fields and settings used to change user passwords.

Item Description

User Name Selected user name.

Current Password Current password.

A hyphen (-) indicates no current password is specified.

New Password New password.

Edit User wizard

Edit User window

Use this window to change the setting for authentication or for the account status.

Change Password confirmation window

Appendix A: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 256



The following table describes the fields and settings used to edit user account
information.

Item Description

User Name Selected user name.

Account Status Account statuses. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + , -. / : ; < = > ? @ [ \ ] ^ _` { | } ~

Re-enter Password Password that the user enters for login.

Edit User window
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Edit User confirmation window

The following table describes the fields and settings in the Edit Users window.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Password Password that the user enters for login.

Edit User confirmation window
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Add User wizard

Add Users window

Use this window to add the created user accounts to the selected user group.

Add User wizard
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Available Users

The following table lists all the candidate users who do not belong to the selected user
group.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Add button

Adds the selected users in the Available Users list to the Selected Users list.

Remove button

Removes the selected users from the Selected Users list and relocates the selected users
to the Available User list.

Add Users window
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Selected Users table

Lists users to be added to the user group.

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Add Users window
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Add Users confirmation window

Selected User Group

Item Description

User Group Name Displays the user group name where the user is added.

Selected Users table

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Add Users confirmation window

Appendix A: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 262



Item Description

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Remove Users window

The Remove Users window is used to remove users from a particular group. However,
the removed users will still remain in the system. To delete users entirely from the
system, see Deleting user accounts (on page 119) .

Selected User Group table

Item Description

User Group Name Displays the name of the user group where the user is removed.

Remove Users window
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Selected Users table

Item Description

User Name Selected user name.

Account Status Account status. The following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups where the user belongs.

Delete Users window

The Delete Users window is used to delete users entirely from the system. If you want to
remove users from a particular group without deleting them in the system, see Changing
user permissions (on page 118) .

Delete Users window
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Item Description

User Name Selected user name.

Account Status Account status. the following statuses are available:

Enabled: The user can use the account.

Disabled: The user cannot use the account or log in to Device
Manager - Storage Navigator.

Authentication Authentication method. The following methods are available:

Local: Does not use authentication server. Uses a dedicated
password for Device Manager - Storage Navigator.

External: Uses authentication server.

Number of User
Groups

Displays the number of user groups to which the user belongs.

Release Lockout window

Item Description

User Name Name of the user whose account you want to unlock

Release Lockout window
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Edit User Group wizard

Edit User Group window

Use this window to change the name of a user group.

The following table describes the fields and settings used to edit user group information.

Item Description

User Group Name Enter the new name of the user group.

You can use ASCII code characters, spaces, and the following
symbols:

! # $ % & ' ( ) + - . = @ [ ] ^ _ ` { } ~

Check Check whether the entered user group name is registered to the
authentication server when you use an authentication server.

Edit User Group wizard
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Edit User Group confirmation window

The following table describes the fields and settings used to edit user group information.

Item Description

User Group Name Displays the new name of the user group.

Number of Roles Displays the number of roles that are assigned to the user
group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group.

Number of Users Displays the number of users that belong to the user group.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Edit User Group confirmation window
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Delete User Groups window

Item Description

User Group Name Displays the new name of the user group.

Number of Roles Displays the number of roles that are assigned to the user
group.

Number of
Resource Groups

Displays the number of resource groups that are assigned to the
user group.

Number of Users Displays the number of users that belong to the user group.

All Resource Groups
Assigned

Displays whether all resource groups are assigned.

Yes: All resource groups are assigned to the user group.

No: All resource groups are not assigned to the user group.

Edit Resource Group Assignment wizard

Edit Resource Group Assignment window

Use this window to assign created resource groups to the user group and to assign
created resource groups to the user group in the Create User Group.

Delete User Groups window

Appendix A: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 268



The following table describes the fields and settings used to assign resource groups with
the Create User Group wizard.

Item Description

All Resource Groups
Assigned

Displays whether all the resource groups are assigned to the
user group.

This item is set to Yes when the following roles are assigned in
the Assign Roles window.
■ Security Administrator (View Only)
■ Security Administrator (View & Modify)
■ Audit log Administrator (View Only)
■ Audit log Administrator (View & Modify)
■ Support Personnel (Vendor Only)

When this item is set to Yes, Unassigned Resource Groups table,
Assigned Resource Groups table, Add button, and Remove
button are disabled.

Edit Resource Group Assignment window
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Unassigned Resource Groups table

The following table lists the resource groups that are not assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group that is not
assigned to the user group to be created.

Number of User
Groups

Displays the number of user groups that are not assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are not assigned to
the resource group.

Number of LDEVs Displays the number of LDEVs that are not assigned to the
resource group.

Number of Ports Displays the number of ports that are not assigned to the
resource group.

Edit Resource Group Assignment window
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Item Description

Number of Host
Groups

Displays the number of host groups that are not assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Add button

Adds the selected resource groups in the Unassigned Resource Groups list to the
Assigned Resource Groups list.

Remove button

Removes the selected resource groups from the Assigned Resource Groups list and
relocates the resource groups to the Unassigned Resource Groups list.

Edit Resource Group Assignment window
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Assigned Resource Groups table

Lists the resource groups to be assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group to be created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Edit Resource Group Assignment window
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Item Description

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Edit Resource Group Assignment confirmation window

The following tables describe the fields and settings used to assign user group names
with the Create User Group wizard.

Edit Resource Group Assignment confirmation window
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Item Description

User Group Name Displays the new name of the user group.

Selected Resource Groups as Assigned Table

The following table describes the fields and settings used to assign resource groups with
the Create User Group wizard.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group assigned to the
user group to be created.

Number of User
Groups

Displays the number of user groups that are assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are assigned to the
resource group.

Number of LDEVs Displays the number of LDEVs that are assigned to the resource
group.

Number of Ports Displays the number of ports that are assigned to the resource
group.

Number of Host
Groups

Displays the number of host groups that are assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Selected Resource Groups as Unassigned Table

The following table lists the resource groups that are not assigned to the user group.

Item Description

Resource Group
Name (ID)

Displays the name and ID of the resource group not assigned to
the user group to be created.

Number of User
Groups

Displays the number of user groups that are not assigned to the
resource group.

Number of Parity
Groups

Displays the number of parity groups that are not assigned to
the resource group.

Edit Resource Group Assignment confirmation window
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Item Description

Number of LDEVs Displays the number of LDEVs that are not assigned to the
resource group.

Number of Ports Displays the number of ports that are not assigned to the
resource group.

Number of Host
Groups

Displays the number of host groups that are not assigned to the
resource group.

Number of iSCSI
Targets

Displays the number of the iSCSI targets that are assigned to the
resource group.

Detail Displays the detail of the selected resource group.

Edit Role Assignment wizard

Edit Role Assignment window

Use this window to add roles to the user group and to assign roles to the user group in
the Create User Group.

Edit Role Assignment wizard
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Unassigned Roles

Lists roles that are not assigned to the user group.

Item Description

Role Displays roles.

Add button

Adds the selected roles in the Unassigned Roles list to the Assigned Roles list.

Remove button

Removes the selected roles from the Assigned Roles list and relocates the selected roles
to the Unassigned Roles list.

Assigned Roles

The following window shows the roles that can be assigned to the selected user group.

Edit Role Assignment window
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Item Description

Role Displays roles.

Edit Role Assignment window
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Edit Role Assignment confirmation window

Selected User Group

Item Description

User Group Name Displays the new name of the user group.

All Resource Groups
Assigned

Displays whether all the resource groups are assigned.

Yes: All the resource groups are assigned to the user group.

No: All the resource groups are not assigned to the user group.

Selected Assigned Roles

Item Description

Role Displays the roles that are assigned to the user group.

Edit Role Assignment confirmation window
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Selected Unassigned Roles

Item Description

Role Displays the roles that are not assigned to the user group.

Setup Server wizard

Select Authentication Server window

To open this window, select Server Setup from the LDAP, RADIUS, or Kerberos properties
window.

The following tables describe the fields and settings used to set up external
authentication in the Select Authentication Server window.

Item Description

External
Authentication

Select the type of authentication server.
■ Disable: Does not use any authentication server. Users are

authenticated with user information registered in the SVP.
■ LDAP: Users are authenticated with user information

registered in the LDAP server.
■ RADIUS: Users are authenticated with user information

registered in the RADIUS server.
■ Kerberos: Users are authenticated with user information

registered in the Kerberos server.

When you select Disable, click Finish to open the confirmation
window.

Setup Server wizard
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Item Description

When you select LDAP, RADIUS, or Kerberos, click Next to open
the Setup Server window.

Select Authentication Server confirmation window

To open this window, select Disable in the Select Authentication Server window.

The following table describes the fields and settings in the Disable authentication server
setup window.

Item Description

External
Authentication

Displays the type of the authentication server.
■ Disable: Does not use any authentication server. Users are

authenticated with user information registered in the SVP.
■ LDAP: Users are authenticated with user information

registered in the LDAP server.
■ RADIUS: Users are authenticated with user information

registered in the RADIUS server.
■ Kerberos: Users are authenticated with user information

registered in the Kerberos server.

LDAP Properties window

To open this window, select Disable or LDAP in the External Authentication window.

Select Authentication Server confirmation window
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Item Description

DNS Lookup Displays whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered

in the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Authentication Protocol Displays the LDAP protocol to use.

LDAP Properties window

Appendix A: Device Manager - Storage Navigator user management GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 281



Item Description

External User Group
Mapping

Displays whether to connect an authentication server to an
authorization server.
■ Enable: Connects an authentication server to an

authorization server.
■ Disable: Does not connect an authentication server to an

authorization server.

Primary Host Name Displays the host name of the LDAP server.

Primary Port Number Displays the port number of the LDAP server.

Domain Name Displays the domain name that the LDAP server manages.

User Name Attribute Displays the attribute name to identify a user, such as a user
ID.

Base DN Displays the Base DN for searching for users to authenticate.

Search User's DN Displays the DN of the user for searching.

Password Displays asterisks (*) to mask the password of the user for
searching.

Timeout Displays the number of seconds before connection to the
LDAP server times out.

Retry Interval Displays the retry interval in seconds when the connection to
the LDAP server fails.

Number of Retries Displays the retry times when the connection to the LDAP
server fails.

Secondary Host Name Displays the host name of the secondary LDAP server.

Secondary Port
Number

Displays the port number of the secondary LDAP server.

Setup Server Displays the Setup Server window.

RADIUS Properties window

This window opens when you select RADIUS in External Authentication.

RADIUS Properties window
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The following table describes the fields and settings in the RADIUS properties window.

Item Description

Authentication Protocol Displays the RADIUS protocol to use.
■ PAP: Password authentication protocol that transmits

plaintext user ID and password.
■ CHAP: Challenge-handshake authentication protocol that

transmits encrypted password.

Primary Host Name Displays the host name, the IPv4 address, or the IPv6
address of the RADIUS server.

Secret Displays asterisks (*) to mask the RADIUS secret key used for
the PAP or CHAP authentication.

RADIUS Properties window
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Item Description

NAS Address Displays the identifier for the RADIUS server to find SVP.

Primary Port Number Displays the port number of the RADIUS server.

Timeout Displays the number of seconds before connection to the
RADIUS server times out.

Number of Retries Displays the retry times when the connection to the RADIUS
server fails.

Secondary Host Name Displays the host name, the IPv4 address, or the IPv6
address of the secondary RADIUS server.

Secondary Port
Number

Displays the port number of the secondary RADIUS server.

External User Group
Mapping -
Authentication Protocol

Displays the LDAP protocol to use.

External User Group
Mapping - DNS Lookup

Displays whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered

in the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

External User Group
Mapping - Host Name

Displays the host name, the IPv4 address, or the IPv6
address of the LDAP server.

External User Group
Mapping - Port Number

Displays the port number of the LDAP server.

External User Group
Mapping - Domain
Name

Displays the domain name of the LDAP server.

External User Group
Mapping - Base DN

Displays the base DN to search for users to authenticate.

External User Group
Mapping - Search
User's DN

Displays the search user's domain name.

External User Group
Mapping - Password

Displays asterisks (*) to mask the password of the user for
searching.

External User Group
Mapping - Timeout

Displays the number of seconds before connection to the
LDAP server times out.

RADIUS Properties window
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Item Description

External User Group
Mapping - Retry
Interval

Displays the retry interval in seconds when the connection to
the LDAP server fails.

External User Group
Mapping - Number of
Retries

Displays the retry times when the connection to the LDAP
server fails.

Setup Server Displays the Setup Server window.

Kerberos Properties window

To open this window, select Kerberos in the External Authentication window.

Kerberos Properties window
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The following table describes the fields and settings used to edit the Kerberos properties.

Item Description

DNS Lookup Displays whether to search for the Kerberos server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered

in the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Realm Name Displays the default realm name.

Primary Host Name Displays the name of the Kerberos server.

Kerberos Properties window
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Item Description

Primary Port Number Displays the port number of the Kerberos server.

Clock Skew Displays the acceptable range of time difference between the
SVP and the Kerberos server.

Timeout Displays the number of seconds before connection to the
Kerberos server times out.

Secondary Host Name Displays the name of the secondary Kerberos server.

Secondary Port
Number

Displays the port number of the secondary Kerberos server.

External User Group
Mapping -
Authentication Protocol

Displays the LDAP protocol to use.

External User Group
Mapping - Primary Port
Number

Displays the port number of the LDAP server.

External User Group
Mapping - Base DN

Displays the base domain name to search for users to
authenticate.

External User Group
Mapping - Search
User's DN

Displays the search user's domain name.

External User Group
Mapping - Password

Displays asterisks (*) to mask the password of the user for
searching.

External User Group
Mapping - Timeout

Displays the number of seconds before connection to the
LDAP server times out.

External User Group
Mapping - Retry
Interval

Displays the retry interval in seconds when the connection to
the LDAP server fails.

External User Group
Mapping - Number of
Retries

Displays the retry times when the connection to the LDAP
server fails.

External User Group
Mapping - Secondary
Port Number

Displays the port number of the secondary LDAP server.

Setup Server Displays the Setup Server window.

Kerberos Properties window
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Setup Server for LDAP

LDAP Setup Server window

To open this window, select LDAP in the Select Authentication Server window.

The following table describes the fields and settings used to edit the server information.

Item Description

Certificate File Name Specify a certificate file. Click Browse to find the file.

Setup Server for LDAP
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Item Description

DNS Lookup Specify whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered

in the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Authentication Protocol Specify an LDAP protocol to use. Available protocols are as
follows.
■ LDAP over SSL/TLS
■ STARTTLS

If you select Enable in DNS Lookup, you cannot select LDAP
over SSL/TLS.

External User Group
Mapping

Specify whether to connect an authentication server to an
authorization server.
■ Enable: Connects an authentication server to an

authorization server.
■ Disable: Does not connect an authentication server to an

authorization server.

External User Group
Mapping - Host Name

Specify a host name of the LDAP server.

ASCII code characters, hyphens (-), and periods (.) can be
specified.

If you select Enable in DNS Lookup, this item is disabled.

External User Group
Mapping - Port Number

Specify a port number of the LDAP server.

If you select Enable in DNS Lookup, this item is disabled.

External User Group
Mapping - Domain
Name

Specify a domain name that the LDAP server manages.

You can specify ASCII code characters, hyphens (-), and
periods (.).

External User Group
Mapping - User Name
Attribute

Specify an attribute name to identify a user, such as a user
ID.

You can specify ASCII code characters and the following
symbols:

LDAP Setup Server window
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Item Description

! # $ % & ' ( ) * + , -. / : ; < = > ? @[ \ ] ^ _` {| } ~
■ Hierarchical model

Specify an attribute name where the value that can
identify a user is stored.

■ Flat model

Specify an attribute name for a user entry's RDN.

External User Group
Mapping - Timeout

Specify the number of seconds before connection to the
LDAP server times out.

External User Group
Mapping - Retry
Interval

Specify a retry interval in seconds when the connection to
the LDAP server fails.

External User Group
Mapping - Number of
Retries

Specify retry times when the connection to the LDAP server
fails.

External User Group
Mapping - Base DN

Displays the base DN to search for users to authenticate.

External User Group
Mapping - Search
User's DN

Displays the search user's domain name.

External User Group
Mapping - Password

Search for a user by specifying his password.Search for a
user by specifying his password. Specify the same password
that is registered in the LDAP server.

You can specify ASCII code characters and the following
symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you specify sAMAccountName in External User Group
Mapping - User Name Attribute, or if you select Enable in
External User Group Mapping, this item must be specified.

External User Group
Mapping - Re-enter
Password

Re-enter the password of the user group you are searching
for to confirm your entry.

You can specify ASCII code characters and the following
symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you enter any password in External User Group Mapping -
Password, you must specify this item.

LDAP Setup Server window
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Item Description

Secondary Server Specify whether to use a secondary LDAP server.
■ Enable: Uses a secondary LDAP server.
■ Disable: Does not use a secondary LDAP server.

If you select Enable in DNS Lookup, this item is disabled.

Secondary Server -
Host Name

Specify a host name of the secondary LDAP server.

You can specify ASCII code characters, hyphens (-), and
periods (.).

If you select Disable in Secondary Server, this item is
disabled.

Secondary Server -Port
Number

Specify a port number of the secondary LDAP server.

If you select Disable in Secondary Server, this item is
disabled.

Test User Name Specify a user name for a server connection test.

You can specify ASCII code characters and the following
symbols:

! # $ % & ' * + - . / = ? @ ^ _ ` { | } ~

Password Specify a password of the user name for a server connection
test.

You can specify ASCII code characters and the following
symbols:

! # $ % & ' ( ) * + , -. / : ; < = > ? @[ \ ] ^ _` { | } ~

Server Configuration
Test

Click Check to conduct a server connection test for the
authentication server and the authorization server based on
the specified settings.

Server Configuration
Test - Result

Displays a result of the server connection test for the
authentication server and the authorization server.

LDAP Setup Server window
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LDAP Setup Server confirmation window

Selected Server

Item Description

External
Authentication

Displays the type of the authentication server.
■ Disable: Does not use any authentication server. Users are

authenticated with user information registered in the SVP.
■ LDAP: Users are authenticated with user information

registered in the LDAP server.

LDAP Setup Server confirmation window
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Item Description

■ RADIUS: Users are authenticated with user information
registered in the RADIUS server.

■ Kerberos: Users are authenticated with user information
registered in the Kerberos server.

Setup Server

Item Description

Certificate File
Name

Displays the certificate file.

DNS Lookup Displays whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered in

the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Authentication
Protocol

Displays the LDAP protocol.

External User
Group Mapping

Displays whether to connect an authentication server to an
authorization server.
■ Enable: Connects an authentication server to an

authorization server.
■ Disable: Does not connect an authentication server to an

authorization server.

Primary Host Name Displays the host name of the LDAP server.

Primary Port
Number

Displays the port number of the LDAP server.

Domain Name Displays the domain name that the LDAP server manages.

User Name
Attribute

Displays the attribute name to identify a user.

Base DN Displays the base DN for searching for users to authenticate.

Search User's DN Displays the DN of a user for searching.

Password Displays asterisks (*) to mask the password of the user for
searching.

LDAP Setup Server confirmation window
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Item Description

Timeout Displays the number of seconds before connection to the LDAP
server times out.

Retry Interval Displays the retry interval in seconds when the connection to the
LDAP server fails.

Number of Retries Displays the retry times when the connection to the LDAP server
fails.

Secondary Host
name

Displays the host name of the secondary LDAP server.

Secondary Port
Number

Displays the port number of the secondary LDAP server.

Setup Server for RADIUS

RADIUS Setup Server window

To open this window, select RADIUS in the Select Authentication Server window.

Setup Server for RADIUS
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The following table describes the fields and settings used to edit server RADIUS
information.

Item Description

Authentication
Protocol

Specify a RADIUS protocol to use.
■ PAP: Password authentication protocol that transmits

plaintext user ID and password.
■ CHAP: Challenge-handshake authentication protocol that

transmits encrypted password.

Host Name Specify a name of the RADIUS server.

RADIUS Setup Server window
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Item Description

You can specify ASCII code characters, hyphens (-), and periods
(.).

Secret Specify a RADIUS secret key used for the PAP authentication or
the CHAP authentication.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

Re-enter Secret Re-enter the RADIUS secret key to confirm your entry.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

NAS Address Specify an identifier for the RADIUS server to find SVP.
■ To specify a host name, select Identifier and enter the host

name.

You can specify ASCII code characters and the following
symbols:

! " # $ % & ' ( ) * + , - . / ; : < > = ? @ [ \ ] ^ _ ( } ~
■ To specify an IPv4 address, select IPv4 and enter 4 numbers

(0-255).

For example:

XXX.XXX.XXX.XXX (X indicates a digit)

Specify only numbers. Do not specify any periods.
■ To specify an IPv6 address, select IPv6 and enter 8

hexadecimal numbers (0-FFFF).

For example:

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY (Y indicates a
hexadecimal digit)

Enter 0 to omit a segment.

Port Number Specify a port number of the RADIUS server.

Timeout Specify the number of seconds before connection to the RADIUS
server times out.

Number of Retries Specify the retry times when the connection to the RADIUS
server fails.

RADIUS Setup Server window
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Item Description

Secondary Server Specify whether to use a secondary RADIUS server and a
secondary LDAP server.
■ Enable: Uses secondary servers.
■ Disable: Does not use secondary servers.

Secondary Server -
Host Name

Specify a name of the secondary RADIUS server.

You can specify ASCII code characters, hyphens (-), and periods
(.).

If you select Disable in Secondary Server, this item is disabled.

Secondary Server -
Port Number

Specify a port number of the secondary RADIUS server.

If you select Disable in Secondary Server, this item is disabled.

External User
Group Mapping

Specify whether to connect an authentication server to an
authorization server.
■ Enable: Connects an authentication server to an

authorization server.
■ Disable: Does not connect an authentication server to an

authorization server.

External User
Group Mapping -
Certificate File
Name

Specify a certificate file. Click Browse to find the file.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
DNS Lookup

Specify whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered in

the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Authentication
Protocol

Specify an LDAP protocol to use. Available protocols are as
follows.
■ LDAP over SSL/TLS
■ STARTTLS

If you select Enable in DNS Lookup, you cannot select LDAP over
SSL/TLS.

If you select Disable in External User Group Mapping, this item is
disabled.

RADIUS Setup Server window
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Item Description

External User
Group Mapping -
Host Name

Specify a host name of the LDAP server.

You can specify ASCII code characters, hyphens (-), and periods
(.).

If you select Enable in DNS Lookup, or if you select Disable in
External User Group Mapping, this item is disabled.

External User
Group Mapping -
Port Number

Specify a port number of the LDAP server.

If you select Enable in DNS Lookup, or if you select Disable in
External User Group Mapping, this item is disabled.

External User
Group Mapping -
Domain Name

Specify a domain name of the LDAP server.

You can specify ASCII code characters, hyphens (-), and periods
(.).

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Base DN

Specify a base DN to search for users to authenticate.

Available characters: Alphanumeric characters (ASCII characters)
and all symbols.
■ Hierarchical model

Specify a DN of hierarchy that includes all the targeted users
for searching.

■ Flat model

Specify a DN of hierarchy that is one level up of the targeted
user for searching.

You can enter alphanumeric characters and all symbols. Note,
however, that when you enter symbols like the following, you
need to use a backslash to escape for each symbol:

+ ; , < = > \ / "

In some cases, you may need to use a backslash and an ASCII
character to escape.
■ \ -> \5c (hexadecimal)
■ / -> \2f (hexadecimal)
■ "-> \22 (hexadecimal)

External User
Group Mapping -
Search User's DN

Search for a user by specifying a DN

Available characters: Alphanumeric characters (ASCII characters)
and all symbols.

RADIUS Setup Server window
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Item Description

If you specify sAMAccountName in External User Group Mapping
- User Name Attribute, or if you select Enable in External User
Group Mapping, this item must be specified.

You can enter alphanumeric characters and all symbols. Note,
however, that when you enter symbols like the following, you
need to use a backslash to escape for each symbol:

+ ; , < = > \ / "

In some cases, you may need to use a backslash and an ASCII
character to escape.
■ \ -> \5c (hexadecimal)
■ / -> \2f (hexadecimal)
■ "-> \22 (hexadecimal)

External User
Group Mapping -
Password

Search for a user by specifying his password. Specify the same
password that is registered in the LDAP server.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Re-enter Password

Re-enter the password of the user you are searching for to
confirm your entry.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you enter any password in External User Group Mapping -
Password, you must specify this item.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Timeout

Specify the number of seconds before connection to the LDAP
server times out.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Retry Interval

Specify a retry interval in seconds when the connection to the
LDAP server fails.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Number of Retries

Specify retry times when the connection to the LDAP server fails.

RADIUS Setup Server window
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Item Description

If you select Disable in External User Group Mapping, this item is
disabled.

Test User Name Specify a user name for a server connection test.

You can specify ASCII code characters and the following symbols:

! # $ % & ' * + - . / = ? @ ^ _ ` { | } ~

Password Specify a password of the user name for a server connection
test.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + , -. / : ; < = > ? @[ \ ] ^ _` { | } ~

Server
Configuration Test

Click Check to conduct a server connection test for the
authentication server and the authorization server based on the
specified settings.

Server
Configuration Test -
Result

Displays a result of the server connection test for the
authentication server and the authorization server.

RADIUS Setup Server window
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RADIUS Setup Server confirmation window

Selected Server

The following table describes the fields and settings in the Server section of the
confirmation window for (RADIUS Setup Server) window.

Item Description

External
Authentication

Displays the type of the authentication server.
■ Disable: Does not use any authentication server. Users are

authenticated with user information registered in the SVP.
■ LDAP: Users are authenticated with user information

registered in the LDAP server.
■ RADIUS: Users are authenticated with user information

registered in the RADIUS server.
■ Kerberos: Users are authenticated with user information

registered in the Kerberos server.

RADIUS Setup Server confirmation window
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Setup Server

The following table describes the fields and settings in the Setup Server section of the
confirmation window for (RADIUS Setup Server) window.

Item Description

Authentication
Protocol

Displays the RADIUS protocol to use.
■ PAP: Password authentication protocol that transmits

plaintext user ID and password.
■ CHAP: Challenge-handshake authentication protocol that

transmits encrypted password.

Primary Host Name Displays the name of the RADIUS server.

Secret Displays asterisks (*) to mask the RADIUS secret key used for the
PAP authentication or the CHAP authentication.

NAS Address Displays the identifier for the RADIUS server to find SVP.

Primary Port
Number

Displays the port number of the RADIUS server.

Timeout Displays the number of seconds before connection to the
RADIUS server times out.

Number of Retries Displays the retry times when the connection to the RADIUS
server fails.

Secondary Host
Name

Displays the name of the secondary RADIUS server.

Secondary Port
Number

Displays the port number of the secondary RADIUS server.

External User
Group Mapping -
Certificate File
Name

Displays the certificate file.

External User
Group Mapping -
Authentication
Protocol

Displays the LDAP protocol to use.

External User
Group Mapping -
DNS Lookup

Displays whether to search for the LDAP server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered in

the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

RADIUS Setup Server confirmation window
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Item Description

External User
Group Mapping -
Host Name

Displays the LDAP server host name

External User
Group Mapping -
Port Number

Displays the LDAP server port number

External User
Group Mapping -
Domain Name

Displays the LDAP server domain name.

External User
Group Mapping -
Base DN

Displays the base DN to search for users to authenticate.

External User
Group Mapping -
Search User's DN

Displays the user's DN for searching.

External User
Group Mapping -
Password

Displays asterisks (*) to mask the password of the user for
searching.

External User
Group Mapping -
Timeout

Displays the number of seconds before connection to the LDAP
server times out.

External User
Group Mapping -
Retry Interval

Displays the retry interval in seconds when the connection to the
LDAP server fails.

External User
Group Mapping -
Number of Retries

Displays the retry times when the connection to the LDAP server
fails.

Setup Server for Kerberos

Kerberos Setup Server window

To open this window, select Kerberos in the Select Authentication Server window.

Setup Server for Kerberos
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The following table describes the fields and settings in the Setup Server section of
Kerberos window.

Item Description

DNS Lookup Specify whether to search for the Kerberos server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered in

the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Realm Name Specify a default realm name.

Kerberos Setup Server window
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Item Description

You can specify ASCII code characters and hyphens (-).

Host Name Specify a host name of the Kerberos server.

You can specify ASCII code characters, hyphens (-), and periods
(.).

If you select Enable in DNS Lookup, this item is disabled.

Port Number Specify a port number of the Kerberos server.

If you select Enable in DNS Lookup, this item is disabled.

Clock Skew Specify an acceptable range of time difference between the SVP
and the Kerberos server.

Timeout Specify the number of seconds before connection to the
Kerberos server times out.

Secondary Server Specify whether to use a secondary Kerberos server.
■ Enable: Uses the secondary server.
■ Disable: Does not use the secondary server.

If you specify Enable in DNS Lookup, this item is disabled.

Secondary Server -
Host Name

Specify a name of the secondary Kerberos server.

You can specify ASCII code characters, hyphens (-), and periods
(.).

If you select Enable in DNS Lookup, or if you select Disable in
Secondary Server, this item is disabled.

Secondary Server -
Port Number

Specify a port number of the secondary Kerberos server.

If you select Enable in DNS Lookup, or if you select Disable in
Secondary Server, this item is disabled.

External User
Group Mapping

Specify whether to connect an authentication server to an
authorization server.
■ Enable: Connects an authentication server to an

authorization server.
■ Disable: Does not connect an authentication server to an

authorization server.

External User
Group Mapping -
Certificate File
Name

Specify a certificate file. Click Browse to find the file.

If you select Disable in External User Group Mapping, this item is
disabled.

Kerberos Setup Server window
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Item Description

External User
Group Mapping -
Authentication
Protocol

Specify an LDAP protocol to use. Available protocols are:
■ LDAP over SSL/TLS
■ STARTTLS

If you select Enable in DNS Lookup, you cannot select LDAP over
SSL/TLS.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Primary Port
Number

Specify a port number of the LDAP server.

If you select Enable in DNS Lookup, or if you select Disable in
External User Group Mapping, this item is disabled.

External User
Group Mapping -
Secondary Port
Number

Specify a port number of the secondary LDAP server.

If you select Disable in Secondary Server, Enable in DNS Lookup,
or External User Group Mapping fields, this item is disabled.

External User
Group Mapping -
Base DN

Specify a base DN to search for users to authenticate.

Available characters: Alphanumeric characters (ASCII characters)
and all symbols.
■ Hierarchical model

Specify a DN of hierarchy that includes all the targeted users
for searching.

■ Flat model

Specify a DN of hierarchy that is one level up of the targeted
user for searching.

You can enter alphanumeric characters and all symbols. Note,
however, that when you enter symbols like the following, you
need to use a backslash to escape for each symbol:

+ ; , < = > \ / "

In some cases, you may need to use a backslash and an ASCII
character to escape.
■ \ -> \5c (hexadecimal)
■ / -> \2f (hexadecimal)
■ "-> \22 (hexadecimal)

External User
Group Mapping -
Search User's DN

Search for a user by specifying a DN

Available characters: Alphanumeric characters (ASCII characters)
and all symbols.

Kerberos Setup Server window
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Item Description

If you specify sAMAccountName in External User Group Mapping
- User Name Attribute, or if you select Enable in External User
Group Mapping, this item must be specified.

If you select Disable in External User Group Mapping, this item is
disabled.

You can enter alphanumeric characters and all symbols. Note,
however, that when you enter symbols like the following, you
need to use a backslash to escape for each symbol:

+ ; , < = > \ / "

In some cases, you may need to use a backslash and an ASCII
character to escape.
■ \ -> \5c (hexadecimal)
■ / -> \2f (hexadecimal)
■ "-> \22 (hexadecimal)

External User
Group Mapping -
Password

Search for a user by specifying his password. Specify the same
password that is registered in the LDAP server.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Re-enter Password

Re-enter the password of the user you are searching for to
confirm your entry.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + - . = @ \ ^ _ |

If you enter any password in External User Group Mapping -
Password, you must specify this item.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Timeout

Specify the number of seconds before connection to the LDAP
server times out.

If you select Disable in External User Group Mapping, this item is
disabled.

External User
Group Mapping -
Retry Interval

Specify a retry interval in seconds when the connection to the
LDAP server fails.

If you select Disable in External User Group Mapping, this item is
disabled.

Kerberos Setup Server window
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Item Description

External User
Group Mapping -
Number of Retries

Specify retry times when the connection to the LDAP server fails.

If you select Disable in External User Group Mapping, this item is
disabled.

Test User Name Specify a user name for a server connection test.

You can specify ASCII code characters and the following symbols:

! # $ % & ' * + - . / = ? @ ^ _ ` { | } ~

Password Specify a password of the user name for a server connection
test.

You can specify ASCII code characters and the following symbols:

! # $ % & ' ( ) * + , -. / : ; < = > ? @[ \ ] ^ _` { | } ~

Server
Configuration Test

Click Check to conduct a server connection test for the
authentication server and the authorization server based on the
specified settings.

Server
Configuration Test -
Result

Displays a result of the server connection test for the
authentication server and the authorization server.

Kerberos Setup Server window
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Kerberos Setup Server confirmation window

Selected Server

The following table describes the fields and settings in the Server section of the
confirmation window for Kerberos Setup Server).

Item Description

External
Authentication

Displays the type of the authentication server.
■ Disable: Does not use any authentication server. Users are

authenticated with user information registered in the SVP.
■ LDAP: Users are authenticated with user information

registered in the LDAP server.
■ RADIUS: Users are authenticated with user information

registered in the RADIUS server.
■ Kerberos: Users are authenticated with user information

registered in the Kerberos server.

Kerberos Setup Server confirmation window
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Setup Server

The following table describes the fields and settings in the Setup Server section of the
confirmation window for Kerberos Setup Server.

Item Description

DNS Lookup Displays whether to search for the Kerberos server using the
information registered in the SRV records in the DNS server.
■ Enable: Performs the search using information registered in

the SRV records in the DNS server.
■ Disable: Performs the search using the host name and the

port number.

Realm Name Displayed the default realm name.

Primary Host Name Displays the name of the Kerberos server.

Primary Port
Number

Displays the port number of the Kerberos server.

Clock Skew Displays the acceptable range of time difference between the
SVP and the Kerberos server.

Timeout Displays the number of seconds before connection to the
Kerberos server times out.

Secondary Host
Name

Displays the name of the secondary Kerberos server.

Secondary Port
Number

Displays the port number of the secondary Kerberos server.

External User
Group Mapping -
Certificate File
Name

Displays the certificate file.

External User
Group Mapping -
Authentication
Protocol

Displays the LDAP protocol to use.

External User
Group Mapping -
Primary Port
Number

Displays the port number of the LDAP server.

External User
Group Mapping -
Base DN

Displays the base DN to search for users to authenticate.

Kerberos Setup Server confirmation window
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Item Description

External User
Group Mapping -
Search User's DN

Displays the search user's domain name.

External User
Group Mapping -
Password

Displays asterisks (*) to mask the password of the user for
searching.

External User
Group Mapping -
Timeout

Displays the number of seconds before connection to the LDAP
server times out.

External User
Group Mapping -
Retry Interval

Displays the retry interval in seconds when the connection to the
LDAP server fails.

External User
Group Mapping -
Number of Retries

Displays the retry times when the connection to the LDAP server
fails.

External User
Group Mapping -
Secondary Port
Number

Displays the port number of the secondary LDAP server.

Kerberos Setup Server confirmation window
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Appendix B:  Device Manager - Storage
Navigator licenses GUI reference

This section describes the Device Manager - Storage Navigator windows that you use to
view and manage the licenses for the software applications on your storage system.

License Keys window

Use the License Keys window to install and uninstall license keys.

Summary

The following table describes the fields and settings in the Summary section of the
License Keys window.

Item Description

Mounted capacity Displays the capacity of internal and external volumes
created in the storage system. When you install the software
whose license capacity type is Mounted Capacity, install
more license capacity than the mounted capacity to keep the
software in Installed status. Values are rounded up to the
second decimal place.
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Item Description

Number of License
Keys

Numbers of license keys are displayed for each status.

License Keys

The following table describes the fields and settings in the License Keys section of the
License Keys window.

Item Description

Program Product Name Name of the software application

Status The current status of the software
■ Installed: The software is available.
■ Installed (Disabled): Installation is complete, but the

license is set to Disabled. This status might appear if an
error occurs after you install software. Resolve the error
and enable the license. This status also appears when the
license key of this software is installed but the license key
of the prerequisite software has expired.

■ Not Installed: The software is not installed.
■ Not Enough License: Installation is complete, but the

license capacity is insufficient. Not Enough License might
remain displayed when the licensed capacity exceeds the
mounted capacity after you reduce the number of LDEVs,
or when the licensed capacity exceeds the used capacity
after you delete pairs or pool volumes. In these cases, you
can update the license status by selecting Update License
Status and then installing the software.

■ Grace Period: The licensed capacity is insufficient because
LDEVs are added, or copy pairs are created, or pool
volumes are added. The license expires in 30 days. Please
purchase the licenses before the license key expires.
Grace Period might remain displayed when the licensed
capacity exceeds the mounted capacity after you reduce
the number of LDEVs, or when the licensed capacity
exceeds the used capacity after you delete pairs or pool
volumes. In these cases, you can update the license status
by selecting Update License Status and then installing the
software.

■ Expired: The term has already expired for the temporary
key. When the status is Expired, you cannot re-install the
temporary key.

License Keys window
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Item Description

Key Type The license key type:
■ permanent
■ term
■ temporary
■ emergency

This field is blank if no license key is installed.

Licensed Capacity ■ Permitted (TB): Displays the permitted volume capacity
for this software in integers. If no upper limit value is set
for the capacity, "Unlimited" displays. This field is blank if
no license is installed.

■ Used (TB): Capacity of the volumes used by the software.
Up to the second decimal place is displayed. The third
decimal place is rounded up. If the license capacity type is
other than Used, a hyphen (-) displays. If no license is
installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1k byte = 1,024 bytes, 1M byte = 1,024 kilobytes, 1G byte =
1,024 megabytes, 1T byte = 1,024 gigabytes

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Install Licenses Opens the Install Licenses window

Uninstall Licenses Opens the Uninstall Licenses window

Enable Opens the Enable Licenses window

Disable* Opens the Disable Licenses window

Update License Status* Opens the Update License Status window

Export* Displays a window that shows the information in the table

* Appears when you click More Actions.

License Keys window
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Install Licenses wizard

This topic describes the Install Licenses wizard.

Install Licenses window

Item Description

License Key Select whether to enter a key code or specify a license key
file.
■ Key Code: Enter a key code to install the software. Use the

license key code for the software to be installed.
■ File: Specify a license key file to install software. Click

Browse and specify the license key file.

Add button Adds the specified license key to the Selected License Keys
table.

Install Licenses wizard
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Selected License Keys

Item Description

Program Product Name Name of the software application

Status The current status of the software
■ Installed: The software is available.
■ Installed (Disabled): Installation is complete, but the

license is set to Disabled. This status might appear if an
error occurs after you install software. Resolve the error
and enable the license. This status also appears when the
license key of this software is installed but the license key
of the prerequisite software has expired.

■ Not Installed: The software is not installed.
■ Not Enough License: Installation is complete, but the

license capacity is insufficient. Not Enough License might
remain displayed when the licensed capacity exceeds the
mounted capacity after you reduce the number of LDEVs,
or when the licensed capacity exceeds the used capacity
after you delete pairs or pool volumes. In these cases, you
can update the license status by selecting Update License
Status and then installing the software.

■ Grace Period: The licensed capacity is insufficient because
LDEVs are added, or copy pairs are created, or pool
volumes are added. The license expires in 30 days. Please
purchase the licenses before the license key expires.
Grace Period might remain displayed when the licensed
capacity exceeds the mounted capacity after you reduce
the number of LDEVs, or when the licensed capacity
exceeds the used capacity after you delete pairs or pool
volumes. In these cases, you can update the license status
by selecting Update License Status and then installing the
software.

■ Expired: The term has already expired for the temporary
key. When the status is Expired, you cannot re-install the
temporary key.

Key Type The license key type:
■ permanent
■ term
■ temporary
■ emergency

This field is blank if no license key is installed.

Install Licenses window
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Item Description

Licensed Capacity ■ Permitted (TB): The window displays the permitted
volume capacity for this software in integers. If no upper
limit value is set for the capacity, "Unlimited" displays.
This field is blank if no license is installed.

■ Used (TB): This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1k byte = 1,024 bytes, 1M byte = 1,024 kilobytes, 1G byte =
1,024 megabytes, 1T byte = 1,024 gigabytes

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Enable Installs license keys in Enabled status. You can select more
than one software product.

Disable Installs license keys in Disabled status. You can select more
than one software product.

Clear All Deletes all license keys from the Selected License Keys table.

Install Licenses window
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Install Licenses confirmation window

This topic describes the Install Licenses confirmation window.

Item Description

Program Product Name Name of the software application

Status Displays the software's installation status.

See the Status item in the Selected License Keys table in the
section Install Licenses window (on page 315) .

Key Type The license key type:
■ permanent
■ term
■ temporary
■ emergency

This field is blank if no license key is installed.

Install Licenses confirmation window
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Item Description

Licensed Capacity ■ Permitted (TB): The window displays the permitted
volume capacity for this software in integers. If no upper
limit value is set for the capacity, "Unlimited" displays.
This field is blank if no license is installed.

■ Used (TB): This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1k byte = 1,024 bytes, 1M byte = 1,024 kilobytes, 1G byte =
1,024 megabytes, 1T byte = 1,024 gigabytes

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Enable Licenses window

This section describes the Enable Licenses window.

Enable Licenses window
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The following table describes the fields and settings in the Enable Licenses window.

Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Status
item in the Selected License Keys table in the section Install
Licenses window (on page 315) .

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

Enable Licenses window
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Item Description

Licensed Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Disable Licenses window

This section describes the Disable Licenses window.

Disable Licenses window
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The following table describes the fields and settings in the Disable Licenses window.

Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Status
item in the Selected License Keys table in the section Install
Licenses window (on page 315) .

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

Disable Licenses window
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Item Description

Licensed Capacity (TB) ■ Permitted: The window displays the permitted volume
capacity for this software in integers. If no upper limit
value is set for the capacity, "Unlimited" displays. This
field is blank if no license is installed.

■ Used: This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Remove Licenses window

This topic describes the Remove Licenses window.

Remove Licenses window
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Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Status
item in the Selected License Keys table in the section Install
Licenses window (on page 315) .

Key Type The license key type:
■ Permanent
■ Term
■ Temporary
■ Emergency

This field is blank if no license key is installed.

Remove Licenses window
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Item Description

Licensed Capacity ■ Permitted (TB): The window displays the permitted
volume capacity for this software in integers. If no upper
limit value is set for the capacity, "Unlimited" displays.
This field is blank if no license is installed.

■ Used (TB): This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1 KB= 1,024 bytes, 1 MB = 1,024 KB, 1 GB = 1,024 MB, 1
TB= 1,024 GB

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
A hyphen (-) displays if the If there is no limit on validity, a
hyphen (-) displays. This field is blank if no license is installed.

Update License Status window

This topic describes the Update License Status window.

Update License Status window
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The following table describes the fields and settings in the Update License Status
window.

Item Description

Program Product Name Name of the software application

Status Displays the software's installation status. See the Status
item in the Selected License Keys table in the section Install
Licenses window (on page 315) .

Key Type The license key type:
■ permanent
■ term
■ temporary
■ emergency

This field is blank if no license key is installed.

Update License Status window
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Item Description

Licensed Capacity ■ Permitted (TB): The window displays the permitted
volume capacity for this software in integers. If no upper
limit value is set for the capacity, "Unlimited" displays.
This field is blank if no license is installed.

■ Used (TB): This is the capacity of the volumes used by the
software. Up to the second decimal place is displayed.
The third decimal place is rounded up. If the license
capacity type is other than Used, a hyphen (-) displays. If
no license is installed, a blank displays.

Licensed capacity displayed is found from calculations
based on the following:

1k byte = 1,024 bytes, 1M byte = 1,024 kilobytes, 1G byte =
1,024 megabytes, 1T byte = 1,024 gigabytes

Term (days) The number of days remaining before the expiration of a
temporary key, an emergency key, or a term key. After the
temporary key has expired, the column shows the number of
days that remain before you can reinstall the temporary key.
If there is no limit on validity, a hyphen (-) displays. This field
is blank if no license is installed.

Update License Status window
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Appendix C:  Configuring storage systems GUI
reference

This section describes the Device Manager - Storage Navigator windows and wizards that
you use to configure storage systems.

Login Message window

The following table describes the fields and settings in the Login Message window.

Item Description

Login Message Enter a login message. You can use up to 2,048 alphanumeric
characters (ASCII codes) and symbols.
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Edit Storage System wizard

Edit Storage System window

The following table describes the fields and settings in the Edit Storage System window.

Item Description

Storage System
Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system.

Location Location of the connected storage system.

Edit Storage System wizard

Appendix C: Configuring storage systems GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 329



Edit Storage System confirmation window

The following table describes the fields and settings in the Confirm window (Edit Storage
System).

Item Description

Storage
System Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where you can
inquire about the storage system.

Location Location of the connected storage system.

Edit Alert Settings wizard

This section describes the Edit Alert Settings wizard.

Edit Storage System confirmation window
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Edit Alert Settings window

Item Description

Notification Alert Select the destination of the alert notification.
■ All: Sends alerts of all SIMs.
■ Host Report: Sends alerts only of SIMs that report to hosts.

Alert destinations are common to Syslog, SNMP, and Email.

Syslog tab

The following table describes the fields and settings in the Syslog tab.

Edit Alert Settings window
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Item Description

Transfer Protocol Select the protocol for Syslog transfer.
■ New Syslog Protocol (TLS1.2/RFC5424)
■ Old Syslog Protocol (UDP/RFC3164)

Primary Server Select whether or not to use the Syslog Server.
■ Enable: Reports SIM to the Syslog Server through Syslog.
■ Does not report SIM to the Syslog Server through Syslog.

Primary Server -

Server Setting

Enter the IP address of the server that you want to set as the Syslog
Server. You cannot set an address with all 0s.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF).

Use this field only when you select Enable in Primary Server.

Primary Server - Port
Number

Enter the port number used by the Syslog Server. Use this field only
when you selected Enable in Primary Server.

Primary Server - Client
Certificate File Name

Specify a certificate file. Click Browse and specify the certificate file. Use
this field only when you select New Syslog Protocol (TLS1.2/RFC5424) in
Transfer Protocol and selected Enable in Primary Server.

Primary Server -
Password

Enter a password for the client certificate. You can enter up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specified Client Certificate File Name.

Primary Server - Root
Certificate File Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select New Syslog Protocol (TLS1.2/
RFC5424) in Transfer Protocol and selected Enable in Primary Server.

Secondary Server Select whether or not to use an alternate server for the Syslog Server.
■ Enable: Reports SIM to the alternate server for the Syslog Server

through Syslog.
■ Disable: Does not report SIM to the alternate server for the Syslog

Server through Syslog.

Edit Alert Settings window

Appendix C: Configuring storage systems GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 332



Item Description

Secondary Server -
Server Setting

Enter the IP address of the server that you want to set as the Syslog
Server. You cannot set an address with all 0s.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF).

Use this field only when you select Enable in Secondary Server.

Secondary Server - Port
Number

Specify a certificate file. Click Browse and specify the certificate file. Use
this field only when you select New Syslog Protocol (TLS1.2/RFC5424) in
Transfer Protocol and select Enable in Secondary Server.

Secondary Server -
Client Certificate File
Name

Specify a certificate file. Click Browse and specify the certificate file. Use
this field only when you select New Syslog Protocol (TLS1.2/RFC5424) in
Transfer Protocol and selected Enable in Secondary Server.

Secondary Server -
Password

Enter a password for the client certificate. You can enter up to 128
alphanumeric characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Use this field only when you specify Client Certificate File Name.

Secondary Server - Root
Certificate File Name

Specify a certificate file. Click Browse and specify the certificate file.

Use this field only when you select New Syslog Protocol (TLS1.2/
RFC5424) in Transfer Protocol and selected Enable in Secondary Server.

Location Identification
Name

Enter a name for identification of the storage system for which SIM is
transferred to the Syslog Server. You can enter up to 32 alphanumeric
characters and the following symbols:

! # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

Spaces are not allowed.

Timeout Enter a value as the time before the timeout for connection to the
Syslog Server is detected. The default is 10.

Use this field only when you selected New Syslog Protocol (TLS1.2/
RFC5424) in Transfer Protocol.

Retry Interval Enter a value between 1 and 60 (seconds) as the retry interval when
communication with the Syslog Server fails. The default is 1.Use this
field only when you selected New Syslog Protocol (TLS1.2/RFC5424) in
Transfer Protocol.
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Number of Retries Enter a value between 1 and 50 as the number of retries when
communication with the Syslog Server fails. The default is 3.Use this
field only when you selected New Syslog Protocol (TLS1.2/RFC5424) in
Transfer Protocol.

Send Test Message to
Syslog Server

Reports SIM for test with Syslog.

Reset settings Cancels the changes within the tab

SNMP tab (when the SNMP protocol version is SNMP v1 or SNMP v2c)

The following table describes the fields and settings in the SNMP tab when the SNMP
protocol version is v1 or v2c.
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Item Description

SNMP Agent Select whether to use the SNMP agent.
■ Enable: Reports SIM through SNMP trap that permits GET REQUEST,

GETNEXT REQUEST, and GETBULK REQUEST*

■ Disable: Does not report SIM through SNMP or permit GET REQUEST,
GETNEXT REQUEST, or GETBULK REQUEST*

SNMP Version Select the SNMP protocol version.

Sending Trap Setting Displays, in the Registered Sending Trap Settings table, the user names
and IP addresses for which SNMP trap information is reported.
■ Community: Displays the community for which SNMP trap

information is reported.
■ Send Trap to: Displays the IP address to which SNMP trap

information is reported
■ Add: Opens the Add Sending Trap Setting window. You can register

up to 32 communities.
■ Change: To change a community, select it, and then click this button

to open the Change Sending Trap Setting window.
■ Delete: To delete a community, select it, and then click this button.

Request Authentication
Setting

Displays, in the Registered Request Authentication Settings table, the
community names and IP addresses that permit GET REQUEST,
GETNEXT REQUEST and GETBULK REQUEST*.
■ Community: Displays the community names that permit GET

REQUEST, GETNEXT REQUEST, and GETBULK REQUEST*
■ Requests Permitted: Displays the IP addresses that permit GET

REQUEST, GETNEXT REQUEST, and GETBULK REQUEST*
■ Add: The Add Request Authentication Setting window opens. You can

register up to 32 communities.
■ Change: To change a community, select it, and then click this button.
■ Delete: To delete a community, select it, and then click this button

System Group
Information - Storage
System Name

Enter the storage system name. You can enter up to 180 alphanumeric
characters and symbols, except for the following:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Caution: Make sure to document the information about the storage
system because the settings will be cleared when the SVP is replaced.

System Group
Information - Contact

Enter the administrator's name or contact information. You can enter up
to 180 alphanumeric characters and symbols, except for the following:

Edit Alert Settings window
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Item Description

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

System Group
Information - Location

Specify a location of the storage system. You can enter up to 180
alphanumeric characters and symbols, except for the following:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

SNMP Engine ID Displays the SNMP engine identifier.

Send Test SNMP Trap Reports test trap to IP addresses that are already registered in the
storage system.

Note: Trap is reported using the content applied previously to the
storage system rather than the current settings in the SNMP tab. Before
reporting test trap, click Finish to apply the changes to the storage
system.

Reset settings Cancels the changes within the tab.

* Only SNMP v2c supports GETBULK REQUEST.

SNMP tab (when the SNMP protocol version is SNMP v3)

The following table describes the fields and settings in the SNMP tab when the SNMP
protocol version is v3.
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Item Description

SNMP Agent Select whether to use the SNMP agent.
■ Enable: Reports SIM through SNMP trap that permits GET REQUEST,

GETNEXT REQUEST, and GETBULK REQUEST
■ Disable: Does not report SIM through SNMP or permit GET REQUEST,

GETNEXT REQUEST, or GETBULK REQUEST

SNMP Version Select the SNMP protocol version.

Sending Trap Setting Displays, in the Registered Sending Trap Settings table, the community
names and IP addresses for which SNMP trap information is reported.
■ Send Trap to: Displays the IP address to which SNMP trap

information is reported
■ User Name: Displays the user used for reporting SNMP trap

information
■ Authentication - Mode: Displays whether authentication is enabled
■ Authentication - Protocol: If authentication is enabled, the

authentication method is displayed
■ Encryption - Mode: Displays whether encryption is enabled
■ Encryption - Protocol: If encryption is enabled, the encryption

method is displayed
■ Add: Opens the Add Sending Trap Setting window. You can register

up to eight IP addresses.
■ Change: To change a destination, select it, and then click this button

to open the Change Sending Trap Setting window.
■ Delete: To delete a destination, select it, and then click this button.
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Item Description

Request Authentication
Setting

Displays the user name that permit GET REQUEST, GETNEXT REQUEST
and GETBULK REQUEST, in the Registered Request Authentication
Settings table.
■ User Name: Displays the user names that permit GET REQUEST,

GETNEXT REQUEST, and GETBULK REQUEST
■ Authentication - Mode: Displays whether authentication is enabled
■ Authentication - Protocol: If authentication is enabled, the

authentication method is displayed
■ Encryption - Mode: Displays whether encryption is enabled
■ Encryption - Protocol: If encryption is enabled, the encryption

method is displayed
■ Add: Opens the Add Request Authentication Setting window. You

can register up to 8 users.
■ Change: To change a user, select it, and then click this button to open

the Change Request Authentication Setting window.
■ Delete: To delete a user, select it, and then click this button.

System Group
Information - Storage
System Name

Enter the storage system name. You can enter up to 180 alphanumeric
characters and symbols, except for the following:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Caution: Make sure to document the information about the storage
system because the settings will be cleared when the SVP is replaced.

System Group
Information - Contact

Enter the administrator's name or contact information. You can enter up
to 180 alphanumeric characters and symbols, except for the following:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

System Group
Information - Location

Specify a location of the storage system. You can enter up to 180
alphanumeric characters and symbols, except for the following:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

SNMP Engine ID Displays the SNMP engine identifier.

Send Test SNMP Trap Reports test trap to IP addresses that are already registered in the
storage system.
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Item Description

Note: Trap is reported using the content applied previously to the
storage system rather than the current settings in the SNMP tab. Before
reporting test trap, click Finish to apply the changes to the storage
system.

Reset settings Cancels the changes within the tab.

Email tab

Item Description

Mail Notice Select whether or not to report failure information through email.
■ Enable: Reports SIM through email.
■ Disable: Does not report SIM through email.

Email Settings This field is mandatory when you selected Enable in Mail Notice.
■ Mail Address: The email address displays.
■ Attribute: Adds email addresses. The Add Address window opens.

Edit Alert Settings window
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Item Description

■ Add: Adds email addresses. The Add Address window opens
■ Change: Changes the selected email address and attribute. The

opens.

You can select more than one email address. When you select more
than one email address, you can change only attributes.

■ Delete: Deletes the selected email address. You can select more than
one email address.

Mail Address (From) Enter the source address of the email for failure information report.

You can enter up to 255 alphanumeric characters and the following
symbols:

! # $ % & ` + - * / ' ^ { } _ .

This field is mandatory when you selected Enable in Mail Notice.

Mail Address (Reply -
To)

Specify the return email address. If you specify this address, return
email from the email recipient is transmitted to the address. If you omit
this address, return email from the email recipient is transmitted to Mail
Address (From).

You can enter up to 255 alphanumeric characters and the following
symbols:

! # $ % & ` + - * / ' ^ { } _ .

Mail Server Setting -
Email Server

Enter the Email server information. You cannot set an IP address with all
0s.
■ Identifier: To specify a host name, select Identifier. You can enter a

name of up to 63 characters.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where

XXX is a number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal
number from 0 to FFFF). You can also use an IPv6 address in
abbreviated format.

This field is mandatory when you select Enable in Mail Notice.

Mail Server Setting -
SMTP Authentication

Select whether or not to perform SMTP authentication.
■ Enable: Performs SMTP authentication.
■ Disable: Does not perform SMTP authentication.

When you select Enable, enter values in Account and Password.

You can enter up to 255 alphanumeric characters and the following
symbols:

! # $ % & ` + - * / ' ^ { } _ .
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Item Description

This field is mandatory when you select Enable in Mail Notice.

Send Test Email Sends SIM for testing through email.

Reset settings Cancels the changes within the tab

Add Sending Trap Setting window (SNMP v1 or v2c)

Use the Add Sending Trap Setting window to set up an alert notification when using
SNMP v1 or SNMP v2c.

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Item Description

Community Specify the community to which SNMP traps are reported.

Add Sending Trap Setting window (SNMP v1 or v2c)
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Item Description

You can select an existing community from the pull down menu or create a new
community. You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Note: Do not include space characters at the beginning or end.

Send Trap to Specify the IP address to which SNMP traps are reported.

Select an existing IP address from the pull down menu or enter a new address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Add Sending Trap Setting window (SNMP v3)

Use the Add Sending Trap Setting window to set up an alert notification when using
SNMP v3.

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Add Sending Trap Setting window (SNMP v3)
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Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Authentication Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Add Sending Trap Setting window (SNMP v3)
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Item Description

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 180
alphanumeric characters, including the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 180 alphanumeric
characters, including the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption -
Re-enter Key

Re-enter the same key.

Change Sending Trap Setting window (SNMP v1 or v2c)

Use the Change Sending Trap Setting window to set up an alert notification when using
SNMP v1 or SNMP v2c.

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Change Sending Trap Setting window (SNMP v1 or v2c)

Appendix C: Configuring storage systems GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 344



Item Description

Community Specify the community to which SNMP traps are reported.

You can select an existing community from the pull down menu or create a new
community. You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Send Trap to Specify the IP address to which SNMP traps are reported.

Select an existing IP address from the pull down menu or enter a new address.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

■ Minus symbol: Removes the IP address in that row.
■ Add IP Address: Adds an IP address. You can add up to 32 IP addresses.

Change Sending Trap Setting window (SNMP v1 or v2c)
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Change Sending Trap Setting window (SNMP v3)

Use the Change Sending Trap Setting window to set up an alert notification when using
SNMP v3.

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Item Description

Send Trap to Specify the IP address to which SNMP traps are reported.
■ IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX (where XXX is a

number from 0 to 255)
■ IPv6: Enter a valid IPv6 address in the format

YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a hexadecimal number
from 0 to FFFF). You can also use an IPv6 address in abbreviated format.

User Name Enter the user name to be used for reporting SNMP traps.

You can enter up to 32 alphanumeric characters, excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Change Sending Trap Setting window (SNMP v3)
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Item Description

Note: Do not include space characters at the beginning or end.

Authentication Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if authentication is
enabled.

Authentication
- Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Authentication
- Password

If authentication is enabled, enter a password. The password must be 8 to 180
alphanumeric characters, including the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption Select whether to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be at least 8 alphanumeric
characters, including the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption -
Re-enter Key

Re-enter the same key.

Add Request Authentication Setting window (SNMP v1 or v2c)

Use the Add Request Authentication Setting window to set up an alert notification when
using SNMP v1 or SNMP v2c.

This window appears when you click Add on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

Community Select an existing community, or create one, permitted to execute GET
REQUEST, GETNEXT REQUEST, and GETBULK REQUEST*.

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Note: Do not include space characters at the beginning or end.

Add Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

Requests
permitted

Specify which users have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST*.
■ All: Accepts GET REQUEST, GETNEXT REQUEST, and GETBULK

REQUEST from all users.

If All is selected, the IP address information is not displayed.
■ Specific IP addresses:

● Select an existing IP address from the pull down menu or enter a
new address.

● IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX
(where XXX is a number from 0 to 255)

● IPv6: Enter a valid IPv6 address in the format
YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a
hexadecimal number from 0 to FFFF). You can also use an IPv6
address in abbreviated format.

● Minus symbol: Removes the IP address in that row.
● Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

* Only SNMP v2c supports GETBULK REQUEST.

Add Request Authentication Setting window (SNMP v3)

Use the Add Request Authentication Setting window to set up an alert notification when
using SNMP v3.

The Add Request Authentication Setting window appears when you click Add on the
SNMP tab of the Set Up Alert Notifications window if the SNMP protocol version is
SNMP v3.

Add Request Authentication Setting window (SNMP v3)
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Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Authenticati
on

Select whether to perform the authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication information is displayed only if authentication is
enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Add Request Authentication Setting window (SNMP v3)
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Item Description

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Authenticati
on - Re-
enter
Password

Re-enter the same password.

Encryption Select whether to perform the encryption
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 180
alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption -
Re-enter Key

Re-enter the same key.

Change Request Authentication Setting window (SNMP v1 or v2c)

Use the Change Request Authentication Setting window to set up an alert notification
when using SNMP v1 or SNMP v2c.

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v1 or SNMP v2c.

Change Request Authentication Setting window (SNMP v1 or v2c)
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Community Select an existing community, or create one, permitted to execute GET
REQUEST, GETNEXT REQUEST, and GETBULK REQUEST*.

You can enter up to 180 alphanumeric characters excluding the
following symbols:

\ , / ; : * ? " < > | & % ^ '

Note: Do not include space characters at the beginning or end.

Change Request Authentication Setting window (SNMP v1 or v2c)
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Item Description

Requests
Permitted

Specify which users have permission to execute GET REQUEST, GETNEXT
REQUEST, and GETBULK REQUEST*.
■ All: Accepts GET REQUEST, GETNEXT REQUEST, and GETBULK

REQUEST from all users.

If All is selected, the IP address information is not displayed.
■ Specific IP addresses:

● Select an existing IP address from the pull down menu or enter a
new address.

● IPv4: Enter a valid IPv4 address in the format XXX.XXX.XXX.XXX
(where XXX is a number from 0 to 255)

● IPv6: Enter a valid IPv6 address in the format
YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY:YYYY: (where YYYY is a
hexadecimal number from 0 to FFFF). You can also use an IPv6
address in abbreviated format.

● Minus symbol: Removes the IP address in that row.
● Add IP Address: Adds an IP address. You can add up to 32 IP

addresses.

* Only SNMP v2c supports GETBULK REQUEST.

Change Request Authentication Setting window (SNMP v3)

Use the Change Request Authentication Setting window to set up an alert notification
when using SNMP v3.

This window appears when you click Change on the SNMP tab of the Set Up Alert
Notifications window if the SNMP protocol version is SNMP v3.

Change Request Authentication Setting window (SNMP v3)
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Item Description

User Name Enter the name of the user permitted to execute GET REQUEST,
GETNEXT REQUEST, and GETBULK REQUEST.

You can enter up to 32 alphanumeric characters, excluding the following
symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Authenticati
on

Select whether to perform authentication.
■ Enable: Authentication is performed.
■ Disable: Authentication is not performed.

Authentication and encryption information is displayed only if
authentication is enabled.

Authenticati
on - Protocol

If authentication is enabled, select the authentication method.
■ SHA
■ MD5

Change Request Authentication Setting window (SNMP v3)
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Item Description

Authenticati
on -
Password

If authentication is enabled, enter a password. The password must be 8
to 180 alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Authenticati
on - Re-enter
Password

Re-enter the same password.

Encryption Select whether to perform encryption.
■ Enable: Encryption is performed.
■ Disable: Encryption is not performed.

Encryption information is displayed only if encryption is enabled.

Encryption -
Protocol

If encryption is enabled, select the encryption method.
■ AES
■ DES

Encryption -
Key

If encryption is enabled, enter a key. The key must be 8 to 180
alphanumeric characters excluding the following symbols:

\ , / ; : * ? " < > | & % ^

Note: Do not include space characters at the beginning or end.

Encryption -
Re-enter Key

Re-enter the same key.

Add Address window

Use the add address window to add an email address to the list of addresses to notify of
a system error.

Add Address window
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The following table describes the fields and settings in the Add Address window.

Item Description

Mail Address Enter an email address and select an attribute (To, Cc, or Bcc).

Email addresses can contain up to 255 alphanumeric characters,
including the following symbols: ! # $ % & ` + - * / ' ^ { } _ .

Change Settings window

Use the change settings window to change an email address.

Change Settings window
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The following table describes the fields and settings in the Change Settings window.

Item Description

Mail Address Enter an email address after change and select an attribute. You can
select more than one email address. When you select more than one
email address, you can change only attributes.

Email addresses can contain up to 255 alphanumeric characters,
including the following symbols: ! # $ % & ` + - * / ' ^ { } _ .

Change Settings window
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Edit Alert Settings confirmation window

Note: Only the tables related to the items you edited are displayed in the
confirmation window.

The following tables describe the fields and settings in the Edit Alert Settings
confirmation window

Item Description

Notification Alert Displays the destination of the alert notification.

This table describes the Syslog Server settings.

Item Description

Primary Server - Syslog
Server

Displays whether or not to use the Syslog Server

Primary Server - IP
Address

Displays the IP address of the Syslog Server

Primary Server - Port
Number

Displays the port number used by the Syslog Server

Primary Server - Client
Certificate File Name

Displays the client certificate file name

Edit Alert Settings confirmation window
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Item Description

Primary Server -
Password

Displays the client certificate password as asterisks

Primary Server - Root
Certificate File Name

Displays the root certificate file name

Secondary Server -
Syslog Server

Displays whether or not to use an alternate server for the Syslog Server

Secondary Server - IP
Address

Displays the IP address of the alternate server for the Syslog Server

Secondary Server - Port
Number

Displays the port number used by the alternate server for the Syslog
Server

Secondary Server -
Client Certificate File
Name

Displays the file name of the client certificate

Secondary Server -
Password

Displays the password of the client certificate as asterisks

Secondary Server - Root
Certificate File Name

Displays the file name of the root certificate

Location Identification
Name

Displays the name for identifying the storage system that transfers SIM
to the Syslog Server

Timeout Displays the time before the timeout for connection to the Syslog Server
is detected

Retry Interval Displays the retry interval when communication with the Syslog Server
fails

Number of Retries Displays the number of retires when communication with the Syslog
Server fails

This table describes the SNMP Information settings.

Item Description

SNMP Agent Displays whether or not to use the SNMP Agent.

System Group
Information - Storage
System Name

Displays the storage system name

System Group
Information - Contact

Displays the administrator's name or contact information

Edit Alert Settings confirmation window
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Item Description

System Group
Information - Location

Displays the storage system location

SNMP Version Displays the SNMP protocol version.

The following tables describes the Registered Sending Trap Settings for the different
SNMP protocol versions.

(when the SNMP protocol version is SNMP v1 or SNMP v2c)

Item Description

Community Displays the name of the community for which the SNMP trap
information is reported.

Send Trap to Displays the IP address to which SNMP trap information is reported.

(when the SNMP protocol version is SNMP v3)

Item Description

Send Trap to Displays the IP address to which SNMP trap information is reported.

User Name Displays the user name to which SNMP trap information is reported.

Authentication - Mode Displays whether the authentication is enabled or not.

Authentication –
Protocol

Displays the authentication method if the authentication is enabled.

Authentication –
Password

Displays the authentication password as asterisks.

Encryption - Mode Displays whether the encryption is enabled.

Encryption – Protocol Displays the encryption method if the encryption is enabled.

Encryption - Key Displays the encryption key as asterisks.

The following tables describes the Registered Request Authentication Setting for the
different SNMP protocol versions.

(when the SNMP protocol version is SNMP v1 or SNMP v2c)

Edit Alert Settings confirmation window
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Item Description

Community Displays the name of community to which GET REQUEST, GETNEXT
REQUEST, or GETBULK REQUEST is accepted.

Requests Permitted Displays the IP address to which GET REQUEST, GETNEXT REQUEST, or
GETBULK REQUEST is accepted.

(when the SNMP protocol version is SNMP v3)

Item Description

User Name Displays the user name that accepts GET REQUEST, GETNEXT REQUEST,
or GETBULK REQUEST.

Authentication - Mode Displays whether the authentication is enabled or not.

Authentication –
Protocol

Displays the authentication method if the authentication is enabled.

Authentication –
Password

Displays the authentication password as asterisks.

Encryption - Mode Displays whether the encryption is enabled.

Encryption – Protocol Displays the encryption method if the encryption is enabled.

Encryption - Key Displays the encryption key as asterisks.

The following table describes the Email Notification settings. (when the SNMP protocol
version is SNMP v3)

Item Description

Mail Notice Displays whether or not to use email to notify users of failure
information

Mail Address (From) Displays the source email address for notification of failure information.

Mail Address (Reply -
To)

Displays the email return address

Server Host Name Displays the email server host name or IP address

SMTP Authentication Displays whether or not to perform SMTP authentication.

SMTP Authentication -
Account

Displays the account used for SMTP authentication.

Edit Alert Settings confirmation window
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Item Description

SMTP Authentication -
Password

Displays the SMTP authentication password as asterisks

The following table describes the Email settings. (when the SNMP protocol version is
SNMP v3)

Item Description

Mail Address Displays the email address after the change

Attribute Displays the attribute of email for SIM notification

Column Settings window

Column Settings window
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Item Description

Restore Default
Settings

Changes the selection of the displayed columns to the factory default settings.

Checkbox Selects the columns to display.

Click the checkbox next to the name of each column that you want to display.
After making the selections, click OK. Only the columns whose checkboxes are
selected are displayed. Columns whose checkboxes are not selected are not
displayed.

Note that you cannot select the checkboxes of the columns that must always
be displayed because they are deactivated.

When you deselect a checkbox, the filter and sort settings of that column are
released. If you display the column again, you must set the filter and sort
settings again.

Column Name Displays the names of the columns in the table. If a column contains two rows,
the name of the upper row is shown on the left of the vertical bar (|). The name
of the lower row is shown on the right of the vertical bar.

Edit Advanced System Settings wizard

Edit Advanced System Settings wizard contains the following topics:
■ Edit Advanced System Settings window (on page 364)
■ Edit Advanced System Settings confirmation window (on page 366)
■ Column Settings window (on page 362)

Edit Advanced System Settings wizard
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Edit Advanced System Settings window

The following table describes the advanced system settings fields and settings in the Edit
Advanced System Settings window.

Item Description

No. Displays the number of function bits for the advanced system
settings.

Advanced System
Setting

Displays advanced system setting names.
■ Hide alert information: The Alert window is not displayed.
■ Refresh forcibly after Apply: The configuration information

for the storage system is forcibly updated after the
configuration changes are applied to the storage system.

■ Disable data polling: Polling stops.
■ Disable retry of data updating: Retry does not take place

even when you fail to acquire data.

Edit Advanced System Settings window
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Item Description

■ External Authentication Compatibility option. If you enable
this option, the authentication method is switched from VSP
G1x00 and VSP F1500 to VSP.

■ Enable reboot of background service: If you enable this
option, when either of the followings exceeds its threshold
value, the background service process for managing
configuration information is restarted. Enable this option
only when requested.
● The amount of memory used in the background service

process
● Time elapsed after the background service process is

started
■ Notify an alert when tier relocation is suspended by system:

If you enable this option, when tier relocation is suspended
by the system, an alert is issued to users. For details about
an alert (SIM) to be issued, see the Troubleshooting chapter
of the Provisioning Guide for Open Systems or Provisioning
Guide for Mainframe Systems.

■ Disable login of the same user: Set this option only when
requested.

■ Disable cache of the PP Info: Set this option only when
requested.

■ Use a unique SNMP engine ID: If you enable this option, a
unique SNMP engine ID is set. If you disable it, the fixed
value is set. When changing the settings for this option, first
set SNMP Agent to Disable, then after the completion of the
settings, set it back to Enable.

Status Displays the statuses of the advanced system settings.

Enable Enables the selected advanced system settings. You can select
more than one advanced system setting.

Disable Disables the selected advanced system settings. You can select
more than one advanced system setting.

Edit Advanced System Settings window
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Edit Advanced System Settings confirmation window

Item Description

No. Displays the number of function bits for the advanced system setting.

Advanced System
Setting

Displays the name of the advanced system setting.

Status Displays the status of the advanced system setting.

Edit Advanced System Settings confirmation window
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Edit High Temperature Mode wizard

Prerequisites
■ You must install the software and activate the license to use the high temperature

mode feature.

Edit High Temperature Mode window

Use this window to set the allowable operating temperature of the storage system.

Edit High Temperature Mode wizard
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Item Description

High Temperature Mode Enables the high temperature mode so that the
storage system can run in a high temperature
environment.
■ Enable (16-40 degrees C): Turns the high

temperature mode on.

The system can run in the temperature range of
(60.8°F to 104°F / 16°C to 40°C). A SIM is displayed
when the internal storage system temperature
exceeds 40°C.

■ Disable (16-32 degrees C):Turns the high
temperature mode off.

The system can run in the temperature range of
(60.8°F to 89.6°F / 16°C to 32°C). A SIM is displayed
when the internal storage system temperature
exceeds 32°C.

Edit High Temperature Mode confirmation window

Use this window to confirm the allowable storage system operating temperature settings
made in the Edit High Temperature Mode window.

Edit High Temperature Mode confirmation window
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Item Description

High Temperature Mode Displays the high temperature mode settings.
■ Enable (16-40 degrees C): The system operates in

high temperature mode (60.8°F to 104°F / 16°C to
40°C).

■ Disable (16-32 degrees C): The system is operating
in standard temperature mode (60.8°F to 89.6°F /
16°C to 32°C).

Edit High Temperature Mode confirmation window
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Appendix D:  Device Manager - Storage
Navigator system GUI reference

This section explains the Device Manager - Storage Navigator windows used to view and
manage storage system tasks, reports, and alerts.

Storage Systems window

Hardware summary

The following table describes the fields and settings in the hardware summary section of
the Storage Systems window.

Item Description

Edit Storage
System

Allows editing of the storage system name, contact, and location.
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Item Description

Storage
System Name

Device name of the storage system.

Contact Contact information such as personnel and telephone number where
you can inquire about the storage system.

Location Location of the connected storage system.

Storage
System Type

Model type of the storage system.

Serial Number Serial number of the storage system.

IP Address IP address of the SVP.

Microcode
Version

This item displays the version of the microcode.
■ Main: Version of the microcode installed in the connected storage

system
■ SVP: Version of the Device Manager - Storage Navigator installed in

the SVP
■ RMI Server: Version of the RMI server installed in the SVP

Total Cache
Size

Total size of the cache memory in the storage system. The capacity
used as the shared memory is not included.

Allocation summary

The following table describes the fields and settings in the allocation summary section of
the Storage Systems window.

Item Description

Internal /
External

This item switches the displayed items.
■ Total: Displays information on both the internal volumes and the

external volumes.
■ Internal Only: Displays information on only the internal volumes.
■ External Only: Displays information on only the external volumes.

Open/
Mainframe

This item switches the displayed capacity units.
■ Total: Displays all the open-systems, mainframe-systems and

multi-platform volumes
■ Open Only: Displays only open-systems volumes
■ Mainframe Only: Displays mainframe-systems and multi-platform

volumes.

Storage Systems window
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Item Description

Capacity Unit This item switches the displayed units of the capacity.
■ Appropriate: Displays the capacity in appropriate unit depending

on the capacity of each item.
■ TB/GB/MB: Displays the capacity of the specified unit.

Physical
Summary

This item displays the capacity of physical logical devices and the
number of devices. It displays different information for open-systems
and mainframe-systems. For details about this item, see the Physical
Summary table.

Virtual
Summary

This item displays capacity of virtual logical devices and the number of
devices. It displays different information for open-systems and
mainframe-systems. For details about this item, see the table below
about virtual summary.

Total Saving
(Software
Deduplication/
Software
Compression/
FMC
Compression)

Total Saving: Displays the ratio and capacity reduced by the capacity
saving function against all data in a storage system.

Software Deduplication: Displays the ratio reduced by the
deduplication function against all data in a storage system.

Note that the following data is contained in the deduplicated capacity.
Therefore, Software Deduplication might be lower than the actual
value:
■ Data in a virtual volume whose capacity saving setting is

Compression.
■ Data which is queued for deduplication processing (Not

deduplicated yet).

Software Compression: Displays the ratio reduced by the software
compression function against all data in a storage system.

FMC Compression: For the total data capacity in a storage system,
displays the ratio of before and after the FMC compression function is
executed.

Total Number
of LDEVs

The number of LDEVs. The information displayed in this field depends
on the type of system. See the following table.

Physical summary

The following table describes the fields and settings in the physical summary section of
the Storage Systems window.

Storage Systems window
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Item Description

Allocated When Open is selected from Open / Mainframe, this item displays
the capacity of path-defined open system volumes (LDEVs) and the
number of logical devices that the host can recognize. This capacity
does not include the control cylinder.

When Mainframe is selected from Open / Mainframe, this item
displays the capacity of path-defined mainframe and multiplatform
volumes and the number of logical devices that the host can
recognize. The Reserved - Used DP Pool, Reserved - Unused DP
Pool, and Reserved - Other volumes are not included. This capacity
does not include the control cylinder.

Reserved - Used
DP Pool

When Total is selected in Internal / External, this item displays the
total capacity of the pages that are actually used in pool of
Dynamic Provisioning and the number of logical devices. The total
capacity does not include the control cylinder.

For a DP pool in which Thin Image pairs are created, the total page
capacity includes the snapshot data capacity.

When an item other than Total is selected in Internal / External, this
item displays the number of logical devices that are actually used in
the Dynamic Provisioning pool. The capacity does not display in this
item, but is counted as part of Reserved - Other.

Reserved -
Unused DP Pool

When the total is selected in Internal / External, this item displays
the capacity remaining after subtracting the Used DP Pool value
from the total capacity of pool of Dynamic Provisioning. Control
cylinder is not included in the capacity. The number of logical
devices does not display.

When an item other than Total is selected in Internal / External, the
capacity and the number of logical devices are not displayed in this
item, and the capacity is counted as part of Reserved - Other.

Reserved - Other When Open is selected from Open / Mainframe, this item displays
the total capacity and the number of logical devices of the following
volumes:
■ Thin Image pool volumes
■ Journal volumes

The control cylinder is not included in the capacity.

The total capacity includes:
■ The pool-VOL capacity that is not used as pool capacity
■ The capacity of the system pool-VOL management area (approx.

4.1 GB per pool)

Storage Systems window
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Item Description

When Mainframe is selected from Open / Mainframe, this item
displays the total capacity of journal volumes and the number of
logical devices of the mainframe and multi-platform volumes.

The control cylinder is not included in the capacity.

The total capacity includes:
■ The pool-VOL capacity that is not used as pool capacity
■ The capacity of the system pool-VOL management area (approx.

3.7 GB per pool)

For both open and mainframe, when an item other than Total is
selected in Internal / External, the capacities for Reserved - Used
DP Pool and Reserved - Unused DP Pool are also counted as part of
this item.

Available Space -
Unallocated

When Open or Total is selected from Open / Mainframe, this item
displays the volume capacity and the number of logical devices
from the open volumes that are not defined paths. The Reserved -
Used DP Pool, Reserved - Unused DP Pool, and Reserved - Other
volumes are not included. The control cylinder is also not included
in the capacity.

When Mainframe is selected from Open / Mainframe, the capacity
and the number of logical devices do not display.

Available Space -
Free Space

When Open is selected from Open / Mainframe, this item displays
the free space in which users can create Open volumes.

When Mainframe is selected from Open / Mainframe, this item
displays the free space in which users can create Mainframe-
systems and multi-platform volumes.

In both Open and Mainframe, the control cylinder is not included in
the capacity, and the number of logical devices does not display.

Physical Total This item displays the total capacity of physical logical devices and
the number of logical devices. Control cylinder is not included in
the capacity.

Virtual summary

The following table describes the fields and settings in the virtual summary section of the
Storage Systems window.

Storage Systems window

Appendix D: Device Manager - Storage Navigator system GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 374



Item Description

DP Allocated * When total is selected in Internal / External, this item displays the
capacity of path-defined virtual volumes of Dynamic Provisioning,
and the number of logical devices. Virtual volumes for Thin Image
are not included. Control cylinder is not included in the capacity.

DP Unallocated* When total is selected in Internal / External, this item displays the
capacity of virtual volumes of Dynamic Provisioning that are not
path-defined, and the number of logical devices. Virtual volumes
for Thin Image are not included. Control cylinder is not included in
the capacity.

Other* When total is selected in Internal / External, the item displays the
virtual volumes of other than Dynamic Provisioning and the
number of logical devices. Control cylinder is not included in the
capacity.

Virtual Total This item displays the total capacity of virtual logical devices and
the number of logical devices. Control cylinder is not included in
the capacity.

* When an item other than Total is selected in Internal / External, the capacity and the
number of logical devices are not displayed.

Storage Systems window

Appendix D: Device Manager - Storage Navigator system GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 375



Port Condition window

You can switch between information for DKC-0 and DKC-1 through a tab. When DKC-1 is
not installed, the DKC-1 tab is not displayed.

Note:
■ Ports not allocated to the user are indicated with Not Available.
■ Except for the Condition column, there may be a difference between the

actual device configuration and the displayed information depending on
the update timing of the storage system.

Refresh: Updates the window display to the latest status.

Number of Ports

The following table describes the fields and settings in Number of Ports.

Port Condition window
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Item Description

Available
(Connected)

Number of ports in use

Available (Not
Connected)

Number of ports that are installed but not in use

Not Available Total number of ports that are installed but blocked

Not Installed Ports not installed

Port Condition

The following table describes the fields and settings in the Port Condition window.

Item Description

Channel Adapter Name of the channel adapter (channel adapter is also called a
front-end director

Adapter Type Type of the channel adapter

Port ID Port identifier

Attribute Port attribute
■ Channel adapter type is Fibre or FCoE: Initiator, Target, RCU

Target, or External
■ Channel adapter type is Mfibre: HTP or FNP
■ When no port is assigned to the user, a hyphen (-) is displayed.

Condition Port Condition icon and port status
■

 Available (Connected): The port is installed and in use.
■

 Available (Not Connected): The port is installed and
available

■ Not Available: The port is either blocked or not assigned to the
user.

Speed Data transfer speed of the port is displayed in gigabits per
second as follows:
■ 2 Gbps
■ 4 Gbps
■ 8 Gbps
■ 10 Gbps

Port Condition window
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Item Description

■ 16 Gbps
■ 32 Gbps

If Auto is set for Port Speed in the Edit Ports window, this item is
displayed as follows:
■ Auto (2 Gbps)
■ Auto (4 Gbps)
■ Auto (8 Gbps)
■ Auto (10 Gbps)
■ Auto (16 Gbps)
■ Auto (32 Gbps)

The values in the parentheses are set by the storage system. If
linkup is not made, a hyphen (-) displays.

Port speed is fixed at 10 Gbps for Fibre Channel over Ethernet
(FCoE).

For details of the Edit Ports window, see the Provisioning Guide
for Open Systems.

For information about the availability of the 32 Gbps SFPs,
contact customer support.

WWN/iSCSI Name WWN/iSCSI name of the port

Export Displays a window for outputting table information

Tasks window

Tasks window
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This window displays a list of tasks performed on the storage system. Up to 384 tasks
can display, including 256 that are Completed and/or Failed. Up to 128 tasks whose
statuses are In Progress, Waiting, and Suspended can also display.

Summary

Item Description

Completed Number of completed tasks.

In Progress Number of tasks in progress.

Waiting Number of tasks waiting.

Suspended Number of suspended tasks.

Failed Number of tasks in which an error occurred.

Tasks tab

Item Description

Task Name Task name specified by a user when the user performed the
task. Click to view the detail of the task.

Status Task status. Click to view more details about status or errors.
■

 Completed or Completed(Request): The task completed
normally.

■
 In progress: The task is being processed by the system.

■
 Waiting: The task is not yet started.

■
 Suspended: The task has been suspended.

■
 Failed: The task ended abnormally.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Start Time Date and time when the task was started.

Blank indicates the task has not started yet.

End time Date and time when the task completed.

Blank indicates the task has not completed yet.

Tasks window
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Item Description

Auto Delete Enabled: A task is automatically deleted when the following two
events occur:
■ The task is completed
■ The number of tasks in the Task list reaches the maximum

number the window can display (384)

Disabled: Tasks will remain displayed until users delete them.
Tasks whose status is Failed are automatically Disabled by the
system.

Suspend Tasks
button

Suspends the selected tasks. They will not be started even if the
storage system is ready. Only waiting tasks can be suspended.

Resume Tasks
button

Resume the selected tasks. The status goes back to waiting.

Delete Tasks button Deletes the selected tasks from the window.
■ The waiting or suspended tasks will be cancelled.
■ The failed or aborted tasks can be deleted from the window.
■ Tasks in progress cannot be deleted.
■ If the maximum number of tasks displayed on the window is

reached when Auto Delete is enabled, execution of a new
task will result in automatic deletion of a task starting with
the oldest one.

Disable Auto Delete * When disabled, the selected task remains in the task list after
the task is completed.

Enable Auto Delete * When enabled, the selected task is deleted from the Task list
when the following two events occur:
■ The task is completed
■ The number of tasks in the Task list reaches the maximum

number the window can display (384)

Export * Displays a window that shows the information in the table

* Appears when you click More Actions.

Task Properties window

This window displays details about a task performed on the storage system. The content
of the window depends on the task you executed.

Task Properties window
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Suspend Tasks window

Use this window to suspend waiting tasks.

Suspend Tasks window
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Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Resume Tasks window

Use this window to resume suspended tasks.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

Resume Tasks window
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Item Description

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Delete Tasks window

Use this window to delete tasks. If you delete a waiting task, the task will be cancelled.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name who performed the task.

Submission Time Date and time when the task was submitted.

Delete Tasks window
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Disable Auto Delete window

Use this window to prevent a task from being automatically deleted from the task
window.

Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name of the person who performed the task.

Submission Time Date and time when the task was submitted.

Enable Auto Delete window

Use this window to automatically delete completed tasks from the task window when the
number of displayed tasks reaches the maximum (384 tasks).

Disable Auto Delete window
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Item Description

Task Name Task name specified by a user when the user performed the
task.

Status Task status.

Type General name of the task.

User Name User name of the person who performed the task.

Submission Time Date and time when the task was submitted.

Edit Information Display Settings window

Use this window to change the display parameters.

Edit Information Display Settings window

Appendix D: Device Manager - Storage Navigator system GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 385



Item Description

Top Status Indicator
Refresh Interval

(Alerts, Audit log, and
Resource Lock)

Interval for the automatic updates of the icons on the upper-
right corner of the Device Manager - Storage Navigator main
window.

You can specify 10-3600 seconds. The default value is 60
seconds.

Task Screen Refresh
Interval

Interval for the automatic updates of the task window.

You can specify 10-3600 seconds, or No Update. The default
value is 60 seconds.

No Update indicates that the task window will be updated
only when a user clicks Refresh or File > Refresh All.

LUN ID Notation Select whether to display the LUN ID in decimal or
hexadecimal notation. The default is decimal. Regardless of
the setting, LUN IDs are displayed in decimal format on
Device Manager - Storage Navigator's secondary window.

Secondary windows Specify whether to enable or disable Device Manager -
Storage Navigator's secondary window.

Enable: Enables Device Manager - Storage Navigator's
secondary window.

Disable: Disables Device Manager - Storage Navigator's
secondary window.

Edit Information Display Settings window
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Reports window

This window lists configuration reports about the storage system.

You can create up to 20 reports.

Summary

Item Description

Number of Reports Number of created reports.

Reports tab

Item Description

Report Name Task name specified when users created a report. Click to view
the report in HTML format.

User Name User name of the person who created the report.

Submission Time Date and time when the report was created.

Create Configuration
Report

Creates a new report.

Download Reports Downloads the created report in both HTML and CSV format.

Delete Reports Deletes the selected report.

Export Displays a window that shows the information in the table

Window for outputting table information.

Create Configuration Report window

Use this window to create storage system configuration reports.

Reports window
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Item Description

Report Type Type of the report to be created.

Format File format.

Delete Reports window

Use this window to delete configuration reports.

Delete Reports window
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Item Description

Report Name Task name specified when users created a report.

User Name User name of the person who created the report.

Submission Time Date and time when the report was created

Alerts window

Displays the list of alerts (SIM) that occurred in the storage system.

Alerts window
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Summary

Item Description

Number of
Uncompleted Alerts

Displays the number of alerts that are not authenticated yet.
■ Acute: Displays total number of Acute level alerts that are not

authenticated yet.
■ Serious: Displays total number of Serious level alerts that are

not authenticated yet.
■ Moderate: Displays total number of Moderate level alerts that

are not authenticated yet.

Alerts window
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Item Description

■ Service: Displays total number of Service level alerts that are
not authenticated yet.

■ Total: Total number of above is displayed.

Alerts

Item Description

Error Code Displays reference code of SIM. For details about reference code,
contact the customer support.

For information about errors that need to be solved, see
Monitoring SIMs alerts in Device Manager - Storage Navigator
(on page 226) .

Date Displays the date when alerts occurred.

Error Level Displays error level of alerts.
■

Service: No need to deal with immediately. Errors that are
dealt with within periodical maintenance.

■
Moderate: No need to deal with immediately. Errors that

are dealt with within periodical maintenance.
■

Serious: Contact the customer support. Take adequate
measure as instructed, report and solve the problem.

■
Acute: Contact the customer support. Take adequate

measure as instructed, report and solve the problem.

Status If status alert remains, Uncompleted displays. If alert is removed
by SVP, Completed displays.

Detail Displays the details of alert that is selected in the list.

Alert Properties window

This window shows details of an alert (SIM) that has occurred in the storage system.

Alert Properties window
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When you select multiple alerts in the Alert window, click Back and Next to change alert
that is displayed.

Item Description

Error Code Displays reference codes of SIM. For details about reference
codes, contact the customer support. For information about
errors that need to be solved, see Monitoring SIMs alerts in
Device Manager - Storage Navigator (on page 226) .

Date Displays the date when alerts occurred.

Alert Properties window
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Item Description

Error Level Displays error level of alerts.
■

Service: No need to deal with immediately. These errors
are dealt with during periodical maintenance.

■
Moderate: No need to deal with immediately. These errors

are dealt with during periodical maintenance.
■

Serious: Contact the customer support. Take adequate
measures as instructed, report and solve the problem.

■
Acute: Contact the customer support. Take adequate

measures as instructed, report and solve the problem.

Status If status alert remains, Uncompleted displays. If alert is removed
by SVP, Completed displays.

Error Section Displays overview of the error where the alert occurred.

Error Detail Displays more detail on the error.

Location Displays where the error occurred. It differs according to the
error code.

Resource Lock Properties window

This window displays information about the user who locks the storage system.

Resource Lock Properties window
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Resource Lock Properties

Item Description

Number of Resource
Groups - Locked

Displays the number of locked resource groups.

Number of Resource
Groups - Unlocked

Displays the number of unlocked resource groups.

Resource Groups

The following table describes the items in the Resource Groups table section of the
Resource Lock Properties window.

Resource Lock Properties window
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Item Description

Resource Group Name
(ID)

Displays the name and ID of the resource group that user can
control

Status Displays the lock status of the resource groups

Locked: Locked user exists

Unlocked: Locked user does not exist

Lock User Displays the user name of the person who locked the
resource

System Displays the name of the system that the locked user is using

Lock Start Time Displays the time when the lock started

Unlock All Forcibly unlocks all locked resource groups

Virtual Storage
Machine

Displays the model type of the virtual storage machine and
serial number set for the resource group

Temperature Monitor window

Displays the temperature information for DKC and DKU.

Temperature Monitor window

Appendix D: Device Manager - Storage Navigator system GUI reference

System Administrator Guide for VSP G1x00 and VSP F1500 395



DKC Ambient Temperature table

Item Description

Chassis Type Displays the chassis ID of the storage system.

Measurement
Location

Displays the measurement location.

Ambient Temperature
(degrees C)

Displays the ambient temperature in degrees Celsius.

A hyphen (-) is displayed when the temperature information
cannot be acquired due to a unit or network failure

Export button Displays a window for outputting table information.

Temperature Monitor window
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DKU Internal Temperature table

Item Description

Chassis Type Displays the chassis ID of the storage system.

Measurement
Location

Displays the measurement location.

Internal Temperature
(degrees C)

Displays the internal temperature in degrees Celsius.

A hyphen (-) is displayed when the temperature information
cannot be acquired because the chassis is not installed, or a
unit or network failure occurred.

Export button Displays a window for outputting table information.

Temperature Monitor window
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Appendix E:  Tool Panel GUI Reference

This section describes the windows and features of the SVP Tool Panel.

Control Panel

This section describes the Tool Panel windows and controls.

Environment Parameter window

This section describes the Environment Parameter window features and controls.

Item Description

RMI time-out period This parameter specifies the time-out period for forcible
logout when a user performs no operation for a certain
period of time because of a network error, etc.

RMI time-out period for Modify This parameter specifies the time-out period for forcible
release of Modify mode when the user is in Modify
mode but does not make any changes that access the
RMI server for a certain period of time.
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Item Description

Polling period for checking exclusive
lock

This parameter specifies the polling period for
monitoring who is changing information while in Modify
mode when other users are viewing the storage system
information in View mode.

Polling period for checking obstacles This parameter specifies the time interval to monitor
failure within the storage system.

Submit Applies the environment parameters to the storage
system.

Reset Resets the environment parameter settings

Download File window

This section describes the Download File window features and controls.

Item Description

Configuration File Select the checkbox for the file to be
downloaded. Downloadable configuration files
differ according to the system configuration.

Submit Downloads the configuration file.

Reset Cancels downloading the configuration file.

Restore File window

This section describes the Restore File window features and controls.

Download File window
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Item Description

Upload File (Archive File) Click Browse... and specify the configuration file
you want to restore.

Next Displays a window for confirming the
configuration file to be restored.

Reset Cancels restoring the configuration file.

Download Dump Files window

This section describes the Download Dump Files window features and controls.

Download Dump Files window
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Item Description

Existing Dump Files Select this when you want to re-download a
previously downloaded dump file. This item
displays only when one or more compressed
dump files exist. If you have not downloaded
any dump files, this item does not display even
though you have acquired dump files via SVP.

Normal Dump Contains all information about the SVP and
minimum information about the storage
system. Select Normal Dump when there is no
fatal problem such as a problem with the
display of Device Manager - Storage Navigator.

Detail Dump Contains all information about the storage
system in addition to the content of Normal
Dump. Select this when you cannot start Device
Manager - Storage Navigator or when you check
for problems with the storage system.

Detail Dump (for DKC Performance) Contains information about I/O performance,
such as collecting Performance Monitor
information in addition to the content of Detail
Dump. Select this when you check for problems
with the I/O performance.

Next Displays a dialog box for confirm that the
downloading of the dump file can start.

Update Certificate Files window

This section describes the Update Certificate Files window features and controls.

Update Certificate Files window
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Item Description

Certificate file (.crt file) Click Browse... and specify the certificate file
(server.crt file).

Key file (.key file) Click Browse... and specify the key file
(server.key file).

Return to the default certificate Returns the SSL certificate to default.

Upload Uploads the SSL certificate.

Reset Cancels the upload of the SSL certificate.

Update Certificate Files for the SMI-S window

This section describes the Update Certificate Files for the SMI-S window features and
controls.

Update Certificate Files for the SMI-S window
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Item Description

Certificate file (.crt file) Click Browse... and specify the certificate file
(server.crt file).

Key file (.key file) Click Browse... and specify the key file
(server.key file).

Return to the default certificate Returns the SSL certificate to default.

Upload Uploads the certificate to the SMI-S provider.

Reset Cancels the upload of the SMI-S provider
certificate.

Upload Configuration Files for SMI-S window

This section describes the Upload Configuration Files for SMI-S window features and
controls.

Upload Configuration Files for SMI-S window
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Item Description

Configuration file Click Browse... and specify the configuration file
you want to upload.

Return to the default configuration Returns the SMI-S provider configuration file to
default

Upload Uploads the configuration file to SMI-S provider.

Reset Cancels the upload of the SMI-S provider
configuration file.

SMI-S Artificial Indication window

This section describes the SMI-S Artificial Indication window features and controls.

SMI-S Artificial Indication window
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Item Description

User ID Enter user ID.

Password Enter password.

Test Sends the artificial indication.

Reset Resets user ID and password.

Set or Delete Certificate File for HCS window

This section describes the Set or Delete Certificate File for HCS window features and
controls.

Item Description

Certificate file (.crt file) Click Browse... and specify the certificate file
(server.crt file).

Register Registers the certificate for HCS.

Set or Delete Certificate File for HCS window
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Item Description

Delete Deletes the certificate for HCS.

Set or Delete Certificate File for HCS window
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Appendix F:  SMI-S provider configuration file

To use this SMI-S function you must create a SMI-S provider configuration file. This
section describes the SMI-S provider configuration files.

Array-setting-01.properties file

The array-setting-01.properties file is an SMI-S provider user configuration file. This
section describes the description format and organization format of SMI-S provider user
configuration files and parameters to be defined.

File description format

The format of the array-setting-01.properties file includes the following items:
■ File format: text
■ Character code: ISO 8859-1
■ Line-end symbol: \n, \r, or \r\n
■ Comment: Line on which # or ! is the first non-space character

File organization format

The organization of the array-setting-01.properties file is shown here:

# comment line

   parameter1= parameter1_setting_value

  parameter2= parameter2_setting_value

# comment line

Parameters defined in user configuration files

The following table describes the parameters can be specified in user configuration files.
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Parameter name Description

VVolForSnapshot Specifies virtual volumes that can be used by the SMI-S
provider.

For parameter details, see VVolForSnapshot parameter (on
page 408) .

PoolIDForSnapshot Specifies pools that can be used by the SMI-S provider.

For parameter details, see PoolIDForSnapshot parameter (on
page 409) .

ResourceGroup Specifies the resource groups that the SMI-S provider can use.

For parameter details, see ResourceGroup parameter (on
page 410) .

All parameters are optional. If no value is specified for a parameter, the default value
applies. However, if you specify VVolForSnapshot, you must also specify
PoolIDForSnapshot. Also note that, If you specify ResourceGroup, VVolForSnapshot
and PoolIDForSnapshot ignored.

VVolForSnapshot parameter

Use the VVolForSnapshot parameter to specify virtual volumes that the SMI-S provider
can use when you operate Thin Image from CreateElementReplica of
HITACHI_ReplicationService.

All virtual volumes are specified by default.

Setting up the VVolForSnapshot parameter

Set up the parameter by using <RangeOfVVol> and <SingleVVol> with a comma (,) as a
delimiter:
■ <RangeOfVVol>: Specifies a range of virtual volumes
■ <SingleVVol>: Specifies a single virtual volume

<RangeOfVVol> format

<S2HexLDKC>:<S2HexCU>:<S2HexLDEV>to<E2HexLDKC>:<E2HexCU>:<E2HexLDEV>
■ <S2HexLDKC>: LDKC number (two-digit hexadecimal) of the first virtual volume in the

specified range
■ <S2HexCU>: CU number (two-digit hexadecimal) of the first virtual volume in the

specified range
■ <S2HexLDEV>: LDEV number (two-digit hexadecimal) of the first virtual volume in the

specified range
■ <E2HexLDKC>: LDKC number (two-digit hexadecimal) of the last virtual volume in the

specified range

VVolForSnapshot parameter
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■ <E2HexCU>: CU number (two-digit hexadecimal) of the last virtual volume in the
specified range

■ <E2HexLDEV>: LDEV number (two-digit hexadecimal) of the last virtual volume in the
specified range

<SingleVVol> format

<2HexLDKC>:<2HexCU>:<2HexLDEV>
■ <2HexLDKC>: LDKC number (two-digit hexadecimal) of the single virtual volume to be

specified
■ <2HexCU>: CU number (two-digit hexadecimal) of the single virtual volume to be

specified
■ <2HexLDEV>: LDEV number (two-digit hexadecimal) of the single virtual volume to be

specified

Example

VVolForSnapshot=00:00:00to00:00:FF,00:02:00,00:04:00to00:04:FF
In this example, a virtual volume having one of the following LDEV IDs is used as the
snapshot target:
■ From 00:00:00 (LDKC=0,CU=0,LDEV=0) to 00:00:FF (LDKC=0,CU=0,LDEV=255)
■ 00:02:00 (LDKC=0,CU=2,LDEV=0)
■ From 00:04:00 (LDKC=0,CU=4,LDEV=0) to 00:04:FF (LDKC=0,CU=4,LDEV=255)

PoolIDForSnapshot parameter

Use the PoolIDForSnapshot parameter to specify pools that the SMI-S provider can use
when you run Thin Image from CreateElementReplica of HITACHI_ReplicationService.

All pools are specified by default.

Setting up the PoolIDForSnapshot parameter

Set up the parameter by using <RangeOfPoolID> and <SinglePoolID> with a comma (,) as
a delimiter:
■ <RangeOfPoolID>: Specifies a range of pool IDs
■ <SinglePoolID>: Specifies a single pool ID

<RangeOfPoolID> format

<Start PoolID>to<End PoolID>
■ <Start PoolID>: ID of the first pool in the specified range
■ <End PoolID>: ID of the last pool in the specified range

PoolIDForSnapshot parameter
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<SinglePoolID> format

<PoolID>
■ <PoolID>: ID of the pool to be specified

Example

PoolIDForSnapshot=1to2,4,6to8

In this example, pools having one of the following pool IDs are used as snapshot pools:
■ 1 to 2
■ 4
■ 6 to 8

ResourceGroup parameter

Use the ResourceGroup parameter to specify resource groups that the SMI-S provider
can use.

All resource groups are specified by default.

Setting up the ResourceGroup parameter

Set up the parameter by using <RangeOfResourceGroupID> and
<SingleResourceGroupID> with a comma (,) as a delimiter:
■ <RangeOfResourceGroupID>: Specifies a range of resource group IDs
■ <SingleResourceGroupID>: Specifies a single resource group ID

<RangeOfResourceGroupID> format

<Start ResourceGroupID>to<End ResourceGroupID>
■ <Start ResourceGroupID>: ID of the first resource group in the specified range
■ <End ResourceGroupID>: ID of the last resource group in the specified range

<SingleResourceGroupID> format

<ResourceGroupID>
■ <ResourceGroupID>: ID of the resource group to be specified

Example

ResourceGroup=1to2,4,6to8
In this example, resource groups having one of the following resource group IDs are
used:
■ 1, 2, 4, 6, and 8

ResourceGroup parameter
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Appendix G:  System option modes (SOMs)

System option modes allow the storage systems to be configured to specific customer
operating requirements.

System option modes

To provide greater flexibility, the storage systems have additional operational parameters
called system option modes (SOMs) that allow you to tailor the storage system to your
unique operating requirements. The SOMs are set on the storage system by your service
representative. Review the SOMs for your storage system, and work with your service
representative to ensure that the appropriate SOMs for your operational environment
are configured on your storage system.

The following table lists and describes the SOMs for microcode version 80-06-61.

Note: The SOM information might have changed since this document was
published. For the latest SOM information, contact customer support.

Table 28 System option modes for VSP G1x00 and VSP F1500

Mode Category Description Default MCU/RCU

15 Common This SOM can reduce the host response time to be
within about 6 seconds.

ON -
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Mode Category Description Default MCU/RCU

Notes:

1. This SOM is used on a storage system where
slow or delayed drive response may affect
business operations.

2. When Dynamic Sparing or Auto Correction
Mode is used, because host I/Os conflict with
copy processing, the I/O watching time is 30
seconds even when this SOM is set to ON.

3. Even though SOM 15 is set to ON, the function
does not apply to SATA or NL-SAS drives.

4. When SOM 771 or SOM 797 is set to ON, the
setting of SOM 771/797 is prioritized for the
read I/O watching time.

5. For additional details about this SOM
(interaction with other SOMs, operational
details), contact customer support (see
SOM015 sheet).

20 TrueCopy for
Mainframe

Universal
Replicator for
Mainframe

S-VOL read only function (secondary system only).

Mode 20 = ON: The S-VOL accepts host read
operations while the pair is split.

Mode 20 = OFF (default): The S-VOL does not
accept host read operations while the pair is split.

OFF RCU

22 Common Regarding the correction copy or the drive copy, in
case ECCs/LRC PINs are set on the track of copy
source HDD, SOM 22 can be used to interrupt the
copy processing (default) or to create ECCs/LRC
PINs on the track of copy target HDD to continue
the processing.

Mode 22 = ON: If ECCs/LRC PINs (up to 64) have
been set on the track of copy source HDD,
ECCs/LRC PINs (up to 64) will be created on the
track of copy target HDD so that the copy
processing will continue. If the number of
ECCs/LRC PINs exceeds 64, the corresponding copy
processing will be interrupted.

Mode 22 = OFF: If ECCs/LRC PINs have been set on
the track of copy source HDD, the copy processing
will be interrupted. (First recover ECCs/LRC PINs by
using the PIN recovery flow, and then perform the
correction copy or the drive copy again).

One of the controlling option for correction/drive
copy.

OFF None

System option modes
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Mode Category Description Default MCU/RCU

36 TrueCopy for
Mainframe

Selects function of CRIT=Y(ALL) or CRIT=Y(PATHS).

Mode 36 = ON: CRIT=Y(ALL) => equivalent to
Primary Volume Fence Level = Data.

Mode 36 = OFF (default): CRIT=Y(PATHS) =>
equivalent to Primary Volume Fence Level = Status.

OFF MCU

64 TrueCopy for
Mainframe

Mode 64 = ON:
■ When receiving the Freeze command, pair

volumes in the storage system that fulfill the
conditions below are suspended and the status
change pending (SCP) that holds write I/Os from
the host is set. The path between MCU and RCU
is not deleted. Query is displayed only but
unusable.

■ When receiving the RUN command, the SCP
status of the pairs that fulfill the conditions
below is released.

■ When a Failure Suspend occurs when Freeze
Option Enable is set, except the pair in which
the Failure Suspend occurs, other pairs that
fulfill the conditions below go into SCP state.

Conditions:
■ TCz P-VOL
■ Mainframe volume
■ Pair status: Duplex/Pending

Mode 64 = OFF (default):
■ When receiving the Freeze command, pairs that

fulfill the conditions below are suspended and
the SCP is set. In the case of CU emulation type
2105/2017, the path between MCU and RCU is
deleted, while the path is not deleted but
unusable with Query displayed only in the case
of CU emulation type 3990.

■ When receiving the RUN command, the SCP
status of the pairs that fulfill the conditions
below is released.

■ When a Failure Suspend occurs while the Freeze
Option Enable is set, except the pair in which
the Failure Suspend occurs, other pairs that
fulfill the conditions below go into SCP state.

OFF Both

System option modes
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Mode Category Description Default MCU/RCU

Conditions:
■ TCz P-VOL
■ Mainframe volume
■ Pair status: Duplex/Pending
■ A pair whose RCU# is identical to the RCU for

which the Freeze command is specified.

Notes:

1. General use: SOM 64 = OFF (default).
2. When all the following conditions are met, set

SOM 64 to ON:

■ Customer requests to stop the update I/O
operation to the RCU of a TCz pair for the
whole storage system.

■ Disaster Recovery function such as GDPS,
HyperSwap, or Fail Over/ Fail Back, which
requires compatibility with IBM® storage, is
not used as SOM 64 operates without
having compatibility with IBM® storage.

■ Only Peer-to-Peer-Remote-Copy operation.
(Do not use it in combination with Business
Continuity Manager.)

3. Even though the Failover command is not an
applicable criterion, when executing the
Failover command while SOM 114 is ON, since
ports are not automatically switched, the
Failover command fails.

4. With increase of Sync pairs in storage system,
the time period to report the completion of
Freeze command and RUN command gets
longer (estimate of time to report completion:
1 second per 1000 pairs), and MIH may occur.

80 ShadowImage In response to the Restore instruction from the
host, if neither Quick nor Normal is specified, the
following operation is performed.

Mode 80 = ON: Normal Restore / Reverse Copy is
performed.

Mode 80 = OFF (default): Quick Restore is
performed.

OFF -

System option modes
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Mode Category Description Default MCU/RCU

Notes:

1. This SOM is applied when the specification for
Restore of SI is switched between Quick
(default) and Normal.

2. The performance of Restore differs depending
on the Normal or Quick specification.

87 ShadowImage Determines whether NormalCopy or QuickResync,
if not specified, is performed at the execution of
pairresync by CCI.

Mode 87 = ON: QuickResync is performed.

Mode 87 = OFF (default): NormalCopy is
performed.

OFF -

104 TrueCopy for
Mainframe

Changes the default of the CGROUP Freeze option. OFF MCU

114 TrueCopy for
Mainframe

Universal
Replicator for
Mainframe

Allows dynamic port mode setting (Initiator/RCU
target for Fibre Channel) through PPRC CESTPATH
and CDELPATH commands.

Mode 114 = ON: Initiator ports automatically
change to RCU target ports, and RCU target ports
automatically change to Initiator ports.

Mode 114 = OFF (default): Automatic port
switching during ESTPATH/DELPATH is disabled.

Notes:

1. If you select an incorrect port while this SOM
is set to ON, and if ESTPATH is executed when
no logic path exists, the port is switched to
RCP.

2. Set this SOM to OFF before using TPC-R or
CSM (IBM® software for disaster recovery).

3. For Fibre Channel interface, do not use the
CESTPATH and CDELPATH commands at the
same time as the SCSI path definition function
of LUN Manager. Fibre Channel interface
ports need to be configured as initiator ports
or RCU target ports before the CESTPATH and
CDELPATH commands are issued.

4. If you use the FCoE port (16FE10 package), you
cannot switch the initiator port and the RCU
target port automatically, even if SOM 114 is
ON.

OFF MCU

System option modes
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Mode Category Description Default MCU/RCU

122 ShadowImage

ShadowImage
for
Mainframe

For Split or Resync request from the Mainframe
host and Storage Navigator.

Mode 122 = ON: By specifying Split or Resync,
Steady/Quick Split or Normal/Quick Resync is
respectively executed in accordance with Normal/
Quick setting.

Mode 122 = OFF (default): By specifying Split or
Resync, Steady/Quick Split or Normal/Quick Resync
is respectively executed in accordance with
Normal/Quick setting.

For details about pairsplit/pairresync command
behavior, contact customer support (see SOM122
sheet).

Notes:

1. Executing the pairresync command from CCI
may be related to the SOM 87 setting.

2. When performing At-Time Split from CCI, set
this SOM to OFF, or specify the environment
variable HORCC_SPLT for Quick. Otherwise,
Pairsplit may turn timeout.

3. This SOM becomes effective after specifying
Split/Resync following the mode setting. The
mode function does not work if it is set during
the Split/Resync operation.

OFF -

142 Common When a command issued to a drive turns to time-
out, the failure is counted on the failure counter of
the drive port. If the failure counter reaches the
port blockage threshold, the drive port is blocked.
When this SOM is set to ON, the port is blocked
when the number of failures reaches the half point
of the threshold, which mitigates the occurrence
possibility of the host time-out.

Mode 142 = ON (default*): The threshold value of
blocking a drive port due to command time-out is
changed to the half of the normal threshold.

Mode 142 = OFF: The threshold value of blocking a
drive port due to command time-out does not
change.

ON -

System option modes
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Mode Category Description Default MCU/RCU

*The default setting for this SOM depends on the
microcode level:
■ Default = ON: 80-04-27 and later (within 80-04-

xx range), 80-05-05 and later
■ Default = OFF: earlier than 80-04-27 (within

80-04-xx range), earlier than 80-05-05 (within
80-05-0x range)

Notes:

1. This SOM should always be set to ON. This
SOM can be set to OFF only when the
customer does not allow to set this SOM to
ON for a storage system already in
production.

2. This SOM is effective for the entire storage
system.
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144 Common This mode is intended to detect and block an HDD
whose response is permanently delayed to keep
reliability.

1. Normal response delay detection logic

Mode 144 = ON: When a response delay drive
is detected, SSB=A4CE and A4DE are logged,
the drive with response delay is blocked, and
SSB=AE4A and SIM=EF0XXX or EF1XXX are
reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see SOM144
sheet).

Mode 144 = OFF: When a response delay drive
is detected, SSB=A4CE is logged, and
SIM=DFFXXX is reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see SOM144
sheet).

2. Early response delay detection logic

When the logic that detects a minor drive
response delay early, which is enabled or
disabled by setting SOM1068 to ON or OFF,
detects a drive response delay, the drive with
response delay is blocked.

SOM144 works with the logic and determines
whether to block a drive or not when the logic
detects a response delay.

Mode 144 = ON: When a response delay is
detected by the logic, SSB=A4CF is logged, the
drive with response delay is blocked, and then
SSB=AE4A and SIM=EF0XXX or EF1XXX are
reported.

The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see sheet
SOM144).

Mode 144 = OFF: When a response delay is
detected by the logic, SSB=A4CF is logged and
SIM=DFFXXX is reported.

ON
80-04-2
7 and
later
(within
80-04-
xx
range),
80-05-0
5 and
later
but
earlier
than
80-06-0
5

OFF
(80-06-
05 and
later)

-
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The behavior varies depending on the
combinations of SOM settings. For details,
contact customer support (see sheet
SOM144).

Note: The mode is applied if a stable host
response is prioritized by separating a drive whose
response is permanently delayed at early stage
when the drive delay is detected. To apply the
mode, note that separating the drive causes
decrease in redundancy.

190 TrueCopy for
Mainframe

Universal
Replicator for
Mainframe

Allows you to update the VOLSER and VTOC of the
S-VOL while the pair is suspended if both SOM 20
and SOM 190 are ON.

Mode 190 = ON: When SOM 20 (S-VOL read-only
option) and this SOM are both ON, you can update
the VOLSER and VTOC of the S-VOL while the pair is
suspended. When the pair is resumed, the VOLSER
and VTOC of the S-VOL are overwritten with the
VOLSER and VTOC of the P-VOL.

Mode 190 = OFF (default): Even when SOM 20 (S-
VOL read-only option) is ON, you cannot update
the VOLSER or VTOC of the S-VOL while the pair is
suspended.

OFF RCU

269 Virtual
LVI/LUN

High Speed Format for CVS (Available for all device
emulation types)

1. High Speed Format support

When redefining all LDEVs included in an ECC
group using Volume Initialize or Make Volume
on CVS setting panel, LDEV format, as the last
process, will be performed in high speed.

2. Make Volume feature enhancement

In addition, with supporting the feature, the
Make Volume feature (re-creating new CVs
after deleting all volumes in a VDEV), which so
far was supported for OPEN-V only, is
available for all emulation types.

Mode 269 = ON: The High Speed format is
available when performing LDEV format on the
Maintenance window of the SVP for all LDEVs in a
parity group. Note that the High Speed format is
not available when performing CVS operations on
Storage Navigator for all LDEVs in a parity group.

OFF Both
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Mode 269 = OFF (default): As usual, only the low
speed format is available when performing CVS
operations on Storage Navigator. In addition, the
LDEV specifying format on the Maintenance
window of the SVP is in low speed as well.

Notes:

1. For additional details about SOM 269, contact
customer support (see SOM269 sheet).

2. In case of creating a small volume using CVS,
the format takes longer time.

3. When performing an LDEV format for all
LDEVs in a parity group with SOM 269 ON, the
format is in high speed, but in the case of
VSP/HUS VM and later models, LDEV format
performed on Storage Navigator for all LDEVs
in a parity group is in low speed.

4. For SATA drive, the format is not in high
speed.

292 TrueCopy for
Mainframe

Issuing OLS when Switching Port. In case the
mainframe host (FICON®) is connected with the
CNT-made FC switch (FC9000 etc.) and is using
along with the TrueCopy for Mainframe with Open
Fibre connection, the occurrence of Link Incident
Report for the mainframe host from the FC switch
will be deterred when switching the CHT port
attribute (including automatic switching when
executing CESTPATH and CDELPATH in case of
Mode114=ON).

Mode 292=ON: When switching the port attribute,
issue the OLS (100ms) first, and then reset the
Chip.

Mode 292=OFF (default): When switching the port
attribute, reset the Chip without issuing the OLS.

OFF Both

305 Mainframe This SOM enables the pre-label function (creation
of VTOC including VOLSER).

Mode 305 = ON: Pre-label function is enabled.

Mode 305 = OFF (default): Pre-label function is
disabled.

OFF -
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Notes:

1. Set SOM 305 to ON before performing LDEV
Format for a mainframe volume if you want to
perform OS IPL (volume online) without fully
initializing the volume after the LDEV Format.
However, full initialization is required in actual
operation.

2. Processing time of LDEV format increases by
as much as full initialization takes.

3. The following functions and conditions are not
supported:

■ Quick format

■ 3390-A (Dynamic Provisioning attribute)

■ Volume Shredder

4. Full initialization is required in actual
operation.

5. Microcode versions earlier than
80-05-32-00/00 or earlier than 80-05-47-00/00
(within 80-05-4x range) have a bug. Refer to
BID=RAID800-XXXX (SR# HDS04414070). Make
sure to use the workaround or the fixed code
when SOM 305 is ON.

308 TrueCopy for
Mainframe

Universal
Replicator for
Mainframe

Allows you to specify whether the Remote Copy
Path status, SIM218x, is reported to the host or
not.

SIM RC=2180 (RIO path failure between MCU and
RCU) is not reported to host. The storage system
reports SSB with F/M=F5 instead of reporting SIM
RC=2180 in case of RIO path failure between MCU
and RCU. Micro-program is modified to report SIM
RC=2180 with this SOM as individual function for
specific customers.

Mode 308 = ON: SIM RC 2180 is reported, which is
compatible with older Hitachi specification.

Mode 308 = OFF (default): SIM RC 2180 is not
reported. Reporting is compatible with IBM - Sense
Status report of F5.

OFF MCU

310 Common Mode 310 = ON: The monitoring timer for MP
hang-up is 6 seconds and returning a response to
the host within 8 seconds is guaranteed.

OFF -
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Mode 310 = OFF (default): The monitoring timer
for MP hang-up is 8 seconds.

Notes:

1. This SOM applies to a site where strict host
response performance is required.

2. If a hardware failure occurs when this SOM is
set to ON, the time until MPB blockage is
determined is shorter than usual.

448 Universal
Replicator

Universal
Replicator for
Mainframe

Mode 448 = ON: After a physical path failure (such
as path disconnection) is detected, a mirror is split
(suspended) one minute after the detection. On
the MCU side, the mirror is suspended one minute
after read journal commands from the RCU stop.
On the RCU side, the mirror is suspended one
minute after read journal commands fail.

Mode 448 = OFF (default): After a physical path
failure (such as path disconnection) is detected, a
mirror is split (suspended) if the path is not
restored within the path mornitoring time set by
the mirror option.

Notes:

1. The mode is applied when pairs need to be
suspended one minute after a communication
error between UR MCU and RCU is detected.

2. When SOM 449 is set to ON, SOM 448 does
not function.

OFF -

449 Universal
Replicator

Universal
Replicator for
Mainframe

This mode is used to enable and disable detection
of communication failures between the MCU and
RCU. The default setting is ON.

Mode 449 = ON (default): When a physical path
failure is detected, the pair is not suspended. On
the MCU side, checking read journal command
disruption from the RCU is disabled, and
monitoring read journal command failures is
disabled on the RCU side.

Mode 449 = OFF: When a physical path failure is
detected, the pair is suspended after the path
monitoring time set by the mirror option has
passed or after one minute. Detecting
communication failures between the MCU and RCU
is enabled. When this mode is set to OFF, SOM 448
can be enabled.

ON MCU

System option modes

Appendix G: System option modes (SOMs)

System Administrator Guide for VSP G1x00 and VSP F1500 422



Mode Category Description Default MCU/RCU

Notes:

1. This SOM is applied when disabling the
detection of communication failures between
the MCU and RCU in UR/URz configuration is
required.

2. When this SOM is set to ON, SOM 448 does
not work.

3. This SOM setting is not changed by microcode
upgrade.

4. This SOM is not effective for remote paths
between an Initiator port on the MCU and a
Target port on the RCU.

5. While a path from the RCU to MCU is
disconnected, if the UR/URz pair remains in
Suspending or Deleting status, recover it in
accordance with the procedure in Recovery
from UR/URz Failure in TROUBLE SHOOTING
section of Maintenance Manual.

454 Virtual
Partition
Manager

CLPR (function of Virtual Partition Manager)
partitions the cache memory in the storage system
into multiple virtual cache and assigns the
partitioned virtual cache for each use. If a large
amount of cache is required for a specific use, it
can minimize the impact on other uses. The CLPR
function works as follows depending on whether
SOM 454 is set to ON or OFF.

Mode 454 = OFF (default): The amount of the
entire destage processing is periodically
determined by using the highest workload of all
CLPRs (*a). (The larger the workload is, the larger
the amount of the entire destage processing
becomes.)

*a: (Write Pending capacity of CLPR#x of
concerned MPB) ÷ (Cache capacity of CLPR#x of
concerned MPB), x=0 to 31

CLPR whose value above is the highest of all CLPRs

Because the destage processing would be
accelerated depending on CLPR with high
workload, when the workload in a specific CLPR
increases, the risk of host I/O halt would be
reduced.

Therefore, set SOM 454 to OFF in most cases.

OFF -
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Mode 454 = ON:

The amount of the entire destage processing is
periodically determined by using the workload of
the entire system (*b). (The larger the workload is,
the larger the amount of the entire destage
processing becomes.)

*b: (Write Pending capacity of the entire system of
concerned MPB) ÷ (Cache capacity of the entire
system of concerned MPB)

Caution: Because the destage processing would
not be accelerated even if CLPR has high workload,
when the workload in a specific CLPR increases, the
risk of host I/O halt would be increased. Therefore,
set SOM 454 to ON only when a CLPR has constant
high workload and the I/O performance in a CLPR
with low workload has higher priority than host I/O
halt in the CLPR with high workload.

Notes:

1. When this SOM is set to ON, even if there is an
overloaded CLPR (CLPR with large Write
Pending capacity), the amount of destage
processing would not increase easily.
Therefore TOV(MIH) may occur in the
overloaded CLPR. Set this SOM to ON only
when the overloaded state of a specific CLPR
would not affect other CLPRs.

When the UR function is used, if user volumes
and journal volumes are defined in different
CLPRs, when the CLPR to which the journal
volumes are assigned overflows, the user
volumes become inaccessible. Therefore it is
recommended to set this SOM to OFF.

2. Because the destage processing will have a
lower priority in the overloaded CLPR, the
overloaded state of the overloaded CLPR is
not removed, and TOV(MIH) might occur.

457 Universal
Volume
Manager

This SOM has two purposes: High-Speed LDEV
Format for External Volumes, and Support for
Mainframe Control Block Write GUI.

OFF Both
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Mode 457 = ON:

1. High-Speed LDEV Format for External
Volumes.

The high-speed LDEV format for external
volumes is available by SOM 457 to ON. When
SOM 457 is ON, if you select an external
volume group and perform an LDEV format,
any write processing on the external logical
units will be skipped. However, if the external
LDEV is a mainframe volume, the write
processing for mainframe control information
only will be performed after the write skip.

2. Support for Mainframe Control Block Write
GUI.

Control Block Write of the external LDEVs in
mainframe emulation is supported by Device
Manager - Storage Navigator (GUI).

Mode 457 = OFF (default): High-speed LDEV
format for external volumes and support for
mainframe control block write GUI are not
available.

Notes:
■ If the LDEV is not written with data “0” before

performing the function, the LDEV format might
fail.

■ After the format processing, make sure to set
SOM 457 to OFF.

459 ShadowImage

ShadowImage
for
Mainframe

When the S-VOL of an SI/SIz pair is an external
volume, the transaction to change the status from
SP-PEND to SPLIT is as follows:

Mode 459 = ON: When suspending an SI/SIz pair:
Waits for the copy data in cache memory to
completely destage to the external volume S-VOL
before changing the pair status to SUSPEND.

Mode 459 = OFF (default): When suspending an
SI/SIz pair: The status changes to SUSPEND as soon
as all of the delta data is copied to S-VOL cache.
The status does not wait for cache to destage to
the S-VOL external volume.

OFF -
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466 Universal
Replicator

Universal
Replicator for
Mainframe

It is strongly recommended that the path between
the primary and secondary storage systems have a
minimum data transfer speed of 100 Mbps. If the
data transfer speed falls to 10 Mbps or lower, UR
operations cannot be properly processed. As a
result, many retries occur and UR pairs might be
suspended. This SOM is provided to ensure proper
system operation for data transfer speeds of at
least 10 Mbps.

Mode 466 = ON: Data transfer speeds of 10 Mbps
and higher are supported. The JNL read is
performed with 4-multiplexed read size of 256 KB.

Mode 466 = OFF (default): For conventional
operations. Data transfer speeds of 100 Mbps and
higher are supported. The JNL read is performed
with 32-multiplexed read size of 1 MB by default.

Note: The data transfer speed can be changed
using the Change JNL Group options.

OFF -

467 ShadowImage

ShadowImage
for
Mainframe

Compatible
FlashCopy®

V2

Compatible
FlashCopy® SE

Snapshot

Universal
Volume
Manager

Volume
Migration

For the following features, the current copy
processing slows down when the percentage of
“dirty” data is 60% or higher, and it stops when the
percentage is 75% or higher. Mode 467 is provided
to prevent the percentage from exceeding 60%, so
that the host performance is not affected.
■ SI
■ SIz
■ FCv2, FCSE
■ Snapshot
■ UVM
■ Volume Migration

Mode 467 = ON (default): Copy overload
prevention. Copy processing stops when the
percentage of “dirty” data reaches 60% or higher.
When the percentage falls below 60%, copy
processing restarts.

Mode 467 = OFF: Normal operation. The copy
processing slows down if the dirty percentage is
60% or larger, and it stops if the dirty percentage is
75% or larger.

ON -
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Caution: This SOM must always be set to ON when
using an external volume as the secondary volume
of any of the applicable replication products.

Notes:

1. It takes longer to finish the copy processing
because it stops for prioritizing the host I/O
performance.

2. This SOM supports background copy only. The
processing to copy the pre-update data to the
S-VOL, which occurs when overwriting data to
uncopied slots of P-VOL in Split processing or
reading or writing data to uncopied slots of S-
VOL, is not supported.

3. Check the write pending rate of each CLPR per
MP blade. Even though there is some free
cache capacity in the entire system, if the
write pending rate of an MP blade to which
pairs* belong exceeds the threshold, the copy
operation is stopped.

*Applies to pairs of SI, SIz, FCv2, FCSE,
Snapshot, and Volume Migration.

471 Thin Image Since the SIM-RCs generated when the Thin Image
pool usage rate exceeds the threshold value can be
resolved by users, these SIM-RCs are not reported
to the maintenance personnel. This SOM is used to
report these SIM-RCs to maintenance personnel.

The SIM-RCs reported by setting the SOM to ON
are: 601xxx (Pool utilization threshold exceeded),
603000 (SM space warning).

Mode 471 = ON: These SIM-RCs are reported to
maintenance personnel.

Mode 471 = OFF (default): These SIM-RCs are not
reported to maintenance personnel.

Note: Set this SOM to ON when it is required to
inform maintenance personnel of these SIM-RCs.

OFF -

474 Universal
Replicator

Universal
Replicator for
Mainframe

UR initial copy performance can be improved by
issuing a command from CCI/Business Continuity
Manager (BCM) to execute a dedicated script
consisting of UR initial copy (Nocopy), UR suspend,
TC Sync initial copy, TC Sync delete, and UR resync.

OFF Both
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Mode 474 = ON: For a suspended UR pair, a TC
(Sync) pair can be created with the same P-VOL/S-
VOL so that UR initial copy time can be reduced by
using the dedicated script.

Mode 474 = OFF (default): For a suspended UR
pair, a TC (Sync) pair cannot be created with the
same P-VOL/S-VOL. For this, the dedicated script
cannot be used.

If the P-VOL and S-VOL are both DP-VOLs, initial
copy performance might not improve with SOM
474 set to ON. This is because with DP-VOLs, not all
areas in a volume are allocated for UR; therefore
not all areas in the P-VOL are copied to the S-VOL.
With less than the full amount of data in the P-VOL
being copied, the initial copy completes in a
shorter time, which might not be improved with
SOM 474.
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Notes:

1. Set this SOM for both primary and secondary
storage systems.

2. When this SOM is set to ON:

■ Execute all pair operations from CCI/BCM.

■ Use a dedicated script.

■ Initial copy operation is prioritized over
update I/O. Therefore, the processing
speed of the update I/O slows down.

3. If this SOM is set to ON, the processing speed
of update I/O slows down by about 15 μs per
command, version downgrade is disabled, and
Take Over is not available.

4. If this SOM is not set to ON for both sides, the
behavior is as follows:

■ OFF in primary and secondary storage
systems: Normal UR initial copy
performance.

■ ON in the primary storage system/OFF in
the secondary storage system: TC Sync pair
creation fails.

■ OFF in the primary storage system/ON in
the secondary storage system: The update
data is copied to the S-VOL synchronously.

5. While this SOM is set to ON, make sure not to
perform microcode downgrade to an
unsupported version.

6. While this SOM is set to ON, make sure not to
perform the Take Over function.

7. This SOM cannot be applied to a UR pair that
is the second mirror in a URxUR multi-target
configuration, URxUR cascade configuration,
or 3DC multi-target or cascading configuration
of three UR sites. If applied, TC pair creation is
rejected with SSB=CBED output.

8. Before setting SOM 474 to ON, make sure that
SOM 1091 is set to OFF. If SOM 1091 is set to
ON, set it to OFF first, and then set SOM 474
to ON.
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484 TrueCopy for
Mainframe

ShadowImage
for
Mainframe

The IBM®-compatible PPRC FC path interface was
supported with TagmaStore USP 50-06-11. As the
specification of QUERY display using FC interface
(hereinafter called New Spec) is different from the
ESCON® specification (hereinafter called Previous
Spec), this SOM enables to display the PPRC path
QUERY with New Spec or Previous Spec.
■ Mode 484 = ON: The status of path using the

Fibre Channel interface is displayed. WWNN is
indicated.

■ Mode 484 = OFF (default): The status of path
using an ESCON® interface is displayed. WWNN
is invalid.

Notes:

1. Set this SOM to ON when you want to
maintain compatibility with the Previous Spec
for PPRC path QUERY display under the
environment where IBM host function (such
as PPRC and GDPS) is used.

2. When an old model or a TagmaStore USP that
does not support this SOM is connected using
TCz, set this SOM to OFF.

3. If the display specification is different between
MCU and RCU, it may cause malfunction of
host.

4. When IBM® TPC-R or CSM software for
disaster recovery is used, set this SOM to ON.

OFF Both

495 NAS Function: That the secondary volume where S-VOL
Disable is set means the NAS file system
information is imported in the secondary volume.
If the user has to take a step to release the S-VOL
Disable attribute in order to perform the restore
operation, it is against the policy for the guard
purpose and the guard logic to have the user
uninvolved. In this case, in the NAS environment,
SOM 495 can be used to enable the restore
operation.

Mode 495 = ON: The restore operation (Reverse
Copy, Quick Restore) is allowed on the secondary
volume where S-VOL Disable is set.

OFF -
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Mode 495 = OFF (default): The restore operation
(Reverse Copy, Quick Restore) is not allowed on the
secondary volume where S-VOL Disable is set.

506 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM is used to enable Delta Resync with no
host update I/O by copying only differential JNL
instead of copying all data.

The UR Delta Resync configuration is required.

Mode 506 = ON:
■ Without update I/O: Delta Resync is enabled.
■ With update I/O: Delta Resync is enabled.

Mode 506 = OFF (default):
■ Without update I/O: Total data copy of Delta

Resync is performed.
■ With update I/O: Delta Resync is enabled.

Note: Even when SOM 506 is set to ON, the Delta
Resync may fail and only the total data copy of the
Delta Resync function is allowed if the necessary
journal data does not exist on the primary storage
system used for the Delta Resync operation.

OFF Both

530 Universal
Replicator for
Mainframe

When a Universal Replicator for Mainframe pair is
in the Duplex state, this SOM switches the display
of Consistency Time (C/T) between the values at
JNL restore completion and at JNL copy completion.

Mode 530 = ON: C/T displays the value of when
JNL copy is completed.

Mode 530 = OFF (default): C/T displays the value
of when JNL restore is completed.

Note: At the time of Purge suspend or RCU failure
suspend, the C/T of Universal Replicator for
Mainframe displayed by Business Continuity
Manager or Storage Navigator may show earlier
time than the time showed when the pair was in
the Duplex state.

OFF RCU

531 Common When PIN data is generated, the SIM currently
stored in SVP is reported to the host.

Mode 531 = ON: The SIM for PIN data generation is
stored in SVP and reported to the host.

OFF Both
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Mode 531 = OFF (default): The SIM for PIN data
generation is stored in SVP only, not reported to
the host, the same as the current specification.

548 ShadowImage
for
Mainframe
from BCM

TrueCopy for
Mainframe
from BCM

Universal
Replicator for
Mainframe
from BCM

This SOM prevents pair operations of TCz, URz, or
SIz via Command Device online.

Mode 548 = ON: Pair operations of TCz, URz, or SIz
via online Command Device are not available.
SSB=0x64fb is output.

Mode 548 = OFF (default): Pair operations of TCz,
URz, or SIz via online Command Device are
available. SIM is output.

Notes:

1. When Command Device is used online, if a
script containing an operation via Command
Device has been executed, the script may stop
if this SOM is set to ON. As described in the
BCM user’s guide, the script must be
performed with Command Device offline.

2. This SOM is applied to operations from BCM
that is operated on MVS.

OFF Both

556 Open Prevents an error code from being set in the 8 -
11th bytes in the standard 16-byte sense byte.

Mode 556 = ON: An error code is not set in bytes 8
- 11 in the standard 16-byte sense byte.

Mode 556 = OFF (default): An error code is set in
bytes 8 - 11 in the standard 16-byte sense byte.

OFF Both

561 ShadowImage

Universal
Volume
Manager

Allows Quick Restore for external volumes with
different Cache Mode settings.

Mode 561 = ON: Quick Restore for external
volumes with different Cache Mode settings is
prevented.

Mode 561 = OFF (default): Quick Restore for
external volumes with different Cache Mode
settings is allowed.

OFF Both

573 TrueCopy for
Mainframe

ShadowImage
for
Mainframe

For the CU emulation type 2105/2107, specifying
the CASCADE option for the ICKDSF ESTPAIR
command is allowed.

Mode 573 = ON: The ESTPAIR CASCADE option is
allowed.

OFF Both
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Mode 573 = OFF (default): The ESTPAIR CASCADE
option is not allowed. (When specified, the option
is rejected.)

Notes:

1. When CU emulation type is 2105/2107, this
SOM is applied in the case where pair creation
in TCz – SIz cascading configuration in the
ICKDSF environment fails with the following
message output. Message: ICK30111I DEVICE
SPECIFIED IS THE SECONDARY OF A DUPLEX
OR PPRC PAIR

2. This SOM is applied when building an
environment using the Metro Mirror F.O./F.B.
function with TPC-R or CSM.

3. The CASCADE option can be specified in the
TSO environment also.

4. Although the CASCADE option can be
specified for the ESTPAIR command, the PPRC-
XD function is not supported.

5. Perform thorough pre-check for any influence
on GDPS/PPRC.

6. The SOM must be enabled only when the
CASCADE option is specified for the ESTPAIR
command for the CU emulation type
2105/2107.

The unit
for which
TCz and
SIz in a
cascading
configurati
on use the
same
volume.

589 Universal
Volume
Manager

When this SOM is ON, the frequency of progress
update of disconnection is changed.

Mode 589 = ON: For each external volume,
progress is updated only when the progress rate is
100%.

Mode 589 = OFF (default): Progress is updated
when the progress rate exceeds the previous level.

Notes:

1. Set this SOM to ON when disconnecting an
external volume while the specific host IO
operation is online and its performance
requirement is severe.

OFF Both
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2. Whether the disconnecting status for each
external volume is progressed or not cannot
be confirmed on Device Manager - Storage
Navigator (It indicates “-“until just before the
completion and at the last it changes to
100%).

598 Universal
Replicator for
Mainframe

This SOM is used to report SIMs (RC=DCE0 to DCE3)
to a Mainframe host to warn that a URz journal is
full.

Mode 598 = ON: SIMs (RC=DCE0 to DEC3) to warn
that a JNL is full are reported to SVP and the host.

Mode 598= OFF (default): SIMs (RC=DCE0 to
DEC3) to warn that a JNL is full are reported to SVP
only.

Notes:

1. This SOM is applied if SIMs (RC=DCE0 to DCE3)
need to be reported to a Mainframe host.

2. The SIMs are not reported to the Open server.
3. SIMs for JNL full (RC=DCE0 and DCE1) on MCU

are reported to the host connected with MCU.
4. SIMs for JNL full (RC=DCE2 and DCE3) on RCU

are reported to the host connected with RCU.

OFF Both

664 Server
Priority
Manager

This mode changes SPM upper limit control
method for WWN control.

In a host configuration in which the queue depth is
greater than 8, multi-path software is used, or the
striping function is used, traffic might be controlled
much lower than the upper limit set for non-
prioritized WWNs. This mode is used to improve
the upper limit control method.

Mode 664 = ON (default): The new upper limit
control (managing the total number of I/Os) is
applied for I/O control. The control works by
monitoring the performance of non-prioritized
WWNs in real time.

ON -
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Note: Even when SOM 664 is ON, some workloads
that exceed an upper limit might not be adequately
controlled (for example, when the Adaptive
multipath policy of Veritas Volume Manager or the
Dynamic Multipathing function of Red Hat
Enterprise Linux is used). In this case, consider
setting the multipath I/O policy to round-robin
instead of other policies.

Mode 664 = OFF: The current upper limit control
(assigning upper limit in advance) is applied for I/O
control. The control works based on the non-
prioritized WWNs performance monitored
immediately before.

Caution: Setting SOM 664 to OFF can result in
overthrottling of workloads and significant impact.
Make sure SOM 664 is set to ON to ensure proper
SPM operations.

Notes:

1. Set this mode to ON when all of the following
conditions are met:

a. The upper limit is set for traffic of non-
prioritized WWNs.

b. The queue depth is greater than 8, multi-
path software is used, or the striping
function is used in a host configuration.

2. To downgrade the microcode from the
support version to an unsupported version
below, set this mode to OFF. If the microcode
is downgraded from a support version to an
unsupported version while this mode is set to
ON, I/Os exceeding the upper limit might be
received or I/Os might be kept lower than the
upper limit.

■ Earlier than 80-03-39-00/00

■ Earlier than 80-04-05-00/00 (within
80-04-0x range)

■ Earlier than 80-04-22-00/00 (within
80-04-2x range)

3. For several seconds at SOM setting change
(ON/OFF), I/Os exceeding the upper limit
might be received.
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665 Common Disables the automatic log dump collection
function that is executed when a hardware failure
occurs to reduce the time to start failure analysis. A
failure log created on a storage system triggers the
function to start at a hardware failure.

Mode 665 = ON (default): The auto dump
collection function is disabled.

Mode 665 = OFF: The auto dump collection
function is enabled.

Notes:

1. This SOM is applied when disabling the
automatic log dump collection function is
required at a failure.

2. This SOM is effective for the entire storage
system.

ON -

689 TrueCopy

TrueCopy for
Mainframe

global-active
device

Allows you to slow the initial copy and resync
operations when the write-pending rate on the
RCU exceeds 60%.

Mode 689 = ON: The initial copy and resync copy
operations are slowed down when the Write
Pending rate on RCU exceeds 60%.

If the CLPR write pending rate where the initial
copy target secondary volume belongs to is not
over 60% but that of MP PCB where the S-VOL
belongs to is over 60%, the initial copy operation is
slowed down.

Mode 689 = OFF (default): The initial copy and
resync copy operations are not slowed down when
the Write Pending rate on RCU exceeds 60% (the
same as before).

OFF Both
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Notes:

1. This SOM can be set online.
2. The micro-programs on both MCU and RCU

must support this SOM.
3. This SOM should be set when requested by

the user.
4. Setting this SOM to ON is recommended when

GAD is installed, as the performance
degradation is more likely to occur due to
active-active I/Os.

5. If the write-pending status remains at 60% or
higher on the RCU for a long time, it takes
extra time for the initial copy and resync copy
to be completed due to the slower copy
operations.

6. If the write pending rate of CLPR to which the
initial copy target S-VOL belongs is not over
60% but that of MP PCB to which the S-VOL
belongs is over 60%, the initial copy operation
is slowed down.

7. Do not set this SOM if the primary or
secondary system is connected to USP V/VM
with microcode earlier than 60-02-xx. If this
SOM is applied and the write-pending rate
reaches 60%, pair suspend might occur.

690 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM is used to prevent Read JNL or JNL
Restore when the Write Pending rate on RCU
exceeds 60% as follows:
■ When CLPR of JNL-Volume exceeds 60%, Read

JNL is prevented.
■ When CLPR of Data (secondary)-Volume

exceeds 60%, JNL Restore is prevented.

Mode 690 = ON: Read JNL or JNL Restore is
prevented when the Write Pending rate on RCU
exceeds 60%.

Mode 690 = OFF (default): Read JNL or JNL Restore
is not prevented when the Write Pending rate on
RCU exceeds 60% (the same as before).

OFF RCU
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Notes:

1. This SOM can be set online.
2. This SOM should be set per customer’s

requests.
3. If the Write Pending status long keeps 60% or

more on RCU, it takes extra time for the initial
copy to be completed by making up for the
prevented copy operation.

4. If the Write Pending status long keeps 60% or
more on RCU, the pair status may become
Suspend due to the JNL-Vol being full.

5. When USP/NSC is used on the P-VOL side, this
SOM cannot be used. If this SOM is set to ON,
SSB=8E08 on the P-VOL side and SSB=C8D1
on the S-VOL side might be output frequently.

696 Open This SOM is available to enable or disable the QoS
function.

Mode 696 = ON: QoS is enabled. (In accordance
with the Share value set to SM, I/Os are scheduled.
The Share value setting from RMLIB is accepted)

Mode 696 = OFF (default): QoS is disabled. (The
Share value set to SM is cleared. I/O scheduling is
stopped. The Share value setting from host is
rejected.)

Note: Set this SOM to ON when you want to
enable the QoS function.

OFF -

701 Universal
Volume
Manager

Issues the Read command at the logical unit
discovery operation using UVM.

Mode 701 = ON: The Read command is issued at
the logical unit discovery operation.

Mode 701 = OFF (default): The Read command is
not issued at the logical unit discovery operation.

OFF -
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Notes:

1. When the external storage is USP/NSC and the
Open LDEV Guard attribute (VMA) is defined
on an external device, set this SOM to ON.

2. When this SOM is set to ON, it takes longer
time to complete the LU discovery. The
amount of time depends on external storages.

3. With this SOM OFF, if searching for external
devices with VMA is set, the VMA information
cannot be read.

4. When this SOM is set to ON while the
following conditions are met, the external
volume is blocked:

■ An external volume to which Nondisruptive
migration (NDM) attribute is set exists.

■ The external volume is reserved by the
host

5. As the VMA information is USP/NSC specific,
this SOM does not need to be ON when the
external storage is other than USP/NSC.

6. Set this SOM to OFF when an external volume
to which nondisruptive migration (NDM)
attribute is set exists.

704 ShadowImage

ShadowImage
for
Mainframe

Compatible
FlashCopy®

Volume
Migration

To reduce the chance of MIH, this SOM can reduce
the priority of ShadowImage, Volume Migration, or
Resync copy internal IO requests so that host IO
has a higher priority. This SOM creates new work
queues where these jobs can be assigned with a
lower priority.

Mode 704 = ON: Copy processing requested is
registered into a newly created queue so that the
processing is scheduled with lower priority than
host I/O.

Mode 704 = OFF (default): Copy processing
requested is not registered into a newly created
queue. Only the existing queue is used.

OFF -
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Notes:

1. Apply this SOM when the load of host I/O to
an ECC that uses ShadowImage or Volume
Migration is high and the host I/O processing
is delayed.

2. If the PDEV is highly loaded, the priority of
Read/Write processing made by
ShadowImage, Volume Migration, or Resync
may become lower. As a consequence the
copy speed may be slower.

721 Common When a parity group is uninstalled or installed, the
following operation is performed according to the
setting of SOM 721.

Mode 721 = ON: When a parity group is
uninstalled or installed, the LED of the drive for
uninstallation is not illuminated, and the
instruction message for removing the drive does
not appear. Also, the windows other than that of
parity group, such as DKA or DKU, are unavailable
to select.

Mode 721 = OFF (default): When a parity group is
uninstalled or installed, the operation is as before:
the LED of the drive is illuminated, and the drive
must be unmounted and remounted.

Notes:

1. When the RAID level or emulation type is
changed for the existing parity group, this
SOM should be applied only if the drive
mounted position remains the same at the
time of the parity group uninstallation or
installation.

2. After the operation using this SOM is
completed, this SOM must be set back to OFF;
otherwise, the LED of the drive to be removed
will not be illuminated at subsequent parity
group uninstalling operations.

OFF -

725 Universal
Volume
Manager

This SOM determines the action that will be taken
when the status of an external volume is Not
Ready.

OFF -
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Mode 725 = ON: When Not Ready is returned, the
external path is blocked and the path status can be
automatically recovered (Not Ready blockade).
Note that the two behaviors, automatic recovery
and block, may be repeated.

When the status of a device is Not Ready blockade,
Device Health Check is executed after 30 seconds.

Mode 725 = OFF (default): When Not Ready is
returned three times in three minutes, the path is
blocked and the path status cannot be
automatically recovered (Response error blockade).

Notes:

1. Applying this SOM is prohibited when USP
V/VM is used as an external storage system
and its external volume is DP-VOL.

2. Applying this SOM is recommended when the
above condition (1) is not met and SUN
storage is used as an external storage.

3. Applying this SOM is recommended when the
above condition (1) is not met and EMC CX
series or Fujitsu Fibre CAT CX series is used as
an external storage.

4. Applying this SOM is recommended if the
above condition (1) is not met and a
maintenance operation such as firmware
update causing controller reboot is executed
on the external storage side while a storage
system other than Hitachi product is used as
an external storage system.

5. While USP V/VM is used as an external storage
system and its volume is DP-VOL, if some
Pool-VOLs constituting the DP-VOL are
blocked, external path blockade and recovery
occurs repeatedly.

6. When a virtual volume mapped by UVM is set
to pool-VOL and used as DP-VOL in local
storage system, this SOM can be applied
without problem.

729 Dynamic
Provisioning

Data
Retention
Utility

When a DP pool is full, if any write operation is
requested to the area where the page allocation is
not provided, this SOM can enable the DRU Protect
attribute for the target DP-VOL.

OFF -
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Mode 729 = ON: Set the DRU Protect attribute for
the target DP-VOL when any write operation is
requested to the area where the page allocation is
not provided at a time when the DP pool is full.
(Not to set in the case of Read request.)

Mode 729 = OFF (default): Do not set the DRU
Protect attribute for the target DP-VOL when any
write operation is requested to the area where the
page allocation is not provided at a time when DP
pool is full.

For details, contact customer support (see SOM729
& 803 sheet).

Notes:

1. This SOM is applied when:

■ The threshold of pool is high (for example,
95%) and the pool may be full.

■ File system is used.

■ Data Retention Utility is installed.

2. Since the Protect attribute is set for V-VOL, the
Read operation cannot be allowed as well.

3. When Data Retention Utility is not installed,
the desired effect is not achieved.

4. Protect attribute can be released from the
Data Retention window of Device Manager -
Storage Navigator after releasing the full
status of the pool by adding a Pool-VOL.

5. With 80-02-01-00/01 and later, the Virtual
Volume Protection (VVP) function is
supported. VVP can be enabled/disabled for
each pool. With SOM 729 disabled, VVP is also
disabled by default, but you can enable VVP
for each pool as needed. With SOM 729
enabled, VVP is also enabled automatically (by
default) when you create a new pool. Caution:
A pool is NOT protected by ANY FUNCTION if
you deliberately turn VVP for the pool from
ON (default) to OFF, even with SOM 729
enabled.
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6. With 80-02-41-00/00 and later, when HMO 63
or 73 is set to ON, the setting of the HMO is
prioritized over the SOM 729 setting, so that
the behavior remains the same as when SOM
729 is OFF even when it is set to ON.

733 ShadowImage

ShadowImage
for
Mainframe

Volume
Migration

This SOM enables to suspend Volume Migration or
Quick Restore operation during LDEV-related
maintenance.

Mode 733 = ON: Volume Migration or Quick
Restore operation during LDEV-related
maintenance is not suspended.

Mode 733 = OFF (default): Volume Migration or
Quick Restore operation during LDEV-related
maintenance is suspended.

Notes:

1. Note that behavior when this SOM is set to
ON and OFF is reversed between USP V/VM
and VSP/HUS VM and later.

2. This SOM should be applied to perform
Volume Migration or Quick Restore during
maintenance operation.

3. Set SOM 733 to ON if you want to prioritize
the Volume Migration or Quick Restore
operation over maintenance activities. In this
case, maintenance activities may fail when the
Volume Migration or Quick Restore operation
works during the maintenance activities.

4. An LDEV-related maintenance operation such
as LDEV installation/removal may fail when
Volume Migration or Quick Restore takes
place.

OFF -

734 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

When exceeding the pool threshold, the SIM is
reported as follows:

Mode 734 = ON: A SIM is reported at the time
when the pool usage rate exceeds the pool
threshold (warning, system, or depletion). Once the
pool usage rate falls below the pool threshold, and
then exceeds again, the SIM is reported again. If
the pool usage rate continues to exceed the
warning threshold and the depletion threshold, the
SIM (SIM-RC625000) is repeatedly reported every
eight (8) hours until the pool usage rate falls below
the depletion threshold.

OFF -
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Mode 734 = OFF (default): A SIM is reported at the
time when the pool usage rate exceeds the pool
threshold (warning, system, or depletion). Once the
pool usage rate falls below the pool threshold, and
then exceeds again, the SIM is reported again. The
SIM is not reported while the pool usage rate
continues to exceed the warning threshold and the
depletion threshold.

Notes:

1. This SOM is turned ON to prevent the write
I/O operation from being unavailable due to
pool full.

2. If the exceeding pool threshold SIM occurs
frequently, other SIMs may not be reported.

3. Though turning on this SOM can increase the
warning effect, if measures such as adding a
pool fail to be done in time so that the pool
becomes full, SOM 729 can be used to prevent
file systems from being destroyed.

4. Turning on SOM 741 can provide the SIM
report to both the users and the service
personnel.

741 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

This SOM enables to switch over whether to report
the following SIM for users to the service
personnel:

SIM-RC 625000 (DP pool usage rate continues to
exceed the threshold)

Mode 741 = ON: SIM is reported to the service
personnel.

Mode 741 = OFF (default): SIM is not reported to
the service personnel.

OFF -
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Notes:

1. This SOM is set to ON to have SIM for users
reported to the service personnel:

■ For the system where SNMP and E-mail
notification are not set.

■ If Device Manager - Storage Navigator is
not periodically activated.

2. When SOM 734 is turned OFF, SIM-RC625000
is not reported; accordingly the SIM is not
reported to the service personnel even
though this SOM is ON.

745 Universal
Volume
Manager

Enables to change the area where the information
is obtained as the Characteristic1 item from
SYMMETRIX.

Mode 745 = ON:
■ The area where the information is obtained as

the Characteristic1 item from SYMMETRIX is
changed.

■ When CheckPaths or Device Health Check (1/
hour) is performed, the information of an
already-mapped external volume is updated to
the one after change.

Mode 745 = OFF (default):
■ The area where the information is obtained as

the Characteristic1 item from SYMMTRIX is set
to the default.

■ When CheckPaths or Device Health Check (1/
hour) is performed, the information of an
already-mapped external volume is updated to
the default.

OFF -
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Notes:

1. This SOM is applied when the EMC
SYMMETRIX is connected using UVM.

2. Enable the setting of EMC SCSI Flag SC3 for
the port of the EMC SYMMETRIX storage
connected with the storage system and
disable the setting of Flag SPC2. If the setting
of EMC SCSI Flag SC3 is not enabled or the
setting of Flag SPC2 is enabled, the effect of
this SOM may not be achieved.

3. If you want to enable this SOM immediately
after setting, perform Check Paths on each
path one by one for all the external ports
connected to the EMC SYMMETRIX storage.
But, without doing Check Paths, the display of
Characteristic1 can automatically be changed
by the Device Health Check to be performed
once an hour. If SSB=AD02 occurs and a path
is blocked, perform Check Paths on this path
again.

4. If the Check Paths is performed while
ShadowImage for Mainframe pair and
FlashCopy® Mirror pair are defined in the
specified volume, the Check Paths operation is
rejected with a message, “605 2518”. If
ShadowImage for Mainframe pair and
FlashCopy® Mirror pair are defined in the
specified volume, do not perform Check Paths
but wait until the display is automatically
changed.

749 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

Dynamic
Tiering

Dynamic
Tiering for
Mainframe

Thin Image

This SOM disables the HDP Rebalance function and
the HDT Tier relocation function which allow the
drives of all ECC Groups in the pool to share the
load.

Mode 749 = ON: The HDP Rebalance function and
the HDT Tier relocation function are disabled.

Mode 749 = OFF (default): The HDP Rebalance
function and the HDT Tier relocation function are
enabled.

OFF -
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Notes:

1. This SOM is applied when no change in
performance characteristic is desired.

2. When a pool is newly installed, the load may
be concentrated on the installed pool
volumes.

3. When 0 data discarding is executed, load may
be unbalanced among pool volumes.

4. Pool VOL deletion while this SOM is set to ON
fails. To delete pool VOLs, set this SOM to OFF.

757 Common Enables/disables output of in-band audit logs.

Mode 757 = ON: In-band audit log is not output.

Mode 757 = OFF (default): In-band audit log is
output.

Notes:

1. Mode 757 applies to the sites where
outputting the In-band audit logs is not
needed.

2. When this SOM is set to ON:

■ There is no access to SM for the In-band
audit logs, which can avoid the
corresponding performance degradation.

■ SM is not used for the In-band audit logs.

3. If outputting the In-band audit log is desired,
set this SOM to OFF.

OFF -

762 Universal
Replicator for
Mainframe

This SOM enables to settle the data to RCU
according to the time stamp specified in the
command when a Flush suspension for an EXCTG
is performed from BCM.

Mode 762 = ON: The data is settled to RCU
according to the time stamp specified in the
command.

Mode 762 = OFF (default): The data is settled to
RCU according to the time stamp that RCU has
received.

OFF Both

(On RCU
side,
considerati
on in
Takeover is
required
for setting)
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Notes:

1. This SOM is applied under the following
conditions.

■ Universal Replicator for Mainframe.

■ EXCTG configuration.

■ Flush suspension with an EXCTG specified
is executed.

■ BCM is installed on the host where the
time stamping function is available.

■ (In the case of multiple-host configuration,
SYSPLEX timer is available on the system)

2. If this SOM is set to ON while the BCM does
not exist in the environment where the time
stamping function is available (In the case of
multiple-host configuration, SYSPLEX timer is
available on the system), the pair status may
not become Suspend after Flush suspension
for an EXCTG.

3. Do not set this SOM to ON if the BCM does
not exist in the environment where the time
stamping function is available (In the case of
multiple-host configuration, SYSPLEX timer is
available on the system).

769 TrueCopy

TrueCopy for
Mainframe

Universal
Replicator

Universal
Replicator for
Mainframe

Controls whether the retry operation is executed or
not when a path creation operation is executed.
(The function applies to both of CU FREE path and
CU single path for Open and Mainframe).

Apply this SOM when the Basic HyperSwap®

function of TPC-R or CSM is used. The Basic
HyperSwap® function can allow the CESTPATH
operation to establish a path to several secondary
systems at the same time. Because attributes of a
port are switched if the CESTPATH operation is
performed with SOM 144 ON, the path status
between the primary and secondary systems is
changed to linkdown. If the CESTPATH operation is
performed to two or more secondary systems at
the same time, MIH may be reported to a host as
the other CESTPATH operation, which has detected
the linkdown path, retries the CESTPATH operation.
To disable an MIH report to a host, set this SOM to
ON to disable the CESTPATH to retry the operation
when a linkdown is detected.

OFF Both
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Mode 769 = ON: The retry operation is disabled
when the path creation operation is executed (retry
operation is not executed).

Mode 769 = OFF (default): The retry operation is
enabled when the path creation operation is
executed (retry operation is executed).

Notes:

1. Apply this SOM when the following three
conditions are met:

■ SOM 114 is set to OFF (operation of
automatically switching the port is
disabled).

■ HMO 49 and HMO 50 are set to OFF
(60-07-51-00/00 and later, 70-02-31-00/00
and later).

■ TPC-R or CSM is used (it is not applied in
normal operation).

2. When SOM 769 is set to ON, SOM 114, HMO
49 and HMO 50 must not be set to ON.

3. In either of the following cases, the path
creation operation might fail after automatic
port switching is executed.

■ SOM 114 is set to ON.

■ HMO 49 and HMO 50 are set to ON.

776 TrueCopy for
Mainframe

Business
Continuity
Manager

Allows you to select whether to output the F/M =
FB message to the host of primary system when
the split or the release operation is performed
from Business Continuity Manager to the S-VOL of
a TCz pair in Duplex status.

Mode 776 = ON: When the status of P-VOL
changes to Suspend during a TCz S-VOL pair
suspend or deletion operation from BCM, the F/
M=FB message is not output to the host.

Mode 776 = OFF (default): When the status of P-
VOL changes to Suspend during a TCz S-VOL pair
suspend or deletion operation from BCM, the F/
M=FB message is output to the host.

OFF Both
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Notes:

1. Set this SOM to ON in the environment where
TCz is used from BCM and the MCU host does
not need the F/M=FB message output during
an S-VOL pair suspend or deletion operation
from BCM.

2. If this SOM is set to ON, the F/M=FB message
is not output to the host when the status of P-
VOL changes to Suspend during an S-VOL pair
suspend or deletion operation from BCM.

3. If the PPRC item of CU option is set to NO, the
F/M=FB message is not output to the host
regardless of setting of this SOM.

4. If the function switch#07 is set to “enable”, the
F/M=FB message is not output to the host
regardless of setting of this SOM.

784 TrueCopy

TrueCopy for
Mainframe

Global-active
device

This SOM can reduce the MIH watch time of RI/O
for a TC, TCz, or GAD pair internally so that update
I/Os can continue by using an alternate path
without MIH or time-out occurrence in the
environment where Mainframe host MIH is set to
15 seconds, or Open host time-out time is short (15
seconds or less). This SOM is effective at initial pair
creation or Resync operation for TC, TCz, or GAD.
(Not effective by just setting this SOM to ON.)

This SOM is applied to TC, TCz, and GAD. This SOM
supports Fibre remote copy paths but not iSCSI.

Mode 784 = ON: The MIH time of RIO is internally
reduced so that, even though a path failure occurs
between storage systems in the environment
where host MIH time is set to 15 seconds, update
I/Os can be processed by using an alternate path
promptly, lowering the possibility of host MIH
occurrence.

Mode 784 = OFF (default): The operation is
processed in accordance with the TC, TCz, or GAD
specification.

OFF Both

System option modes

Appendix G: System option modes (SOMs)

System Administrator Guide for VSP G1x00 and VSP F1500 450



Mode Category Description Default MCU/RCU

Notes:

1. This SOM is applied to the environment where
Mainframe host MIH time is set to 15 seconds.

2. This SOM is applied to the environment where
OPEN host time-out time is set to 15 seconds
or less.

3. This SOM is applied to reduce RI/O MIH time
to 5 seconds.

4. This function is available for all the TC, TCz,
and GAD pairs on the storage system, unable
to specify the pairs that are using this function
or not.

5. To apply this SOM to TCz, MCU and RCU must
be USP V/VM or later models and micro-
program must be the support version on both
sides.

6. For a TC, TCz, or GAD pair with this SOM
effective (RI/O MIH time is 5 seconds), the
setting of RI/O MIH time made at RCU
registration (default is 15 seconds, which can
be changed within range from 10 to 100
seconds) is invalid. However, RI/O MIH time
displayed on Device Manager - Storage
Navigator and CCI is not “5 seconds” but is
what set at RI/O registration.

7. If a failure occurs on the switched path
between storage systems, Mainframe host
MIH or Open server time-out may occur.

8. If an MP to which the path between storage
systems belongs is overloaded, switching to
an alternate path delays and host MIH or
time-out may occur.

9. If an RI/O retry occurs due to other factors
than RI/O MIH (5 sec), such as a check
condition report issued from RCU to MCU, the
RI/O retry is performed on the same path
instead of an alternate path. If a response
delay to the RI/O occurs constantly on this
path due to path failure or link delay, host MIH
or time-out may occur due to response time
accumulation for each RI/O retried within 5
seconds.

10. Even though this SOM is set to ON, if
Mainframe host MIH time or Open host time-
out time is set to 10 seconds or less, host MIH
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or time-out may occur due to a path failure
between storage systems.

11. Operation commands are not available for
promptly switching to an alternate path.

12. This SOM works for the pair for which initial
pair creation or Resync operation is executed.

13. Micro-program downgrade to an unsupported
version cannot be executed unless all the TC,
TCz, and GAD pairs are suspended or deleted.

14. For operational specifications in each
combination of MCU and RCU of TCz/TC,
contact customer support (see SOM784
sheet).

15. For GAD pairs, this SOM is effective if the
microcode version supports GAD.

16. This SOM does not support iSCSI paths
between storage systems. When iSCSI is used
for paths between storage systems, the time
to switch to an alternate path cannot be
reduced. For this, if a failure occurs on a path
between storage systems in an environment
where host time-out time is short, a time-out
may occur on the host side. A time-out may
also occur on the host side when a failure
occurs on an iSCSI path between storage
systems if storage system paths of Fibre and
iSCSI coexist in an environment where host
time-out time is short so that the
configuration where storage system paths of
Fibre and iSCSI coexist is not supported too.

787 Compatible
FlashCopy®

V2

This SOM enables the batch prefetch copy.

Mode 787 = ON: The batch prefetch copy is
executed for an FCv2 pair and a Preserve Mirror
pair

Mode 787 = OFF (default): The batch prefetch
copy is not executed.

OFF -
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Notes:

1. When this SOM is set to ON, the performance
characteristic regarding sequential I/Os to the
FCv2 target VOL changes.

2. This SOM is applied only when SOM 577 is set
to OFF.

3. This SOM is applied if response performance
for a host I/O issued to the FCv2 target VOL is
prioritized.

803 Dynamic
Provisioning

Data
Retention
Utility

While a DP pool VOL is blocked, if a read or write
I/O is issued to the blocked pool VOL, this SOM can
enable the Protect attribute of DRU for the target
DP-VOL.

Mode 803 = ON: While a DP pool VOL is blocked, if
a read or write I/O is issued to the blocked pool
VOL, the DRU attribute is set to Protect.

Mode 803 = OFF (default): While a DP pool VOL is
blocked, if a read or write I/O is issued to the
blocked pool VOL, the DRU attribute is not set to
Protect.

For more details, contact customer support (see
SOM729 & 803 sheet).

OFF -
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Notes:

1. This SOM is applied when:

■ A file system using DP pool VOLs is used.

■ Data Retention Utility is installed.

2. Because the DRU attribute is set to Protect for
the V-VOL, a read I/O is also disabled.

3. If Data Retention Utility is not installed, the
expected effect cannot be achieved.

4. The Protect attribute of DRU for the DP V-VOL
can be released on the Data Retention
window of Device Manager - Storage
Navigator after recovering the blocked pool
VOL.

5. With 80-02-01-00/01 and later, the Virtual
Volume Protection (VVP) function is
supported. VVP can be enabled/disabled for
each pool. With SOM 803 disabled, VVP is also
disabled by default, but you can enable VVP
for each pool as needed. With SOM 803
enabled, VVP is also enabled automatically (by
default) when you create a new pool. Caution:
A pool is NOT protected by ANY FUNCTION if
you deliberately turn VVP for the pool from
ON (default) to OFF, even with SOM 803
enabled.

855 ShadowImage

ShadowImage
for
Mainframe

Volume
Migration

By switching this SOM to ON/OFF when
ShadowImage is used with SOM 467 set to ON,
copy processing is continued or stopped as follows.

Mode 855 = ON: When the amount of dirty data is
within the range from 58% to 63%, the next copy
processing is continued after the dirty data created
in the previous copy is cleared to prevent the
amount of dirty data from increasing (copy after
destaging). If the amount of dirty data exceeds
63%, the copy processing is stopped.

Mode 855 = OFF (default): The copy processing is
stopped when the amount of dirty data is over
60%.

For details, contact customer support (see SOM855
sheet).

OFF -
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Notes:

1. This SOM is applied when all the following
conditions are met

■ ShadowImage is used with SOM 467 set to
ON.

■ Write pending rate of an MP blade that has
LDEV ownership of the copy target is high

■ Usage rate of a parity group to which the
copy target LDEV belongs is low.

■ ShadowImage copy progress is delayed.

2. This SOM is available only when SOM 467 is
set to ON.

3. If the workload of the copy target parity group
is high, the copy processing may not be
improved even if this SOM is set to ON.

857 Common This SOM enables or disables to limit the cache
allocation capacity per MP blade/unit to within the
prescribed capacity* except for Cache Residency
Manager.

Mode 857 = ON: The cache allocation capacity is
limited to within the prescribed capacity*.

Mode 857 = OFF (default): The cache allocation
capacity is not limited to within the prescribed
capacity*.

*Prescribed capacity:
■ VSP G1000, VSP G1500, VSP F1500: 256 GB

Notes:

1. This SOM is applied to stabilize the
performance by preventing paging of PM
control information from occurring. For
details, refer to the section of Virtual Partition
Manager in the guideline.

2. The cache hit rate may decrease.
3. The cache allocation capacity per MPB/MPU is

limited to within the prescribed capacity.

OFF -

867 Dynamic
Provisioning

Dynamic
Tiering

All-page reclamation (discarding all mapping
information between DP pool and DP volumes) is
executed in DP-VOL LDEV format. This new method
is enabled or disabled by setting this SOM to ON or
OFF.

ON -
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Mode 867 = ON (default): LDEV format of the DP-
VOL is performed with page reclamation.

Mode 867 = OFF:LDEV format of the DP-VOL is
performed with 0 data writing.

Notes:

1. This SOM is applied from factory shipment.
2. Do not change the setting of this SOM during

DP-VOL format.
3. If the setting of this SOM is changed during

DP-VOL format, the change is not reflected to
the format of the DP-VOL being executed but
the format continues in the same method.

872 Universal
Volume
Manager

When this SOM is applied, the order of data
transfer slots is guaranteed at the destaging from
the storage system to an external storage system.

Mode 872 = ON (default*): The order of data
transfer slots from the storage system to an
external storage is guaranteed.

Mode 872 = OFF: The order of data transfer slots
from the storage system to an external storage is
not guaranteed.

*The default is OFF for microcode earlier than
80-03-31. In 80-03-31 and later versions, this SOM
is set to ON before shipment. If the micro-program
is exchanged to a supported version (80-03-31 or
later), the setting remains OFF and needs to be set
to ON manually.

Notes:

1. This SOM is applied when performance
improvement at sequential write in UVM
configuration is required.

2. By setting this SOM to ON, the usage rate of
MPs in MPB may become imbalanced, but the
processing is balanced in the MPB and the
performance per MPB is not affected.

ON -

895 TrueCopy for
Mainframe

Setting this SOM to ON or OFF, the link type with
transfer speed of 8 Gbps/16 Gbps or 4 Gbps is
reported respectively.

Mode 895 = ON (default*): When the FICON®/FC
link up speed is 8 Gbps/16 Gbps, the link type with
transfer speed of 8 Gbps/16 Gbps is reported.

ON Both
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Mode 895 = OFF: The link type with transfer speed
of up to 4 Gbps is reported , even when the actual
transfer speed is 8 Gbps/16 Gbps.

* The default value depends on the microcode
version as follows:
■ 80-05-23 to 80-05-32, 80-06-01 and later: default

= ON
■ 80-05-22 and earlier, 80-05-4x, 80-05-61: default

= OFF

Notes:

1. To apply this SOM, the RMF version of
mainframe z/OS® to be connected must be
1.12 or higher.

2. If the OS does not use a supported version,
the transfer speed cannot be displayed
correctly.

3. If all RMF versions of mainframe z/OS
connected are 1.12 or higher, set this SOM to
ON.

4. If any version of mainframe z/OS connected is
lower than 1.12, set this SOM to OFF.

896 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

Dynamic
Tiering

Dynamic
Tiering for
Mainframe

Thin Image

This SOM enables or disables the background
format function performed on an unformatted
area of a DP/DT/TI pool.

For information regarding operating conditions,
see the Provisioning Guide.

Mode 896 = ON (default): The background format
function is enabled.

Mode 896 = OFF: The background format function
is disabled.

ON -
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Notes:

1. This SOM is applied when a customer requires
the background format for a DP/DT/TI pool in
the environment where new page allocation
(in the case that system files are created from
a host for newly created multiple DP-VOLs, for
example) frequently occurs and the write
performance degrades because of an increase
in write pending rate.

2. When the background format function is
enabled, because up to 42 MB/s of ECCG
performance is used, local copy performance
may degrade by about 10%. Therefore,
confirm whether the 10% performance
degradation is acceptable or not before
enabling the function.

3. When a Dynamic Provisioning VOL on an
external storage system, which is used as an
external VOL, is used as a pool VOL, if the
external pool on the external storage side
becomes full due to the background format,
the external VOL may be blocked.

If the external pool capacity is smaller than
the external VOL capacity (Dynamic
Provisioning VOL of external storage system),
do not enable the background format
function.

4. If the background format function is disabled
by changing this SOM setting, the format
progress is initialized and the entire area
becomes unformatted.

5. The background format for FMC drives is not
disabled. When FMC drives are used, use SOM
1093.

897 Dynamic
Tiering

Dynamic
Tiering for
Mainframe

By the combination of SOM 897 and 898 setting,
the expansion width of Tier Range upper I/O value
(IOPH) can be changed as follows.

Mode 897 = ON:
■ SOM 898 is OFF: 110%+0IO
■ SOM 898 is ON: 110%+2IO

OFF -
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Mode 897 = OFF (default):
■ SOM 898 is OFF: 110%+5IO (default)
■ SOM 898 is ON: 110%+1IO

By setting the SOMs to ON to lower the upper limit
for each tier, the gray zone between other tiers
becomes narrow and the frequency of page
allocation increases.

Notes:

1. Apply this SOM when the upper tier usage is
low and lower tier usage is high.

2. This SOM must be used with SOM 898.
3. Narrowing the gray zone increases the

number of pages to migrate between tiers per
relocation.

4. When Tier1 is SSD while SOM 901 is set to ON,
the effect of SOM 897 and 898 to the gray
zone of Tier1 and Tier2 is disabled and the
SOM 901 setting is enabled instead. In
addition, the settings of SOM 897 and 898 are
effective for Tier2 and Tier3.

For more details about the interactions between
SOMs 897, 898, and 901, contact customer support
(see SOM897_898_901 sheet).

898 Dynamic
Tiering

Dynamic
Tiering for
Mainframe

By the combination of SOM 898 and 897 setting,
the expansion width of Tier Range upper I/O value
(IOPH) can be changed as follows.

Mode 898 = ON:
■ SOM 897 is OFF: 110%+1IO
■ SOM 897 is ON: 110%+2IO

Mode 898 = OFF (default):
■ SOM 897 is OFF: 110%+5IO (default)
■ SOM 897 is ON: 110%+0IO

By setting the SOMs to ON to lower the upper limit
for each tier, the gray zone between other tiers
becomes narrow and the frequency of page
allocation increases.

OFF -
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Notes:

1. Apply this SOM when the usage of upper tier
is low and that of lower tier is high.

2. This SOM must be used with SOM 897.
3. Narrowing the gray zone increases the

number of pages to migrate between tiers per
relocation.

4. When Tier1 is SSD while SOM 901 is set to ON,
the effect of SOM 897 and 898 to the gray
zone of Tier1 and Tier2 is disabled and the
SOM 901 setting is enabled instead. In
addition, the settings of SOM 897 and 898 are
effective for Tier2 and Tier3.

For more details about the interactions between
SOMs 897, 898, and 901, contact customer support
(see SOM897_898_901 sheet).

899 Volume
Migration

In combination with the SOM 900 setting, this SOM
determines whether to execute and when to start
the I/O synchronous copy change as follows.

Mode 899 = ON:
■ SOM 900 is ON: I/O synchronous copy starts

without retrying Volume Migration.
■ SOM 900 is OFF: I/O synchronous copy starts

when the threshold of Volume Migration retry is
 exceeded. (Recommended)

Mode 899 = OFF (default):
■ SOM 900 is ON: I/O synchronous copy starts

when the number of retries reaches half of the
threshold of Volume Migration retry.

■ SOM 900 is OFF: Volume Migration is retired and
I/O synchronous copy is not executed.

Notes:

1. This SOM is applied when improvement of
Volume Migration success rate is desired
under the condition that there are many
updates to a migration source volume of
Volume Migration.

2. During I/O synchronous copy, host I/O
performance degrades.

OFF -

System option modes

Appendix G: System option modes (SOMs)

System Administrator Guide for VSP G1x00 and VSP F1500 460



Mode Category Description Default MCU/RCU

900 Volume
Migration

In combination with SOM 899 setting, this SOM
determines whether to execute and when to start
the I/O synchronous copy change as follows.

Mode 900 = ON:
■ SOM 899 is ON: I/O synchronous copy starts

without retrying Volume Migration.
■ SOM 899 is OFF: I/O synchronous copy starts

when the number of retries reaches half of the
threshold of Volume Migration retry.

Mode 900 = OFF (default):
■ SOM 899 is ON: I/O synchronous copy starts

when the threshold of Volume Migration retry is
exceeded. (Recommended)

■ SOM 899 is OFF: Volume Migration is retired and
I/O synchronous copy is not executed.

Notes:

1. This SOM is applied when improvement of
Volume Migration success rate is desired
under the condition that there are many
updates to a migration source volume of
Volume Migration.

2. During I/O synchronous copy, host I/O
performance degrades.

OFF -

901 Dynamic
Tiering

Dynamic
Tiering for
Mainframe

By setting this SOM to ON or OFF, the page
allocation method of Tier Level ALL when the drive
type of tier1 is SSD changes as follows.

Mode 901 = ON: For tier1 (drive type is SSD), pages
are allocated until the capacity reaches the limit.
Without consideration of exceeding performance
limitation, allocation is done from highly loaded
pages until reaching the capacity limit

When the capacity of tier1 reaches the threshold
value, the minimum value of the tier range is set to
the starting value of the lower IOPH zone, and the
maximum value of the lower tier range is set to the
boundary value.

OFF -
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Mode 901 = OFF (default): For tier1 (drive type is
SSD), page allocation is performed based on
performance potential limitation. With
consideration of exceeding performance limitation,
allocation is done from highly loaded pages but at
the point when the performance limitation is
reached, pages are not allocated any more even
there is free space.

When the capacity of tier1 reaches the threshold
value, the minimum value of the tier range is set to
the boundary value, and the maximum value of the
lower tier range is set to a value of boundary-value
× 110% + 5 [IOPH].

Notes:

1. This SOM is applied when pages with the
maximum capacity need to be allocated to
tier1 (drive type is SSD) with Dynamic Tiering
or Dynamic Tiering for Mainframe.

2. When Tier1 is SSD while SOM 901 is set to ON,
the effect of SOM 897 and 898 to the gray
zone of Tier1 and Tier2 is disabled and the
SOM 901 setting is enabled instead. In
addition, the settings of SOM 897 and 898 are
effective for Tier2 and Tier3.

3. The following is recommended when applying
SOM 901.

actual I/O value (total number of I/Os of all
tiering policies) < performance potential value
of Tier1* × 0.6

* The performance potential value of Tier1
displayed on Monitor information by using
Dx-ray.

For more details about the interactions between
SOMs 897, 898, and 901, contact customer support
(see SOM897_898_901 sheet).

904 Dynamic
Tiering

Dynamic
Tiering for
Mainframe

By setting this SOM to ON or OFF, the number of
pages to be migrated per unit time at tier
relocation is changed.

Mode 904 = ON: The number of pages to be
migrated at tier relocation is set to up to one page
per second.

OFF -
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Mode 904 = OFF (default):No restriction on the
number of pages to be migrated at tier relocation
(existing specification).

Notes:

1. This SOM is applied when:

■ Dynamic Tiering for Mainframe is used
(including multi-platform configuration).

■ The requirement for response time is
severe.

2. The number of pages to be migrated per unit
time at tier relocation decreases.

908 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM can change CM capacity allocated to
MPBs with different workloads.

Mode 908 = ON: The difference in CM allocation
capacity among MPBs with different workload is
large.

Mode 908 = OFF (default): The difference in CM
allocation capacity among MPBs with different
workload is small (existing operation) .

OFF Both
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Notes:

1. If a CLPR is used by only some MPBs among
all the installed MPBs, set this SOM to ON for
the CLPR to increase CM capacity allocated to
the MPBs that use the CLPR.

Example:

(a) A CLPR only for UR JNLG.

(b) A configuration where MPBs and CLPRs are
separately used for Open and Mainframe
systems.

2. Since CM capacity allocated to MPBs with low
load is small, the performance is affected by a
sudden increase in load.

3. SOM 908 cannot be used with SOM 933. When
SOM 933 is set to ON, the function of SOM
908 is canceled even though SOM 908 is ON.

4. This SOM is effective for a CLPR. Therefore,
when setting this SOM to ON/OFF, select
target "LPRXX (XX=00 to 31)". For example,
even when CLPR0 is defined (any of CLPR1 to
31 are not defined), select “LPR00” first and
then set this SOM to ON/OFF.

930 Dynamic
Provisioning

Dynamic
Tiering

ShadowImage

When this SOM is set to ON, all of the zero data
page reclamation operations in processing are
stopped. (Also the zero data page reclamation
cannot be started.)

* Zero data page reclamation by WriteSame and
UNMAP functions, and IO synchronous page
reclamation are not disabled.

Mode 930 = ON: All of the zero data page
reclamation operations in processing are stopped
at once. (Also the zero data reclamation cannot be
newly started.)

Mode 930 = OFF (default): The zero data page
reclamation is performed.

For details about interactions with SOM 755 and
SOM 859, contact customer support (see SOM930
sheet).

OFF -
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Notes:

1. This SOM is applied when stopping or
disabling zero data page reclamation by user
request is required.

2. When this SOM is set to ON, the zero data
page reclamation does not work at all.

* Zero data page reclamation by Write Same
and UNMAP, and IO synchronous page
reclamation can work.

3. When downgrading micro-program to a
version that does not support this SOM while
this SOM is set to ON, set this SOM to OFF
after the downgrade.

* Because the zero data page reclamation
does not work at all while this SOM is set to
ON.

4. This SOM is related to SOM 755 and SOM 859.

937 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

Dynamic
Tiering

Dynamic
Tiering for
Mainframe

By setting this SOM to ON, HDT monitoring data is
collected even if the pool is a DP pool.

Mode 937 = ON: HDT monitoring data is collected
even if the pool is a DP pool.

Only Manual execution mode and Period mode are
supported.

Mode 937 = OFF (default): HDT monitoring data is
not collected if the pool is a DP pool

OFF -
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Notes:

1. This SOM is applied when HDT monitoring
data collection is required in DP environment.

2. When HDT is already used, do not set this
SOM to ON.

3. For HDT monitoring data collection, shared
memory for HDT must be installed. For
details, contact customer support (see
SOM937 sheet).

4. If monitoring data collection is performed
without shared memory for HDT installed, an
error is reported and the monitoring data
collection fails.

5. Before removing the shared memory for HDT,
set this SOM to OFF and wait for 30 minutes.

6. Tier relocation with monitoring data collected
when this SOM is set to ON is disabled.

7. When DP is converted into HDT (after
purchase of software license), the collected
monitoring data is discarded.

8. Before downgrading the micro-program to an
unsupported version, set SOM 937 to OFF and
wait for at least 30 minutes.

972 Common By setting this SOM, THP Page Size in Inquiry Page
E3h is changed. THP Page Size varies depending on
the combination of SOM 972 and 973 settings. For
details, contact customer support (see
SOM972_973 sheet).

Notes:

1. This SOM is applied when a delay in host I/O
response due to reclamation processing
occurs in a customer environment.

2. Reclamation processing is delayed.
3. This SOM is to prioritize host I/O response

over reclamation processing in VxVM
environment, so that the time required for
reclamation processing may increase when
this SOM is set to ON.

For details about the interaction between this SOM
and SOM 1069, contact customer support (see
SOM1069 sheet).

OFF -
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973 Common By setting this SOM, THP Page Size in Inquiry Page
E3h is changed. THP Page Size varies depending on
the combination of SOM972 and 973 settings. For
details, contact customer support (see
SOM972_973 sheet).

Notes:

1. This SOM is applied when a delay in host I/O
response due to reclamation processing
occurs in a customer environment.

2. When this SOM is set to ON, reclamation
processing is delayed.

3. This SOM is to prioritize host I/O response
over reclamation processing in VxVM
environment, so that the time required for
reclamation processing may increase when
this SOM is set to ON.

For details about the interaction between this SOM
and SOM 1069, contact customer support (see
SOM1069 sheet).

OFF -

1015 Universal
Replicator

Universal
Replicator for
Mainframe

When a delta resync is performed in a 3DC multi-
target configuration with TC and UR, this SOM is
used to change the pair status to PAIR/Duplex
directly and then complete the delta resync. If the
delta resync fails and all differential data items are
copied, the pair status changes to COPY/Pending
regardless of the SOM 1015 setting, and then it
changes to PAIR/Duplex.

When the existing delta resync function is required
(pair status changes to COPY/Pending and then to
PAIR/Duplex), set this SOM to ON before
performing delta resync. If SOM 1015 is set (ON or
OFF) while delta resync is being peformed, the
setting is not applied.

Mode 1015 = ON: The pair status changes to
COPY/Pending and then to PAIR/Duplex when a
delta resync is performed in a 3DC multi-target
configuration.

Mode 1015 = OFF (default): The pair status
changes directly to PAIR/Duplex when a delta
resync is performed in a 3DC multi-target
configuration.

Notes:

OFF MCU
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1. The pair status changes directly to PAIR/
Duplex when this SOM is OFF (default). Set
this SOM to ON only when the status change
to COPY/Pending and then PAIR/Duplex is
required.

2. Set this SOM on the site of TC S-VOL in TC-UR
3DC configuration. If site switch by delta
resync might occur, set this SOM on both TC
primary and secondary sites.

3. For microcode versions and storage system
models that do not support this SOM, even if
this SOM is set to OFF on L site of TC-UR delta
configuration, the behavior does not change
but the status changes to COPY/Pending and
then the delta resync is completed.

4. Regardless of the remote command device
setting, the copy status does not change to
COPY/Pending and then the delta resync is
completed.

5. If a delta resync fails, all-data copy works. In
this case, the pair status changes to COPY/
Pending and then the delta resync is
completed even when this SOM is set to OFF.

6. When this SOM setting is default (OFF), a delta
resync operation is completed without pair
status change to COPY/Pending. Therefore, if
an operation depends on the pair status
changing to COPY/Pending, such as running
the CCI pairevtwait command, set this SOM to
ON.

7. When this SOM setting is default (OFF) (pair
status changes directly to PAIR/Duplex), SIMs
and SSBs that are reported due to a pair
status change to COPY/Pending are not
reported.

8. If this SOM is set to ON or OFF during delta
resync, the setting is not applied. Change this
SOM setting before delta resync.

9. During delta resync, downgrading the
microcode to a version that does not support
this SOM is disabled in TC-UR delta
configuration. If microcode downgrade is
disabled (FunctionID:0701) when delta resync
is not in process, suspend the UR pair and
then retry the microcode replacement.
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1017 Universal
Replicator for
Mainframe

This SOM can be used to advance arbitration
processing of an extended consistency group and
restore journal data on storage systems at the
secondary site even when a Mainframe host
continues to issue I/Os with invalid time stamps.

Mode 1017 = ON: When Mainframe host I/Os with
invalid time stamp continue, the time stamp is
replaced with the latest time stamp in those of
journal data that storage systems at secondary site
in a consistency group receive, so that the
arbitration processing makes progress and journal
data in storage systems at secondary site can be
restored.

Mode 1017= OFF (default): The above function
does not work.

OFF RCU
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Notes:

1. When a Mainframe host issues I/Os with
invalid time stamps, SSB=4874 and SSB=CD58
are logged on storage systems at primary and
secondary sites respectively. In this case,
verify that the LDEV# of the primary volume
reported in SSB=4874 and the LDEV# of the
secondary volume reported in SSB=CD58 are
the primary and secondary volumes of a pair
respectively. If the combination of the
reported volumes matches the exact pair,
apply this SOM to all storage systems at
secondary site so as to advance the
arbitration processing and to restore journal
data on storage systems at secondary site.

2. This SOM works only when the timer type of
journal option on MCU and RCU is system.

3. Set the SOM to ON for all storage systems at
secondary site in Universal Replicator for
Mainframe MxN configuration (EXCTG).

4. To use the SOM, microcode must be the
support version and the SOM must be set to
ON for all storage systems at the secondary
site. To fail over, microcode must be the
support version and the SOM must be set to
ON for all storage systems at the primary site
too.

5. The function is applied to time stamps that
storage systems at secondary site receive
after setting the SOM.

6. If a Mainframe host issues I/Os with invalid
time stamps, SSB=CD58 is logged on the
target storage system at secondary site. If the
SOM is set to ON, SSB=CD57 is logged on the
target storage system at secondary site.

1021 Universal
Volume
Manager

This SOM can enable or disable the auto-recovery
for external volumes of an EMC storage system.

Mode 0121 = ON: An external volume that is
blocked due to Not Ready status can be recovered
automatically regardless of the type of external
storage system.

OFF -
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Mode 1021 = OFF (default): An external volume
that is blocked due to Not Ready status might not
be recovered automatically depending on the type
of external storage system.

Notes:

1. This SOM is applied when the auto-recovery of
external volumes that are blocked due to Not
Ready status is desired in UVM connection
using an ECM storage system as an external
storage system.

2. When this SOM is set to ON and the
connected external storage system is not in
stable status (such as failure and recovery
from failure), a blockage due to Not Ready
status and auto-recovery might occur
repeatedly.

1043 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM disables journal copy.

Mode 1043 = ON: When the following conditions
are met at the UR secondary site, the journal copy
is disabled.

For versions 80-02-05-00/00 and later, the
following conditions (1) and (2) or (1) and (3) are
met:

1. 4,096 or more journals are accumulated at the
secondary site.

2. The CLPR write pending rate for journal
volumes of MP blade/unit for which journal
ownership at the RCU is defined is 25% or
higher (including the write pending rate for
other than journal volumes).

3. It takes 15 seconds or longer to start restore
after journal copy at the RCU.

OFF Both
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For versions earlier than 80-02-05-00/00, the
following conditions (1) and (2) or (1) and (3) are
met:

1. 4,096 or more journals are accumulated at the
secondary site.

2. The CLPR write pending rate for journal
volumes of MP blade/unit for which journal
ownership at the RCU is defined is 25% or
higher (including the write pending rate for
other than journal volumes).

3. The initiator operating rate of the MP blade/
unit for which journal ownership at the RCU is
defined is 40% or higher.

Note: Even though the above conditions are met,
journal copy is not disabled when all time stamps
of the journals accumulated are the same in a
consistency group containing multiple journals.

Mode 1043 = OFF (default): The journal copy is
not disabled.

Notes:

1. This SOM applies when one of the following
conditions is met:

a. Multiple journals are registered in a
consistency group of CCI.

b. Multiple journals are registered in an
extended consistency group.
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c. Journals are accumulated at the
secondary site, causing the system
performance to decrease.

2. If SOM 690 is set to ON and the Write Pending
rate is 60% or higher, the journal copy is
disabled regardless of the setting of this SOM.

3. When the host write speed is faster than the
JNL copy speed, the usage rate of the master
journal increases.

4. This SOM is effective within the range of each
CLPR. Therefore, an operation target LPRxx
(xx= 00 to 31) needs to be selected before
setting this SOM to ON/OFF.

For example, when setting this SOM only to
CLPR0 (even though this SOM is not set to
CLPR 1 to 31), select "LPR00" and then set this
SOM to ON/OFF. If "System" is selected and
then this SOM is set to ON, this SOM is not
effective for any of the CLPRs.

5. Set SOM 1043 to ON when journals are not
accumulated at the RCU. If journals have
already been accumulated at the RCU, journal
copy does not start until the journal usage
rate becomes 0%. (If you need to set SOM
1043 to ON while journals are accumulated,
set Purge Suspend, and then perform resync.)

1050 Global-active
device

TrueCopy

TrueCopy for
Mainframe

Universal
Replicator

Universal
Replicator for
Mainframe

This SOM enables creation of pairs using user
capacity in excess of 1.8 PB per system by
managing differential BMP in hierarchical memory
for pair volumes whose capacity is 4 TB (open) or
262,668 cyl (mainframe) or less.

Mode 1050 = ON: For pair volumes of 4 TB (open)/
262,668 cyl (mainframe) or less, differential BMP is
managed in hierarchical memory that performs
caching to CM/PM using HDD as a master and
enables creation of pairs using user capacity in
excess of 1.8 PB per system.

For microcode 80-02-4x and later, you should use
hierarchical memory for all remote copy pairs.
Using SOMs 1050 and 1058 enables the use of
hierarchical memory for volumes of 4 TB or less,
which increases the total amount of replicated
capacity above 1.8 PB.

OFF Both
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WARNING: If you allocate more than 1.8 PB of
replicated capacity for volumes of 4 TB or less and
then later want to return to using shared memory,
you will have to delete some pairs to reduce the
total replicated capacity for volumes of 4 TB or less
to below 1.8 PB.

Mode 1050= OFF (default): For pair volumes of 4
TB (open)/262,668 cyl (mainframe) or less,
differential BMP is managed in SM as usual so that
the user capacity to create pairs is limited to 1.8 PB
per system. Also, differential MPB management
can be switched from the hierarchical memory to
SM by performing a resync operation for pairs
whose volume capacity is 4 TB (open)/ 262,668 cyl
(mainframe) or less.
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Notes:

1. This SOM is related to SOM 1058.
2. The hierarchical memory is used for volumes

over 4 TB (open)/262,668 cyl (mainframe) even
when this SOM is set to OFF.

3. When this SOM is turned OFF after operating
with this SOM set to ON, if resynchronizing
pairs whose volume capacity is 4 TB (open)/
262,668 cyl (mainframe) or less managed in
the hierarchical memory, the pair resync
operation might fail due to lack of the SM
capacity.

4. If a pair resync operation fails, the pairs
exceeding 1.8 PB of user capacity need to be
deleted.

5. Open non-DP-VOLs do not support
hierarchical memory differential management
so that this SOM cannot be applied.

6. To downgrade the microcode, the procedure
described in Maintenance Manual (Function
ID 01:03 described in 03 MICRO-FC) is
required. Refer to the manual before applying
this SOM.

7. Apply this SOM when you want to create pairs
using user capacity exceeding 1.8 PB per
system.

8. Depending on the I/O pattern, I/O response
might be affected.

9. Depending on the condition, initial copy time
might be affected.

10. The differential BMP managed in hierarchical
memory does not use the shared memory,
but the differential data is managed in a pool
with which the volumes are associated. For
the pool capacity necessary for the differential
data management, refer to the "Differential
data" section in the user guide.

11. Before using this SOM to increase pair
volumes on the storage system, check the
resources on the storage system to make sure
all performance requirements are met.
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1058 Global-active
device

TrueCopy

TrueCopy for
Mainframe

Universal
Replicator

Universal
Replicator for
Mainframe

This SOM can change differential BMP
management from SM to hierarchical memory so
that the number of pairs to be created on a system
and user capacity used for pairs increase.
■ For mainframe systems, all pairs can be

managed in hierarchical memory so that pairs
can be created by all LDEVs.

■ For open systems, pairs that can only be
managed in SM use SM so that the number of
pairs that can be created using non-DP-VOLs
increases.

Mode 1058 = ON:

When SOM 1050 is ON:
■ By resynchronizing mainframe VOLs of 262,668

cyl or less, the differential BMP management is
switched from SM to hierarchical memory.
Hierarchical memory management remains as
is.

■ By resynchronizing open VOLs (DP-VOLs only) of
4 TB or less, the differential BMP management
is switched from SM to hierarchical memory.
Hierarchical memory management remains as
is.

When SOM 1050 is OFF:
■ By resynchronizing mainframe VOLs of 262,668

cyl or less, the differential BMP management is
switched from hierarchical memory to SM. SM
management remains as is.

■ By resynchronizing open VOLs (DP-VOLs only) of
4 TB or less, the differential BMP management
is switched from hierarchical memory to SM. SM
management remains as is.

Mode 1058 = OFF (default):

When SOM 1050 is ON: The differential BMP
management does not change by resynchronizing
pairs.

OFF Both
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When SOM 1050 is OFF:
■ By resynchronizing mainframe VOLs of 262,668

cyl or less, the differential BMP management is
switched from hierarchical memory to SM. SM
management remains as is.

■ By resynchronizing open VOLs (DP-VOLs only) of
4 TB or less, the differential BMP management
is switched from hierarchical memory to SM. SM
management remains as is.

For microcode 80-02-4x and later, you should use
hierarchical memory for all remote copy pairs.
Using SOMs 1050 and 1058 enables the use of
hierarchical memory for volumes of 4 TB or less,
which increases the total amount of replicated
capacity above 1.8 PB.

WARNING: If you allocate more than 1.8 PB of
replicated capacity for volumes of 4 TB or less and
then later want to return to using shared memory,
you will have to delete some pairs to reduce the
total replicated capacity for volumes of 4 TB or less
to below 1.8 PB.
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Notes:

1. Depending on the I/O pattern, I/O response
might be affected.

2. Depending on the condition, initial copy time
might be affected.

3. This SOM is related to SOM 1050.
4. Open non-DP-VOLs do not support

hierarchical memory differential management
so that this SOM cannot be applied.

5. To downgrade the microcode, the procedure
described in Maintenance Manual Function ID
01:03 described in 03 MICRO-FC. is required.
Refer to the manual before applying this SOM.

6. This SOM is applied when increasing the
number of pairs that can be created on a
system or the user capacity for pairs is
desired.

7. The differential BMP managed in hierarchical
memory does not use the shared memory,
but the differential data is managed in a pool
with which the volumes are associated. For
the pool capacity necessary for the differential
data management, refer to "Differential data"
in the manuals for TC, UR, and GAD. Before
using this SOM to increase pair volumes on
the storage system, reexamine the resource
on the storage system to make sure all
performance requirements are met.

8. Before using this SOM to increase pair
volumes on the storage system, re-examine
the resource on the storage system to make
sure all performance requirements are met.

1061 Compatible
FlashCopy®

V2

Compatible
FlashCopy® SE

This SOM is used to enable the copy after write
(CAW) function of FlashCopy®.

By setting this SOM to ON, CAW (While copy
processing is withheld, command response is
returned first and then the copy is done in
asynchronous manner) can work so as to improve
random write response performance. (In the case
of sequential write, as an improvement to copy
data in advance has been implemented, the equal
performance can be achieved without CAW.)

Mode 1061 = ON: The CAW function works.

OFF -
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Mode 1061 = OFF (default): The CAW function
does not work. (COW works.)

Notes:

1. This SOM is applied when the CAW function is
enabled.

2. The cache write pending rate may increase.

1067 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM is used to enable microcode downgrade
to a version that does not support URxUR
(including delta).

Mode 1067 = ON: Even when a UR pair has been
registered, downgrading the microcode to a
version that does not support URxUR (including
delta) is allowed.

Mode 1067 = OFF (default): If any UR pair has
been registered, downgrading the microcode to a
version that does not support URxUR (including
delta) is not allowed.

Notes:

1. This SOM is applied to enable microcode
downgrade to a version that does not support
URxUR (including delta) if the configuration
where any UR pair has been registered is not
URxUR (including delta).

2. Setting this SOM to ON allows microcode
downgrade at sites where only 1 mirror is
used in URxUR multi-target configuration
without delta resync and cascade
configuration (L or R site in multi-target, and P
or R site in cascade), but the following
phenomena occur after microcode
downgrade. Make sure that the target storage
system does not contain pairs of URxUR
configuration.

OFF Both
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Phenomena:

a. When the microcode is downgraded at S
site (local or remote) in multi-target
configuration, the pair between P site
and the target S site cannot be
resynchronized.

b. When the pair between I site and R site in
cascade configuration is resynchronized,
the pair status cannot change from COPY
to PAIR.

c. When the microcode is downgraded at R
site in cascade configuration, the pair
between I site and R site cannot be
resynchronized.

1068 Common This mode can detect and report a minor drive
response delay early by severely checking drives.

Mode 1068 = ON: Drive response delay is checked
and detected with conditions that are more severe
than current conditions.

When SOM 144 is set to ON, the drive with
response delay is blocked.

Target drive: HDD, FMD, SSD

Mode 1068 = OFF: Drive response delay is checked
and detected with current conditions.

The behavior varies depending on the
combinations of SOM settings. For details, contact
customer support (see SOM144 sheet).

Notes:

1. Apply this mode to detect a minor delay in
drive response.

2. When a delay is suspected, a processing to
refer to the statistics data and determine the
delay works.

3. If SOM 157 is set to ON, the output prevention
status of SSB=A4CE is not cleared in one-day
cycle.

4. When applying this mode only, a SIM for delay
detection is reported but the HDD is not
blocked. To block the HDD, SOM 144 also
needs to be applied.

OFF -
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1069 Common By setting this SOM, the INQUIRY Page E3h field is
changed. The field varies depending on the
combination of SOMs 972, 973, and 1069. For
details, contact customer support (see SOM1069
sheet).

Notes:

1. This SOM is applied when the page problem
occurs in an environment where Symantec
ASL 6.0.5 or higher is used and SOM 972
and/or 973 is set to ON.

2. When this SOM is set to ON, reclamation
processing is delayed.

3. The priority of setting when SOMs are set at
the same time is SOM 1069, 972, and then
973. The setting of higher priority SOM is
enabled.

OFF -

1070 Global-active
device

This SOM changes the processing for a group
operation with GAD consistency group (CTG).

Mode 1070 = ON: The status change of all pairs in
a consistency group. is performed for 50 msec.

Mode 1070 = OFF (default): The status change of
all pairs in a consistency group is performed for 1
msec.

Notes:

1. This SOM is applied when reducing the time to
complete status change of all pairs in a
consistency group at a group operation
(suspension and resync operation) with the
GAD CTG function. In a system configuration
where host I/O performance is prioritized, do
not use this SOM because setting this SOM
may affect the host I/O performance.

2. The MP usage rate increases during status
change of all pairs in a consistency group. For
details about approximate percentage
increase in MP usage rate, contact customer
support (see SOM1070 sheet).

OFF Both

1079 Dynamic
Provisioning

Dynamic
Tiering

This SOM is set not to run the Proprietary ANCHOR
command during microcode downgrade from a
version that supports the Proprietary ANCHOR
command to a version that does not support the
command.

OFF -
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Mode 1079 = ON: The Proprietary ANCHOR
command is unavailable.

Mode 1079 = OFF (default): The Proprietary
ANCHOR command is available.

Notes:

1. This SOM is applied when downgrading the
microcode from a version that supports the
Proprietary ANCHOR command to a version
that does not support the command.

2. Whether the Proprietary ANCHOR command
can be run or not varies depending on the
setting combination of SOM 1079 and HMO
97 as follows:

a. SOM 1079 setting ON/HMO 97 setting
ON --> Proprietary ANCHOR command
Unavailable

b. SOM 1079 setting ON/HMO 97 setting
OFF --> Proprietary ANCHOR command
Unavailable

c. SOM 1079 setting OFF/HMO 97 setting
ON --> Proprietary ANCHOR command
Available

d. SOM 1079 setting OFF/HMO 97 setting
OFF --> Proprietary ANCHOR command
Unavailable

1080 Global-active
device

Universal
Volume
Manager

This SOM is intended for a case that multiple
external connection paths are connected to a
Target port on an external system with a quorum
disk and there is a path whose performance
degrades. For such a case, this SOM can eliminate
impacts on commands run for other external
devices that share the Target port with the quorum
disk on the external system by setting the time to
run a reset command for the Target port to be the
same (15 seconds) as that to run other commands
for the other external devices.

Mode 1080 = ON: The time to run the reset
command for the quorum disk on the external
system is 15 seconds to eliminate the impacts on
commands run for the other external devices that
share the Target port with the quorum disk on the
external system.

OFF -
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If a response to ABTS is delayed for 12 seconds or
longer, the quorum disk may be blocked.

Mode 1080 = OFF (default): The time to run a
reset command for the quorum disk when
performance of a path degrades is 3 seconds so
that a retry is performed by an alternate path to
avoid quorum disk blockage.

Notes:

1. This SOM is applied if avoiding impacts on
commands for other external devices sharing
a Target port on an external system side with
a quorum disk is prioritized over preventing
quorum disk blockage when a response to
ABTS is delayed.

The delay is caused due to path performance
degradation in a configuration where the
Target port is shared between external
devices and the quorum disk.

2. When connection performance degradation
occurs, the quorum disk blockage is more
likely to occur.

1083 Dynamic
Provisioning

Universal
Volume
Manager

This SOM enables or disables DP-VOL deletion
while an external volume associated with the DP-
VOL with data direct mapping attribute is not
disconnected.

Mode 1083 = ON: DP-VOL deletion is enabled.

Mode 1083 = OFF (default): DP-VOL deletion is
disabled.

OFF -
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Notes:

1. This SOM is applied when the following
conditions are met.

■ A DP-VOL with data direct mapping
attribute is deleted.

■ The data of external volume with data
direct mapping attribute associated with a
deletion target DP-VOL with data direct
mapping attribute will not be used again.

2. When SOM 1083 is set to ON, the data of
external volumes cannot be guaranteed.

3. When DP-VOL deletion is performed without
disconnecting an external volume, the data of
the external volume cannot be guaranteed.

1086 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

Universal
Volume
Manager

This SOM enables or disables the performance
improvement for Dynamic Provisioning volumes
that are Universal Volume Manager volumes used
as pool volumes.

Mode 1086 = ON (default): The performance
improvement is enabled.

Mode 1086 = OFF: The performance improvement
is disabled.

Notes:

1. This SOM is applied when the IOPS
performance of an external storage system is
higher than 80k × the number of installed
MPBs, which is the value of IOPS that an entire
local storage system sends to an external
storage system.

2. When it is required to set this SOM to OFF, if
IOPS sent from the local storage system to the
external storage system is higher than 80k ×
the number of installed MPBs, reduce the
IOPS to lower than 80k × the number of
installed MPBs, and then set this SOM to OFF.
(Otherwise CWP increases and cache is
overloaded.)

ON -

1091 Compatible
FlashCopy®

V2

This SOM enables or disables the IBM®

zHyperWrite function. When this SOM setting is
changed to ON or OFF, SCI is reported to the host
and the zHyperWrite function is enabled or
disabled.

OFF Both
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TrueCopy for
Mainframe

Universal
Replicator for
Mainframe

Mode 1091 = ON: The zHyperWrite function is
enabled. (ReadFeatureCode setting for the
zHyperWrite function)

Mode 1091 = OFF (default): The zHyperWrite
function is disabled.

Notes:

1. This SOM can be applied when DKCMAIN
version 80-04-21-00/00 or higher that
supports the zHyperWrite function is used.

2. To use the zHyperWrite function, a HyperSwap
environment is required.

3. To enable the zHyperWrite function, set this
SOM to ON on both MCU and RCU.

4. To downgrade the microcode to a version that
does not support the zHyperWrite function,
set this SOM to OFF prior to downgrading the
microcode.

5. Even when this SOM is set to ON for a storage
system in 3DC configuration, the zHyperWrite
function does not work for volumes in 3DC
configuration.

6. Do not set this SOM to ON if SOM 474 is set to
ON.

7. Do not set this SOM to ON if Preserve Mirror
configuration is created.

8. Do not set this SOM to ON if the TCz Function
Switch 12 is set to ON.

9. To use the zHyperWrite function, make sure
that the CFW Data setting for the PPRC/TCz
pairs is set to Secondary Volume Copy so that
CFW data is copied to the S-VOL. If CFW Data
is set to Primary Volume Only, zHyperWrite
will not function.

1093 Dynamic
Provisioning

Dynamic
Tiering

Thin Image

This SOM is used to disable background unmap
during microcode downgrade from a version that
supports pool reduction rate correction to a
version that does not support the function.

Mode 1093 = ON: Background unmap cannot
work.

Mode 1093 = OFF (default): Background unmap
can work.

OFF -
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Note: This SOM is applied when downgrading
microcode from a version that supports pool
reduction rate correction to a version that does not
support the function is disabled.

1096 Universal
Replicator

Universal
Replicator for
Mainframe

This SOM disables read-journal frequency
reduction.

Mode 1096 = ON: The read-journal frequency
reduction does not work.

Mode 1096 = OFF (default): The read-journal
frequency reduction works.

Notes:

1. This SOM is applied when a significant delay,
which is about 200 msec or longer, occurs in
the line between MCU and RCU.

2. When this SOM is set to ON while round-trip
delay time is small (about less than 20 msec),
the usage rate of RCU Initiator increases by
10% x the number of journals.

3. Even though this SOM is supposed to be
applied to UR RCU, apply it to both MCU and
RCU on the premise of DR operation.

4. This SOM is effective for each CLPR, so that
select the operation target LPRxx (xx=00 to
31), and then set this SOM to ON/OFF. For
example, when only CLPR0 is defined (CLPR1
to 31 are not defined), select LPR00 and then
set this SOM to ON/OFF. This SOM is not
effective for any CLPRs if “System” is selected
even when this SOM is set to ON.

OFF Both

1099 TrueCopy for
Mainframe

When PPRC FREEZE using GDPS works, the FREEZE
might time out if the storage system has more than
32 CUs. This SOM changes the FREEZE behavior to
prevent time-out for a storage system with more
than 32 CUs.

OFF MCU
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Mode Category Description Default MCU/RCU

Mode 1099 = ON: When FREEZE is received, the
completion of path deletion for those other than
the last path is not reported but only the
completion of path deletion for the last path is
reported. If multiple CUs share an RCU path, path
deletion does not work at FREEZE per CU, so that
the following phenomenon may occur:
■ After Hyperswap is performed, SSB=8BD8 and

8BD9 are logged for a pair where the
Hyperswap is performed.

Mode 1099 = OFF (default): The completion of
path deletion for every path is reported.

Notes:

1. Apply this mode when a storage system with
over 32 CUs is used in a TCz environment in
which PPRC FREEZE is available.

2. The mode is effective for the entire storage
system.

3. To set this mode to ON, the microcode must
be 80-04-24-00/00 or later on both the MCU
and the RCU.

4. FREEZE using Sync CTG is performed without
path deletion, so it is not subject to this
change in FREEZE behavior.

1106 Dynamic
Provisioning

Dynamic
Provisioning
for
Mainframe

Dynamic
Tiering

Dynamic
Tiering for
Mainframe

This SOM is used to monitor the page usage rate of
parity groups defined to a pool, and perform
rebalance to balance the usage rate if the rate
differs significantly among parity groups.

Mode 1106 = ON: The usage rate is checked once a
day and the rebalance works if the rate is not even.

Mode 1106 = OFF (default): The rebalance does
not work even when the usage rate is not
balanced.

The pool usage rate is determined as unbalanced
when there is 25% or more difference between the
usage rate of each parity group in the pool and the
average.

OFF -
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Mode Category Description Default MCU/RCU

Note: The term "page usage rate" refers to the
percentage of the number of assigned pages in
each PG compared to the total number of pages in
the pool. For HDT pools, the term "total number of
pages" is the number of pages assigned within
each specific tier.

Examples:

1. In an HDP pool, if the usage rates of PG1, PG2,
and PG3 are 50%, 40%, and 30% respectively,
it is not determined as unbalanced.

Because the average parity group usage rate
is (50%＋ 40%＋ 30%) / 3 ＝ 40% and the
difference in the rate between each parity
group and the average is 10% at the
maximum.

2. In an HDP pool, if the usage rates of PG1, PG2,
and PG3 are 80%, 40%, and 30% respectively,
it is determined as unbalanced.

Because the average parity group usage rate
is (80%＋ 40%＋ 30%) / 3 ＝ 50% and the
difference in the rate between each parity
group and the average is 30% at the
maximum.

3. In an HDT pool, if the usage rates of PG1, PG2,
and PG3 are 80% (SSD), 40% (SAS15K) and
30% (SAS15K), it is not determined as
unbalanced, because:

■ The average parity group usage rate of
Tier1 is (80%) / 1 ＝ 80% and the difference
in the rate between the parity group and
the average is 0%.

■ The average parity group usage rate of
Tier2 is (40%＋ 30%) / 2 ＝ 35% and the
difference in the rate between the parity
group and the average is 5% at the
maximum.

Note: This SOM is applied when balancing the
usage rate is required at a customer site where the
usage rate is not even.
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Mode Category Description Default MCU/RCU

1113 Deduplication
and
Compression

If a problem occurs while the capacity saving
function is enabled and the MP usage rate needs
to be reduced to identify the failure, use this mode
to stop asynchronous processing of host I/Os by
the capacity saving function other than garbage
collection and de-staging.

Mode 1113 = ON: The asynchronous processing of
host I/Os by the capacity saving function, other
than garbage collection and de-staging, is stopped.

Note: While the capacity reduction processing is
not working, the capacity saving rate might
degrade.

Mode 1113 = OFF (default): The capacity saving
function fully works.

Relationship between SOM 1113 and SOM 1112:
When both modes are set to ON, the setting of
SOM 1112 is prioritized over that of SOM 1113.
When SOM 1112 is set to ON, all asynchronous
processing for host I/Os among those related to
the capacity saving function are stopped, including
garbage collection and de-staging, so that write
I/Os to V-VOLs with Compression or Deduplication
and Compression set are disabled.

OFF -

1115 Deduplication
and
Compression

When this SOM is set to ON, data is initialized
without using metadata at LDEV format for a
virtual volume with capacity saving enabled.

Caution: Use SOM 1115 only when performing
recovery procedures. This SOM is used only when
performing recovery procedures described in the
Maintenance Manual.

Mode 1115 = ON: When LDEV format is performed
for a virtual volume whose capacity saving setting
is Compression, the data is initialized without using
the metadata.

OFF -
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Mode 1115 = OFF (default): When LDEV format is
performed for a virtual volume whose capacity
saving setting is Compression, normal formatting is
performed, but if one of the following conditions is
met, the data is initialized without using metadata.
■ There is a pinned slot.
■ The capacity saving status is “Failed”.
■ The virtual volume is blocked (Normal restore

cannot be performed).

Notes:

1. Apply this SOM only when performing
recovery procedures. For details about when
to turn SOM 1115 on and off, see the
instructions in the Maintenance Manual.

2. The processing time increases with increase in
pool capacity.

Estimate of processing time:

Processing time (minutes) = ceiling(pool
capacity (TB)/40) + 5

ceiling: The value enclosed in ceiling( ) must
be rounded up to the nearest whole number.

The processing finishes early if there is less
capacity of allocated pages.

3. Do not change this SOM setting during LDEV
format for a virtual volume whose capacity
saving setting is Compression. If the setting is
changed, the processing cannot be performed
correctly and may end abnormally depending
on the timing.

4. This SOM is effective only for LDEV format for
a virtual volume whose capacity saving setting
is Compression, so that there is no side effect
in relation to user data, but the processing
may take more time than that when this SOM
is set to OFF depending on the pool capacity.
Therefore, do not use this SOM for cases
other than pool volume blockage recovery.

1118 Open This SOM is used to disable the ENC reuse
function.

OFF -
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Mode 1118 = ON: When a failure occurs in the
Expander chip mounted on a controller board
(CTLS, CTLSE) or an ENC board, the reuse function
does not work but SIM=CF12XX is reported and the
ENC is blocked.

Mode 1118 = OFF (default): When a failure occurs
in the Expander chip mounted on a controller
board (CTLS, CTLSE) or an ENC board, the reuse
function works.

If the ENC is reusable, SIM=CF12XX and then
CF14XX are reported, and the ENC is reused.

If the ENC is not reusable, SIM=CF12XX is reported,
and the ENC is blocked.

Note: The ENC reuse function is enabled as
default. This SOM is applied when you want to
disable the ENC reuse function.

1119 Deduplication
and
Compression

This SOM is used to downgrade the microcode as
follows while capacity saving is enabled: from
80-05-05-00/00 or later to 80-05-01-00/00 or later.

New control information is added with 80-05-05 for
the inflow control processing when capacity saving
is enabled. However, it must be guaranteed that
the area is not used when the microcode version is
80-05-01 or later. This SOM disables the control
information added with 80-05-05 when capacity
saving is enabled to enable microcode downgrade.

Mode 1119 = ON: The control information is not
used when capacity saving is enabled.

Mode 1119 = OFF (default): The control
information is used when capacity saving is
enabled.

OFF -
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Notes:

1. Set this SOM to ON when the microcode
downgrade described above is performed,
even if capacity saving is not currently in use
but has been used before.

2. After the microcode downgrade is complete,
make sure to set this SOM to OFF.

3. This SOM is effective for the entire storage
system.

4. The write performance might degrade when
this SOM is ON.

1120 Dynamic
Provisioning

Thin Image

This SOM disables TI pair creation in DP pools and
releases cache management devices to enable the
microcode downgrade from 80-05-44 or later to
earlier than 80-05-44.

Mode 1120 = ON: TI pair creation with DP pool
specified is disabled. Also, if any cache
management devices are reserved while there is
no TI pool in the storage system, all cache
management devices are released.

Mode 1120 = OFF (default): No action.

Notes:

1. Set this SOM to ON when the microcode
downgrade described above is performed
while there is a DP pool in the storage system.

2. Set this SOM to ON only when downgrading
the microcode.

3. Before setting this SOM to ON, delete all TI
pairs in DP pools.

4. After the microcode downgrade is complete,
make sure to set this SOM to OFF.

OFF -

1147 Universal
Replicator for
Mainframe

This mode is used to prevent the performance of
write I/O to a URz P-VOL from degrading when the
path condition is unstable or the RCU site is
overloaded in a configuration where high-speed
drives (HAF/SSD) are used for journal volumes.

Apply this mode when:
■ Drives constituting a URz journal volume are

HAF/SSD(*), and
■ Host I/Os are prioritized and accumulating

journal is required (suspending is acceptable).

OFF MCU
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* If the drives constituting the URz journal volume
are HDDs, the mode can be applied when the
staging performance outweighs the amount of
read journal transfer.

Mode 1147 = ON The caching rate of journal data
created at a write I/O to a URz P-VOL is limited to
50% (equal to Open environment). (The URz pair
might be suspended as journal data tends to
accumulate compared to the OFF setting.)

Mode 1147 = OFF (default) The caching rate of
journal data created at a write I/O to a URz P-VOL is
limited to 70% (same as usual). (Compared to the
ON setting, the performance of host write I/Os
tends to be affected when CWP reaches 70%.)

Notes:

1. Do not set this mode to ON if HDDs whose
staging performance is lower than the amount
of read journal transfer are used for the
journal volume.

2. This mode is effective for CLPR. To set the
mode, select an operation target LPRxx (xx=00
to 31), and then set the mode to ON or OFF.

When defining CLPR0 only (for example, when
CLPR 1 to 31 are not defined), select LPR00
and then set the mode to ON or OFF. If
System is selected and then the mode is set to
ON, the mode is not effective for any CLPRs.
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